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Welcome to TEMA!

                       

TEMA is a software package for motion analysis, based on the Trac kEye technology from Image Systems
AB.

 What's New?
 TEMA Main Window
 Getting Started 
 Using the Help System
 System Versions
 TEMA Viewer

Note: The same information as in this online help system can be found in standalone T EMA manual in .
pdf form.
Look in your TEMA installation folder\Help. The software Ac robat Reader from Adobe is required to open
this file. 

If you have any questions or problems with this software, please e-mail our technical support.
 
For additional information about Image Systems AB and our products,
please visit our website, www.imagesystems.se

 

http://www.imagesystems.tv
http://www.imagesystems.tv
mailto:support@imagesystems.se
www.imagesystems.se
http://www.imagesystems.se


p3

© Image Systems AB, 2011

Using the Help System
 The majority of dialogs and windows contain either a Help button, or appropriate options in a Help

menu, to enable context-sensitive help to be displayed from the application.
 
 Context-sensitive help can also be displayed by pressing the <F1> key when the appropriate

dialog or window has been selected. This is partic ularly useful for simple windows that contain only
graphical information, i.e. those that do not have buttons or a m enu.

 
 The simplest dialogs do not have a specific help topic, espec ially if the dialog itself contains its own

instructions. If help is required for such dialogs, return to the parent dialog and access help from
there.

 
 Once a help topic has been displayed, you may follow the hyperlinks to associated information.
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System Versions
To match different user conditions, TEMA comes in a broad variety of versions. 

 The  base  products  are  TEMA  Motion  and  TEMA  Automotive.  There  is  also  the  Camera  Control
version, which is a freestanding product. This can however, be combined with  analysis functionality. 

 Optional products are TEMA Arena and TEMA Gun Scoring

 For users who do not need all 2D functionality, there are pre-set 2D entry configurations with limited
functionality. Those are listed below. 

 Further customization can be done using in a huge number of different optional functionality. 

Available 2D entry configurations
Besides the 3D and 6D options, TEMA 2D is also offered in a number of different entry levels, where your
specific application determines the level of TEMA you require. An entry level can over time be updated to
a higher level of TEMA.  A summary of the functionality is described below.  

TEMA Starter 1: Allows  tracking of  single  point  with  correlation  tracker.  Possible  to  plot  one  point
and make table of positions. 

TEMA Starter 2: Allows tracking of 5 points with correlation tracker. Possible to plot points and make
tables of positions, velocity and acceleration. Some additional scaling functionality. 

TEMA Lite: Starter 2 plus quad tracking, X/Y diagrams and export of data. A TEMA Lite user has
also possibility to upgrade to the major TEMA options like 3D, 6D etc.

TEMA Player: Image viewer and format conversion. It can view all formats that TEMA c an view,
but no analysis can be done. There are two versions of this one, Player 1 and 2.
Player 2 can 

Optional functionality
3D

6D

TEMA Lens calibration

Airbag Contour Tracker

Airbag Volume

MXT Tracker

TEMA Viewer

Advanced Viewer
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Required configurations

The different TEMA options require different basic  functionality and are therefore not available to all
configurations of TEMA. Below is a list of which configuration that is required for a certain TEMA option.  

TEMA Starter I LITE TEMA
Motion

TEMA
Automotive

Options
Dongle licence   
Floating license   
3D   
6D  
MXT tracker 
Airbag Volume 
Lens calibration Image Systems  
Lens Calibration Aicon  
Viewer  
Advanced Viewer  
3D with moving cameras  
Outline  tracker, threshold based (TEMA motion option)
Adv. Outline tracker, edge based  (TEMA motion option)  not applicable

TEMA Camera Control
TEMA Camera Control is an option to TEMA, the world leading system for advanced motion analysis, and
it  offers  the  possibility  to  control  several  different  brands  of  high-speed  cameras  from  one  single
program.
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Lite Version
The Lite version contains functionality applicable to a broad range of sim pler situations.

The standard Lite version contains the following menu options:
 File 

o New 
 Camera View
 Data File

o New Test
o Open Test
o Save Test
o Save Test As
o Exit

 Edit 
o Copy
o Delete
o Test Description
o Time Properties
o Scaling/Grid (2D Scaling, coordinate Grids only) 
o Properties

 View 
o Zoom In
o Zoom Out
o Zoom 1:1
o Notes
o Split View
o Show Window

 Camera 
o Add Point
o Add Distance
o Add Angle
o Goto t0
o Set t0
o Show Camera View Windows
o Show Zoom Windows
o Image Enhancement
o Select New Image File
o Rename View

 Tracking 
o Enable
o Disable
o Sleep
o Sleep in Selected Interval

 Diagram 
o New 

 XT Diagram
 XY Diagram
 Table

o Grid
o Legends
o Legends Settings
o Export Data

 Tools 
o Select
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o Relation
o Distance
o Angle
o Zoom
o White Balance
o Toolbars
o Licence
o Optimize Display Performance
o Preferences

Note: Your configuration may differ from the above standard version.
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Getting Started
This section outlines the basic steps for each m ode of operation, providing links to the detailed
instructions for each step.

The TEMA system is capable of operating in the following modes: 
 2D
 3D
 6D
 DIC

Note: 3D, 6D & DIC are optional features.
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2D - Getting Started
The following is the list of steps required to set up an im age sequence, track it in two dimensions and
display the results graphically: 

1. Start up TEMA. 
2. Add a new camera view. 
3. Add some tracking points. 
4. Position the tracking points. 
5. Run the tracking function. 
6. Display the results, as required, in:

o An XT Diagram; 
o A Multi Axis Diagram; 
o An XY Diagram; 
o A Time Table. 

7. Save the results. 
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Getting Started - 3D (Optional Feature)
The following is the list of steps required to set up two image sequences from two camera views taken of
the same test, track them in three dimensions and display the results graphically.

Note: The original filming must be carried out under the following c onditions:
 The two cameras must be positioned far enough apart, compared to the distance to the target to

give a significant difference in perspective. The best results are obtained when the two cam eras
and the centre of the target roughly form an equilateral triangle. If the angle from the target to
the cameras is small, poor results are obtained.

 A minimum of four reference points are required for ac curate orientation of the cameras.
 The two film sequences must include a significant event that is easily identifiable to enable the

two sequences to be synchronised. This can be, for example,  the point of impact in a crash test
or the momentary illumination of a light sourc e. 

1. Start the TEMA system. 
2. Add the first camera view. 
3. Use the White Balance tool to adjust the displayed colours for the first cam era view. 
4. Repeat steps 2 and 3 for the second camera view. 
5. If you wish to use a different coordinate system, see Maintaining 3D Coordinate Systems. 
6. Synchronise the first camera view:

o Position the displayed sequence at the significant event . 
o Set t0 to this time. 
o Insert reference points from a calibration target. 

7. Repeat step 5 for the second camera view.
Note: The reference points for the second camera view are inserted automatically from the same
file as was selected for the first camera view. 

8. Calibrate the first camera view:
o Select all the reference points in the camera view. 
o Assign the required tracker to the group of reference points . 
o Position the reference points in the camera view. 
o If a point is not visible, put the tracker to sleep for that point . 
o Set up the orientation of the reference points from the camera view. 

9. Repeat step 7 for the second camera view.
If any of the points are visible in one camera view, but not in the other, a help line is shown in the
camera view where the point is not visible. The position of the point lies som ewhere along the
help line if it is behind a foreground object, or somewhere beyond the end of the help line if it is
outside the image area.
A 3D results node is added to the Test Contents window . 

10. At this stage you can display a table containing the calculated 3D positions of the reference points
and compare them with the measured positions specified in the calibration target file. 

11. For each camera view, disable the reference points:
o Select all the reference points in the camera view. 
o Disable the tracker. 

12. For each point you wish to track:
o Select the first camera view. 
o Add the point, give it a suitable name and assign the required tracker to it . 
o Select the second camera view. 
o Add the point, give it the same name and assign the required tracker to it .
o (Assigning the same name is done by selecting the name from the 'Select from' drop-down list

in the Point Setup dialog, or simply by keying the same name.)
o A target point with the same name is automatically added to the 3D results node. 

13. Position the time at t0. 
14. Position each point to be tracked in both camera views. 
15. Position the time to the required start time. 
16. Run the tracking. 
17. Display the results, as required, in:
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o An XT Diagram; 
o A Multi Axis Diagram; 
o An XY Diagram; 
o An Advanced Diagram; 
o A Table. 

18. Save the results.
Note: The calibration data is saved with the test set up and results. It may be imported into a
later test to avoid the need to set up the calibration again. 
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Getting Started - 6DOF (Optional
Feature)
The following is the list of steps required to set up an im age sequence from a single camera view taken
of a target containing a number of tracking points, track them in six degrees of freedom and display the
results graphically. 

1. Start up TEMA. 
2. Add the camera view. 
3. Position the time to the required start time. 

Note: The position of the target in this image defines the coordinate system. 
4. Insert target points from a target model. 
5. Select all the target points in the camera view. 
6. Assign the required tracker to the group of target points . 
7. Position the target points in the camera view. 
8. At this stage you can display a table containing the calculated 6D positions of the reference points

and compare them with the measured positions specified in the calibration target file. 
9. Run the tracking. 
10. Select coordinate system for the 6DoF output (Menu 'Camera': '6DoF Coordinate System...')
11. Display the results, as required, in: 

o An XT Diagram; 
o A Multi Axis Diagram; 
o An XY Diagram; 
o A Table. 

11. Save the results. 
Note: The calibration data is saved with the test set up and results. The calibration data may be
imported into a later test to avoid the need to set it up again.

See Also
6D Calculations
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Working with TEMA

Starting up and Closing down
Starting up
Note: If you attempt to start an unlicensed copy of TEMA, the Unlicensed dialog is displayed, which
requires you to acquire a licence before continuing. See Managing Licences.

Start the system by: 

 Double-clicking on the TEMA application icon in the Programs list in the Windows Start menu.

OR

 Click on the TEMA application icon in the Windows desktop. When TEMA has started, and If a
path to the Templates Directory is given in the Preference Archive/Directories, the Select
Template dialog will open. The dialog will list the available Templates in the Templates Directory
as set in the Preference Archive. If enabled in the Preference Archive, the <Empty Test>
template is available also. This is just an empty test with no setups at all. In this dialog, selec t the
template to load into TEMA. When a template has been loaded, an asterisk in the TEMA title bar
will indicate that the test is not saved yet. Note: If no path to the Templates Directory is given,
the <Empty Test> template will load by automatically. 

OR

 Double-clicking on a TEMA test file in Windows Explorer. In this case the selected test is
automatically loaded. 

If the XXXX test exists message dialog is displayed, this indicates that TEMA did not close down
properly when you last worked with it. Continue by selecting the appropriate button:

 Use Autosave - to continue working with the autosaved test;
 Create new test - to discard the autosaved test and create a new one. 

The Autosave feature automatically makes a backup copy of the current test at regular intervals. The
latest backup copy is made available after the TEMA system is not closed down properly, typic ally as a
result of a software problem.

Closing down
Close the system by selecting the Exit option form the File menu. If there is unsaved data in the c urrent
test, the Unsaved Changes dialog is displayed. This dialog is also displayed if there are unsaved
changes when closing, opening or starting a test. The dialog offers the following options:

 Save - saves the changes to the current test file. If the file is read-only, this option is disabled. 
 Save As - displays the Save As dialog to enable changes to be saved to a different, or new, test

file. 
 Discard - discards the changes and close the system. 
 Cancel - leaves the test open without closing the system . 

Optimising Performance
The display of images can be optimised to increase performance. The Display Performance Setup dialog
is displayed when the system is upgraded or re-installed. It contains buttons to initiate the perform ance
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test in two modes. When the test has been completed, the Archive window is displayed.

After a hardware upgrade, e.g. the installation of a better graphics c ard, it may be appropriate to rerun
the performance test. You may run the test in either of the modes.

The modes are:
 Run performance test automatically to suggest settings -  runs a benchmark test during which

various items are displayed. No intervention is required.
 Select display settings manually - enables you to specify which of a num ber of alternative

methods is to be used to optimise the display. 

It is recommended that other software is closed down while the tests are being c onducted and that no
user action is taken.

1. Select the Optimize Display Performance  option from the Tools menu in the Archive window.
The Display Performance Setup dialog is displayed. 

2. To run the test automatically: 
o Select the Run performance test to suggest settings  button.
o The Automatic Display Performance Test  dialog is displayed. 
o Select the required Optimization Criteria: 

 Colour most important
 Grayscale most important

o Specify the Compatibility Setup.
o The use of DirectDraw can cause problems on some computers. If this happens, selec t the 

Skip DirectDraw Test check box and rerun the test. 
o Select the Test button.
o When the test is finished a message is displayed, which indicates that the optimization does

not take effect until all image windows have been c losed and reopened. 
o Select the OK button. 

3. To run the test manually: 
o Select the Select display settings manually  button.
o The Manual Display Performance Test  dialog is displayed. 
o Select the required display optimisation method: 

 Standard
 DirectDraw
 Note: This method causes problems on certain computers. If it does, select a different

method. 
 Optimized 1
 Optimized 2

o Select the OK button.
o The selected method is applied, but the optimization does not take effect until all im age

windows have been closed and reopened. 

 



p15

© Image Systems AB, 2011

TEMA Main Window
The TEMA Main Window is displayed directly when the system is started.

The window contains: 
 A menubar; 
 Several toolbars; 
 A display area; 
 A Test Contents window. 

In general the appearance of the window and subordinate windows and dialogs reflects the Windows NT/
XP style. Specifically:

 Toolbars - Floating toolbars are used throughout the system , which means that you can drag and
drop them to any convenient position on the screen. 

 Tooltips - Tooltips are displayed for tool buttons and other applicable item s. 
 An hourglass is displayed during time demanding operations. 
 Many items have a pop-up menu displayed via the right mouse button. The options displayed

depend on the type of item selected and its context. 
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TEMA Main Window - Illustration
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TEMA Display Area
The TEMA window display area is used to display all the information related to the c urrent test. The
information is displayed in subordinate windows that c annot be moved outside the boundaries of this
display area.

Note: Dialogs used to set up tests may be moved outside the display area.
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Test Contents
The Test Contents window is used to overview all the items included in the current test, such as c amera
views, target points, diagrams, stick figures, angles etc. In a 3D test, the 3D results are also in the test
contents list. 
        
The items in the list are organized in a tree structure that can be expanded (+) and collapsed (-) in the
standard manner.

Icons are used to indicate the type of item and its state. For a tracked point, its state in the current
image is displayed as a pair of icons.

Displaying an item in the list
Clicking an item in the list will make a a window to appear displaying the marked item (Camera view,
point zoom etc). 

Multi selecting items in the list
Items can be multi-selected in the Test Contents tree by holding the <Ctrl> key while  selecting items in
the list. 

Multi selecting grouped camera views in the list
Holding the <Alt> key while clicking one camera view in the list will select all other views in the list in
the same group. (Camera Views, points etc)

Managing Diagrams via Test Contents
 Deletion of diagram(s):

o Select or multi select the diagram(s) in the Test Contents tree, right-click and select Delete.
OR
o Select or multi select the diagram(s) in the Test Contents tree and select the  button.

 Show closed or hidden diagram(s):
o Select or multi select the diagram(s) in the Test Contents tree, right-click and select Show

Window.
OR
o Select or multi select the diagram(s) in the Test Contents tree and double-click on the

diagram(s).
 Create an editable Diagram Copy:

o Select the diagram/table in the Test Contents tree, right-click and select Create Diagram
Copy.

o This command creates an editable copy of the existing diagram /table, any changes can be
made (via Diagram Properties) without changing the original diagram/table. Valid for XT,
Multi Axis, XY, Advanced, 3D, Image Diagram, Time Table and Point Table.

 Create a Time Table with selected data:
o Select the diagram/table in the Test Contents tree, right-click and select Copy to Time

Table.
o This command creates an editable copy of the existing diagram , any changes can be made

(via Diagram Properties) without changing the original diagram/table.

See also...

Windows
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TEMA Menu
The TEMA window menubar contains the following options: 

 File - controls tests,  views and printing. 
 Edit - manipulates data and system settings. 
 View - controls the display of windows.
 Camera - controls the use of the camera. 
 Tracking - controls the tracking function. 
 Diagram - controls the display of diagrams. 
 Tools - controls the use of system tools. 
 Windows - contains a list of open windows. 
 Help - controls access to the help system. 
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File Menu
The File menu contains the following options: 

 New Camera View - Displays the Open Image Sequence dialog to open an image file as a camera
view. 

 Add Camera - (Optional Feature) Displays the Add Camera dialog. 
 New Data File - Displays the standard Open dialog to  open a fixed format data file. 
 New Test - Clears the display area and the Test Contents window ready for a new test. 
 Open Test - Displays the standard Open Dialog to open a previously saved test.
 Save test - Diplays the standard Save dialog to save the current test. (If the test has not been saved

previously, the Save As dialog is diplayed.)
 Save Test As - Displays the standard Save As dialog to save the current test under a different nam e.
 Create Template (optional) - Displays the Create Template dialog where a Template can be created.

Saves the test as a template in the specified Template directory.
 Manage Templates - Displays the Manage Templates dialog, where the user can manage the User

Templates or the Factory Templates.
 Start Test (optional) - The Start Test Command when working towards a Test Database. 
 Refresh Test (optional) - The Refresh Test Command when working towards a Test Database.
 End Test (optional) - The End Test Command when working towards a Test Database.
 Export to Viewer CD - Displays the Export to Viewer CD dialog to export the test to a viewer CD.
 Import View - Displays the standard Open dialog to import a camera view.
 Print - Prints the selec ted displayed image, diagram or table.
 Print Report - Displays the Print Reprt dialog to print a test  report. 
 "Test List" - Contains the ten most recently used tests, which may be selected directly to open a

test.
 TEMA Test Database Interface (optional)
 Exit - Closes the system. 
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Edit Menu
The Edit menu contains the following options: 

 Undo - Cancels the last operation.
 Redo - Restores the last operation that was undone .
 Copy - Copies the selected data to the clipboard . 
 Paste - Pastes the selected data into any appropriate applic ation.
 Delete - Deletes the selected item. 
 Find Image - Helps to identify images.
 Test Description (optional) - Creates and maintains a description of the test . 
 Test Data (optional) - Gun Scoring test Data setup. 
 Test Sections (optional) - Test Sections setup.
 Test Attributes (optional) - For setup of additional test information.  
 Time Properties - Displays the Time Properties dialog to enable you to set the time properties

for the test. 
 Combined Image Export - Wizard for exporting a merged external presentation of selected

image sequences, diagrams etc., in which the user decides and designs the contents and layout.
 Scaling/Coordinate Systems - Displays the Scaling / Coordinate Systems dialog to enable you

to specify motion planes, coordinate systems and coordinate grids. 
 3D Coordinate Systems (optional) - Displays the 3D Coordinate Systems dialog to enable you

to add and maintain 3D Coordinate Systems. This option is only displayed if you have the optional
3D feature installed. 

 3D Interpolation (optional) - Specifies the 3D Interpolation of sleeping points  (No
interpolation, Linear or Cubic interpolation).

 Area of Interest - Defines a rectangular area of interest in a camera view that can be used to
limit the part of the image used for Image Enhancement and Image Export. 

 Default Trackers - A user-defined set of tracker icons shown in the Default Trackers toolbar.
The tracker icons can be added, edited, removed or renamed.

 Properties - Displays the properties of the selected item from the Test Contents window or a
Diagram window. 
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View Menu
The View menu contains the following options: 

 Zoom In - makes the image larger. 
 Zoom Out - make the image smaller . 
 Zoom 1:1 - returns the image to its normal size. 
 Split View - displays multiple images from a camera view. 

o Single - the current image is displayed in the normal manner.
o Multi - the image area is split into a number of rectangles, each showing a different tim e.
o Hscroll - as Multi, but the images are displayed in one row that can be scrolled horizontally.
o Vscroll - as Multi, but the images are displayed in one column that can be scrolled vertically.
o Showall - displays all images.
o Setup - customises the split view.

 Show Window - Displays the selected camera view in the display area. 
 Show Zoom Window - Displays the Zoom window for the selected camera view. 
 Image Enhancement - Adjusts the colour parameters to improve the display of images. 
 Time Overview - displays the Time Overview window.
 Notes - saves the contents of the status bar in a set of notes . 
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Camera Menu
The Camera menu contains the following options: 

 Add Point - Adds a point to the selected camera view. 
 Add Point Generator (Optional) - Adds a point generator to selected camera view.
 Add Distance - Adds a distance to the selected camera view. 
 Add Angle - Adds an angle to the selected camera view. 
 Add Stick Figure - Adds a stick figure to the selected camera view. 
 Add Contour - Adds a contour to the selected camera view. 
 Add Corridor - Adds a set of corridors to the selected camera view.
 Add Exclude Rectangle - Excludes a certain area(s) in the image for the tracker.
 Add Exclude Polygon - Excludes a certain area(s) in the image for the tracker.
 Add Body Model (Optional - TEMA Biomechanical System only) - Adds an existing body model.

o Import from File
o Copy from Other View

 Point Groups
o Create Point Group - Creates a point group
o Import Point Group - Imports a point group 
o Move Selection to Group - Adds points to a point group
o Add Group to Selection - Adds points to a multiple point groups
o Remove Selection from Group  - Removes points from a point group

 Goto t0 - Sets the current time to t0. 
 Set t0 - Sets t0 to the current time. 
 Control Time - Selects the camera view used to control time steps. 

 Rename View - Displays the Rename View dialog. 

 Insert Reference Points (3D) -  See Insert Target Points below.
 Insert Target Points (6D) - Inserts reference/target points for setting the orientation of the

camera. 
Note:This option is only displayed if you have the optional 3D or 6D feature installed. In the 6D
option it is called "Insert Target Points". 

 Edit Reference Points (3D) - See Edit Target Points below.
 Edit Target Points (6D) - Review the used reference/target points. 
 Lens Calibration
 Wand Calibration
 Camera Orientation

o Static Camera Orientation (optional: 3D).
o Relative Camera Orientation (optional: 3D).
o Enter Camera Orientation (optional: 3D or 6D).
o Reset Camera Orientation - Resets the Camera Orientation if confirmed.

 Import Camera Parameters - Imports calibration and orientation data  from a previous test.
This option is only displayed if you have the optional 3D or 6D feature installed.

 
 6DoF Coordinate System - Select coordinate system for the 6DoF output, it is either 

o Object coordinate System at t=0
o Camera Coordinate System 

 Export Images - Exports images: 
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o from a single camera view window or zoom window.
o from multiple camera views. 

The following options are only displayed if the Camera Control optional feature is
included in the system.
 Assign Camera to View - Relates physical cameras to logical cameras in the test description.
 Camera Setup Window - Specifies the parameters for the cameras in the test.
 Scan for Cameras - Scans the available network to identify all the attached cameras.
 Set Black Reference - Sets a "black area" as a reference point for the cameras in the test.
 Download Images - Manually downloads images from the cameras in the test. 
 Arm - Activates the cameras in the test.
 Snapshot Recording - Captures and records short image sequences (similar to Arm command).
 Redo Auto Download -  Performs the Auto Download command, which makes it possible to

automatically download the image sequences captured by the cam era(s). 
 Clear Cameras - Deletes all the images from all the cameras in the test.
 Normal Snapshot - Snapshot captured using normal light.
 Low Light Snapshot - Snapshot captured using low light.
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Tracking Menu
The Tracking menu contains the following options: 

 Enable - Enables the tracker for the selected point in the Test Contents window. 
 Disable - Disables the tracker for the selected point in the Test Contents window. 
 Sleep - Causes the tracker to register the selected point as being asleep  in the current and

successive images. 
 Sleep in Selected Interval - Puts the selected point to sleep in the current image. 
 Position... - Enables the user to manually set the pixel coordinates of a tracking point .

. 
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Diagram Menu
The Diagram menu contains the following options: 

 New - Creates new diagrams.
o XT Diagram - Displays an XT Diagram - a 2D diagram with time on the x-axis and a

component on the y-axis. 
o Multi Axis Diagram - Displays a Multi Axis Diagram  - a 2D diagram with up to four Y axes. 
o XY Diagram - Displays an XY Diagram - a 2D diagram with component on both axes. 
o Advanced Diagram - Displays an Advanced Diagram - a complex 2D diagram, i.e. individual

components from different sequences can displayed against eac h other 
o Table - Displays a Table containing selected data. 

 Grid - Toggles the display of a grid on a diagram. 
 Legends - Toggles the display of legends on a diagram. 
 LegendsSettings - Specifies the content of the legend bar. 

o Alt Colour - displays the both the legend colour and the alternative legend c olour in the
legends definition bar.

o Note: Interpolated points are always displayed in the alternative colour. irrespective of
whether the legends are shown or not. 

o Vertical Axis Min - displays in the legend the minimum vertical value, together with the
horizontal axis value at which it occurs. 

o Vertical Axis Max - displays in the legend the maximum vertical value, together with the
horizontal axis value at which it occurs. 

o Horizontal Axis Value - displays the current horizontal axis value. 
o Vertical Axis Value - displays the current vertical axis value. 

 Export Data - Exports data from a Table.
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Tools Menu
The Tools menu contains the following options: 

 Selection - Activates the Selection Tool used for placing points in an im age. 
 Distance - Activates the Distance Measurement Tool. 
 Angle - Activates the Angle Measurement Tool. 
 Velocity/Distance - Activates the Velocity/Distance Measurement Tool.
 Zoom - Activates the Zoom Tool. 
 White Balance - Activates the White Balance Tool. 

 Toolbars - Contains a sub-menu entry for each Toolbar, which is used to toggle the display of the
Toolbar.
o Standard.
o Tools.
o Data.
o Time Panel.
o Time Slider.

 Licence - Manages TEMA user licences.
o Request - Requests a new licence key. 
o Install - Installs a licence key. 
o Transfer -Transfers a licence key. 
o Connect - Connects to a floating/site licence. 
o Disconnect - Disconnects to a floating/site licence. 

 Optimize Display Performance - Runs the display performance test. 

 Corridors - Creates and maintains a set of corridors held in an external file. 
 Body Model - (Optional Feature) 
 AICON Lens Calibration - (Optional Feature) Performs AICON lens calibration. 
 Preferences - Maintains Preference Settings. 
 Preference Management (optional)
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Windows Menu
The Windows menu lists the windows that are currently open. The Windows menu also contains the
following options:

 Cascade - To overlap all currently open windows.
 Tile - To organise all currently open windows side by side.
 Minimize diagram windows - To minimize all diagram windows. This enables more calculation

power as the diagrams will be temporarily disconnected.
 Restore diagram - To restore all minimized diagram windows which have been temporarily

disconnected.
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Help Menu
The Help menu provides information about this version of TEMA and ac cess to the Help contents page.
The TEMA Automotive option displays the TEMA Main Window help topic .
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TEMA Toolbars
The TEMA window contains the following toolbars:

 Standa
rd

 Point
Control

 Tools

 Default
Tracker
s 

 Data

 Section
s

 Time
Panel

 Time
Slider

 Camera
Control

 Test
Sequen
ce 

See Also...

Displaying Toolbars
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Standard Toolbar
The Standard toolbar contains the following:  
 

  - New Test
  - New Camera View
  - Add Camera (Optional Feature - Camera Control)  
  - Assign Camera To View (Optional Feature - Camera Control)
  - Open Test
  - Undo
  - Redo
  - Save Test
  - Print
  - Properties
  - Scaling/Coordinate Systems
  - Delete Selected Item(s)
  - Copy Selected Item(s)

  - Paste
  - Open up a window

  - Lock/Free Window
  - Show Zoom Window

  - Open Image Enhancement dialog
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Point Control Toolbar
The Point Control toolbar contains the following:

  - Enable

  - Disable

  - Sleep

  - Sleep in Selected Interval

 



p33

© Image Systems AB, 2011

Tools Toolbar
The Tools toolbar contains the following: 

  - Zoom In
  - Zoom Out
  - Zoom 1:1 (Normal size)
  - Selection Tool
  - Distance Measurement Tool
  - Angle Measurement Tool

 - Velocity/Distance Measurement Tool
  - Zoom Tool
  - White Balance Tool
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Default Trackers Toolbar
The Default Tracker toolbar contains a user-defined set of trackers. 

The tracker icons shown in the toolbar c an be added, edited, removed or renamed. 
When a new point is added to the test, the selection in the toolbar controls the settings of the point.

 Default Tracker Toolbar appearance by default.

 Example of Default Tracker Toolbar appearance when different trackers have been added.

  - If  the "Auto toggle" is enabled, a left-c lick in the Camera View window will add and
position a new point to the test. 

  - If the "Auto toggle" is disabled, the user must first add a point and then position it to the
test. 

  - Displays the toolbar vertically or horizontally.

 The content of the Default trackers toolbar can be changed from the Edit Default Trackers dialog
by selecting the Default Trackers option from the Edit menu.

 The following changes of the Default Trackers toolbar can be made:
o Add tracker:

 Press the Add button and the Point Setup dialog will open.
 Specify the properties of the tracker.
 Press OK button and the tracker icon will be added to the Default Trackers toolbar.

o Edit tracker:
 Press the Edit button and the Point Setup dialog will open.
 Edit the properties of the tracker.
 Press OK button and the settings of the tracker icon will be updated.

o Remove tracker: 
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 Highlight the tracker icon name in the Edit Default Trackers dialog and press
Remove button.

o Rename tracker:
 Highlight the tracker icon name in the Edit Default Trackers dialog and retype the

name in the Rename dialog.
o Change order of trackers:

 Highlight the tracker icon name in the Edit Default Trackers dialog and press  or

 button. .

See Also...
Definitions of different trackers.
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Data Toolbar
The Data toolbar contains the following:      

  - Add a Point
  - Add a Distance
  - Add an Angle
  - Add a Corridor

  - Add a Stick Figure

  - Add a Contour
  - Add Exclude Rectangle
  - Add Exclude Polygon
  - Add a XT Diagram
  - Add a Multi Axis Diagram
  - Add a XY Diagram
  - Add an Advanced Diagram

  - Add a 3D Diagram

  - Add an Image Diagram
  - Add a Time Table

  - Add a Point Table

  - Add a Report 
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Time Panel Toolbar
The Time Panel toolbar contains the following:

  - rewinds the image sequence.
  - plays the image sequence backwards.
  - positions the image sequence one step backwards.
  - stops the movement of the image sequence.
  - positions the image sequence one step forwards.
  - plays the image sequence forwards.
  - fast forwards the image sequence.

  - shows the current play/track mode.
Note: In tracking mode, one of the green arrows is also illuminated to indicate the tracking
direction:
o Tracking. 
o Backward Playing. 
o Forward Playing.

  - tracks backwards.
  - tracks one frame backwards.
  - tracks one frame forwards.
  - tracks forwards.
  - specifying Control Time.

  - sets t0.

  - displays the current time.
Clicking on the green arrow turns the display into a normal text box into which you may key a
time value. The current time is set to this time value. This is the equivalent of setting the Goto
time in the Time Properties dialog.

The system can handle time resolution to a level as low as nanosec onds (10-9). However, the
number of significant digits is limited, i.e. resolution to this low level should not be used for
absolute times measured from the start of a year, for example.

  - sets the current time to t0. 

  - opens the Time Properties dialog (optional).
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Time Slider Toolbar
The Time Slider toolbar contains a slider used to move to a particular time in the sequence. It also
indicates the time selected when the buttons above it are pressed, including changing the tim e when the
play buttons are used.

Specifically: 
 The red line indicates the current time. 
 The green diamond indicates t0, the reference tim e. 
 The upper, lighter coloured bar indicates the user defined time interval. 
 The lower, darker coloured bar indicates the time limits of the available data. 

The slider has a pop-up menu containing the following options: 
 View all - when this option is selected, all the data in the test is displayed, otherwise only the

selected interval is displayed and the lower bar in the slider is rem oved. 
 Snap to ends - enables the time slider to be set exactly at the end of the tim e range. This

function operates separately for each end of the time range. If you wish to position a time slider
close to the end, de-select this toggle. 

 Reset user interval - resets the user defined interval to the full available tim e range. It is

equivalent to selecting the  button in the Time Properties dialog. 
 Time Properties - displays the Time Properties dialog. 
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Camera Control Toolbar
This toolbar is only displayed if the Camera Control optional feature is included in the system.

The Camera Control toolbar contains the following: 

  - Enables Camera Control Mode. Live images are sent from the cameras to the program.
Parameters can be set for the next rec ording.

  - Enables Continuous Live Image. Live images are sent continuously from the cameras to
the program. This command can only be used when Camera Control Mode  is enabled. 

  - Enables Low Light Setting. Command setting the exposure and frame frequency to low
light mode to allow for focus setting  etc . in low light conditions. This command can only be used
when Camera Control Mode  is enabled.

  - Take A Snapshot From All Cameras Using Normal Light . Command taking a snapshot
from the camera using the recording exposure time. This command can only be used when 
Camera Control Mode  is enabled. 

  - Low Light Snapshot. Command taking a snapshot from the camera using an exposure
time set to low light mode to allow for focus setting etc . in low light conditions.

  - Setup Camera
  - Scan for Cameras

  - Set Black Reference
  - Download Images from Camera
  - Open Arming Dialog. Command opening dialog where all c ameras can be armed and

triggered.

  - Open Snapshot Recording Dialog
  - Clear Stored Images from all Cameras
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The End
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Test Sequence Toolbar
The Test Sequence toolbar is only displayed if the Camera Control (optional feature) is included in the
system.

This toolbar includes a selec tion of commands/functions from the Camera Control toolbar and contains
the following: 

  - Start Test. Command when working towards a Test Database. (Optional  Feature -
Enterprise Edition). 

  - Assign Camera To View. Command showing the cameras located by the Camera Scan
Function.

  - Enables Camera Control Mode. Live images are sent from the cameras to the
program. Parameters can be set for the next recording. 

  - Enables Continuous Live Image. Live images are sent continuously from the cameras
to the program. This command can only be used when Camera Control Mode  is enabled.

  - Enables Low Light Setting. Command setting the exposure and frame frequency to low
light mode to allow for focus setting  etc . in low light conditions. This command can only be used
when Camera Control Mode  is enabled.

  - Take A Snapshot From All Cameras Using Normal Light . Command taking a
snapshot from the camera using the recording exposure time. This command can only be used
when Camera Control Mode  is enabled.

  - Open Arming Dialog. Command opening dialog where all c ameras can be armed and
triggered. 

  - End Test. Command when working towards a Test Database. (Optional  Feature -
Enterprise Edition).
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Tools

Using the Selection Tool
The Selection tool enables points to be placed in the im age and manipulated.

Points may be added to the Test Contents window and defined irrespec tive of the tracker mode, but they
cannot be placed in the image and manipulated unless the Selection tool has been selec ted.

1. Select the Selection option from the Tools menu.
Alternatively, select the  tool. 
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Using the Distance Measurement Tool
This tool is used for measuring distances between points in camera views and diagrams.
Note! Not valid for 3D diagrams.  

1. Select the Distance option from the Tools menu.
Alternatively click the  tool. 

2. Select the camera view or diagram.  
3. Position the cursor on a point.

Its X and Y coordinates are shown in the Statusbar. 
4. Hold down the left mouse button and drag the pointer to another point on the graph.

A straight line is drawn between the two points.
The Statusbar shows three distance measures between the two points:
o distance - diagonal distance; 
o dx - x-axis distance; 
o dy - y-axis distance. 

5. Release the left mouse button.
The line and distance measures are removed from the display. 
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Using the Angle Measurement Tool
This tool is used for measuring angles between points in camera views and diagrams.
Note! Not valid for 3D diagrams.
 

1. Select the Angle option from the Tools menu.
Alternatively click the  tool. 

2. Select the camera view or diagram.  
3. Position the cursor on a point. 
4. Click the left mouse button and drag the pointer to a sec ond point on the graph.

A straight line is drawn between the two points. 
5. Click the left mouse button and drag the pointer to a third point on the graph.

A second straight line is drawn between the points two and three.
The angle between the two lines is shown in the Statusbar. 

6. Move the mouse outside the selected cam era view or diagram.
The lines and angle are removed.
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Using the Velocity/Distance
Measurement Tool
This tool is used for measuring an average velocity and/or a distance in c amera views.
 
1. Select the Velocity/Distance option from the Tools menu.

Alternatively click the Velocity/Distance Measurement  tool . 
2. Select the Camera View.  
3. Set a scale for the Velocity/Distance Measurement  tool in the Camera View:

o Press the right mouse button and selec t Scaling.
o Enter a length in the dialog and select Scale.
o Select two positions, corresponding to the entered length, in the cam era view using the left

mouse button.
4. Measure an average velocity:

o Select a position in the Camera View by pressing the left mouse button
o Change to a different time, by using the Time Slider or the Time Panel toolbar. 

(IF NOT - only a distance will be calculated).
o In the Camera View select the next position by pressing the left m ouse button.
o A straight line is drawn between the two points. 
o The distance and velocity is displayed at the bottom  of the Camera View. 

Notes:
o The scale entered above is only used in the Velocity/Distance Measurement tool and only in

the Camera View where it was calculated. It is saved with the test and will be used the next
time the test is opened.

o The scale can be changed at any time by right-clicking in the Camera View and selecting
Scaling.

o The scale can be removed at any time by right-clicking in the Camera View, selecting Sc aling
and then Pixel Distance.
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Using the Zoom Tool
This tool is used for controlling the magnification level in diagrams. 

1. Select the Zoom option from the Tools menu.
Alternatively click the  tool. 

2. Select the required diagram. 
3. To increase the magnification, draw a rectangle around the point of interest.

The selected area is expanded to fill the diagram and the axes are adjusted acc ordingly.
This operation may be repeated as often as required. 

4. To return the diagram to its original size, selec t the Zoom 1:1 option from the View menu.
Alternatively, click the right mouse button and selec t the Show All option from the pop-up
menu. 

See Also...

Using the Zoom Window
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Using the White Balance Tool
The White Balance tool is used to adjust the displayed colours relative to a selected colour, i.e. it only
operates for colour images.
 

1. Select the White balance option from the Tools menu.
Alternatively, select the  tool.
When the cursor is placed in the image, the colour at the selected point is displayed in the
Statusbar as 'R: 17  G: 19  B: 16', for example. 

2. Use the mouse to mark an area in the image that should be light gray.
When the mouse button is released, the colour calibration is perform ed and the colours in the
displayed image are changed.
If the calibration cannot be performed, a message is displayed in the Statusbar to indicate the
problem. 

3. Repeat the process until you are satisfied with the c olour balance.
If the message changes to 'Calibrating Colour Adjustment: , At least one colour channel is
saturated', it means that one of the colour c hannels has reached its limit and the calibration
cannot be performed. Choose a different colour on which to base the calibration. 

4. Alternatively, you may right click and select a lighting c onfiguration from the pop-up menu, i.e. 
None, Daylight, Tungsten or Fluorescent. These apply preset calibrations to the image without
the need to mark the image. The last option, White Patch, is always disabled and refers to the
standard method defined at step 2. It is autom atically selected when you mark the image. 

See Also...

Image Enhancement
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Windows        
Function
Double clicking any item(s) in the test c ontents list will open up a window displaying the selec ted item.
The item can be a camera view (Sometimes referred to as a Camera View Window) or a point zoom
window. 

Features
Most windows in TEMA have two main modes; Free and Locked. 

 Free - this mode will make the window interactive. This means that its contents will change
depending on what is selected in the test contents tree. If a single tracked point is selected, the
window will display a point zoom with that point in the center. If a c amera view is selected, the whole
tracked image will be displayed instead. 

 Locked - the window will not be affected by the selected item s in the test contents tree. This is to
be used when the contents of a window are defined and not to be changed depending on what is
selected in the test contents tree.  

Multi selections 

More than one item can be selected and put into one window. 

Selecting more than one point in the list will make the window split up and display a point zoom  for each
point. 

Even different kinds of items can be selected and put into the sam e window: point zooms and camera
views can be displayed in one single window at the sam e time. 

Multi selections can be made across the borders of camera views also, allowing the user to put zoom
windows of points in different camera views into the same window (This different from multi selection in
image export which will select camera views only even if point are selec ted also). 

Windows with several items displayed

In a window with more than one item displayed, the Export Images command from the Camera menu
will only export the upper left item displayed. Multi image export can only be done from the test c ontents
window (see above). The same goes for image zoom using the zoom buttons   from the tool bar,
only the upper left item will be zoomed. 

However, at any time, right clicking any item in the window will of course offer a right c lick menu valid
for this very item. 
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Setting Up the Test
TEMA tests can be stored as test descriptions in ".ted" files, whic h makes them available for use in the
future.

The File menu contains a series of options to enable you to manage test files. Some of the options are
also accessible from the standard toolbar.

Note: If there is any unsaved data when you c lose a test either explic itly or implicitly, a warning is
displayed that asks if you wish to save the data.

The following functions are available: 
 Start a new test
 Open an existing test
 Save a test
 Save a test under a new name
 Create Template
 Manage Templates
 Close a test (via the Test Contents window)

Starting a new test

 When the system is started up the Select Template dialog is displayed.

1. Select a  Factory Template or a  User Template from the list to load into TEMA as a new test.

o Factory Templates are templates that are installed by the TEMA installation program . 
o User Templates are templates that are created by the user (with the Create Templates

command). User templates can be renamed and/or removed from the Manage Templates
dialog. 

Option: If the Select Template dialog shouldn't appear every time the New Test option is
selected, check Don't show this dialog again.  

2. Click OK. 

o The new test will now open up as when the template was created.
or 
o If <Empty Test> has been selected, an empty test only displaying the Test Contents

window with no setups will open. 

The test can now be worked with as any TEMA test.

 You may start a new test at any time: 

1. Select the New Test option from the File menu. Alternatively, click the tool.

Notes:
o If there are unsaved changes in the previous test, the Unsaved Changes dialog is displayed.
o If a path to the Templates Directory is given in the Preference Archive/Directories, the Select

Template dialog will open. The dialog will list the available Templates in the Templates
Directory as set in the Preference Archive. 

o If enabled in the Preference Archive, the <Empty Test> template is available also. This is
just an empty test with no setups at all. 
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o When a template has been loaded, an asterisk in the TEMA title bar will indic ate that the test
is not saved yet.

o If no path to the Templates Directory is given, the <Empty Test> template will load by
automatically. 

2. Select a  Factory Template or a  User Template from the list to load into TEMA as a new test.

o Factory Templates are templates that are installed by the TEMA installation program . 
o User Templates are templates that are created by the user (with the Create Templates

command). User templates can be renamed and/or removed from the Manage Templates
dialog. 

Option: If the Select Template dialog shouldn't appear every time the New Test option is
selected, check Don't show this dialog again.  

3. Click OK. 

o The new test will now open up as when the template was created.
or 
o If <Empty Test> has been selected, an empty test only displaying the Test Contents

window with no setups will open. 

The test can now be worked with as any TEMA test.

Note: If the system is started by double-clicking a test file in Windows Explorer, that test file is
automatically loaded.

Note: If you work with a test planning system via a Test Database Interface (optional) , there is a
policy (optional) that may restrict the possibilities to open a new test that is not associated with this.
This policy is set in the Test Planning System preference (optional). If the policy for this is set to
Warning Every Time, and the warning that occurred was canceled, the TEMA  test selection dialog
will require the user to open an existing test or to c reate a new one from here.  

Opening an existing test
1. Select the Open Test option from the File menu.

Alternatively, click the tool.
If there are unsaved changes in the previous test, the Unsaved Changes dialog is displayed.
Decide what to do about the these changes .
A standard Open dialog is displayed. 

2. Select the required test. If Cancel is sslecetd here, a redirec tion will be made to the load Template
dialog, like when opening up a new test. 

3. Select the Open button.
The selected test is opened in the same condition as when it was saved.
Note: You may also select the required test directly from the File menu if it is in the list of the ten
most recently accessed tests. 

Saving a test
1. Select the Save Test option from the File menu.

Alternatively, click the tool.
If the test has been saved previously, it is saved again under the sam e name.
If the test has not been saved previously, a standard Save as dialog is displayed. 

2. Proceed as for saving a test under a new name, see below.

Saving a test under a new name
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1. Select the Save Test As option from the File menu.
A standard Save as dialog is displayed with the Save as type preset to '.ted'. 

2. Key in or browse for the required File name. 
3. Select the Save button. 

Create Template
1. Select the Create Template option from the File menu. The Create Template dialog will open. 
2. Key in the Template Name.
3. Option: Check Ask for images when loaded if the template should ask for image files next time

it is being loaded.
4. Click OK. The Generated Template will now be saved in the Template Directory as set in the

Preference Archive. 

Note: When opening up a new test, TEMA will look into the same Template directory and suggest any
of the Templates there to be loaded as new tests. 

Manage Templates
1. Select the Manage Templates option from the File menu. The Manage Templates dialog will

open.  
2. Select the User Templates tab.
3. Option: Rename or delete applicable template(s) in the shown list.
4. Option: Check the Add empty test to template list to be able to choose an "<Empty test>"

from the template list, otherwise the choice is between already existing User Templates.
5. Option: Uncheck Don't ask for a template when creating a new test  to be able to select a

template from the template list when preparing a New Test next time. 
6. Select the Close button.

Note: The Factory Templates can not be renamed or deleted.

Closing a test
1. Select the X button in the Test Contents  window.

If there are unsaved changes in the previous test, the Unsaved Changes dialog is displayed.
Decide what to do about the these changes .
The current test is closed.

Note: A new test is not started automatically. 
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Specifying Camera Views
The New Camera View dialog is displayed when an image file is opened for a new camera view. It is used
to inform the system about the physical aspects of the camera used to produce the view.

1. Key a Name for the new camera view.

2. Use the browse button  to get to the camera view name dialog (optional). This contains a list
of view names in the Preference Camera view list (optional). The names can be used for the new
camera view. 
Note: Duplicate names are not allowed in the same test. 

2. Key the camera Frame Frequency. 
3. Define the Gamma Correction. 
4. To amend the Camera Parameters:

Note: The Camera Parameters frame is only displayed if you have the optional 3D or 6D feature
installed. 
o Select the Define Camera Parameters check box.
o The remaining fields in the Camera Parameters frame are enabled.
o The Image Size is fixed and cannot be changed. 
o Select the Camera Type from the drop-down list. 
o Key the Focal Length of the camera lens, selecting the measurement unit from the adjacent

drop-down list. 
o Key the Pixel Size, selecting the measurement unit from the adjacent drop-down list. 
o Specify the x and y coordinates of the camera's Optical Center. 

1. The Frame Frequency can be set using an entry field. If there is a frame frequency defined in
the image file the operator must enable the Override toggle before he can change the frame
frequency to some other value. If there is no frame frequency in the image file the Override toggle
is selected by default and can not be unchecked by the operator.

5. Select the OK button.
The New Camera View window is closed. 

6. When a new camera view is added, a new locked window will open up displaying the added
camera view. 
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Camera View Window
When a new Image File has been opened, a Window in locked mode is opened displaying the c amera
view.  

Right clicking in this window will offer fast access to a number of functions; 

 Lock/Free Window
 Camera View Properties
 Camera View Attributes (optional)
 Camera Orientation

o Static Camera Orientation (optional: 3D).
o Relative Camera Orientation  (optional: 3D).
o Enter Camera Orientation (optional: 3D or 6D).
o Reset Camera Orientation - Resets the Camera Orientation if confirmed.

 Scaling/Coordinate Systems
 Geometry (optional)
 3D coordinate systems
 Airbag volume (optional)
 Show Zoom window
 Set t0
 Control time
 Find Image
 Tools
 Image Enhancement
 Disable Image Enhancement
 White Balance
 Zoom in/out
 Split View
 Print
 Copy
 Paste
 Export Images
 Delete
 Add

o Point
o Point Generator
o Distance
o Angle
o Stick Figure
o Contour
o Exclude Rectangle
o Exclude Polygon
o Corridor... 

 Exclude By Default
 Show Disabled Items
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 Camera View Properties
1. Select the required camera view. 

2. Select the Properties option from the Edit menu or via right clicking the camera view
window/properties. The Camera View Properties dialog is displayed. This has several tabs,
and some are optional. Amend, if required; 
o Image File properties.
o Tracking properties.
o Colour/Contrast properties (optional Image Enhancement feature)
o Camera Parameters properties (optional 3D or 6D feature) 
o Airbag Analysis properties (optional Airbag tracker feature)

3. Specify the Display Mode by selecting the appropriate radio button:
o Original Image - displays the original image loaded to the test. 
o Tracking Image - displays the tracked image in the selected mode. 

4. Select the OK button. 
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Airbag Analysis Properties (Optional
Feature)
The Airbag Analysis tab in the Camera View Properties dialog is used to spec ify how the results of an
airbag tracking are calculated. It is applicable to both the Airbag tracker and the Advanced Airbag
tracker.

1. Select the required camera view. 
2. Select the Properties option from the Edit menu

The Camera View Properties dialog is displayed. 
3. Select the Airbag Analysis tab. 
4. Extreme Points:

        Select the required type of Extreme point analysis: 
o Min/max in coordinate direction  - the points  with the maximum x or y coordinates. 
o Intersections with coordinate axes  - the intersections of the contour  with the coordinate

axes.
o Note: For this option to be effective, the coordinate system  origin has to be within the airbag. 

5. Specify the intersection lines. This is a third way of calculating extreme points for a chain code
besides those described above.  By selecting intersection lines, TEMA will calc ulate the extreme
points for the intersections between those lines and the chain c ode. The Add button will make the
Add line dialog to appear. In this, start and end points for an intersection line can be selec ted
from the available tracked points in the cam era view. While marking an added line, the Edit
button will open up the same dialog, making it possible to select new points to define the
intersection line.

       
Note: the results from the airbag tracker analysis can be inserted into a diagram .  The results are divided
into two groups, curve and visualizer results. Curve results are
 Extreme points coordinates; Right, Left, Up and right. Can be plotted both in XT and XY diagram s.
 Angle between chaincode major axis and coordinate system x axis. (Can be usefully plotted in XT

diagrams only).
 Area of outline tracker as a function of time. Can be plotted in XT diagrams only.
 Circumference of outline tracker as a function of time. Can be plotted in XT diagrams only.
 Volume (Optional Feature): Rotates the airbag contour around an axis and c omputes the volume of

the resulting rotational solid. 

Visualizer results
 Visualizer appearance of the outline tracker as a function of tim e. Can be plotted in XY diagrams only.

See illustration of visualizer data inserted into XY diagram  below.
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See Also...

Airbag Analysis Calculations

Inserting results into diagram

Maintaining Camera View Properties
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Camera Parameters (Optional Feature)
When an image file is opened for a new camera view, the New Camera View dialog is displayed. It is
used to inform the system about the physical aspects of the camera used to produce the view. This
information can be subsequently maintained via the Camera Parameters tab in the Camera View
Properties dialog.

From TEMA version 3.9 camera calibrations can also be exported. This will include camera
internal data as well positions/attitude if applicable. The 'Import' button is replaced with one
'Import Parameters' button and one 'Export Parameters' button.   

1. Select the required camera view. 
2. Select the Properties option from the Edit menu

The Camera View Properties dialog is displayed. 
3. Select the Camera Parameters tab. 
4. To import a set of camera parameters: 

o Select the Import button.
o The standard Open dialog is displayed.
o Select the file containing the required set of parameters. The accepted file formats are 

described below.
o Select the Open button. 
o The parameters from the selected file are imported and displayed in the Camera Parameters

tab. The Define Camera Parameters check box is automatically selected.     
5. Select the Define Camera Parameters check box, if it is not automatically selected.

If this is not done, none of the parameters can be amended. 
6. Select the Camera Type from the drop-down list. 
7. Specify the Focal Length, selecting the measurement unit from the adjacent drop-down list. 
8. Specify the Pixel Size, selecting the measurement unit from the adjacent drop-down list. 
9. Specify the Optical Center in terms of x and y coordinates. 
10. Key the required Aspect Ratio.

The default value is "1". 
11. If you wish to correct the lens distortion: 
12. Select the Correct Lens Distortion check box. This prerequisites that a lens calibration (Planar

Target or AICON) has been performed for this sensor. 
13. Amend the Distortion Parameters, as required, i.e. xH, A1, B1, C1, r0, yH, A2, B2, C2 and A3.

Note: These parameters are the coefficients used by the lens distortion correction algorithm  and
should not be amended without a thorough knowledge of how the algorithm  uses them. 

14. If 3D or 6D is about to be calculated, select the Dynamic Camera Orientation check box if the
camera position (s) is not constant during the test. 

Accepted file formats
When importing camera parameters from a file, TEMA accepts data from the following calibration
software:

 Planar Target Lens Calibration (*.xml).
 AICON Lens Calibration (*.ior).
 The Bouguet Lens Calibration toolbox. 

This is a third-party program described in the web page http://www.vision.caltech.edu/bouguetj/
calib_doc/.

Data from the Bouguet Lens Calibration toolbox are imported as an ASCII text file containing 12 floating-
point numbers, one per line. These numbers are the parameters calculated by the Bouguet program:

o Line 1: fc(1)
o Line 2: fc(2)
o Line 3: cc(1)

http://www.vision.caltech.edu/bouguetj/calib_doc/
http://www.vision.caltech.edu/bouguetj/calib_doc/
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o Line 4: cc(2)
o Line 5: alpha_c
o Lines 6-10: kc(1) through kc(5)
o Line 11: nx
o Line 12: ny

See Also...
Maintaining Camera View Properties.
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Colour/Contrast Properties (Optional
Feature)
The Colour/Contrast tab in the Camera View Properties dialog is used to specify the contrast and
brightness of the displayed image.

1. Select the required camera view. 
2. Select the Properties option from the Edit menu

The Camera View Properties dialog is displayed. 
3. Select the Colour / Contrast tab. 
4. To amend the Contrast:

o Key in a new value or adjust it using the slider.
o Any change made is immediately reflected in the displayed View window in the display area. 
o Select the Reset button to set the values to zero. 
o Select the Revert button to remove the affect of the changes made. 

5. Amend the Brightness in the same way. 

See Also...

Maintaining Camera View Properties
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Image File Properties
Function
When an image file is opened for an existing camera view (from the archive or from physical camera
connected to the system), the New Image File dialog is displayed. 
It is used to inform the system about the physical aspects of the camera used to produce the view. This
information can be subsequently maintained via the Image File tab in the Camera View Properties dialog.

In TEMA with Test Sections functionality (optional), this dialog will not only be able to display the
properties of the image sequence in the section currently active i test, but for all sections to which the
camera view is assigned. In other words, we c an enter the image file properties from a camera view in
one section in test, select any other section in the properties dialog and view the properties of the im age
sequence in that section.   

Appearance 
Basic version
 The basic details  of the image file currently in the camera view are listed; 

o File Format - the format of the image file. 
o Image Mode - 
o Image Size - the size in pixels (x*y) of the image frames.  
o Sequence Size - the number of bytes in the image file. 
o Sequence Length - the number of frames in the sequence. 

The Timing section allows you to c ontrol how timing information in the image file is used. There are two
possible types of timing information that can be available in an im age file: 

 Frame Frequency is the nominal frequency of the frames in the image file. Note that for some file
formats, such as AVI, this frame frequency can sometimes be fixed to 25 or 30 Hz even if the cam era
recording rate was something different.

 The Frame Zero Time function is connected to the Set t0 function. Set t0 can be a more convenient
way of selecting the Frame Zero Time, especially if you know the exac t time for some other frame
than zero.

Per Frame Time Stamps are available from some high speed cameras. This means that the c amera
records the exact exposure time for each frame, compared to the hardware trigger pulse. Normally, for a
digital camera this is very close to the time that can be calculated using the Fram e Zero Time and the
Frame Frequency. A notable exception is slave synced Phantom cameras which typically have a notably
lower nominal Frame Frequency than the actual frequency seen by the tim e stamps. This has to do with
the mechanism used to synchronize the c ameras. For film cameras where the individual frame times are
created using TrackEye decoding func tions the individual frame times can be substantially different as
the camera is actually running at a varying speed.

With Sections (optional)
 The upper part of the dialog contains a list of the Test Sections to which the camera view is

assigned. Each section is listed together with the im age file, if any. Marking a section in the list will
make its image file properties to be displayed below. 

 Below the sections list is the basic details (as in basic  version, see above) of the Image file currently
assigned to the Selected Section in the sections list above.  If no image file is assigned, all fields
will be empty here. 
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 The End Test Export list. 

Procedure
No Test Sections

1. Select the required camera view. 
2. Select the Properties option from the Edit menu

The Camera View Properties dialog is displayed. 
3. Select the Image File tab. Note: the basic details of the image file cannot be amended. 

4. To load a new image file into the camera view, click the Load button. This will open up the Open
Image Sequence dialog. 

5. To register the fact that you have moved the image file via Explorer, select the Find button. This
will open up the Reselect Image File dialog.  

6. To remove any specified image file from the camera view, click Clear.

7. The Use Per Frame Time Stamps toggle allows the operator to selec t to use individual time
stamps for each frame if available. If Per Frame Time Stamps are not available or if the operator
selects not to use them the Frame Frequency and Frame Zero Time are used to calculate the time
for each frame.

8. The Frame Frequency can be set using an entry field. If there is a frame frequency defined in
the image file the operator must enable the Override toggle before he can change the frame
frequency to some other value. If there is no frame frequency in the image file the Override toggle
is selected by default and can not be unchecked by the operator.

9. The Frame Zero Time can be set using an entry field. If there is a tim e for frame zero defined in
the image file the operator must enable the Override toggle before he can change the frame zero
time to some other value. If there is no frame zero time in the image file the Override toggle is
selected by default and can not be unchecked by the operator.

10. Define the Gamma Correction. 

7. Specify the InterlaceMode, which controls how the recorded images are presented to the
Tracking function:
o Full Frame - the odd and even lines in the image are presented as a single image. 
o Interlaced Video, Odd Line First  - specifies that the half image containing the odd lines is

presented before the 'even' half image. 
o Interlaced Video, Even Line First  - specifies that the half image containing the even lines is

presented before the 'odd' half image. 

8. Specify the Image Orientation, i.e. how the image is displayed, by selecting the appropriate
button:

o

o - rotates the image in a clockwise direction by 90 degrees. Repeated selec tion of the button
increases the rotation in 90 degree steps. The total rotation with respect to the starting point
is displayed beneath the button. 

o

o - rotates the image in a counter-clockwise direction by 90 degrees. Repeated selection of the
button increases the rotation in 90 degree steps. The total rotation with respect to the starting
point is displayed beneath the button. 

o

o - the image is mirrored. 
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o

o - the orientation of the image is reset to its original position. 

o The Revert To/Load Preference Defaults  buttons   will be functional if the Camera
view is in the Views (optional) list. 

With Test Sections

1. Select the required camera view. 
2. Select the Properties option from the Edit menu

The Camera View Properties dialog is displayed. 
3. Select the Image File tab. Here is information of the image file in the camera view for the

currently active section.
4. In the Relevant Sections area (optional), a list of the current Sections to which the camera view

has been assigned can be seen. 
o Auto. 

o If the check box is checked; the camera view will be assigned to all sections in test at all
times. Thus, if a new section is added to the test, this will also be added to this list
automatically. No sections can be removed from the list. 

o If the check box is unchecked, any section can be removed from the list using the Remove
button. The camera view will then not be assigned to that test sec tion. If in camera
control, download cannot be made for this camera view in that section. 

o If a section in the list has an image file assigned, it cannot be removed. To remove a section
with image file from the camera view, click the Clear button in the Selected Section area. The
Remove button will then be functional.

o The Revert To/Load Preference Defaults  buttons   (optional) will only be functional
if the Camera view is in the Views list. 

5. Selected Sections (optional). This area contains information of the image file in the camera
view for the selected section in the section list (see above) as well as the option of reloading a
new image file into this sec tion. 
o File Format - the format of the image file. 
o Image Mode - 
o Image Size - the size in pixels (x*y) of the image frames.  
o Sequence Size - the number of bytes in the image file. 
o Sequence Length - the number of frames in the sequence. 
o Frame Frequency  - the frame frequency as set when the camera view was added to the test.

The   can be amended here. 
o Load  - load a new image file to the selected section 
o Find - Reselect Image File
o Clear - remove the image file from the selected section.

6. End Test Exports (optional) 
Note: If a Remote Export Server is set up, this will be automatically used for all the End Test

Image Exports.

For each section from which an end Test export is to be made, repeat the following steps for eac h
export setting to be added;

o Click the Add button, the Add End Test Exports dialog will appear. 
o Select an Image Export setting from the drop box. This contains the whole list of all saved

Image Export settings in the preference archive. 
o Set an export File Pattern also. This will be the name used on the exported file. Note that the

files from the end test export must have unique names. In case a file name is not unique, an
error message will appear when the End test Command is given and we will have to reset the
exports again, using all unique names. 
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o Click OK when ready.
o Edit the entry fields of any End Test Export item by the use of the Edit dialog.

7. Define the Gamma Correction. 

8. Continue with steps 4-8 above. except the Gamma Correction. 

See Also...

Supported Image Formats

Maintaining Camera View Properties
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Reselect Image File
If you have clicked the Find button in the Image File Properties dialog, this dialog will open. 

Function
With the use of this dialog, a new image file can be selected instead of the one c urrently used in a
camera view. 

The need occurs when a test is opened on another workstation where the im ages are on different
locations. To be able to review an image sequence for a camera view, the image file has to be reselected.
 

Each time a new file has been used as the source for a camera view, this will be added to a referenc e list
for this camera view. This list is displayed in the Reselect dialog. 

Selecting amongst the candidates in list
For selecting an image that is correct, TEMA has a way of sorting the im age candidates in the list. 

The Search New Location is a function that will search a specified location on the network for a file with
properties (checksum, file name etc) as close to the original file as possible, using this for the c amera
view. 

However, the user can override this by using the Select Other File function. By the use of this, any file
can be used in the camera view. It is them up to the user to decide that this is the correc t image to use.
A case when this is needed is when an image has been modified in an enhancement program and a
camera view is to be specified with this image instead of the original.

Appearance
For each file in the list, the following information can be read: 

 File name - the name of the file. Most often, the names are the same as the file initially used. It is
basically only when the user selects a new file by the Select Other File function (see below) that the
filename may be another than the original file.

 Directory - the directory at where the file was located on any workstation when used. 

 Available  - Offers information of whether the file is currently available on the direc tory or not (Yes/
No).

 Selection  -  If a file is currently used in the camera view, this will be stated here as Accepted. If
another file is selected with the Select Other File function, this status will c hange to Refused.  

Also, there are additional file information below the file list; 
 
 Image Count - the number of image frames in the image file.  

 Skip Count - If the image file has a skip between the images, the length of this will be stated here.

 Start Image - is the selected variant  missing some frames in the beginning, compared  to the
original (yes/No).

 
 Flip - Is the selected variant flipped compared to the original (yes/No).
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 Zoom X - Is the selected variant zoomed in the x direction compared to the original (yes/No).

 Zoom Y - Is the selected variant zoomed in the y direction compared to the original (yes/No).

 Size - Image size in pixels*pixels.

 Size (bytes) - image file size.

 Color Mode

 Color Correction - Is the selected variant color corrected compared to the original (yes/No).(yes/no)

 UniqueID  - a  checksum based on the images in the file. The value is unique foe each file. Should
the images have been modified in any way, the checksum will not be the same as the original file. 

 File History
o Origin - when a file is created, maybe via image export or download form a camera, the

performance will be saved together with the resulting file. This inform ation can be seen here.
For files created in TEMA versions where this was not im plemented, this column will just state 
unknown. 

o Time - time at when the file was creted

Procedure:

Use the buttons below the list, depending on the needs; 

1. Search New Location  - TEMA will search a directory for a new candidate for the c amera view.
Specify the directory. 

2. Browse for other file - the Open Image Sequence dialog will open. By the use of this, browse to a
new file to use. 

3. Remove Selection - Remove the selection from the list.
4. Selected Location - use the marked variant in the list. 
5. Accept Any Selection - Load any file. The system will accept any selection made. 
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Tracking Properties
The Tracking tab in the Camera View Properties dialog is used to specify how points are displayed in a
camera view during tracking.

1. Select the required camera view.
 

2. Select the Properties option from the Edit menu.
The Camera View Properties dialog is displayed.

 
3. Select the Tracking tab.

 
4. To amend the Appearance of tracked points in the image, select the appropriate Edit button and

select the required colour from the Colour Editor dialog.

Note: Changing the colour may improve the legibility of the image displayed, or a printed version,
depending on the nature of the c olour and shading of the image.

o Point Colour - enables the colour of displayed points to be spec ified. 
o Selected Point - enables the colour of the selected point to be specified.

 
5. To display point names, select the Show name check box.

 
6. If you wish the point names to be displayed on a background colour: 

o Select the Show background check box. 
o Specify the required colour.

 
7. To hide non-calculated (not tracked) points, enable the Hide non-calculated points check box.

8. To specify how the Trace facility is to operate:
o Select the appropriate radio button:

o Show before now - Display points before the current point in time; 
o Show after now - Display points after the current point in time; 
o All - Display all points; 
o None - Trace disabled. 

o Key the Trace Length, which defines the number of point positions you wish to display in the
current image. This number defines both how many previous and/or following points are
displayed relative to the current point.

 
9. To specify which images to skip, key the Image Steps in the Image Steps frame.

For example, if "5" is keyed, every fifth image is tracked.
 

10. To specify the Default Tracking Image mode for tracking, select the appropriate radio button.
Note that the default set here can be overridden for each point individually in the point setup.
o Colour - Full colour is displayed.
o B/W - Gray scale, as defined by the luminance, is displayed. 
o Red - Only the red colour plane is displayed. 
o Green - Only the green colour plane is displayed. 
o Blue - Only the blue colour plane is displayed.

 
11. To specify how the system is to Interpolate Sleeping Points, select the appropriate radio

button:
o No Interpolation - Switches off the interpolation function. 
o Linear - Uses a linear function. 
o Cubic - Uses a cubic polynomial. Note: If the data is 'noisy', the use of cubic  interpolation can

lead to unpredictable results. Always chec k the results by displaying them in a 2D Diagram.
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12. To change the Display Mode of the image shown in the Camera View window, select the
appropriate radio button:
o Original Image - The image as stored on disk. 
o Default Tracking Image - The Default Tracking Image mode is applied to the shown image.

See Also...

Maintaining Camera View Properties
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Interpolation of Sleeping Points
Function
When a tracked point is put to sleep for a number of frames there will be a corresponding gap in the
output data. TEMA can interpolate (fill in) the data in these gaps, provided there are trac ked samples
both before and after the gap. 

There are two methods of interpolation:

 Linear – TEMA finds a linear function of time (a straight line in an X-T diagram) that connec ts the
last tracked point before the gap with the first tracked point after the gap. The values of this linear
function are then used to replace the sleeping data.

 Cubic – As linear, but instead of a linear function a cubic polynomial, that fits the two last points
before and the two first points after the gap, is used. Using a cubic function gives a sm oother curve
than a straight line, but if the data is noisy it can som etimes lead to strange-looking deviations from
the expected curve. 

It is also possible to turn off interpolation and leave the gaps in the data unfilled.

When displayed in a diagram, interpolated data will be indicated with a contrasting line colour from the
rest of the curve.

Procedure
There are two places in TEMA where interpolation is performed:

 Directly after tracking: 
o Before any other operation (except the optional c orrection for lens distortion) is performed on

the tracked data, sleeping data is interpolated. 
o 2D angles and distances, as well as velocities and accelerations, are then calculated using the

interpolated data.
o The settings for this interpolation function are available on the Tracking tab in the Camera

View Properties dialog.
 After 3D positions are calculated  (optional feature): 

o The 3D module does not operate on interpolated input data. The reason for this is that
interpolation introduces errors in the data (if a point was put to sleep because it was not
visible, its true position is unknown; interpolating the gap in the data is just a way of guessing
where it was) which will be magnified by the 3D process and may lead to unpredictable
results. 

o Instead TEMA interpolates gaps in the 3D data as a separate step. 
o The settings for this interpolation are available by:

  Right-clicking on 3D Results in the Test Contents.
or
 Selecting 3D Interpolation in the Edit menu.

See Also...
Maintaining Tracking Properties.
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Camera View Attributes
Function
The camera view attributes are additional information that can be assigned a camera view, focal length
etc. Camera view specific additional information. The attributes are all created in Preferences/ Attributes. 

Note: Updated Camera View Attributes will affect new tests only. Neither the currently opened nor any
other existing tests are affected. 

When selected from the camera view right click menu, the Camera View Attributes dialog will open. T his
presents the present camera view attributes in the preference list. After each attribute is a entry field in
which any information about the camera view can be added. 

See also...

Test Attributes
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Opening Image Sequences
Procedure

1. To open an image sequence for a new camera view: 
o Select the New Camera View option from the File menu.
alternatively
o Click the  tool.
The Open Image Sequence dialog is displayed.

or

To change to a different image file for the same camera view:
o Select Properties from the Edit menu and press Load button in the Camera View

Properties dialog.
alternatively
o Select Camera View Properties by right-clicking and press Load button in the Camera

View Properties dialog.
The Open Image Sequence dialog is displayed.

2. From the top left frame, select the drive and directory that contains the required im age sequence.
The selected image sequence source is shown in the Directory field and the details of the image
sequences in the folder are displayed in the Sequence list.

If the required directory is on another machine in the network: 
o Select the Network button.
o The standard Map Network Drive dialog is displayed. 
o Browse for the required computer/directory. 
o Select the OK button.
o The selected computer/directory is assigned a drive letter and added to the list of drives. 

3. Select the Sequence you wish to open.
The first image in the selected sequence is displayed in the Preview frame.
Note: The list can be sorted on any column by clicking the column header with the left mouse
button. Right clicking the column header displays the Column Setup dialog, which is used to
specify the data to be displayed.

4. While having an image file marked in the Sequence list, there are four buttons ac tivated above
the list:
o Network... - Click this if the required directory is on another machine in the network. For

further details see paragraph 2 above. 
o Fileformat Info - Click this to get information of workstation where the file was created,

operator, time and source file. 
o Delete Images - Click this to delete the image sequence marked. 
o Check Signature (optional) - If having a Digital Signature, this can be reviewed here before

using the image file.
  
5. Below the Sequence list the Refresh  button is activated. This button enables to make sure that

the content in the Sequence list is valid.

6. To select the marked image file, click the OK button. Note:  If the image file is not found at the
registered location when TEMA attempts to open it, but is found at another defined Image
Location, the Image File Not Found  dialog will appear. 

For a new camera view, the New Camera View  window is displayed.
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o Specify the camera view parameters.
o The new camera view is displayed in a separate View window within the display area.
o A camera icon and the name of the camera view are added to the Points List window. 

         For an existing camera view, the New Image File dialog is displayed.
o Specify the image file parameters.
o The selected image file replaces the previous one in the camera view. 

See also...

Supported Image Formats
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Image File Not Found
Function
When an image file that is used in a TEMA test is deleted, m oved or renamed outside TEMA, it will not be
found when opening the test again. 

In such situation, the Image File Not Found dialog will open. This enables you to cancel the use of the file
or to re-select the file at its new destination or with its new nam e. 

Appearance
 Search - if the image file has been moved from its original location,  relocate  it with help of the The

Browse for Folder dialog.
 Select - if the image file has been renamed, re-select it with its new name with help of the Open

Image Sequence dialog. 
 Cancel - cancel the use of the file in the test.
 Help  - takes you to this help page. 
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Specifying Image File Parameters
When changing the image sequence in a camera view, most of the defined parameters apply, e.g. those
applying to the camera. This dialog is used to specify the few param eters applying to the image sequence
and is displayed automatically after the new image file has been selected.
 

1. Amend the Name, if required.
Note: Duplicate names are not allowed in the same test. 

2. Key the camera Frame Frequency. 
3. Define the Gamma Correction. 
4. Select the OK button.

The Select New Image File dialog is closed. 
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Templates
Function
A Template is a generic definition of a Test, but with no data or pointers to im ages. When a template is
created, the procedure is saving the test setup, but the actual data is rem oved from this. 

A template is stored on the workstation as a file. At any time, a template can be opened in TEMA again.
It will then open up as a a copy of the test used that was used to create the tem plate, but with no data
or images. New data and images can now be applied instantly, and all c amera views, diagrams etc  will
update with this data. 

Using templates is a very time efficient way of working if a number of specific test setups are often used.
Those typical tests could then be saved as templates, working as model when the use of a specific test
type arises.

 

Types of usage
The templates and tests can be used in two main ways. 

From Test to Template 
An existing Test can be used as a model when creating a template. The test first opened in TEMA.  You
may then amend the test as desired and c reate a template from it by using the Create Template
command. This will generate a copy of the test but without the associations to the data used in this. 

Note: A Template is a .ted file, just like any other TEMA test, even if it does not contain any data. When
creating a template, this kind of special .ted file will be saved in the Templates directory as specified in
the Preference Archive. It is no actual difference between what is called a template and a TEMA test
saved without any data. The difference is the way of usage. A .ted file stored in the Tem plates Directory
will be treated as a template; it may be loaded into TEMA with the File/New Test com mando. 

Note 2:  A general template does not contain any tracked data nor references to any images used in a
test. However, in the File/Create New Template dialog, there is a check box saying Wipe Images and
Data. Having this unclicked, will result in the creation of a template with tracked data and images. 

From Template to Test 
An existing template can be used as a model when creating a test. The template is first opened in TEMA
with the new test c ommand. The command will lead to a open Template dialog where all templates are
listed. From this list, the desired template can be selec ted and opened in TEMA. When opened, it can
be considered a test but with no data yet inserted.  You may then amend the template as desired
and add data. The "Template" (it may now contain data) can then be saved either as a test OR as a
Template. The first will will generate a regular test and the latter a c opy of the Template but with no data
associated (see above). 

When opening up a new test in TEMA, initially a tem plate is always opened. Opening a blank new test, is
with no setups made, is just loading a spec ial case of templates, called <Empty Test> in the template
list. The existence of this can be determined in the preference archive/directories.   

Accessed via...
File/Create Template 
File/New Test. 

See also...
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Setting Up the Test.
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Test Sections (optional)
Function
In many applications, a static (non-m oving) camera is used for shooting multiple sequences during the
same test; calibration sequence and additional test sequences. 

In such applications, in TEMA, we might want to track a number of reference points in the camera view,
calibrating the camera and then use this calibrated camera when tracking in a subsequent test
sequence. 

To make this simple, TEMA has a user interface that allows the use of several im age sequences in one
camera view. 

Instead of just add a camera view to a test, a Section is added to the test. A Section is an item that can
be specified with several image sequences and assigning them all to a camera view. 

Several sections can be added to a test. 

Multi/Single sections
There are two different types of Test Sections; Multi and Single Test sections.
 A Multi Section handles stored images on the RAM memory of a camera. The download c ommands

will capture such data and download to the specified download directories. 
 A Single Section operates on live images only. Having a single section ac tive, when in Camera

Control Mode, the Arm command, that captured stored images, cannot be performed. Instead, the
Single Frame Capture function will be available, that captures a live snapshot from  all cameras in the
test. Typically, we want to capture a reference board, using one fram e only. After download, a single
section in store mode will delimit the time panel to one frame only (the first frame), even if the
downloaded sequences in the camera view(s) have several frames. Using a single section, there is a
live download function also, that will capture a live snapshot from one camera at a time. 

Appearance
For each section in the list, the following information can be read: 

 Section Name, as given in the Add Section dialog. 
 Single status enabled/disabled, see below. 
 Download 1. Default File Pattern for Download from camera, download directory 1. The filename will

appear in the Camera Setup window. Editable enter field.
 Download 1. Default File Pattern for Download from camera, download directory 2. The filename will

appear in the Camera Setup window. Editable enter field.
 Export. The default name for the exported file when entering the Image Export dialog. Editable enter

field.

Procedure
1. Select Edit/Test Sections. The Sections Setup Dialog will appear. As can be seen in the sections

list, there is one section present from start. This is the Default section. Due to system  design, at least
one section has to be present at all times. Therefore, this cannot be removed before we have added
one additional section to the test. 

2. To Add an Additional test section to the test, click the Add button. The Add Section interface will
appear. 
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3. Give the Section a suitable Name.

4. If the Single check box is enabled, this section will be a single section. 

5. The Download File pattern contains the filename patters from the Preference Archive/Directories if
present,  for the dual download destinations. Override by typing som ething else in the enter fields. 

6. Enter an Export File pattern to be used as nam e of exported file when performing an Image Export.
The built in variable $VIEWNAME$ will use the view name automatically. 

7. The Default section can now be removed from the test by selec ting it in the sections list and clic king 
Remove. 

8. The fields for Download 1 & 2 and Export can be amended in the list. Click the item and re-type. Click
outside the enter field when ready. 

9. Change the order of the sections in the list. Mark an item and click the down arrow buttons  
to move it in the list. The same order as in the list will be used in the Sections tool bar in the m ain
window.  

10. Edit the entry fields of any Section by the use of the Edit dialog. 

11. Click the OK button when ready. 

12. In the Tool bar, the added sections can now be selected from  the drop box. The currently displayed
section is selected. 

13. If a camera view is added to the test, the image file will be associated to the selected section. If a live
camera is added to the test, the downloads from this will be done with the filename patterns as set
for the selected section. Thus, if several sections are available and another one is selec ted, the
camera view will display another image sequence. 

14. If track points are added to the camera view in the current section, those will be present for the
selected section only. Thus, if several sections are available and another one is selected, the point list
below the camera view will change to match the points added to the c amera view in the other
section. 

15. If the camera view properties are entered for a camera view, and select Image File Properties, we can
manage the sections at where the image file is used. 

See also...

Arena test
Point Generator
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Specifying the Gamma Correction
An image sequence that you use may or may not have been gamma corrected. If it has been corrected,
the correction factor may or may not have been stored in the file.

When an image sequence is selected, if there is a gam ma correction factor in the file, it is displayed in
the appropriate dialog, i.e. 

 New Camera View; 
 Select New Image File; 
 Camera View Properties. 

If  the value is not in the file, the default value is assum ed, i.e. 1.8.

The general preferences contain a preferred gamma correction which is set to the value most suitable for
your display, the default value being 1.8.

In any of the above dialogs:
 If you do not select the Define File Gamma checkbox, the displayed value is assumed to apply to

the file. This level of correction is removed and the preferred level applied.
 If you do select the Define File Gamma checkbox and key a value, the keyed value is assum ed

to apply to the file. This level of correction is removed and the preferred level applied. 
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Opening Data Files
Function
This function enables to use data from a number of fixed format file types, which the system  recognises
automatically without the need to specify the format. The format file types are:

 Files based on the ISO:13499 standard.
 A subset of the formats produced by the DIAdem software.
 HDF (Hierachical Data Format).
 Altair Binary Format.
 CSV, comma-separated values, see example below.
 Tab-separated values, see example below.

Procedure
 To use this function:

1. Select the New Data File option from the File menu.
The standard Open Data File dialog displayed.

 
2. Browse for the required file.
 

3. Select the  button.

For most file formats, the Select Columns dialog is displayed. It shows the c olumns available in
the selected file. All columns are selected by default. If not  all c olumns are required:
o Select the required columns using the available buttons:

 Mark All - selects all columns. 
 Unmark All - unselects all columns. 
 Mark Selected - selects all the columns you have marked using the mouse and the

<shift> and <ctrl> keys in the standard Windows m anner. 
 Unmark Selected - unselects all the columns you have marked using the mouse and the

<shift> and <ctrl> keys in the standard Windows m anner. 
 Individual columns may be selected by clic king the appropriate check box. 

o When you have set the required columns, select the OK button. 

For CSV- and Tab-separated values: A data file with signals or "curves" as c olumns in a multi-
column sheet, the files can probably be imported in TEMA, either directly or by m aking some
minor changes. Any file extension can be used (.txt, .dat etc.). See exam ples below.

4. The selected file is imported.
Note: If the Unit column contains a value, i.e. a measurement unit, that the system  does not
recognise, a warning is displayed indicating that the data will be im ported as a scalar value.
A file icon, the file name and the list of selected columns are added to the Test Contents
window.

Examples
Both files below will result in three sequences in TEMA named a, b and c.

Example 1:

t,a,b,c
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ms,m,m/s,G
1,5,7,9
2,6.1,7.2,9.3
3,7.2,8.3,10.2
4,7.2,8.3,10.2
5,7.2,8.3,10.2
6,7.2,8.3,10.2
7,7.2,8.3,10.2
8,7.2,8.3,10.2
9,7.2,8.3,10.2
10,7.2,8.3,10.2
...

Rules:
 The first row is the name of each "signal" or "curve".
 The second row is the unit for each column.
 The first column must be the time base (sample time for each row).
 Note! Each value is separated with a tab or a c omma.
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Importing Camera Views
This function is used to import into the current test a camera view held in an external ".ted" file, i.e. from
a previously saved test.

1. Select the Import View option from the File menu.
The standard Open dialog is displayed. 

2. Select the required camera view. 
3. Select the Open button.

The Import View window is displayed, showing all the camera views in the selected test. 
4. Select the required camera view. 
5. Select the OK button. 
6. The selected camera view is displayed in a separate View window within the display area.

A camera view icon and the name of the camera view are added to the Test Contents window. 
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Setting Time Properties
This function is used to specify how time is handled during the test.

1. Select the Time Properties option from the Edit menu. 
2. To set the User Defined Interval:

Note: This function is used to limit the images from a sequence used for tracking and analysis to a
specific time range.
o Key the required User defined start time frame.

o Alternatively, select the  button to set the start time to the current time. 
o Key the required User defined stop time frame.

o Alternatively, select the  button to set the stop time to the current time. 

o You may reset the start and stop times to cover the full range by selec ting the  button. 
3. To position at a particular point in time: 

o Key in the required Goto time. 
o Select the Go button. 

4. To specify the Animation Speed:
Note: The Animation speed specifies the speed at which the tim e panel operates in relation to the
test time, i.e. how many seconds of test time relate to one second of analysis tim e.
o Select the Use Animation Speed checkbox. 
o Key the required speed in the Animation Speed field.
o The value is specified in units of test time per unit of analysis time, i.e. real time. 

5. To set the Time Run Mode, select the appropriate checkboxes:
o If Normal is specified, the sequence stops when the end is reached. 
o If Auto Reverse is specified, the sequence is played in reverse, then forwards again until the

stop button is selected. 
o If Circular is specified, the sequence is repeatedly played from the beginning until the stop

button is selected. 
6. Select the OK button. 

 



p84

© Image Systems AB, 2011

Setting up List Columns
The Column Setup dialog is used to specify the columns to be displayed in a list view and to spec ify the
sort sequence of the items in the list. 

1. Right click a column header in left or right side of the window/dialog, as appropriate.
The Column Setup dialog is displayed, showing the columns currently displayed and those
available for display. 

2. To make a column visible, select it in the Invisible columns list and click the  button. 
3. To make a column invisible, select it in the Visible columns list and click the  button. 
4. To move a visible column to the right, select it in the Visible columns list and click the 

button. 
5. To move a visible column to the left, selec t it in the Visible columns list and click the button. 
6. To specify the sort sequence:

o Select the Sorting checkbox. 
o Select the sort key from the Sort by drop-down list. 
o Specify the sort sequence by selecting (for ascending) or de-selecting (for descending) the 

Ascending checkbox. 
7. Select the OK button. 
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Creating and Maintaining a Test
Description
A test description is a free text entry that is used to provide a brief description of the associated test. It
can subsequently be included in print reports to describe the context of the test results.

1. Select the Test Description option from the Edit menu.
The Test Description dialog is displayed. 

2. Key in or amend the free text description of the test. 
3. Select the OK button. 
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Lens Calibration
Every lens has an inbuilt distortion to some degree. In order to obtain accurate results from  the system it
is necessary to perform a camera lens calibration on a regular basis. This is achieved by comparing the
predicted positions of the points on a fixed target with the actual m easured positions and calculating the
deviation. The results of each calibration may be stored as xml files and used later to compensate for
lens distortion by using the lens distortion correction function. 

Lens calibration in TEMA can be done in three ways; 
 AICON Lens Calibration
 3D Target Lens Calibration
 Planar Target Lens Calibration
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AICON Lens Calibration (optional)
Function
The AICON calibration method is a separate software from  AICON 3D Systems GmbH in Germany, which
can be integrated to TEMA. For the camera lens combination it calculates internal parameters together
with a transfer function to adjust for lens distortion. The method uses a dedicated physical calibration
board on which all markers have a very accurately measured 3D position (x, y & z), which automatically
are identified by the software module.

The AICON lens calibration is a three step process:
 Create a template.

The camera template has to be c reated in AICON once only for each new camera, and this has to
be performed before calibrating the camera. 

 Calibrate a camera. 

 Inspect calibration result.

Procedure
Creating a Template

1. Select the AICON Lens Calibration option from the Tools menu.
Note: Alternatively, you can perform the calibration from outside TEMA by starting the application
"dpa_calib10".
The AICON Lens Calibration dialog is displayed. 

2. Select the Calibrate button.
The New calibration - Selection of template  dialog is displayed. 

3. To calibrate a new camera, double-click on "New template".
The New template- Select camera dialog is displayed.

4. Select .
The Create new camera dialog is displayed.

5. Specify the camera details.
Note: The Name, Resolution, Sensor size and nominal Principal point are the minimum
requirement.

6. Select the Save button.
The Create new camera dialog is removed and the New template- Select camera dialog is
redisplayed.

7. Select the OK button.
The New template- Insert cameras dialog is displayed.

8. Select the Next button.
The New template- add reference information dialog is displayed.

9. Select the Next button.
The New template- Parameter dialog is displayed.

10. Check the settings displayed and amend them if necessary.
For the supplied calibration board, the default settings should be used, i.e.
o Type of coded targets - 12 bits.
o white target.
o Index values - from = 2, to = 147.
o Allow very small targets? - select this check box if the camera has low resolution.

11. Select the Next button.
The New template- Calibration settings dialog is displayed.

12. Select the Next button.
The New template- Summary of parameters dialog is displayed.

13. Check the settings.
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If necessary, use the Back button and amend the settings.
14. Select the Finish button.

The New calibration - Selection of template  dialog is redisplayed with the new template added
with the name "Unnamed". 

15. Amend the name to reflect the type of the c amera. 

Calibrating a Camera
1. Double-click the required template in the New calibration - Selection of template  dialog.

The New calibration - Enter information dialog is displayed.
2. Key the Project name.

This is a unique name that will be used to identify this particular calibration.
3. Amend the Project path, if necessary.

This is the directory where intermediate calibration files are stored. The default value created by
the program can be used.
Note: When a name is keyed, the path is automatically extended.

4. Make sure that the Image selection and calibration check boxes in the Start automatically
frame are selected.

5. Select the Next button.
If the specified directory does not exist, a warning is displayed.

6. Select the Yes button to create the directory.
The New calibration - Calibration settings dialog is displayed. This contains a series of value
and check box pairs. A selected check box indicates that the c orresponding parameter is to be
calibrated and the value used as an approximate starting point.

7. Select the required check boxes and amend the values if necessary.
It is allowable to give a zero starting value for all parameters except the Focal length and the
Principal point.

8. Select the Next button.
9. The New calibration - Summary of parameters dialog is displayed.
10. Check the settings.

If necessary, use the Back button and amend the settings.
11. Select the Finish button.

The Choose images dialog is displayed. 
12. Select the Select images button.

The standard Open dialog is displayed. 
13. Select one or more image files.

The image files should be in Windows bitmap format (.bmp) or in uncompressed TIFF format (.
tif). They should be pictures of the calibration board from different angles and with different
camera orientations, taken with the same focus settings and at approximately the same camera-
object distance as for the intended use of the camera.

14. Select the OK button.
The Measurement dialog, containing a progress indicator, is displayed and the calibration
proceeds automatically. When finished, the AICON Lens Calibration dialog is displayed and
contains a summary of the calibrated parameters.
Note; If the calibration fails, select the Details button in the Measurement dialog to determine
the reason for the failure.

Results
15. Select the View Results button.

 The Results dialog is displayed where you can review the calibration and check the results.
There are three tabs in the dialog:
o Measurement - this shows the measurements of points in the images. Selecting the Info

("i") button next to an image name displays the Image measurement information  dialog (
Image tab) showing the point identification graphic ally in the image. Selecting the Grid tab
displays the measured image coordinates with error estimates associated with the point
identification.

o Pre-orientation - this shows the 6DOF of the camera relative to the board in each image.
Selecting the Info ("i") button displays a schematic picture of the camera's orientation.

o Calibration - this shows the calibrated parameters. Selecting the Info ("i") button and then
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selecting the Grid tab displays the estimated standard deviations of each parameter
16. When satisfied with the results, select the OK button.
17. Select the Save Results button in the AICON Lens Calibration dialog.

The Save as dialog is displayed.
18. Save the calibration results as a text file with the extension ".ior".
19. Select the Close button.

Create New Camera Dialog
The Create New Camera dialog contains the following information:

 Name - the name to be assigned in the system  to the camera.
 Camera values

o Resolution (Pixel) - the size of the image in pixels, e.g. 1600*1200.
o Sensor size (mm) - the actual size of the sensor.
o If this is not known, choose a reasonable nom inal value for the size of one pixel and multiply

the resolution by this value. In the above example, a nominal pixel size of 5 µm is chosen, the
computed sensor size is 8*6 mm.

o Note: The result of guessing the pixel size and sensor size in this way is that the calibrated
focal length differs from the real focal length. This is perfectly norm al and works since the
quantity that is important in photogrammetry is actually the ratio (foc al length) : (pixel size).

o Focal length (MM) - this is used as a starting value for the calibration.
 Distortion parameters

o Principal point (mm) - In unknown, enter half the values for the sensor size, i.e. the
coordinates of the centre of the image.

o Radial-symmetric - These fields and check boxes determine which parameters are calibrated
by default and specify their default values. You do not need to c hange these fields.

o Asymmetric - These fields and check boxes determine which parameters are calibrated by
default and specify their default values. You do not need to change these fields.

 Import - Button used to import a camera specification from an external file.
 Save - Button used to save the camera specification and return to the New template - Select

camera dialog.
 Cancel - Button used to cancel the setup.
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3D Target Lens Calibration (optional)
Function
The TEMA Lens calibration process involves the following major steps: 

 Record an image sequence containing the target using the cam era/lens combination you wish to
calibrate and save it as an image file on the workstation. The target should be stationary during
this process and placed so that it fills the im age. The calibration may be done from a single image
but better results are obtained from a sequence because the results from each image are
averaged. 

 Define a TEMA test which carries out a normal automatic 2D Tracking on the camera view. The
target points are included in the Tracking by means of Reference Points. The trac ked sequence is
then fed into a Lens Calibration function. The calibration function compares the tracked
coordinates against the measured known positions as stored in the Arc hive. 

 Carry out the calibration and store the results on an external XML file. The file can then be
imported into the sensor when used in any test, m aking lens distortion compensation possible.  

The calibration reference points (target)

The calibration process requires specific Reference points (target) to be c onstructed and modeled
accurately in the system. The target must have at least 15 points if you wish to inc lude lens distortion in
the calibration and at least 5 points if you wish to calibrate only for foc al length, principal point and
aspect ratio. The points must not all be in the same plane otherwise the calibration func tion is not able to
make the necessary depth calculations. The x, y, z coordinates of the target points are m easured to sub-
millimeter accuracy. 

If the camera's foot point is known, its position may be specified and used as input to the calibration.

Procedure
1. Input the camera view with the calibration target visible via the Add New Cam era View function.
2. Insert the required Calibration Reference Points visa the Camera/Insert Reference Points.
3. Track each of the reference points through the calibration sequenc e. 
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4. When finished tracking, select the Camera/Lens Calibration option from the menu bar. The Lens
Calibration dialog will appear. 

5. Specify the Reference points to use in the calibration by clicking in the list.
6. Specify the Distortion Model. The Radial model has increasing distortion with inc reasing lens

radius. The Polynomial model sets up polynomials in the X and Y directions to model the
distortion. Which one of the models to use is a matter of opinion, but most often the Radial model
is the best choice.

7. Specify the camera axis, x, y or z.    
8. Check the Distance To Target Known check box if this is true. This will allow the distance to be

typed in the entry field below.   
9. Enter the Known Parameters.
10. When finished, select the Calibrate button.

The calibration is performed and displayed in the Calibration Results dialog.

Results
11. See Reviewing the results for an explanation of how to interpret the results. 
12. Select the Save button to save the results as xml file. Such can be imported into any TEMA test

using the this sensor.  This is done in the Camera View Properties dialog.  
13. Select the Close button. 
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Reviewing the results from the 3D target
lens calibration
The results of each calibration must be checked, especially if you choose to save them in the Archive
because they are then available to be used for compensating for camera performance in other tracked
sequences.

The Calibration Results dialog shows the results of the calibration under the following headings: 
 Camera Position
 Camera Orientation
 Internal Camera Parameters
 Foot Point Offset (This result is only displayed if the camera has been calibrated for foot point

offset.) 
 Residual
 Distortion (This result is only displayed if the camera has been calibrated for lens distortion.) 

As well as assessing the results of an individual c alibration it is advisable to compare the results against
previous calibrations to identify any major changes which may need to be addressed.

Camera Position

This displays the calibrated position of the camera's optical centre (focal point). A deviation of a few
centimetres in any direction is acceptable, espec ially since the optical centre is not usually m arked. This
information is not stored in the Archive because it is not used for correction.

Camera Orientation

This displays the angles giving the camera's orientation relative to the coordinate axis. This inform ation
is not stored in the Archive because it is not used for correction.

Internal Camera Parameters

The following internal parameter are displayed: 
 Focal length - The focal length is measured in pixels (which may vary in size from installation to

installation).
 Note: There are different definitions of foc al length which means the measured value may differ

from the value specified by the lens manufacturer. 
 Principal point - The x and y coordinates of the principal point should norm ally be close to the

centre of the image. 
 Aspect ratio -  This is normally "1" for most cameras and should be within 1% of the expec ted

aspect ratio. 

Foot Point Offset

The position of the focal point is difficult to identify on a camera. To overcome this, a foot point is
specified at an easily identifiable position on the camera. The foot point offset is the angular vector from
the foot point to the focal point. It is used to calculate the focal point from  the foot point.

Residual

This is a measure of how well the predicted image matches the measured image. The smaller the figure,
the better the match. the range of acceptable values varies depending on the num ber of reference points
and the camera resolution.

Distortion
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This is a measure of the distortion of the shape of the target attributable to the c amera lens. It is defined
as the maximum distance (in pixels) between a calibration point's image before and after c orrection.

Selecting the View Distortion Coefficients button displays the Distortion Coeffic ients dialog which contains
the 30 coeffic ients (15 for the X dimension and 15 for the Y dimension) use in the calibration
calculations.
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Planar Target Lens Calibration
Function
For a chosen camera and lens combination this lens calibration method calculates the camera internal
parameters together with a transfer function to adjust for lens distortion. The m ethod requires a
dedicated physical calibration target (e.g. physic al calibration board or a printed version of the board)
together with a set of images of the target. The calibration images can either be separate snapshots or
parts of a longer image sequence captured by either a still cam era or a video camera.

Procedure
The lens calibration is a seven-step process:

1. Recommendations for calibration target (printed version)
2. Recommendations for image capture
3. Recommendations for camera setup
4. Image capture of calibration target
5. Download of images
6. Calibration of camera
7. Inspection of result

1. Recommendations for Calibration Target (printed version)
When using a calibration target consisting of a printed version of the physic al calibration board, please
follow instructions how to print your own calibration board:

 Print the calibration target on paper size A1 (594 x 841 mm) or A2 (420 x 594 mm) depending on the
camera field of view.

 The accuracy of the squares should be at least 0,3 mm for a paper size of A1.
 Use a printer that keeps the aspect ratio of the squares.
 It is important to keep the printed calibration target flat when sticking it to a hard surfac e.

2. Recommendations for Image Capture
In order to determine the camera parameters, the camera that has to be c alibrated needs to capture
images of the calibration target. Please pay attention to the following:

 Calibration target size. (See chapter 2.1)
 Filling the format. (See chapter 2.2)
 Calibration target placement. (See chapter 2.3)
 Set of calibration images. (See chapter 2.4)

2.1  Calibration Target Size
The camera focus should be the same as when the camera is used after calibration. This puts
constraints on the distance between the camera and the calibration target, which means that it is not
possible to have full control over how large the target will appear in the im age. The limits on the
apparent size of the calibration target are:

 All four reference points (the four round target m arkers) must be visible in all calibration
images.

 The reference points should not be less than six pixels ac ross in any image.
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2.2  Filling the Format
 The image sequence of the calibration target needs to be as format filling (i.e. image filling) as

possible. This is necessary to determine the distortion for the entire image format. 
 The format filling does not necessarily have to be in one single image. Depending on the focal

length and the environmental conditions more images might be necessary.
 It is important that, in the total of the images, the format is well used. 

2.3  Calibration Target Placement
 In order to achieve a precise determination of the principal point, it is useful to perform  a

rotation of the calibration target around the cam era axis (swing). The best result is achieved,
if a 90º rotation as well as a 180º degree rotation is perform ed.

 A tipping over of the calibration target relatively to the camera causes the capturing of sloped
images. These sloped images are necessary to determine the focal length.

2.4  Set of Calibration Images
A recommended set of calibration images are described and shown below:

 Images 1-3: Different swings between camera and calibration target.
 Images 4-7: Sloped images with different angels between the cam era and the calibration

target. Recommended slope is approximately 45º.
 Images 1, 2, 3, 4, and 5 described are an absolute m inimum. The accuracy of the calibration

generally improves if more images are added, up to a m aximum of about 20 images.

It is important that the reference points (target markers) on the calibration target are c lose to the
edge of the image. It does not matter if some parts of the target are out of the im age view.

For more information about Recommendations for image capture  see More about...

IMG1_0_degr IMG2_90_degr IMG4_45_degr_from_left IMG5_45_degr_from_right

IMG3_180_degr IMG6_45_degr_from_below IMG7_45_degr_from_top

Explanations of illustrations above

 The red square illustrates the camera view/captured image of the calibration target.
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 The red arrow points towards the topside of the calibration target.

When the calibration target does not fill the entire image a recommended set of calibration images
are described and shown below:

 Images 1-4: The calibration target fills less than half the image frame. When capturing images
of the target in each of the four quadrants of the frame, they fill the entire format together.

 Images 5-8: Sloped images. The target fills less than half the im age frame. When capturing
images of the target in each of the four quadrants of the fram e, they fill the entire format
together. Recommended slope is approximately 45º.

 Corresponding images to those described above (and shown below) can be captured but with
different swing and slope.

IMG1_0_degr_1Q IMG2_0_degr_2Q IMG5_45_degr_from_right_1
Q

IMG6_45_degr_from_left_2Q

IMG3_0_degr_3Q IMG4_0_degr_4Q IMG7_45_degr_from_left_3Q IMG8_45_degr_from_right_4
Q

Explanations of illustrations above

 The red square illustrates the camera view/captured image of the calibration target.

 The red arrow points towards the topside of the calibration target.

3. Recommendations for Camera Setup

3.1  Camera Settings 
A very important fact is that the camera parameters change when the focus setting and/or the zoom
setting of the lens is changed. This means that:

 All calibration images must be captured with the same focus setting and the same zoom
setting. 

 The calibration results are only valid for a unique camera setting. 
 Use manual focus. Do not use auto focus.
 Use a small aperture (f-stop) and possibly long exposure time. The aperture can be changed

after calibration if desired.

3.2  Camera Placement 
 To reduce the risk for motion blur it is recommended to mount the camera on a tripod when

capturing the calibration images.
 As described above the calibration images should be captured from different directions relative

to the calibration target. When describing this it is assumed that the target is in a fixed



p97

© Image Systems AB, 2011

position and the camera is moved around. This is often inconvenient or even im possible. In
such cases keep the camera fixed and move the calibration target instead.

 Use the same distance for capturing images, either by using a fixed position of the calibration
target and moving the camera or a by using a fixed position of the c amera and moving the
calibration target. 

3.3  Lighting
 Good and uniform lighting is important to get sharp images that produce accurate calibration

results. 
 Take care to avoid reflections in the surface of the calibration target, since this m ay make it

hard to find the reference points (target markers). 

For more information about Recommendations for camera setup  see More about...

4. Image Capture of Calibration Target
When the recommendations for image capture and camera settings respectively have been ac quired, the
image sequence of the calibration target can be captured. 

1. Place the calibration target in front of the c amera.

2. Capture an image sequence of the calibration target from different angles according to above
recommendations.

 It is recommended to capture snapshots rather than a continuous m ovie, because it makes the
calibration process easier.

 Use the same distance for capturing images.
 Use a fixed position of the calibration target and move the camera

OR
Use a fixed position of the camera and move the calibration target.

5. Download of Images
 When downloading images from the camera it is vital that the images appear as "seen by the

camera", e.g. for a swing 180° image it really should be up-side-down. Do not use the option to
rotate the images so they appear right side up.

 TEMA requires the calibration images to be a part of a film sequence. This sequence may also contain
any number of images that will not be used for the c alibration.

 There are two ways that the images can be organized when downloaded from the camera, as
separate snapshots or as a continuous movie. 

5.1  Separate snapshots
 Each calibration image will be stored as a separate file. 
 Before loading these images into TEMA, make sure that the file names conform to the

following rules:
o All file names should start with the same string of characters. This string is the nam e of

the image sequence that is seen inside TEMA.
o Following the name string should be consecutive numbers with the same number of

digits. These numbers are the frame numbers of the images within the sequence.
o Following the digits is the usual file name extension, e.g. ".jpg" for JPEG images.
o As an example, if we have ten image files named calib0001.jpg, calib0002.jpg,

calib0003.jpg and so on up to calib0010.jpg. TEMA will read them as one sequence
called "calib".
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5.2  Continuous movie
 The calibration images are part of a continuous movie sequence and will either be stored as

one big file (e.g. AVI file) or as a set of separate files with a nam ing convention as described
above. In both cases they can be loaded directly into TEMA.

 Such a sequence will probably contain a lot of "interm ediate" images that not will be used
(typically is that the calibration target is moving between different positions in the image
frame). 

 TEMA will let you skip the intermediate images and only use the images that are part of the
calibration set. 

6. Calibration of Camera

1. Create a camera view and open an image sequence.

 Select the New Camera View option from the File menu. The Open Image Sequence
dialog will appear. 

 Select the image file of the calibration target and press the OK button. The New Camera
View dialog will appear. 

 Do not enter any camera parameters in the New Camera View dialog. Do not enter any
frame frequency either, since it is not used by the c alibration.

 Press OK button. The program automatically highlights the image file of the calibration target
in the Test Contents dialog and a camera view of the calibration target is shown. 

2. Start the Lens calibration wizard.

 Select the Planar Target Lens Calibration option from the Camera menu. The Lens
Calibration Wizard dialog will appear. 
The Status section in Lens Calibration Wizard dialog will communicate the necessary steps to
complete the calibration. 

3. Some inputs need to be made before proceeding with the calibration. 

 Set Calibration input data of the camera.
o If known, enter Physical Pixel Size (value and unit) of applicable camera in the

Calibration input section.
OR
Check Unknown in the Calibration input section

 Set Calibrated Parameters of the camera.
o Influence which parameters will be calibrated by checking Calibrate Tangential

Parameters or Calibrate A3.
o This is an advanced feature. In most cases both check boxes can be left unchecked. For

more information, please see the Lens Distortion Model.

4. Create a Reference model of the calibration target.

 Generate a Reference model.
o Mark Generate in the Reference model section and modify the Size of squares

(value and unit of one calibration target square).
o Press Generate button to generate tracking points of the calibration target.
o The accuracy in the “size of squares” will not affect the accuracy of the calibration. It

will only affect the intermediate results, which are the camera positions in each frame.
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OR
 Import a Reference model. This option is only relevant for users having an already created

target model of the calibration target.
o Mark Import from file in the Reference model section and press the Import button.
o Select applicable Target file (.trg) and press Open button.

5. Position tracking points on the calibration target.

 The calibration process requires four tracking points to be pointed out on eac h frame. TEMA
will automatically name these tracking points when moving the cursor towards the reference
points (target markers) in the image of the calibration target by: Lower left, Lower right,
Upper right and Upper left tracking point.

o Note! The names “Lower left”, “Lower right”, “Upper right” and “Upper left” refer to
positions of the four reference points when the c alibration target is turned
right-side-up. These names will be kept even though the calibration target has been
turned 90º or 180º.

o Note! Three of the reference points are also identifiable by having yellow identification
triangles, marked in image below.

o Note! It is important to position the trac king points (Lower left, Lower right, Upper right
and Upper left) correctly, even though the calibration target has been turned 90º or
180º.

o Note! If the positioning of tracking points gets wrong, press Clear frame button or
Clear all frames button.

 Place the first tracking point Lower left with the cursor in the reference point at position
"Lower Left".
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 During the calibration process the Status section in Lens Calibration Wizard dialog will
communicate next step, e.g. "Processing frame…" followed "OK. Goto next frame.".

 Place the second tracking point Lower right with the cursor in the reference point at position
"Lower right".

 Place the third tracking point Upper right with the cursor in the reference point at position
"Upper right".

 Finally place the fourth tracking point Upper left with the cursor in the reference point at
position "Upper left".

 Wait a while for the TEMA system to find the remaining tracking points.

 Inspect the tracking result. If one or more tracking points are wrongly detec ted, then clear the
frame to stop it from affecting the calibration, by pressing Clear frame button.

 Goto next frame by pressing Play button and Stop button OR alternatively Step forward
button in the Time section.

 Position the four (4) tracking points as before: Lower left, Lower right, Upper right and
Upper left.

 Repeat this procedure until at least five (5) frames of the calibration target have been m arked
with tracking points. The Status section in Lens Calibration Wizard dialog will communicate
next step. 

7. Inspection of Results

1. View Calibration result.
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 When satisfied with the result of positioning tracking points, continue by pressing Next
button.

 The calibration result will appear in the in Lens Calibration Wizard dialog. 

 View the calibration result and analyse the Mean Residuals and Max Residuals.
o By selecting a Frame# (row) in the Image section the Worst Point will be shown in

red colour in the image to the right. 
  
2. Save calibration result.

 When satisfied with the calibration result press the OK button and save the result as an XML
file (.xml).
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More about Image Capture and Camera Setup...
The information below is presented in the same order as it appears in the Planar Target Lens
Calibration chapters above.

Format filling
There should be calibration points (target pattern) in all parts of the im age frame in at least one image.
This does not mean that the calibration target must fill the entire format in any single image, but that
the target can be moved between images so that it fills the format when the images are viewed together.
See illustration below.

IMG1_0_degr_1Q IMG2_0_degr_2Q

IMG3_0_degr_3Q IMG4_0_degr_4Q

Explanations of illustrations above

 The red square illustrates the camera view/captured image of the
calibration target.

 The red arrow points towards the topside of the calibration target.

Calibration target placement
To describe the orientation of the camera relative to the target the terms swing and slope are used.

 Swing is a rotation of the camera around the optical axis (or the equivalent rotation of the calibration
target). Swing 0° means that the calibration target appears right side up, while swing 90° m eans that
it appears standing on edge, and swing 180° shows it up-side-down.

 Slope is the angle between the camera’s sensor plane and the surface of the target. A slope of 0º
means that the image is taken head-on (that is, the angle between the optic al axis of the lens and
the target is 90°).

Number of calibration images
 It is not recommended to use at least five (5) images as an absolute m inimum.
 It is not recommended to use more than 20 images since it will lead to long processing times and

may also lead to decreased accuracy due to accumulation of rounding errors.

Focus 
 If the camera has different focus for the different calibration images the calibration results will be of

poor quality, and the calibration algorithm may not even be able to find a solution.
 For an auto focus camera the requirement for a fixed focus setting can lead to problem s. The auto
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focus should be turned off and the camera manually focused at the distance it will be used. If auto
focus cannot be turned off all the calibration images must be captured at the sam e distance from the
calibration target.

Zoom 
Changing the zoom setting of a zoom lens not only changes the focal length (which determines the
image scale) but also all other lens parameters. 

Aperture (f-stop) 
 The lens aperture (f-stop setting) only has a small effect on the lens parameters. A smaller aperture

(high f-stop number) leads to a larger depth of focus (the range of distances at which the lens will
produce sharp images).

 Using a small aperture as recommended above often means that a long exposure tim e should be
used, which increases the risk for motion blur. Mounting the camera on a tripod could prevent this.

Lighting 
With a still camera a flash can be used, provided it does not give reflections in the calibration target
(which is often the case if the flash is mounted close to the lens).
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Lens Distortion Model
Abstract
Below follows a description of the Lens Distortion Model used in TEMA's Planar target lens calibration.

Distortion Model
Let (x, y) be the uncorrected pixel coordinates. These coordinates refer directly to the image and are the
output of  the various tracking algorithms.

The distortion correction produces corrected pixel coordinates ( x', y' ) which are an approximation to
what an "ideal" camera would see. 
The correction algorithm works with normalized coordinates ( X, Y ) and ( X', Y' ) given by

 
where (x0, y0)  is the principal point and R0 is a scale factor that is chosen by the calibration algorithm .

The relation between corrected and uncorrected coordinates is given by the equations

where

and     is the distance from the principal point.

Note that the equations above tell how to compute the uncorrected coordinates if the corrected
coordinates are known — dX and dY are given as functions of the corrected coordinates X' and Y'. Usually
the situation is the opposite: the uncorrected coordinates (the output of our trackers) are known and
compensation for distortion is wanted. TEMA implements an iterative procedure to solve the equations in
this case.

Description of the Parameters
In the formulas above, the term dr depends only on the distance from the principal point. It is radially
symmetric around the optical axis and is therefore called the radial distortion.
 
The radial distortion term describes the fact that the image scale varies slightly with the angle between
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the incoming ray of light and the optical axis (in an ideal camera the scale is constant over the entire
image). This is usually the dominant part of the distortion.
 
For most lenses the radial distortion varies quite slowly with r, and it can be ac curately approximated
with just the first two terms of the polynomial.

The terms involving the coefficients B1and B2 are called tangential distortion. Tangential distortion is
caused by the lens elements not being perfectly aligned, which causes the lens system not to be radially
symmetric. The tangential distortion is usually much smaller than the radial distortion. In many cases the
tangential coefficients B1 and B2 can be set to zero without affecting the accuracy of the result.
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Lens Calibration Wizard dialogs
The different sections of the Lens Calibration Wizard dialogs will be explained below.

Status
This section communicates next step in the calibration process.

Reference model
This section generates or imports a reference model of the calibration target, consisting of the
coordinates of all tracking points.
 Current model - given name of reference model when importing a file.
 Current model - "calibrationboard" when generating a referenc e model.
 Size of square - value and unit of one calibration target square.

Time section
See Time Panel Toolbar.

Result section
This section erases tracking points. 
 Clear Frame – erases all tracking points in one frame.
 Clear All Frames - erases all tracking points in all frames.

Calibration input
 Physical Pixel Size

o Enter the size of a pixel on the camera sensor, if known. This value is only used to convert the
calibrated focal length to a "real world" measurement. Internally TEMA measures the focal
length as a number of pixels (this is logical when tracking all measurements in pixels). 
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o If the pixel size is known this number can be converted to a focal length, whic h can be
compared to the number specified for the lens. 

o If the pixel size is unknown check the check box Unknown. Then TEMA will not display the
focal length but will otherwise work as usual.

 Calibrated Parameters
o Influence which parameters to be calibrated by the wizard. This is an advanced feature. In

most cases both check boxes can be left unchecked. 

Images
This section gives information of processed images.
 Frame # - number of frame or image.
 Time Stamp - time of frame.
 Points – no of tracking points in a frame.
 Mean Residuals (pixels) – mean difference between tracked points and reference m odel points.
 Max Residuals (pixels) – maximum difference between trac ked points and reference model points.
 Worst Point – coordinate of the worst point (also marked red in image).

Calibrated Parameters
This section shows the result from all calibration images.

Distortion Table
This Distortion Table button gives a Calibrated Distortion table, which shows the radial distortion
component for different values of the distance R from  the principal point.
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Wand Calibration
Function
TEMA Wand Calibration is a calibration tool for 3D motion analysis of high-speed tests.

To perform a 3D analyze the camera parameters (positions, attitudes and focal length) have to be
known. The Wand Calibration tool will simplify the calibration work flow and determine  these parameters.

Two active markers (LED light bulbs) on a
rigid wand are tracked in an image
sequence where the wand is moved around
in a measurement volume. The tracked
markers are used to perform a relative
orientation on the observing cameras. The
distance between the markers is used for
scale.

The use of Wand Calibration will increase
the accuracy and ensure that the results
acquired from the analysis are accurate
enough to draw the correct conclusions.

Prerequisites:
 The length of each wand is unique and has to be known before calibration (distance between the

markers), see wand calibration specification from Image System.
 At least two (2) cameras are required to perform the Wand Calibration and test.
 Activating the wand after image recording has started will ensure the synchronization of the cameras.
 Approx. 1000 images are recommended for wand calibration of cameras.

Procedure
The Wand Calibration is a six-step process:

1. Camera setup and recommendations.
2. Image capture for calibration and recommendations.
3. Image capture of test.
4. Down load of images.
5. Wand calibration of cameras in TEMA 3D (Wizard).
6. Analysis of test in TEMA 3D.

1. Camera Setup and Recommendations
 Position the cameras for the test and set

the final zoom, focus and aperture
according to recommendations below.
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Camera Placement Recommendations:  
o To reduce the risk for motion blur it is recommended to mount the camera on a tripod when

capturing the calibration images.
o Place the cameras to cover required measurement volume.
 The side of a typical measurement  volumes are 1-5 m.
 Each part of the measurement  volume  must be covered by at least two (2) cameras.
 More than two cameras can cover a part of the measurement volume; the usage of more

cameras will increase the accuracy of the markers and decrease the possibility of obstructed
camera views.

 The accuracy of the analysis depends on the geometry between the points and the observing
cameras; 90º angles are optimal, 30º – 150º angles are acceptable.

 
Camera Settings Recommendations:
A very important fact is that the camera parameters change when the focus setting and/or the zoom
setting of the lens is changed. This means that:
o All calibration images must be captured with the same focus setting and the same zoom setting . 
o The calibration results are only valid for a unique camera setting. 
o Use manual focus. Do NOT use auto focus.
o Use regular room lighting.  
o Perform the camera settings by using live images. The objective is to capture a 1000-image

sequence of the wand which is synchronized, well focused, has maximal contrast relative the
background and a motion blur < 1 mm.
 Set focus and aperture so that the complete measurement volume is in focus . 
 Set the exposure time to enable good contrast of the markers and distinguished

black-and-white fields if the wand.
 Set the exposure time to < 333 s to guarantee a motion blur < 1 mm of the wand is moved 3

m/s.
 Set the frame rate to 25-30 frames/s.

o Take notes of the camera settings for reuse in future tests.

2. Image Capture for Calibration and Recommendations
The objective of the image capture is that when all images are viewed as overlayed images, the points
should cover the entire measurement volume.
 Place the operator holding the wand

inside the measurement volume.
 Start the image capture.
 Activate the wand and move it inside

the entire measurement volume 
according to recommendations below.

 Start a synchronized recording of the
wand from all cameras according to
recommendations above (chapter 1). 

Image Capture Recommendations:
o Move the wand so that the markers are visible to the cameras as much as possible.
o Move the wand smoothly in the entire measurement volume, so it spends the same time in each

part of the volume. 
o Capture approx. 1000 images. 300 images is a minimum.

Note: An image will only be usable if at least two cameras view both markers .

3. Image Capture of Test
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 Set the final frame rate and exposure time for the test. 
 The wand calibration is unique for each camera. 

Do NOT change camera positions, zoom, focus or
aperture. 

 Set applicable exposure time and frame rate due to test
requirements.

 Perform the test and make a synchronized recording
from all cameras. 

4. Down Load of Images
 The calibration images are part of a continuous movie sequence and will either be stored as one big

file (e.g. AVI file) or as a set of separate files. In both cases they can be loaded directly into TEMA.

5. Wand Calibration of Cameras in TEMA 3D (Wizard)
 Use TEMA 3D and the calibration images to

calibrate the system via the Wand
Calibration wizard (described below).

All necessary parameters will be calibrated
and the process is 100 % automatic.

1. Create at least two camera views and open the image sequences.

o Select the New Camera View option from the File menu. The Open Image Sequence dialog
will appear. 

o Select the applicable image files of the wand and press the OK button. The New Camera View
dialog will appear. 

o If the focal length and pixel size are known, it is recommended to enter these values for
applicable cameras.
Note: The pixel size will be given automatically if Camera Type is selected.

o Press the OK button. The program automatically highlights the image file of the wand in the Test
Contents dialog and the selected number of camera views of the wand are shown.

o For each of the used image sequences, set t0 at the exact time when the wand is being activated.
This is to ensure the synchronization of the camera views.

2. Start the Wand Calibration wizard.

o Select the Wand Calibration option from the Camera menu. The Wand Calibration Wizard
dialog will appear. The Status section in the Wand Calibration Wizard dialog will c ommunicate the
necessary steps to complete the calibration. 

o Step 1 - Basic Setup : 
 Select which Views to Calibrate . All views are selected by default.
 Select Primary  (origin of coordinates) from the drop-down list.
 Enter the Wand Length  (value and unit), e.g. 0.601 m. See Prerequisites  above.
 Select the Calibration Time Interval  in which the wand is active;

o Select All Times . 
OR
o Enter values/units manually.
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OR

o Use the Set to current time , Set to start of time interval  or Set to end of

time interval   buttons.
 Press the Next button to continue.

o Step 2 - Calibration Points:
 Select how the wizard will find the points; Automatic  or Manual . 

o If the Automatic  option is selected:
- Then press the Go button to find the points.
- When the tracking is completed press the Next button to perform the Wand Calibration

and wait while it is in progress. Data will be created for camera position, orientation
and focal length.

o If the Manual  option is selected (adequate when automatic tracking is difficult or when the
wand is not  supplied by Image Systems AB) the following is required:
- Previously tracked points.
- At least two (2) points per camera view.
- The names of the tracked points have to be the same in all camera views.
- Selection of points in the drop-down lists.
Then press the Next button to  perform the wand calibration and wait while it is in
progress. Data will be created for camera position, orientation and focal length.

Note: The Residual measures how well TEMA is adjusting the parameters to the measurement
data. the residual decreases during calibration process.

 Press the Back button to perform necessary changes in step 1.
 Press the Close button to close the wand calibration process. It can later be reopened.
 If any error messages are received, please follow the instructions shown in the Status

message field.
 If the calibration has succeeded, see step 3 below.

o Step 3 - Calibration Results:
 The Calibration results include:

o The individual Camera Parameters (orientation and focal length), presented in separate
tabs.

o The quality measurement Overall Results (Mean 3D Error) is presented below the
camera parameters. 
- Mean 3D Error is the estimated average 3D error in the final result, if this c alibration

is used in 3D tests with markers and high quality images. It is based on the average 3D
parallax and the tracking accuracy of the Circle tracker. 

o More detailed calibration results are available by pressing the More button.

- Points Per Image Section
displays the number of used
point observations in each
section of the image; Centre,
Upper Left, Upper Right,
Lower left and Lower Right.

- Max Parallax - The parallax is defined as the "miss distance" between the lines of
sight from each camera to the point.

- Mean Wand Length Deviation gives the mean deviation of the wand length computed
at each time.

- Max Wand Length Deviation gives the max deviation of the wand length computed at
each time.

o The Status message indicating the status of the Wand Calibration:
- Calibration successfully completed.
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- Calibration failed.
- Calibration completed with warnings.

 Review the results and press the OK button to accept the results.
 Press the Close button to close and reject the results. The calibration c an later be resumed.
Note: If needed the markers of the wand can be tracked as usual. This handles the cases where
the calibration images have to low contrast to be calibrated automatically and those cases when
the user has constructed his own wand.

6. Analysis of Test in TEMA 3D
 Use TEMA 3D and the test images to

analyse the points of interest in the test
images. 

3D results are computed for each point
that is tracked in two or more calibrated
cameras.

Note: The calibration can be reused in
future tests as long as the camera setup
is identical.

o Open a new test.
o Import the images captured during test.
o Import the previously performed calibration results from the calibration test (.ted-file).
o Define a 3D coordinate system by using the markers in the test images.
o Track the points to be analyzed.
o The 3D result is automatically calculated for all points that have been tracked and are nam ed the

same in two or more camera views.
o Save the test as a TEMA test (.ted-file).
o From version 3.9 calibration parameters can be save to an *.XML file. This file c an be later be

imported in 'Camera View Properties'.
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Test Database Interface (optional)
Function
TEMA provides a possibility to interact with an external test
database. This enables automatic setup of TEMA tests according to
information in the test database. 

Appearance
The test database interface is reached from the File menu. 

Export xml file  
-- This is just for testing --
The function is reached by <Alt> + <Shift> + T. 
Export a TEMA test into a xml format file. In General, a xml file is just a text file and c ontains no data. A
TEMA xml file, resulting from a xml export of a test, c ontains information of how the test was set up. The
specific xml layout of the file makes it possible for TEMA to re-import it and re-create the test. This
prerequisites that the data produced and images used in the exported test is still on the sam e locations
as when the export was done. Some fields in a xml file can be edited, using any text editor, m aking
adjustments in a test before importing. 

The test database interface can im port xml files whose information is determined by 

Import xml file

Start Test 
Enter a new Test specification and load the spec ified
test from the Test Database into TEMA.

Unknown View Names
If the Start Test Command is about to load a test from  an xml file containing one or more camera view
names not present in the list of known views in the preference archive, the Unknown View Name
dialog will appear. This contains the whole view list.

The used can now select whether to add the view name into the views list or not.

Add View - adds the unknown view name to the view list in the preference archive. 
Don't Add - the view will be used in test but the view name will not be added to the  view list in the
preference archive

Refresh Test
Reload updated Test Database information into an
ongoing TEMA test using the Test Specification already given at Start
Test. This is useful if errors are found in the Test Database after
the test has been started in TEMA. Just correct the errors and
refresh TEMA.

End Test
Store final information back to the Test Database using
the Test Specification already given at Start Test. When this is done, the test will be closed and a new
test can be opened. Policies can be set to specify the Program actions at End Test. 
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End Test Exports
The End Test command can be combined with automatic Image Exports to be carried out at End Test. In
the Image Export Dialog, we can make Image Export Settings (different image formats, overlays,
ranges etc) and save those in the preference archive under different names. The functionality allows any
number of end test exports to be performed automatically. The command works on three levels in the
test and the number of combinations can therefore be huge;

o For each camera view i test
o For each Test section in test
o For each image export setting in preference archive. 

If a Remote Export Server is set up, this will be automatically used for the End Test Image Exports.
 

See also...

Preferences/Test Database Interface setup

 



p116

© Image Systems AB, 2011

Controlling Time

Specifying Control Time
You may insert several camera views into a test, each of which has a different timescale. Consequently,
the diagrams generated from these camera views also have different timescales.

You may specify which camera view timescale should be used to control the stepping of time via the time
panel and time slider. Camera views and assoc iated diagrams that have no sample matching the current
time use the sample closest in time as its current sample. 

1. Select the camera view that is to be used to control the stepping of time. 
2. Select the Control Time option from the Camera menu.

The icon is displayed adjacent to the name of the selected c amera view and the Control Time
option is disabled for this camera view. 
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Time Overview
The Time Overview window is used to display graphically the status of the data in the test.

It is most useful in conjunction with the system  when the Camera Control optional feature is available.
However, it can be used in the Standard system.

To display the Time Overview window, select  Time Overview from the View menu.

Standard System
The time span of the loaded data is displayed.

Camera Control System
In Live Digital mode, the time span of the data that can be recorded is displayed, together with the tim e
span of the data that has been specified to be autom atically downloaded.

Note: In the following example, a pre-trigger frame count of 10 frames was specified. This is translated
to a pre-trigger time and is indicated in the display by the time spans starting before the zero time.
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In TEMA mode, the time span of the available data in the c amera is displayed, together with the time
span of the data already downloaded to the system .

In the following example, the time span for the 20 frames already automatically downloaded is shown.

The following illustration shows the same situation, but after the Clear Cameras command has been
executed.

Note: The timescale axis is automatically adjusted to reflect the data to be displayed.
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Setting t0
1. Use the Time Panel toolbar or the Time Slider toolbar to set the current time to a particular point

of interest in the image sequence.
This time is typically at a readily identifiable event in the sequenc e such as the point of impact in
a crash test or a calibration light being extinguished. It is used as a referenc e time during the test
and the subsequent analysis. It is referred to as "t0". 

2. Click the  button.
t0 is set to the current time, which is indicated by the red line being positioned over the green

diamond on the time slider, i.e. .

Alternatively: 
o Select the Set t0 option from the Camera menu.
o The Enter New Time dialog is displayed. 
o Key the New time for current frame. 
o Select the required unit from the adjacent list. 
o Select the OK button. 
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Setting the Current Time to t0
Using the system results in the current time being moved to different times in the test. 
You may reset the current time to t0, the defined reference time for the test:
 

1. Select the Goto t0 option from the Camera menu.

Alternatively, click the  button.
The current time is set to t0, which is indicated by the red line being positioned over the green

diamond on the time slider, i.e. . 
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Tracking

Setting up and Running Tracking
The system contains the following facilities for specifying points to be tracked: 

 Controlling the tracker:
o Disabling the tracking function for a point in a sequence . 
o Enabling the tracking function for a point in a sequenc e. 
o Putting a point to sleep in a sequence . 
o Waking up a sleeping point. 

 Controlling a point:
o Advanced facilities for controlling the tracking of a point via the Point setup dialog. 
o Putting a point to sleep on an image. 
o Using the Zoom function to position a point. 

Note: You may find it convenient to select several points at the sam e time to specify or amend their
common properties. The <shift> and <control> keys may be used in the standard manner to selec t
multiple points.

Specifying a point for tracking

1. Select the button.

The first point, Point#1 is added to the Test Contents window. The icon indicates that the
tracker is enabled for the point, but that its position in the im age has not been registered.
 

2. Select the Properties option from the Edit menu to:
o Change the name of the point.
o Specify the tracker algorithm if you wish to change the default.

3. Position the mouse pointer where you want to place the point in the displayed im age.

4. Click with the left mouse button.
The point is placed in the image with its position indicated by a cross.
 

5. You may move the point
o  by using Drag and Drop.
OR
o by positioning the point more accurately using the Point Zoom window.
OR
o by manually set the pixel coordinates by selecting Position... option from the Tracking

menu. 

The icon indicates that the tracker is enabled for the point and its position in the im age has
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been registered.
 

6. Repeat the above steps to specify any other points that you wish to track autom atically.
Note: As soon as a new point is added it becomes current and the previous point c hanges colour.
You are now ready to run tracking. 

 



p124

© Image Systems AB, 2011

Managing Tracked Points
TEMA contains a number of functions to enable you to manage tracking points: 

 Add a Point. 
 Add a Duplicate Point. 
 Copy a Tracker Setup. 
 Enable the Tracker for a Point. 
 Disable the Tracker for a Point. 
 Register a Point as being Asleep. 
 Put a Point to Sleep in the Selected Interval . 
 Unregister a Point in the Selected Interval . 
 Wake a Point in the Selected Interval. 
 Zoom a Point. 

The following descriptions refer to a single point. However, you may select several points using the
<Shift> and <Ctrl> keys where appropriate. In these circumstances any ac tion which operates on the
'current point' assumes that the first point in the list is c urrent.

 Right clicking a point in the camera view window offers fast acces to a number of functions. 

o Point setup
o Copy setup from point
o Show Point Zoom
o Sleep In Selected Intervals
o Unregister in selected interval
o Wake up point
o Recalculate All (only valid for virtual points)
o Suggest Point Position
o Auto find similar
o Delete Point
o Duplicate Point
o Enable Point for tracking
o Disable Point for tracking
o Sleep

 Selecting a point in the Test Contents tree will make the right-click menu to contain some more
options. Those are merely options useable when making multi-selections of points. Multi selec tion is
possible in the list but not in a c amera view.

o Point Groups

Note; when clicking on a point in the camera view, the point will not be selected in the list in test
contents tree. The items highlighted in the list will remain in that status no matter which point is c licked
in the camera view. This is to avoid open point windows with multiselected points not to change their
contents at all times a point i selected in a camera view. 

Point Display

The current status of each point is defined by two icons. The position of a point displayed in the current
image is indicated by one of several markers.

First Icon
The first icon indicates the tracker assigned to the selected point:
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Each of the tracker icons may be displayed in three forms depending on the tracker state. The following
show the variations as applied to the Airbag tracker: 

- indicates that the tracker is enabled and the selected point is tracked in the current and
subsequent images until the tracker status is changed;

- indicates that the tracker is disabled and the selected point is not tracked in the current and
subsequent images until the tracker status is changed;

- indicates that the tracker marks the selected point as being asleep in the c urrent and subsequent
images until the tracker status is changed.

Second Icon
The second icon indicates the status of the point in the current im age. It may take the following values: 

- indicates that the position of the point has not been defined.

- indicates that the point has a valid position set automatically by the tracker.

- indicates that the point has a valid position set m anually by the user.

- indicates that the point is asleep in the c urrent image.

- indicates that the point is being tracked but that its position has been lost for one of several
reasons: 

 it has moved outside the tracked area of the image; 
 it is hidden; 
 its movement is too erratic to track autom atically; 
 the image quality is not good enough. 

- indicates that the point has a valid position set automatically by the tracker by calculation from its
group membership rather than by measurement.

Each of the point status icons may be displayed in two forms depending on whether the point is a
member of a point group or not, a red dot will be added if the point is in a group: 



p126

© Image Systems AB, 2011

- indicates that the point is not in a group;

- red dot indicates that the point is in a group. 

+ 
- red dot and + sign indicate that the point belongs to m ultiple groups.

Point Display
A point displayed in the current image may be marked by one of the following indic ators:

- tracked position;

- last known position of a sleeping point;

- last known position of a non-registered point;

- last known position of a lost point.

Adding a Point
1. Select the required camera view. 
2. Add a point by:

o Selecting the Add Point option from the Camera menu.
OR
o Selecting the  tool.
A new point is added to the Test Contents window and made available for tracking.
The settings of the point is controlled by the current selection in the Default Trackers toolbar. 

3. Change the default name  of the point by clicking on the point name twice (not a double-c lick)
and keying the required name. 

4. Double-click on the point.
The Point Setup dialog is displayed. 

5. Specify the properties of the point. 

The Default Tracker Toolbar contains a user-defined set of trackers. 

Adding a Duplicate Point
1. Select the required camera view. 
2. Right-click the point to be duplicated in the Test Contents window. 
3. Select the Duplicate option from the pop-up menu.

A new point is added to the Test Contents window and made available for tracking. 
4. Change the default name by clicking on the point name twice (not a double-click) and keying the

required name. 
5. Double-click on the point and amend the properties of the point , if required. 

Copying a Tracker Setup
1. Right-click the point in the Test Contents window that you wish to set up. 
2. Select the Copy Setup from Point button.

The Copy Tracker From Point dialog is displayed. 
3. Select the point whose tracker setup is to be copied. 
4. Select the OK button. 
5. Double-click on the point and amend the properties of the point , if required. 

Enabling the Tracker for a Point
1. Select the required camera view. 
2. Select the required point. 
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3. Select the Enable option from the Object menu.
The tracking function is enabled for the selected point. This state is indic ated by a plain tracker

icon, e.g. for the Airbag tracker. This is the default state of all points. 

Disabling the Tracker for a Point
1. Select the required camera view. 
2. Select the required point. 
3. Select the Disable option from the Object menu.

The tracking function is disabled for the selected point. This state is indicated by a crossed trac ker

icon, e.g. for the Airbag tracker.
If the sequence is re-tracked, any previous information about disabled points is retained, rather
than being deleted. This facility is useful if one of the points to be tracked is not straight forward,
e.g. it moves erratically from one image to the next. The other points m ay be tracked
automatically while the one point is disabled. This point may then be enabled and trac ked
manually or semi automatically. 

Registering a Point as being Asleep
1. Select the required camera view. 
2. Select the required point. 
3. Select the Sleep option from the Object menu.

The tracker registers the selected point in the current and successive images as being asleep and

is indicated by two icons, e.g. for the Airbag tracker. The first icon indicates that the
tracker is asleep, while the second indicates that the point is asleep in the c urrent image. The
tracker continues to register the selected point in suc cessive images as being asleep until the
tracker is enabled or disabled for the selected point. 
o If you wish to mark the position of the selected point in a later image, select the point in the

list and mark the position in the image. The icons change to . The second icon
indicates that the point has been placed manually. The first icon indicates that the tracker has
been automatically enabled. If you do not want the tracking to c ontinue automatically, move
to the next image and select the Sleep option from the Object menu. The icons change to

. 
o If you wish to disable the tracker, move to the next image and select the  Disable option from

the Object menu. The icons change to . 

Putting a Point to Sleep in the Selected Interval
1. Select the required camera view. 
2. Select the required point. 
3. Select the Sleep in Selected Interval option from the Object menu.

Alternatively, click the tool.
The selected point in the current image is marked as being asleep, i.e. the point exists but is
hidden and consequently cannot be assigned coordinates. This is indicated by two ic ons, e.g. 

for the Airbag tracker. If you wish to wake up the point, this m ay be achieved by using

the mouse to position the point in the image and is indicated by the icons c hanging to 
. 

Unregistering a Point in the Selected Interval
1. Select the required camera view. 
2. Right-click the required point. 
3. Select the Unregister in Selected Interval option from the pop-up menu.
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The selected point in the current image is marked as being unregistered, i.e. the point exists but

is not assigned coordinates. This is indicated by two ic ons, e.g. for the Airbag tracker.
If possible, you may position the point using the mouse. When positioned in the image, this is

indicated by the icons changing to . 

Note: For Virtual Points see also the alternative function Recalculate All.

Waking a Point in the Selected Interval
1. Select the required camera view. 
2. Right-click the required point. 
3. Select the Wake in Selected Interval option from the pop-up menu.

The selected point in the current image is marked as being manually positioned at its "lost"

position. This is indicated by the icons changing from to . 

Reposition the point at the correct position. This is indicated by the icons c hanging from 

to . 

Selected interval
The Selected Interval can be set from the time panel slider or from a text table in a test. Using the tim e
panel slider, a time interval can be defined by holding the <Shift> key while dragging the slider between
the first and the last sample in the interval. The selec ted interval will be enlighted.
Using a text table, the same procedure is used; the intreval is marked by holding the <Shift> key. The
selected time interval will now be enlighted in the time panel also. 
The selected time interval will now be used when selec ting Putting a Point to Sleep,  Unregistering a Point
 or Waking a Point in the Selected Interval.
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Zooming a Point
1. Open up an empty window or have a present window open. 
2. Select the point in the test contents tree. The Window will now display the point zoom  with the

point allways in the centre. 

        OR

3. Select the Show Window option from the View menu.
Alternatively, click the tool.
The Point Zoom window is displayed, showing part of the image around the point to enable the
image detail to be studied.
Each selected point is displayed in its own frame in the window. This enables points to be placed
more accurately by selecting their positions in the Point Zoom  window, rather than in the
displayed image. When a point is moved in the Point Zoom window, the dialog is refreshed so that
the point remains at its centre of its particular fram e.
Note: Using the left mouse button in the Point Zoom window or the View window repositions the
point in both places. 

Suggest Point Position

This function predicts and suggests positions of reference points. 

1. In a camera view, select Camera/Insert Reference Points . 

2. Select the correct tracker algorithm for all selected points. 

3. Insert a few points accurately (at least three), advisably spread both in horizontal and vertic al
direction in the total image. Note: The more accurately the points are manually positioned, the
better the suggested position of the other points will be. You may then adjust the position of any
point manually, or select one or more points and get their suggested position relative to the rest of
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the points by re-selecting the tool.

4. To get suggested positions for the remaining points:

o Mark any point in the point list.

o Right-click the point list and select the Suggest Point Position function.

o The Suggest Point Position dialog will appear.

5. The following options are available in the Suggest Point Position dialog:

o Click the Use colour Edit button to edit the colours of the points in the camera view.

o Click the OK button to show/register the suggested points in the cam era view.

o Click the Cancel button to cancel the suggestion of point positions.
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Autofind similar points
Function
Autofind is functionality for automatic detec tion of tracking points in images. This can be done in the
current frame or in each frame during tracking. In a case where there are many similar points to be
tracked (for example when tracking a calibration board) the operator just has to set the tracker to m atch
one of theese points and then leave the rest of the points to the autofind sim lilar functionality. 

Currently Autofind is implemented for Quad-, MXT-  and centre-of-gravity (COG) trackers

Autofind uses a tracking point as a tem plate to find similar points. 
By choosing a point tracking attributes (e.g. tracker type, template 
size, tolerance) you can define the type of points that Autofind 
will find. Autofind returns a list of point c andidates, paired up 
with quality estimates. The quality estimate ranges from 0 (poor) to 
1 (perfect).                

Procedure
Autofind in current frame

1. Insert a point (template point) in the image
2. Right-click the point in the test contents list or in the c amera view and choose Autofind Similar

points. The Autofind points dialog will appear. This shows a list of the Autofind points.These are
the suggested positions suitable for tracking with the tracker of the original point. The user can select
which ones to really create trackers for by clicking in the list. Hitting the Add button moves the
selected point(s) to the list of tracked points, while Add all adds all points directly. 

3. Click Add or Add all. The default point name field controls the name that a point receives when
adding.

4. The list can be sorted on the different columns which simplifies the selection process. 
5. Drag the Tolerance slider below the list OR type a value manually. The slider thresholds the content

of the listbox. 
6. Set the Point-pair distance.  A distance threshold that removes points that are too close to existing

track points or points with higher quality among the current Autofind points. The unit of this
threshold is pixels. 

7. Select Visualization type, box or ID number.
8. All points in the Autofind list are shown as small squares or ID numbers in the tracking window, the

selected ones in red and the remaining ones in yellow. The visualization radio buttons select whether
the tracking window shows IDs or boxes at the point coordinates.

Autofind during tracking

1. Insert a point in the camera view
2. Go to the point setup for the point. 
3. Set tracker to Quad-, MXT- or centre-of-gravity (COG)  tracker. 
4. Enable the toggle Autofind similar points. Autofind will now be performed in each frame during

tracking.

Examples of use

Say you wish to automatically find small dark dots on a white background 
in a single frame. Do this by adding a point to a target, place it on one of the dots, enter 
its point setup and adjust the thresholds. Then leave the point setup and ac cess the 
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autofind points dialog as described above.
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Point Setup
Starting from version 3.9 the point setup is a window 
 dynamically reflecting selections in 'Test Contents'
 reacting on test time changes
 and does not have to be closed

Features and setup functions in general remain the same. Changes are activated via an 'Apply' button. 

- - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - -
- - - - - - - - 

1. Select either a single point or a group of points using the standard Windows m ouse and keyboard
combinations, i.e. the <Shift> key for a block selection and the <Ctrl> key for a non-contiguous
selection. 

2. Change the properties of the point/points in the Point Setup dialog which is displayed by:
o Selecting the Properties option from the Edit menu.
OR
o Double-clicking on the point in the Test Contents window.
OR
o Clicking on the Add or Edit button in the Edit Default Trackers dialog.
The Point Setup dialog is used to define how the tracking is carried out for a selected point. Any
property change made applies "from now on", i.e. tracking may be temporarily stopped and the
definition of a point changed before continuing. The information you specify applies to all the
selected points. 

3. Key in or amend the Point name.
The system gives a new point a name from the range 'Point#1', 'Point#2', etc . You may use these
default names or key in a more meaningful name.
If multiple points have been selected, the field is disabled and individual nam es cannot be
changed.
You may also change the name of a point directly by selecting it in the Test Contents window
and amending the name. 

4. If this is the setup of a Point Generator, the Generated name prefix can be set here also. For
example, if the generated name is set to "Point", the names of the n points generated from the
point generator will be Point1...Pointn.

5. For the optional 3D feature, select the required point nam e from the Select from drop-down list.
The drop-down list contains the names of all the points defined for all the c amera views in a 3D
test. Selecting a name from the list changes the original name of the point to the selec ted name.
This enables you to assign the same name to the same point in all the camera views in which it
appears, thus allowing 3D point calculations to be made. 

6. Image Mode - override the default image mode as set in the Tracking setup. Note that the the
tracking  can be done on enhanced images also.

7. Specify the display of tracker visualizer (tracker appearance) data in the Show Tracker .
o Animate - Enabled will draw visualizer data in real time as the current time moves in test. 
o Show - specifies the appearance of visualizer data in camera view window. Select With Skip

(enter interval value) or use any of the preset interval settings; At current time, All, Dense,
Normal or Sparse. 

o Specify the visualizer color also.
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8. Key the Accept lost points for xxx frames value.
This specifies in how many consecutive images a lost point should be treated autom atically as
being asleep. If the point is lost in any subsequent consecutive image it is treated as lost.
The default setting is '0' which means that any point that cannot be positioned is reported as lost.
If you set this field to the value '2', the tracker puts the point to sleep in the first two consec utive
images where it is lost and does not report it as being lost. If the point is also lost in the next
image, it is reported as being lost. 

9. If the point is a member of a point group, select the Use Group to calculate lost points  check
box if the point position is to be calc ulated from the group definition when lost during tracking. 

10. If you do not want Frame to frame prediction de-select the check box.
Using Frame to frame prediction mode is the default and means that the tracking func tion
takes into account the previous positions of the point when tracking its next position. 
De-selecting Frame to frame prediction mode should be used in circumstances where the
movement of the point as seen in the image is erratic. 

11. Select the required Tracking method button.
The layout and contents of the dialog are amended to reflect the selection made. 

12. Specify the tracking parameters for the selected point(s). 
o Correlation - looks in each successive image for the area contained within the correlation

template. This method is applicable to most cases. 
o Quadrant Symmetry - finds the symmetry center of the image within the search area and is

applicable to Patrick targets, chessboard squares, etc . 
o Circular Symmetry - finds the symmetry center of the image within the search area and is

applicable to concentric circles, spokes on a bicycle wheel or c ombinations thereof. 
o Centre of Gravity - tracks a regular, roughly circular shaped object that does not change size

and shape during the tracking process.
o Circle (optional) - tracks circular objects even if part of the object is obscured.
o Airbag (Optional Feature) - tracks the outline of an irregular shaped object that m ay change

size and shape during the tracking process. 
o Advanced Airbag (Only available with the Airbag Optional Feature) - tracks the outline of an

irregular shaped object that may change size and shape during the trac king process. It uses a
different method from the Airbag tracker in order to track the outline. 

o MXT Target (Optional Feature) - finds the symmetry centre of the image within the search
area and is applicable to MXT targets with either four or five outer white dots on a black
circular background. 

o Virtual - specifies that the point is virtual, i.e. its position in succ essive images is calculated
from the positions of the other points in its point group, rather than by measurement. There is
no setup procedure. 

o Constant - specifies a fixed point in the image that can subsequently be used as a reference
point for analysis and display.

o Corner Contour - tracks the curvature of edges, e.g.corners in any shape.
o The choice of which method to use depends on the nature of the target and the m easurements

you wish to make. The following points should be taken into c onsideration: 
o The Airbag, Quadrant Symmetry and MXT Target methods should be used to track their

intended targets. 
o The Advanced Airbag method should be used when the background is not clearly distinguished

from the airbag. If the background is clearly distinguished, the Airbag method should be used
because it operates faster and produces a result of the same accuracy as the advanced
method. 

o The Circular Symmetry method should be used for c ircular or almost circular targets. It is not
so good for elliptical targets. For these use the Centre of Gravity m ethod. 

o The Centre of Gravity method should be used for a well-defined target with a good c ontrast
against the background. 

o The Correlation method is generally effective in most cases. 
o The Virtual method is used when the point is not to be tracked at all. Its position is always
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calculated from its membership of a point group. When this option is selected, the Setup
button is disabled. 

13. If you wish the settings you have made to be the default for points added in the future, selec t the 
Save as default button. These will then be added to the Default Trackers toolbar.
Note: This new default is also applied to new camera views and new tests.
Note: The setup of existing points is not affected, even those still at the original default. 

14. Select the OK button. 
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Running Tracking
These instructions assume that the first image in the sequence is displayed and the points to be tracked
have been specified.
 

1. Click on:

o the  button (track forward).
or
o the  button (tracks one frame forwards).

While the tracking function plays through the image sequence, the message "Tracking in
progress" is displayed in the Statusbar.

For each image it calculates the position of each point and m arks it in the image with a cross.
When it is finished, the last image in the sequence remains on the display.
 

2. If the tracking function is unable to position a point in an im age, the message "<point name> is
lost" is displayed and you may position the point using the mouse.
Note: If the lost point is not visible in the View window, make sure that the whole of the c amera
view is visible.

 
3. You may stop the tracking function at any time by clicking the  button and continue from that

point later by clicking:
o the  button.
or
o the  button.

4. To view the results:
o Click on  button (sequence rewind).
o Click on the  button repeatedly (step forward through the sequence).
 

5. You may now save the results at this point, if you wish, espec ially if the tracking has taken a long
time. 
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Displaying a Split View
The split view function is used to control how cam era view images are displayed. The default is to display
one image at a time, but you can specify that any num ber of images are displayed at the same time.

1. Select the camera view for which you wish to display a split view. 
2. Select the Split View option in the View menu. 
3. Select the required type of view from the Split View sub-menu. 

o Single - The current image is displayed in the normal manner.
o Multi - The image area is split into a number of rectangles, each showing a different time. The

default is to show five images centred on the c urrent time.
o HScroll - As Multi, but the images are displayed in one row that can be scrolled horizontally. 
o VScroll - As Multi, but the images are displayed in one column that can be scrolled vertically. 

4. If you wish to display all images, select the Showall option from the Split View sub-menu.
This option can be selected in conjunction with any of the first four options.
In Multi mode, the system skips images in order avoid a too small grid. The first, last and c urrent
images are always displayed. 

5. If you wish to customise the split view, select the Setup option from the Split View sub-menu. 
o Key the Count, i.e. the number of images to be displayed when Showall is not selected. 
o Key the Skip, i.e. the number of images to be skipped between succ essive displayed images

in HScroll and VScroll modes. 
o Key the Min Size (%), i.e. the minimum percentage of the original image size to be displayed

in Multi mode. 
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Exclude Area (Rectangle or Polygon)
Function
In order to make the tracking procedure efficient, c ertain areas in the image can be excluded for the
tracker, becoming "forbidden" areas. 

This is useful when tracking one point that has a similar pattern very close. Without any exc lude area,
there is a risk that the point is lost as the tracker strats to track the sim ilar pattern next to the point.
Adding an exclude area will remove that risk, easing the tracking proc edure. 

Another way of usage is when using the COG, the outline or the advanced outline trac ker when tracking
e.g. an airbag. Adding exclude areas next to the outline tracker in such c ases will align the tracker to the
exclude area side facing the tracker. This will make an exact tracking of the airbag, without the tracker
spilling out outside the airbag. 

Procedure

In General
The exclude rectangle function is reached from the menu bar; Camera/Add Exclude Rectangle.

Selecting this will add a red square to the image and an  icon in the point list. This is the exc lude
area. The size of this can be amended to match the area not to be tracked. Adding an exclude area that
intersects with a previous one will result in a double negation; the area enclosed by two exc lude areas
will be a non exclude area, see illustration below.

The exclude polygon function is reached from the menu bar; Camera/Add Exclude Polygon. This will

add an exclude area which shape is set by the user. A  icon will also be added to the tracker window
tree structure. When selected; a mouse click will result in a sort of draw tool. The subsequent clicks will
result in the sides of the exclude polygon. Any number of sides can be added to this. To finish the shape
of the polygon, just drag the mouse pointer from the tracking area. The finished polygon will be
highlighted in the exclude transparent red. The exclude polygon can now be re shaped to fit any
condition; all of the corners points between the polygon sides can be dragged. Just hold the left m ouse
button and drag. The illustration below shows an exclude polygon. 
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Besides the user defined shape, the properties of the exc lude polygon are the same as those of the
exclude rectangle described above. 

The option exclude by default encloses the whole image in an exclude area. Like this, nothing in the
image can be tracked. By using the double negation nature of the exc lude areas (see above), adding an
exclude area in this mode will result in a small non-excluded area that can be tracked, see illustration
below. 

In this way, the areas that are to be tracked and those that are not can be custom ized to match almost
any situation. 

Airbag tracker
The illustrations below aim to describe the differenc es when using an outline tracker without and with an
exclude area next to the tracker. 
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Above; no exclude area added. The outline tracker tends to spill out below the airbag.

The outline tracker aligned to an exclude area. 
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Point Generator
Function
In some applications, like in Gun Scoring tests, we might want to track points that are not visible in the
start frame, but that appears by chance in subsequent im ages. The point generator makes this
convenient. 

The Point Generator is the Auto find Similar Points functionality, but works over a whole sequence,
consisting of many frames. 

Using the point setup interface, a point-model is set up in one frame where an area with desired
appearance is visible. When tracking the sequence, the point generator will then generate trac king points
for all areas, or spots,  where a similar pattern appears. After being applied, those points are then
tracked throughout the sequence.

Procedure
1. Step to the frame at where one spot with the desired pattern is visible. 
2. Mark the camera view in the test contents list.
3. Select Camera/Add Point Generator option. The Point Generator item will be added to the test

contents list like a point sorted below the camera view.  
4. Double Click the point generator item OR right click it and select Point Setup. The Point Setup dialog

will appear. 
5. Apply the point generator to the pattern to track. 
6. Set up the point generator using the point setup interface. 
7. Track through the sequence. 

See also...

Exclude areas
Running Tracking
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Angles/Distances

Maintaining Distances
A distance is defined as the length of a straight line between two specified points in a c amera view.
During tracking the length of the line is determined for each tracked image and can be manipulated and
displayed in the same way as a tracked point.

You may: 
 Add a distance. 
 Maintain the properties of a distance. 

Adding a Distance
1. Select the required camera view. 
2. Select the Add Distance option from the Camera menu.

Alternatively, click the  tool.
The new distance is added to the Test Contents window with a default name and no definition. 

3. To define the distance in an image:
o Select the distance in the Test Contents window. 
o Click on the first point and drag the mouse to the second point.
o When the mouse button is released, the distanc e is displayed in the image as a straight line

with an arrow pointing from the first point to the second. 
4. Amend the distance properties, as defined below. 

Maintaining Distance Properties
1. Select the required distance in the Test Contents dialog. 
2. Select the Properties option from the Edit menu.

The 2D Distance Setup dialog is displayed. 
3. Amend the Name of the distance. 
4. Select Point 1 from the adjacent drop-down list. 
5. Select Point 2 from the adjacent drop-down list. 
6. Select the OK button. 



p143

© Image Systems AB, 2011

The End
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Maintaining Angles
An angle can be specified between two or four points. 
The definiton of the angels can be seen in the angle setup dialog. 

During tracking the size of the angle is determined for each tracked image and can be manipulated and
displayed in the same way as a tracked point.

You may: 
 Add an angle. 
 Maintain the properties of an angle . 

Procedure

Adding a new angle
1. Select the required camera view. 
2. Select the Add Angle option from the Camera menu.

Alternatively, click the  tool.
The new angle is added to the Test Contents window with a default name and no definition. 

3. To define the angle in an image:
o Select the angle in the Test Contents window. 
o Click on the first point and drag the mouse to the second point.
o When the mouse button is released, the first angle line is displayed in the im age. 
o For a 2-point angle, drag the mouse to the second point.
o For a 3-point angle, click on the second point and drag the mouse to the third point.
o When the mouse button is released, the second angle line is displayed in the im age and the

angle is indicated by an arc. 
o For a 4-point angle, click on the third point and drag the mouse to the fourth point.
o When the mouse button is released, the second angle line is displayed in the im age and the

angle is indicated by an arc. 
4. Amend the angle properties, as defined below. 

Maintaining Angle Properties
1. Select the required angle in the Test Contents dialog. 
2. Select the Properties option from the Edit menu.

The Angle Setup dialog is displayed. 
3. Amend the Name of the angle. 
4. Select the 2-point, 3-Point or 4-Point radio button, depending on the type of angle required. 
5. Select Point#1 from the adjacent drop-down list. 
6. Select Point#2 from the adjacent drop-down list. 
7. Select Point#3 from the adjacent drop-down list. 
8. For a 4-Point angle, select Point#4 from the adjacent drop-down list. 
9. Select the OK button.

Note: The drop-down lists contain a NONE option. If this is selec ted, the system assumes the
point to be further along the x-axis from the previous point. In this way 2-Point and 1-point
angles may be defined. A 2-Point angle is one where only two points are defined as not NONE. A
1-Point angle is one where only one point is defined as not NONE. 

 

See Also...

Angle Definitions
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Angle Definitions

2-Point angle
The 2 point angle is the angle between the line through the two points and the positive axis direction. It
is computed as the angle for the vector from point 2 to point 1.

3-Point angle
The 3 point angle is only defined for positions. It is calculated as the angle between the displac ement
vectors from point 2 to points 1 and 3.

4-Point angle
The 4 point angle is only defined for positions. It is calculated as the angle between the displac ement
vector from point 2 to point 1 and that from point 3 to point 4.
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Corridors/Stick Figures/Body Models

Corridors
Function
Corridors are used to define limits that can be drawn on a diagram or a camera view. They are used to
indicate graphically the position of a particular test condition lim it. If a diagram line or an item in a
camera view crosses the corridor line, then the limit has been exceeded.

Appearance
Corridors can be specified as any shape that can be drawn as a series of straight lines. Enc losed shapes,
such as the one shown below, are defined by spec ifying the "starting point" twice.

Corridors are displayed in the Diagram Corridors window, which is used to:

 Create corridors
 Amend corridors; 

It contains the following information:

Menu Bar

The Menu bar contains the following options: File - manages corridors: New - creates a new set of
diagram corridors. Open - opens an existing set of diagram corridors. Save - saves the currently open
set of diagram corridors. Save As - saves the diagram corridors under a new name and makes the new
set of diagram corridors current. Close Window - closes the Diagram Corridors window. Window - lists
the windows that are currently open. Help - provides information about this version of Trac kEye and
access to the Help contents page. The Diagram Corridors option displays this Help topic. 

Dimensions

The Dimensions frame contains the following for both the X and Y dimensions: Dimension - a list of the
available dimensions.
Note: The default is "dimensionless" which means that dimension is used to display a scalar quantity. 
Unit - the list of available units applicable to the selected dim ension. 

Lines
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The Lines frame contains a list of the lines defining the set of diagram  corridors, together with Add Line
and Remove Line buttons. 

Selected Line

The Selected line frame contains a list of the points for the selected line in term s of X and Y coordinates,
together with Add Point, Insert Pointand Remove Point buttons.

Procedure
To create a set of corridors:

1. Select the Corridors option from the Tools menu.
The Diagram Corridors window is displayed, containing one diagram corridor line comprising
two points. 

2. For each of the dimensions X and Y: 
o Select the required Dimension from the list of available dimensions. 
o Select the required Unit from the list of available units applicable to the selected dim ension. 

3. At the diagram corridor line level, you may: 
o Add a new line: 

o Select the Add Line button.
o A new line is added to the Lines list with a default name and two default points. 
o Select the default line name and edit the name, if required. 
o Define the points for the line. 

o Edit a line: 
o Select the required line in the Lines list. 
o Click the line name twice and edit the name, if required. 
o Define the points for the line. 

o Remove a line:
o Select the required line in the Lines list. 
o Select the Remove Line button.
o The selected line is removed. 

4. At the point level for a Selected line, you may: 
o Add a new point: 

o Select the Add Point button.
o A new point is added to the end of the Selected line list with its X and Y coordinates set

to '0'. 
o Select the X coordinate and key the required value. 
o Select the Y coordinate and key the required value. 

o Insert a new point: 
o Select the point above which the new point is to be inserted. 
o Select the Insert Point button.
o A new point is added above the selected point in the Selected line list with its X and Y

coordinates set to '0'. 
o Select the X coordinate and key the required value. 
o Select the Y coordinate and key the required value. 

o Edit a point: 
o Select the required point in the Selected line list. 
o Select the X coordinate and key the required value. 
o Select the Y coordinate and key the required value. 

o Remove a point:
o Select the required point in the Selected line list. 
o Select the Remove Point button.
o The selected point is removed. 
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5. Select the Save option from the File menu.
The standard Save as dialog is displayed. 

6. Browse for the required folder. 
7. Key the file name.

The file type is pre-set to "XML". 
8. Select the Save button.

The corridors are saved in the specified file and the name of the window is appended with the full
path to the file. The corridors can be amended if required. 

To amend a set of corridors:

1. Select the Corridors option from the Tools menu.
The Diagram Corridors window is displayed, containing one diagram corridor line comprising
two points. 

2. Select the Open option from the File menu.
The standard Open dialog is displayed. 

3. Browse for the required set of corridors. 
4. Select the Open button.

The selected corridors are displayed in the Diagram Corridors window. 
5. You may:

o amend the dimensions and units; 
o maintain lines; 
o maintain points. 

6. When the required diagram corridors have been amended:
o To save the set of diagram corridors under the original name, select the Save option from the

File menu;
o or 
o To save the set of diagram corridors under a different name: 

o Select the Save As option . 
o Save the set of diagram corridors. 

Add a Corridor
1. Select the required camera view in the Points List window. 
2. Select the Add Corridor option from the Camera menu.

Alternatively, select the Add Corridor button in the following Diagram Properties dialogs:
o XT
o Multi Axis
o XY
o Advanced

4. The Open File dialog is displayed.
Note: Only corridors matching the dimensions of the displayed image/diagram are presented for
selection. 

3. Select the required set of corridors.
This is done by browsing in the folder structure in the top left frame and selecting the required
corridors file in the top right frame. The selected Directory and Filename are displayed.
If the required folder is on a network drive not shown in the top left frame, select the Network
button and map it via the standard Map Network Drive dialog. 

4. Select the OK button.
The selected corridors are displayed in the image and a Corridor node is added to the Test
Contents window. This enables the corridor to be rem oved, if required. 
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Stick Figures
A stick figure is a line drawing superimposed on a camera view. The lines are drawn between pairs of
points added to the c amera view. Any number of lines may be drawn.

Stick figures are automatically tracked when the points used to draw them  are tracked. A typical use of a
stick figure is to draw an approximate skeletal structure of a dummy in a crash test. Displaying the stick
figure in a diagram adds to the ease of interpretation of the results.

You may: 
 Add a stick figure. 
 Maintain the properties of a stick figure . 
 Amend a stick figure using the Relation tool . 

Adding a Stick Figure
1. Select the required camera view. 
2. Select the Add Stick Figure option from the Camera menu.

Alternatively, click the tool.
The new stick figure is added to the Test Contents window with a default name and no
definition. 

3. Define the stick figure in the image by amending its properties, as defined below. 

Maintaining Stick Figure Properties 
1. Select the required stick figure in the Properties List dialog. 
2. Click the required stick figure again. 
3. Amend the Name of the stick figure. 
4. Select the Properties option from the Edit menu.

The Stick Figure dialog is displayed. 
5. To add a selection: 

o Select a point in the left point list. 
o Select a point in the right point list. 
o Select the Add button.
o The selection is added to the From - To list. 

6. To remove a selection: 
o Select it in the From - To list. 
o Select the Remove button. 

7. When all the required selections have been made, select the OK button.
The specified stick figure is displayed in the camera view. 

Amending a Stick Figure using the Relation Tool
1. Select the required angle in the camera view. 
2. Select the Relation option from the Tools menu.

Alternatively, click the tool. 
3. To add a new line, select the first point on the line and drag it to the second point. 
4. To remove a line: 

o Right-click the line. 
o Select the Remove Line option from the pop-up menu.
o The line is removed. 

5. Repeat the process as required.
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Body Models (optional) 
Function
A Body Model consists of a set of segments where each segment is defined as the line between two
tracked points. Each segment can be assigned a mass and a centre of gravity.

Body models are automatically tracked when the points used to draw them are tracked. Displaying the
body model in a diagram adds to the ease of interpretation of the results.

If 3D positions have been calculated for each point in the model, the 3D position of each segment's
centre of gravity as well as that of the centre of gravity of the whole m odel is also calculated. A centre of
gravity (COG) entry is added to the Test Contents window for eac h segment of the body model and an
additional one for the whole body model. These entries can be selec ted for inclusion in diagrams.

Body models can be created and edited within TEMA and exported to/im ported from ASCII files.

You may: 
 Use the body model tool to: 

o Create a body model. 
o Maintain a body model. 

 Add a body model by: 
o Importing from a file. 
o Copying from another view. 

Procedure
Creating a Body Model

1. Select the Body Model option from the Tools menu.
The Body Model dialog is displayed. 

2. Create the points. 
3. Create the body model from the points. 
4. Select the Save or Save as option from the File menu.

The standard Save as dialog is displayed. 
5. Save the body model at an appropriate location.

Note: the body model is saved in a .trg file. 
6. If you wish to create another body model, select the New option from the File menu and repeat

the above procedure 

Creating the Points

To add a point:
1. Select the Add button in the Points list.

A new point is added to the Points list. 
2. Select the point. 
3. Key in a suitable name 

To remove a point:
1. Select the point. 
2. Select the Remove button in the Points list.

The selected point is removed from the Points list. 

Creating the Body Model from the Points

To add a segment:
1. Select a point in the left side of the Body Model frame.
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Note: The next point in the right side is automatically selected. 
2. Select a different point in the right side of the Body Model frame, if necessary. 
3. Select the Add button in the Body Model frame.

A new segment is added to the Body Model frame. It is given: 
o a default Name consisting of the two point names separated by a hyphen, e.g. "Foot - Ankle". 
o a default Mass of "0". 
o a default COG (centre of gravity) of "0.5", i.e. halfway from the first point to the second. 

4. To change the name, select the segment Name and key the required name. 
5. To change the mass, select the segment Mass and key the required value. 
6. To change the centre of gravity, select the segment COG and key the required value. 

To remove a segment:
1. Select the segment. 
2. Select the Remove button in the Body Model frame.

The selected segment is removed from the Body Model frame. 

Maintaining a Body Model
1. Select the Body Model option from the Tools menu.

The Body Model dialog is displayed. 
2. Select the Open option  from the File menu.

The standard Open dialog is displayed. 
3. Browse for the required .trg file and open it.

The selected body model is displayed. 
4. Maintain the body model as described in: 

o Creating the Points. 
o Creating the Body Model from the Points. 

5. Select the Save option from the File menu.
The amended body model is saved under the same name.
Note: Use Save as to save under a different name. 

6. Select the Close option to close the Body Model dialog. 

Importing a Body Model from a File
1. Select the camera view to which the body model is to be assigned. 
2. Select the Add Body Model option from the Camera menu. 
3. Select the Import from File option from the Add Body Model sub-menu.

The standard Open dialog is displayed. 
4. Browse for the required .trg file and open it.

The points from the selected body model are displayed in the Test Contents window under the
selected camera view. The file name is used as the name of the point Group. 

Copying a Body Model from Another View
1. Select the camera view to which the body model is to be assigned. 
2. Select the Add Body Model option from the Camera menu. 
3. Select the Copy from Other View option from the Add Body Model sub-menu.

The Select Model dialog is displayed. 
4. Select the required body model from the list of those already in the test. 
5. Select the Copy button.

The points from the selected body model are displayed in the Test Contents window under the
selected camera view. The file name is used as the name of the point Group.
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Trackers
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Algorithms

Setting up the Airbag Tracker (Optional
Feature)
The Airbag Tracker Setup dialog is used to 'tune' the Airbag tracking func tion which tracks an irregular
shaped object that may change size and shape during the tracking process. A prime example is a vehicle
airbag whose shape may be defined by the setup func tion in the last image in the sequence when it is
fully expanded. It may then be tracked forwards from the first image in which it appears.

For a tracked image, the edge coordinates of the airbag can be displayed in the Statusbar (in the grid
coordinate system). This is achieved by moving the cursor to the required point on the red outline. The

cursor changes to and the  coordinates are displayed:

The analysis to be performed on the airbag after tracking can also be specified. 

The Airbag Tracker Setup dialog contains the following fields: 
 Zoom- enables the magnification of the displayed image to be controlled directly from within the

dialog. 
 Image - this shows the Search Area size (yellow rectangle) and the centre of the target  (purple

cross). The Search Area is updated automatically when the corresponding parameters are
changed. The centre of the target is moved by clicking at the centre of the Search Area and
dragging it to the appropriate point. The Search Area is autom atically repositioned around the
new target centre. It also incorporates a zoom function to enable you to c ontrol the magnification
of the image. 

 Search Area - this is the area around the point in the previous image in which the tracker looks
when trying to position the point in the current im age.
o Size (X) - the width of the Search Area. 
o Size (Y) - the height of the Search Area.
o You may specify the Search Area by keying in the width and height, or by drawing it direc tly

with the mouse. Note: The mouse should be position at the centre of the point when you start
to draw the Search Area. 

 Accept search area edge hits - If this checkbox is not selected, when part of the target m oves
outside the search area, the target is lost. If this checkbox is selected, when part of the target
moves outside the search area, that part of the target inside the search area is treated as a hit. 
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 Object Thresholds - these tools are used to define the shape of the object which is to be
tracked.
o Min - The minimum threshold may be adjusted by keying in a value or dragging the slider to

an appropriate position. 
o Max - The maximum threshold may be adjusted by keying in a value or dragging the slider to

an appropriate position. 
o The two threshold tools are used in combination to adjust the threshold range of the object

within the full value range of 0 to 255. This enables the object which is to be tracked to be
defined distinctly in contrast to the background. The outline of the target is shown in red. See 
Adjusting the Threshold Levels. Threshold range may be further adjusted, if required. 

 Subtract/Remove Background Image  - subtracts/removes(improved algorithm) the selected
image from each image in the sequence, thus removing extraneous parts of the image that could
interfere with the tracking process. 
Disadvantage: When  the background is not a plain colour, the pattern the background has will be
superimposed on the foreground object. 

Removal settings - Checkbox  to activate im proved background removal algorithm.

The result of the image subtraction is passed through a median filter to remove noise and small
artifacts. Then a threshold is applied to the median filter to produce a binary image. This binary image
is then used to mask out the background. 

The algorithm only works for a static camera as the background has to be at the same position in the
reference image as in the processed image for the first subtraction to give a reasonable result. In some
tests the camera will invariably have minute changes in attitude and/or position or display aliasing
effects. To cope with this a parameter called “wiggle” is introduced. Wiggle basically moves the
reference image around by an integer number of “wiggle” pixels in each direction in an effort to find
the smallest difference from the background. The wiggle parameter increases the runtime of the
algorithm as wiggle^2 so small values are recommended. Typically values 0-2 are used.

Remove background - check to activate ....An improved background removal feature will
remove the static background without superimposing any pattern from the background on the
foreground objects.
Threshold - The threshold value that is applied to create the binary image described in the
algorithm. This   should be as low as possible without introducing unwanted artifacts. Values around
5-20 are typically good     depending on the image quality.
Filter size - The size of the median kernel that is used to remove artifacts and noise. Only odd
values are     ever used, if you specify an even value the next larger odd size will be used. Typical values
are 2-20.
Wiggle - The number of integer pixels to “wiggle” the reference image around to find the 
lowest difference to the background before performing filtering and applying threshold.

o None - no image subtraction. 
o First image - subtract the first image from each image. 
o Image at time - subtract the specified image from each image. The image is specified  by

keying the time or by positioning at the required image and selecting the button, i.e.
current time. 

 Pre Filtering - this feature applies a filter to the image to produce a smoother definition before
the selected threshold range is applied.
o Filter type  - The following filter types are available:

o Gaussian - A Gaussian smoothing pre-filter is applied. (In earlier versions of the system
this filter was referred to as 'Blur'). 
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o Median - A Median smoothing pre-filter is applied. 
o None - No pre-filtering to be applied. 

o Filter size - specifies the size in terms of pixels of the filter to be applied. The size is set to 3,
5, 7 or 9 by selecting the appropriate radio button. 

See Also...

Exclude area

Point Setup dialog
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Airbag Analysis Calculations (Optional
Feature)
The Outline is a composite data type that represents the shape of an im age object and is produced as
output from the outline tracker. The Outline always form s a closed loop, as seen in the diagram below.
The Outline Analysis node provides the necessary tools to calculate the extreme points in different
directions for the shape, shown as red crosses in the diagram. The analysis function also c alculates the
orientation of the shape, defined as the angle, , between its major axis and the x axis. (Note: The major
axis is defined mathematically as the "principal axis of inertia" and is calc ulated from the second
moments of the shape.)

Note: The following diagram assumes a zero reference angle implying that the extreme points are
calculated in the four directions given by the positive and negative x and y axis of the im age coordinate
system.

By applying a non-zero reference angle the extreme values can be calculated in other directions as well.
The reference angle is defined as the rotation of the four measurement directions relative to the fixed
image coordinate system. Positive angles rotate the measurement directions in an anti-clockwise
direction. This becomes very powerful when the object orientation is used as reference angle. It gives the
extreme points in the objects own direction.

In the following diagram, the extreme values are calculated in the image coordinate system.
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In the following diagram, the measurement directions have been rotated by a positive angle (theta)
gained from the object orientation calculation. The extreme values are then calculated into the "new"
direction.
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Airbag Volume analysis
Function
The airbag volume analysis function can calculate the volume of an object. The analysis is based on the
results of outline trackers in several calibrated camera views. As the name of the function implies, the
function can be used for time-varying volumes as well, such as airbags. The final result is a 3D volum e
sequence that can be used in diagrams and tables.   

Procedure
To make an volume analysis, the cameras used must be calibrated. The more cameras used in the
analysis, the better the result. Three cameras is adequate and is recommended.

The basic algorithm of the volume analysis function is;

1. produce a 3D model of the real object based on outline trac kers in different camera views using
calibrated cameras.

2. calculate the volume of the 3D model.
3. compensate for estimated over approximation of volume - the volume calibration. 

The 3D model

The viewing cone
To describe the 3D model we have to use the so c alled "3D Viewing cone". This is an imaginary 3D cone
which has its apex in the camera's focal point. The base of the viewing cone has the shape of the outline
as seen by the camera. The illustration below aims to describe this.  

The 3D model is produced by using the view cones from all cameras in the test. The intersection defines
the 3D model. The illustration below aims to show this. 
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The volume calibration
The volume calibration is used for solving step three in the volum e analysis algorithm; revealing the
relation between the 3D model volume and the real objec t volume. 

The 3D model is always an overestimation of the real objec t volume. This is due to 'dead angles' between
the camera views. The illustration above shows the situation.

The dark areas in the illustration of the 3D model above cannot be seen from any camera view.
Nevertheless those areas will be c ontained i the 3D model and its volume. The overestimation of the 3D
model volume is also due to the incapability of the volum e analysis algorithm to handle cavities.  

In order to calculate the real object volume, this overestimation must be estimated. The process of doing
that is what we call the volume calibration. 

There are two procedures for doing this, called Fitted Sphere and Actual Current Volume. Both
methods are based on the same basic idea. 

Fitted sphere
This algorithm uses the same image sequence that is used for the 3D m odel. 

In order to estimate the volume overestimation, a sphere is superimposed onto each camera view. The
radius of the sphere is set to match the object as much as possible. The sphere is the volume reference.
In each camera view, an outline tracker is added to the sphere. Those two steps are totally transparent
to the user. Using the same procedure as when computing the 3D model, the volume of the sphere is
calculated. With both the true sphere's volume and the computed 3D model's volume known, the ratio of
over-estimation is extracted. The same ratio (roughly) exists between an inflated airbag and its 3D
model, so using this ratio, the real object volume can now be calculated. 

Actual Current Volume
Instead of using a fitted sphere as reference, an actual real world model of the object (with known
volume) is used.  The model is placed in the camera setup and filmed. The object is then tracked in each
camera view and its volume is calculated by the volume analysis function as above. The differenc e
between the real known volume and the calculated one is the overestimation. Just like in the fitted
sphere algorithm above, the ratio between the volumes is calculated and then used when calculating the
real object volume later on. 

Time-varying volumes
In the case of time varying volumes (airbags) the volume relation as calculated in one frame can be used
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in the whole sequence, resulting in a value of the real objec t volume that is fine. In the airbag case,
making the volume i the last image frame (when the bag is fully inflated) is best in m ost cases. This
gives an overall accuracy that is good. Should better accuracy be needed in the fram es at when the
airbag is poorly inflated, better result is obtained if the volum e calibration is done earlier in the
sequence. 

The importance of keeping the camera setup
When one volume calibration has been done, this can be used for several tests in the same camera
setup. It is important to keep the cameras at the exact positions at where they were calibrated (3D
Static Camera orientation) in all tests using that volume calibration. This is as each volume calibration is
unique for each camera setup. 

Calculating Real object volume
When a volume calibration has been done, a volume sequence will be produced when the object is
tracked in each camera view using the outline tracker.  As the 3D model volume is used for each new
object volume value, a model volume sequence will be produced also. This is called Model Volume while
 the real object volume sequence is called just Volume. Both sequences can be used in diagrams and
tables in TEMA. 

The illustration below shows those two sequences inserted in a XT diagram . Here, the overestimation can
be seen; the Model Volume sequence (red plot) is a bit dislocated upwards c ompared to the Volume
sequence (blue plot).

Procedure
The test description prerequisites calibrated cameras and a TEMA configuration with airbag analysis
configuration. The calibration data from the test where the cam eras were calibrated has to be imported
into the volume analysis test. This is done for each camera in test by;

1. Mark the camera view in the test contents tree and select Camera/Import Calibration from the
menu bar. 

2. Browse to the TEMA test where the calibration was done. Click OK. 
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3. In the Import Calibration dialog, select the corresponding calibration for each camera. Click OK.   

Volume Calibration with Fitted Sphere

1. Add camera views of real object sequence into test.
2. Step to the image frame displaying the object having the shape at which the highest ac curacy is

desired. Typical for airbag; select the last image where the airbag is fully inflated.
3. Add point for tracking into each camera view. Be sure to use the same point name in each camera

view.
4. Select tracker type Outline (Airbag and Advanced Airbag) tracker. The illustration below shows airbag

trackers added on four camera views in an airbag test. The exclude areas are used to support the
outline trackers

5. In the test contents window, a 3D data will appear. Right clic k on the 3D Results and selecting
Airbag Volume or selecting Edit/Airbag Volume will make the Airbag Volume Calculation
window to appear.

6. Select Fitted Sphere and press OK. The volume calibration is now ready.
7. Continue to track the object using the same outline tracker. For an airbag, begin when the airbag is

fully inflated and track backwards. 
8. Volume data will now be produced. This can be inserted into diagrams and tables. 



p162

© Image Systems AB, 2011

Volume Calibration with Actual Current Volume

1. Add camera views of model into test.
2. Add point for tracking into each camera view. Be sure to use the same point name in each camera

view.
3. Select tracker type Outline (Airbag and Advanced Airbag) tracker. 
4. In the test contents window, a 3D data will appear. Right clic k on the 3D Results and selecting

Airbag Volume or selecting Edit/Airbag Volume will make the Airbag Volume Calculation
window to appear.

5. Select Actual Current Volume and press OK. The volume calibration is now ready.
6. Start a new test and add camera views of the real object. Use the same calibrated cameras. 
7. Add point for tracking into each camera view. Be sure to use the same point name in each camera

view.
8. Select tracker type Outline (Airbag and Advanced Airbag) tracker. 
9. Track the object using the same outline tracker. For an airbag, begin when the airbag is fully inflated

and track backwards. 
10. Volume data will now be produced. This can be inserted into diagrams and tables. 

Note: The airbag can be inserted as a Vizualizer in a 3D-diagram.

 
See Also...

Exclude area

Point Setup dialog
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Setting up the Advanced Airbag
Tracker (Optional Feature)
Note: The Advanced Airbag Tracker is available only if the optional Airbag Tracking functionality is
included in your TEMA system.

The Advanced Airbag Tracker differs from the standard Airbag Tracker in that it uses edge detection
together with a contour model instead of intensity thresholds.

The Advanced Airbag Tracker Setup dialog is used to 'tune' the Advanced Airbag tracking function whic h
tracks an irregularly shaped object that may change size and shape during the trac king process. A prime
example is a vehicle airbag whose shape may be defined by the setup func tion in the last image in the
sequence when it is fully expanded. It may then be tracked forwards from the first image in which it
appears.

When the "Airbag point" has been added to the image and the Advanced Airbag Tracker assigned to it in
the Point setup dialog, the green lines show the initial, automatic calculation of the target. A c losed
boundary line (purple) can be drawn around the ac tual target using the mouse in order to limit the target
area. This is done by left-clicking at a convenient start point and m oving the mouse to the next point.
This action is repeated until an enclosed polygon has been drawn.

Note: If the image in the Point Setup dialog is too small to draw the polygon accurately, the dialog can
be closed and the polygon drawn in the Main window image. The Point Setup dialog can then be
reopened.

When the polygon has been completed, the position of the "Airbag point" is rec alculated (red) only within
the search area (yellow rectangle). The boundary of the polygon entered by the user is displayed in blue.
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Since feedback is very important in order to obtain a feel for what c hanging a parameter actually does,
the feature detection (and optionally the contour) is recalculated live when the user c hanges a
parameter. To provide a good sense of how well edges are detected, the detected edges are displayed
overlaid on the image.

During tracking, the user can stop at any time if the contour gets stuck on false features and c orrect it.
When the user has edited the contour, tracking is done again for the c urrent frame with the edited
contour as initial data. If the user wants to override this behaviour and draw the contour m anually
without re-tracking, this can be done by holding the ALT key while editing.

For a tracked image, the edge coordinates of the airbag can be displayed in the Statusbar (in the grid
coordinate system). This is achieved by moving the cursor to the required point on the red outline. The

cursor changes to and the  coordinates are displayed: 

The analysis to be performed on the airbag after tracking can also be specified. 

The Advanced Airbag Tracker Setup dialog contains the following fields: 
 Zoom- enables the magnification of the displayed image to be controlled directly from within the

dialog. 
 Image - shows the Search Area size (yellow rectangle). The other coloured lines are described

above. 
 Edge Detection - specifies how the edges of the target are determ ined.
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o Image Blur - the standard deviation s used for the Gaussian filter kernels in the edge
detector. The higher the value, the more noise is filtered out at the expense of good
localisation of the edge. Key in value or use the slider. Slider spans between None and Blur
(max value).

o Edge Threshold - corresponds to the ratio of edge pixels / non-edge pixels. It controls the
number of pixels considered as an edge. Key in value or use the slider. Slider spans between
Strict (value zero) and  Lenient (max value).

 Remove Background Edges - subtracts the detected edges in the selected im age from each
image in the sequence, thus removing extraneous parts of the image that could interfere with the
tracking process. 
o No - no image subtraction. 
o First image - subtract the first image from each image. 
o Image at time - subtract the specified image from each image. The image is specified either

by keying the time or by positioning at the required image and selecting the button, i.e.
current time. 

 Remove Inner Edges - checkbox used to specify whether to keep only the outermost edge
segments. Any edge segment that cannot "see" the edges of the search area in all four directions
(due to beeing hidden behind another detec ted edge) will be removed when enabled.  

 Contour  Generation - used to specify how the shape of the object is calculated and viewed.
o Contour Smoothing - the higher the value, the less jagged the contour at the expense of not

being able to retain sharp corners. Key in value or use slider. Slider spans between None and
Smooth (max value). 

o View Contour - checkbox used to specify whether the contour is displayed. The contour often
obscures the detected edges. The user can hide the contour to obtain a better view of the
edges.

See Also...

Point Setup dialog

Exclude areas
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Setting up the Centre of Gravity
Tracker
The Centre of Gravity Tracker Setup dialog is used to 'tune' the Centre of Gravity tracking function which
tracks an object that does not change size and shape during the trac king process.

The Object target is bounded by the red outline, which is c reated by adjusting the maximum and
minimum threshold values.

The Search Area in which the search is conducted is enclosed by the yellow square.

A prime example of its use is the tracking of a calibration target which consists of a dark circle on a light
background, or vice versa. 

For help on how to use the Threshold slider, see Adjusting the Threshold Levels.

The Centre of Gravity Tracker Setup dialog c ontains the following fields: 
 Zoom- Enables the magnification of the displayed image to be controlled directly from within the

dialog. 
 Image - This shows the Search Area size (yellow rectangle) and the centre of the target (green

and/or purple star, depending on its size in relation to the Searc h Area). The Search Area is
updated automatically when the corresponding parameters are changed. The centre of the target
is moved by clicking at the centre of the Search Area and dragging it to the appropriate point. The
Search Area is automatically repositioned around the new target centre. It also incorporates a
zoom function to enable you to c ontrol the magnification of the image. 

 Search Area - This is the yellow area around the point in the previous im age in which the tracker
looks when trying to position the point in the current im age.
o Size (X) - The half width of the Search Area. 
o Size (Y) - The half height of the Search Area.
o You may specify the Search Area by keying in the width and height, or by drawing it direc tly

with the mouse. 
 Object Thresholds - these fields are used to define the object which is to be tracked.

o Min - The minimum threshold may be adjusted by keying in a value or dragging the slider to
an appropriate position. 

o Max - The maximum threshold may be adjusted by keying in a value or dragging the slider to
an appropriate position. 

o The two threshold tools are used in combination to adjust the threshold range of the object
within the full value range of 0 to 255. This enables the object which is to be tracked to be
defined distinctly in contrast to the background. The outline of the target is shown in red. 

o Slider - Used to set the m inimum and maximum thresholds. 
o Automatic Detect - Determines the object radius by adjusting its gray scale threshold

values. It starts from the centre cross in the red search area c reated and searches radially
outwards until desired object radius is obtained. 
o Object radius - Used to decide the proper gray scale threshold. This should be adjusted

so that it is slightly smaller than the size of the target to be trac ked. 
o Bright object - Used to automatically find the threshold settings by detec ting a bright
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object with darker surroundings. Position the centre cross in the centre of the object and
make sure the search area encloses the object. Pressing the button will then m ake the
object thresholds to be set at reasonable start values. Am end those if needed by dragging
the slider.

o Dark object - Same as above but for a dark objec t with light surroundings.

See Also...

Point Setup dialog
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Setting up the Circular Symmetry
Tracker
The Circular Symmetry Tracker Setup dialog is used to 'tune' the Circ ular Symmetry  tracking function
which looks in each successive image for the circular target contained within the target square, i.e. the
purple Template, when the Tracker is set up.

The Search Area in which the search is conducted is enclosed by the outer yellow square. Optionally,
after the second image the search may be restricted to the inner yellow square, which is a quarter of the
size of the outer square. This option works best when the target does not m ove erratically after the initial
move in the second image.

Under normal circumstances there is no need to change the default settings, except: 
 Search Area  - you may need to increase this if the movement of a point between successive

images is erratic, i.e. if its predicted position lies outside the Search Area.
 Note: If the Search Area is too large, the tracking function takes longer and m ay become confused

with extraneous 'noise'. 
 Object size - you may need to increase this because the object radius has to be bigger than the

radius of the point, since you are tracking the edge of the point. 

The Circular Symmetry Tracker Setup dialog contains the following fields: 
 Zoom- enables the magnification of the displayed image to be controlled directly from within the

dialog. 
 Image - this shows the Search Area size (yellow rectangle) and the Target size (purple

rectangle). Both of these are updated automatically when the corresponding parameters are
changed. 

 Template - this is the definition, i.e. size and shape of the target that the tracker uses. 
o Object size - this is used by the tracking filter to reduce the radius of the tracked target, i.e.

a smaller area is used to track the target. 
 Search Area - this is the area around the point in the previous image in which the tracker looks

when trying to position the point in the current im age.
o Size (X) - the width of the Search Area. 
o Size (Y) - the height of the Search Area. 
o Reduce After 2nd Image - check box used to specify that the size of the Search Area is to

be reduced when a prediction can be calculated thereby inc reasing speed. Select this option if
prediction can be used. 

 Pull point to straight path - When moving from image to image during tracking, there may be
several potential matches within the Search Area. The greater the physical m ass of the target
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being tracked, the less likely it is to make erratic changes in position from frame to frame. The
more the slider is moved to the right, the more the tracker is biased towards accepting matches
closer to the position in the previous image even though there are better matches further away. 

 Tracker Tolerance - slider used to set the tolerance level used when the tracker is predic ting the
position of a point. Set a higher value to increase the tolerance, e.g. in a situation where the
tracker is producing accurate results, but the 'noise' level in the images causes them to be
rejected because they are outside the default tolerance. 

See Also...

Point Setup dialog
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Setting up the Constant Tracker
The Constant Tracker Setup dialog is used to place and retain a point at a fixed position in suc cessive
images. It is typically used as a referenc e point for subsequent analysis. It is marked in the image as a
red cross.

The Constant Tracker Setup dialog contains the following fields: 
 Zoom- enables the magnification of the displayed image to be controlled directly from within the

dialog. 
 Image - this shows the Search Area size (yellow rectangle) and the Target size (purple

rectangle). Both of these are updated automatically when the corresponding parameters are
changed. It also incorporates a zoom function to enable you to control the m agnification of the
image. 

 Point Position - the position may be specified by drag and drop or by keying the X and Y
coordinates: 

See Also...

Point Setup dialog
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Setting Up the Advanced Circle Tracker

The Advanced Circle Tracker (beta) Setup dialog is an experimental development of the Circ le Tracker,
including more advanced settings and controls. 

The standard cursor is replaced by a circle shaped cursor. The size of this circle is adjusted using the
mouse scroll wheel. 

Data sequences generated from this tracker are:
-  coordinates
-  circumference
-  area
-  (rotational) volume

The Advanced Airbag Tracker Setup dialog contains the following fields: 
 Edge Detection - specifies how the edges of the target are determ ined.

o Image Blur - the standard deviation s used for the Gaussian filter kernels in the edge
detector. The higher the value, the more noise is filtered out at the expense of good
localisation of the edge. Key in value or use the slider. Slider spans between None and Blur
(max value).

o Edge Threshold - corresponds to the ratio of edge pixels / non-edge pixels. It controls the
number of pixels considered as an edge. Key in value or use the slider. Slider spans between
Strict (value zero) and  Lenient (max value).

 Remove Background Edges - subtracts the detected edges in the selected im age from each
image in the sequence, thus removing extraneous parts of the image that could interfere with the
tracking process. 
o No - no image subtraction. 
o First image - subtract the first image from each image. 
o Image at time - subtract the specified image from each image. The image is specified either

by keying the time or by positioning at the required image and selecting the button, i.e.
current time. 

 Remove Inner Edges - checkbox used to specify whether to keep only the outermost edge
segments. Any edge segment that cannot "see" the edges of the search area in all four directions
(due to beeing hidden behind another detec ted edge) will be removed when enabled.  

 Contour  Generation - used to specify how the shape of the object is calculated and viewed.
o Contour Smoothing - the higher the value, the less jagged the contour at the expense of not

being able to retain sharp corners. Key in value or use slider. Slider spans between None and
Smooth (max value). 

o View Contour - checkbox used to specify whether the contour is displayed. The contour often
obscures the detected edges. The user can hide the contour to obtain a better view of the
edges.

 Radius - using radius to add to tracking control capabilities.
o Current radius - the higher the value, the less jagged the contour at the expense of not

being able to retain 
o Limit radius change - Check to activate limits of radius change going from one image to the

next 
o Max difference/frame - Maximum allowed difference in pixels 
o Current radius - Tolerance for radius detected 

See Also...

Point Setup dialog

Exclude areas
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Setting up the Correlation Tracker
The Correlation Tracker Setup dialog is used to 'tune' the Correlation trac king function which looks in
each successive image for the part of the image contained within the correlation circle, i.e. the purple 
Template, when the Tracker is set up.

The Search Area in which the search is conducted is enclosed by the outer yellow square. Optionally,
after the second image the search may be restricted to the inner yellow square, which is a quarter of the
size of the outer square. This option works best when the target does not m ove erratically after the initial
move in the second image.

For the best results, the area within the circle should contain a well defined object.

Under normal circumstances there is no need to change the default settings, except: 
 Search Area - you may need to increase this if the movement of a point between succ essive

images is erratic, i.e. if its predicted position lies outside the Search Area.
 Note: If the Search Area is too large, the tracking function takes longer and m ay become confused

with extraneous 'noise'. 
 Total Size - you may need to increase the size slightly when using high resolution film, or

decrease it slightly when using video tape, in order to match the size of the object being tracked. 

The Correlation Tracker Setup dialog contains the following fields: 
 Zoom- enables the magnification of the displayed image to be controlled directly from within the

dialog. 
 Image - this shows the Search Area size (yellow rectangle) and the Target size (purple

rectangle). Both of these are updated automatically when the corresponding parameters are
changed. It also incorporates a zoom function to enable you to control the m agnification of the
image. 

 Template - this is the definition, i.e. size and shape of the target that the tracker uses. 
o Core Size - the tracking function looks at all pixels within the Core Radius. 
o Total Size - the tracking function looks at only some of the pixels within the Total Radius. 
o Update Factor - the tracking function updates the template by taking into account how it

appeared in the previous image. A '0' value means that no acc ount is taken, while a '1' value
means that the template is completely updated. If the value is set too high, it m ay cause
drifting of the point's position, so a low value is recom mended. 

o Circle - uses a circular template. 
o Square - uses a square template. 
o Cross - uses a cross shaped template. 

 Search Area - this is the area around the point in the previous image in which the tracker looks
when trying to position the point in the current im age.
o Size (X) - the half width of the Search Area. 
o Size (Y) - the half height of the Search Area. 
o Reduce After 2nd Image - check box used to specify that the size of the Search Area is to

be reduced when a prediction can be calculated thereby inc reasing speed. Select this option if
prediction can be used. 

 Filtering - when the Use Sobel filter checkbox is selected, the images are pre-processed using a
Sobel filter. 
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 Pull point to straight path - When moving from image to image during tracking, there may be
several potential matches within the Search Area. The greater the physical m ass of the target
being tracked, the less likely it is to make erratic changes in position from frame to frame. The
more the slider is moved to the right, the more the tracker is biased towards accepting matches
closer to the position in the previous image even though there are better matches further away. 

 Tracker Tolerance - slider used to set the tolerance level used when the tracker is predic ting the
position of a point. The tolerance is a threshold that defines if a point is to be c onsidered lost or
not. Set a higher value to increase the tolerance, e.g. in a situation where the tracker is producing
accurate results, but the 'noise' level in the images causes them to be rejected because they are
outside the default tolerance. 

See Also...

Point Setup dialog
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Setting up the Corner Contour Tracker
The Corner Contour Tracker can detect edges and find corners along these edges. One c orner will be
selected as the track point. The tracking algorithm  is as follows:

1. Edges are detected using a Canny algorithm (background edges can be removed). Detected edges
are visualized as green lines in the Point setup dialog. If the num ber of pixels in the edges are
greater than 15% of the total amount of pixels in the search area then the text 15% will appear in
the point setup dialog and the settings for the edge detection will have to be edited (for instanc e
by moving the Edge Threshold towards Strict, see below).

2. Endpoints for all edge lines are extracted. If an edge intersects another edge, pixels are rem oved
at the intersection until all lines have exactly two endpoints. These endpoints can be connec ted
again in the third step. Endpoints are visualized as blue pixels in the Point setup dialog.

3. Endpoints that are close to each other are mapped as connected. An endpoint can be connec ted to
more than one other endpoint. However, if a line does not have an endpoint, if two lines are
connected at both ends, or if several lines are connected without leaving any endpoint free then
no corners will be detected in the following steps. The pixels c onnecting one endpoint to the next
are visualized as red pixels in the Point setup dialog.

4. Lines, beginning at one unconnected endpoint to another unconnected endpoint, are extracted. If
the lines are extracted along a path where more than two endpoints are c onnected several lines
are extracted.

5. The best corner on each line is extracted. Two different methods can be used for extracting the
best corner of the line. In the first method a line segment is moved along the line, one pixel at a
time, and the point with the largest perpendicular distanc e to the line between the segment
endpoints will be the position of the best corner for the line (the segem ent corresponding to this
point is the best corner segment). This method is always used for the first image when tracking is
started. In the second method the line segment is correlated against the segment selected as the 
best corner segment for the first image when tracking is started. The best c orner on each line are
visualized with blue crosses in the Point setup dialog.

6. The corners from each line is finally compared to each other and the best of these corners are
selected. The selected corner is visualized with a red cross in the Point setup dialog.

The Corner Contour Tracker dialog contains the following fields:

 Edge Detection
o Image Blur - The higher the value, the more noise is filtered out at the expense

of good localization of the edge. Set slider between Strict and Lenient or type
value.

o Edge Threshold - corresponds to the ratio of edge pixels / non-edge pixels. It
controls the number of pixels considered as an edge. The higher the value, the
more edges are detected. Set slider between Stric t and Lenient or type value.

o Remove Background Edges - remove edges found in both the c urrent image
and the background image, thus removing extraneous parts of the image that
could interfere with the tracking process.
 No - no background image is used.
 First image – the background image is the first image in the sequence.
 Last->First image – the last image in the image sequence is used for the

first half of the sequence and the first image is used for the second half of
the sequence.

 Corner Detection
o Segment length – length of the segment that is moved along the edge in step 5
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above. If the edge is shorter that the segment length then that edge will be
ignored. A too short segment length will make it difficult to detect round edges.

o Max Gap – determines if endpoints should be connected in step 3 above. (See
also Pull point to straight path, below).

o Best corner mode
 Sharpest corner – the best corner for a line (step 5 above) is the sharpest

corner.
 Similar shape – the sharpest corner will be selected, in step 5 above, for

the first image when tracking starts. Edges in following images will be
compared to this edge.

 Search Area - set the size of the search area (yellow square). The square can also be
resized using the mouse.

o Size (X) - the width of the Search Area.
o Size (Y) - the height of the Search Area.

 Pull point to straight path - tracking prediction. Will also affect the allowed size of the
gap between endpoints for connection in step 3 above. The accepted gap will scale with the
distance to the predicted track position; Max Gap will be used at zero distance and Pull
point to straight path/100 * Max Gap will be used at the edge of the search area.

 Tracker Tolerance - Set slider between Strict and Lenient or type value.
 Accuracy

Accessed via...
Tracking window/Point menu/Point Setup option/ Point setup dialog /CornerContour button.
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Setting up the Intersection Tracker
(optional)
Function

The Intersection Tracker Setup dialog is used to 'tune' the Intersec tion tracking function. Basically, this
works in three steps. 

1. First, it will look for edge pixels. Such are pixels in the border between a darker and lighter area in an
image. In the most lenient case, all pixels in an image can be considered as edge pixels in som e way.
Therefore, some limitations in the definition of the edge pixels has been done in order to obtain a
useable result. The result can be tuned further by adjusting the settable param eters in the tracker
setup. The Search Area in which the search is conducted is enclosed by the outer yellow square.
Detected edge pixels are visualized by green lines.  

2. Second, when the edges in the search area has been detected, the tracker will searc h for edge
sections that can be fitted to a straight line. The m inimum length of the fitting is settable. The value
will be visualized by the size of the purple square; the length of any of its sides is equal to the
minimum line length. When the fitting has been done, the result is visualized by blue lines
superposed on the detected edges.

3. Finally, the tracker will detect intersections between the straight line fittings within the search area.
The intersection found nearest to the center of the search area (The yellow cross) will be the default
candidate for the point to track. The point is visualized by the red c ross. 

Appearance

The Intersection Tracker Setup dialog contains the following fields: 

 Edge Detection
o Image Blur - The higher the value, the more noise is filtered out at the expense of good

localization of the edge. Set slider between Strict and Lenient or type value.
o Edge Threshold - corresponds to the ratio of edge pixels / non-edge pixels. It controls the

number of pixels considered as an edge. The higher the value, the m ore edges are detected.
Set slider between Strict and Lenient or type value.

 Line Detection
o Min Length - Set the minimum length of lines to be detected. This will set the size of the

purple circle as well.
o Max Gap -  set the maximum accepted gap when calculating a straight line fitting. The

feature is to be used in cases when the shapes of an edge sections is m ostly straight but has
delimited deviations from the "straight line pattern". With no Gaps allowed, the line fitting will
be done on the straight segments only, often resulting in lots of short line fittings. Too short
line fittings may result in important trends being missed. However, defining Gaps with the size
of the deviations will result in straight line fittings perform ed over edge segments that
includes even great deviations from any straight line pattern, thus c ontaining trends in the
shapes of the edges. 

 Search Area - set the size of the search area (yellow square). The square can also be re sized
using the mouse. 
o Size (X) - the width of the Search Area. 



p178

© Image Systems AB, 2011

o Size (Y) - the height of the Search Area. 

 Pull point to straight path - When moving from image to image during tracking, there may be
several potential matches within the Search Area. The greater the physical m ass of the target
being tracked, the less likely it is to make erratic changes in position from frame to frame. The
more the slider is moved to the right, the more the tracker is biased towards accepting matches
closer to the position in the previous image even though there are better matches further away. 

 Tracker Tolerance - slider used to set the tolerance level used when the tracker is predic ting the
position of a point. Set a higher value to increase the tolerance, e.g. in a situation where the
tracker is producing accurate results, but the 'noise' level in the images causes them to be
rejected because they are outside the default tolerance. 

Note:  Validity check is done on all typed values.  
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Setting up the MXT Tracker (Optional
Feature)
The MXT Tracker Setup dialog is used to 'tune' the MXT Target trac king function which looks in each
successive image for the MXT target centred by the purple cross Template, when the Tracker is set up.

The Search Area in which the search is conducted is enclosed by the outer yellow square. Optionally,
after the second image the search may be restricted to the inner yellow square, which is a quarter of the
size of the outer square. This option works best when the target does not m ove erratically after the initial
move in the second image.

Under normal circumstances there is no need to c hange the default settings, except:
 Search Area - you may need to increase this if the movement of a point between succ essive

images is erratic, i.e. if its predicted position lies outside the Search Area.
 Note: If the Search Area is too large, the tracking function takes longer and m ay become confused

with extraneous 'noise'. 
 Object size - you may need to adjust this because the object radius should be smaller than the

object. In this case, you are tracking the centre cross of the m arker to avoid noise from the outer
edge. 

The MXT Tracker Setup dialog contains the following fields: 
 Zoom- enables the magnification of the displayed image to be controlled directly from within the

dialog. 
 Image - this shows the Search Area size (yellow rectangle) and the Target size (purple

rectangle). Both of these are updated automatically when the corresponding parameters are
changed. 

 Search Area - this is the area around the point in the previous image in which the tracker looks
when trying to position the point in the current im age.
o Size (X) - the width of the Search Area. 
o Size (Y) - the height of the Search Area. 
o Reduce After 2nd Image - check box used to specify that the size of the Search Area is to

be reduced when a prediction can be calculated thereby inc reasing speed. Select this option if
prediction can be used. 

 Version - the version of the tracker installed with your system  is displayed. This information is
useful if a problem is reported or an explanation requested. 

 Target type - this is the type of target selected from the drop-down list. The options are:
o Type 1 (1+4 dots) - black circular target with a centre and four outer white dots; 
o Type 2 (1+5 dots) - black circular target with a centre and five outer white dots. 

 TrackerTolerance - slider used to set the tolerance level used when the tracker is predic ting the
position of a point. Adjusting the slider position automatically updates the % figure displayed,
and vice versa. Set a higher value to increase the tolerance, e.g. in a situation where the trac ker
is producing accurate results, but the 'noise' level in the images causes them to be rejected
because they are outside the default tolerance. 

See Also...
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Point Setup dialog
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Setting up the Advanced Circle Tracker

The Quadrant Symmetry Tracker Setup dialog is used to 'tune' the Quadrant Sym metry  tracking function
which looks in each successive image for the quadrant contained within corner markers in the quadrant
circle, i.e. the purple Template, when the Tracker is set up.

The Search Area in which the search is conducted is enclosed by the outer yellow square. Optionally,
after the second image the search may be restricted to the inner yellow square, which is a quarter of the
size of the outer square. This option works best when the target does not m ove erratically after the initial
move in the second image.

Under normal circumstances there is no need to change the default settings, except: 
 Search Area - you may need to increase this if the movement of a point between succ essive

images is erratic, i.e. if its predicted position lies outside the Search Area.
 Note: If the Search Area is too large, the tracking function takes longer and m ay become confused

with extraneous 'noise'. 
 Object size - you may need to adjust this because the object radius should be smaller than the

object. In this case, you are tracking the centre cross of the m arker to avoid noise from the outer
edge. 

The Quadrant Symmetry Tracker Setup dialog contains the following fields: 
 Zoom- enables the magnification of the displayed image to be controlled directly from within the

dialog. 
 Image - this shows the Search Area size (yellow rectangle) and the Target size (purple

rectangle). Both of these are updated automatically when the corresponding parameters are
changed. 

 Template - this is the definition, i.e. size and shape of the target that the trac ker uses.
o Object size - this is used by the tracking filter to reduce the radius of the tracked target, i.e.

a smaller area is used to track the target. 
 Search Area - this is the area around the point in the previous image in which the tracker looks

when trying to position the point in the current im age.
o Size (X) - the width of the Search Area. 
o Size (Y) - the height of the Search Area. 
o Reduce After 2nd Image - check box used to specify that the size of the Search Area is to

be reduced when a prediction can be calculated thereby inc reasing speed. Select this option if
prediction can be used. 

 Pull point to straight path - When moving from image to image during tracking, there may be
several potential matches within the Search Area. The greater the physical m ass of the target
being tracked, the less likely it is to make erratic changes in position from frame to frame. The
more the slider is moved to the right, the more the tracker is biased towards accepting matches
closer to the position in the previous image even though there are better matches further away. 
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 TrackerTolerance - slider used to set the tolerance level used when the tracker is predic ting the
position of a point. Set a higher value to increase the tolerance, e.g. in a situation where the
tracker is producing accurate results, but the 'noise' level in the images causes them to be
rejected because they are outside the default tolerance. 

See Also...

Point Setup dialog
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Setting up the Circle Tracker
(Optional)

The Circle Tracker Setup dialog is used to 'tune' the Circle
tracking function which tracks circular objects.

The tracker can track circular objects even if part of the
object is obscured, see image to the right.

Data sequences generated from this tracker are:
-  coordinates
-  radius
-  (tracked) area

Thresholds are used to define the object. The Object target
is bounded by one red and one green outline. The red outline
is the result of the threshold operation and the green outline
is the corresponding circle.

The Search Area in which the search is conducted is
enclosed by the yellow square.

A prime example of its use is the trac king of the Image System Wand for Wand Calibration (a c alibration
target which consists of two light circles on a dark background). 

The Circle Tracker Setup dialog contains the following fields: 
 Zoom - Enables the magnification of the displayed image to be controlled directly from within the

dialog. 
 Image - This shows the Search Area size (yellow rectangle) and the centre of the target. The

Search Area is updated automatically when the corresponding parameters are changed. The
centre of the target is moved by clicking at the centre of the Search Area and dragging it to the
appropriate point. The Search Area is automatically repositioned around the new target centre. It
also incorporates a zoom function to enable you to control the m agnification of the image. 

 Search Area - This is the yellow area around the point in the previous im age in which the tracker
looks when trying to position the point in the current image. You may specify the Search Area by
keying in the width and height, or by drawing it directly with the m ouse. 
o Size (X) - The half width of the Search Area. 
o Size (Y) - The half height of the Search Area.

 Thresholds are used to define the object. 
When Object Contrast is set to:
o Bright (dynamic) or Dark (dynamic), threshold levels are set automatically in every frame of

the image sequence.
OR

o Manual (static), the user has to provide static threshold levels to define the object.
 Min - The minimum threshold may be adjusted by keying in a value or dragging the slider

to an appropriate position. 
 Max - The maximum threshold may be adjusted by keying in a value or dragging the slider

to an appropriate position. 
 Slider - Used to set the m inimum and maximum thresholds. For help on how to use the

Threshold slider, see Adjusting the Threshold Levels.
 Tracker Tolerance  - Is used to control how circular the (non obscured part of the) object has to

be and how much the radius of the circle can deviate from  one image to the next without loosing
track.
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See Also...

Point Setup dialog
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Adjusting the Threshold Levels
Several of the tracker setup dialogs contain threshold levels. These can be adjusted using the following
procedure.

The minimum and maximum threshold levels define the pixel intensity interval within whic h the object is
expected to be found. Pixels with intensities outside this interval are treated as bac kground pixels and
are excluded from consideration.

Note: High pixel intensity values give a bright pixel and low intensities give dark pixels.

Setting threshold levels to produce a good definition of the target is som etimes not straightforward,
especially if the contrast between the target and its background is not sharply defined. Using the
following procedure normally produces good results, espec ially if the target is well-separated from  the
background: 

1. Place the purple cross at the centre of the required target object. 
2. Adjust the Search Area using the mouse so that it is as small as possible, but covers the whole

object and has some overlap. 
3. Set the Min threshold to 0 and the Max threshold to 255, i.e. the whole range is included.

This results in an outline as big as the Search Area. However, it is not visible because the red
outline is exactly behind the yellow Search Area. 

4. For a bright object on a dark background:
o Leave the Max threshold at 255. 
o Click the left red marker (minimum threshold) on the slider repeatedly until the objec t is well-

targeted, i.e. the outline has shrunk and formed tightly around the object. 
o Adjust the right red marker (maximum threshold) on the slider if nec essary.

o
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o

o

5. For a dark object on a bright background:
o Leave the Min threshold at 0. 
o Click the right red marker (maximum threshold) on the slider repeatedly until the objec t is

well-targeted, i.e. the outline has shrunk and formed tightly around the objec t. 
o Adjust the left red marker (minimum threshold) on the slider if nec essary.

o
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o

o

6. For a gray object on a mixed bright/dark background:
o Leave the Max threshold at 0. 
o Click the left red marker (minimum threshold) on the slider repeatedly until the objec t is well-

targeted against the dark background. 
o Leave the Min threshold at its current setting. 
o Click the right red marker (maximum threshold) on the slider repeatedly until the objec t is

well-targeted against the dark bac kground.
o Note: The Max threshold could be adjusted before the  Min threshold, depending on the nature

of the image.

o
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o

o
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Groups, Contours and Virtual Points
(Optional Feature)
Consider a typical vehicle crash test involving a dummy and an airbag. As the test proc eeds, the airbag
expands and progressively obscures the dummy's head and the tracking points marked on it. To obtain
the best results from such a test, it is important to identify the position of all the tracked points in eac h
successive image. The usefulness of the test is also im proved if the position of the dummy's facial outline
is known, even when it is obscured. This enables, for example, an assessment of how c lose the face came
to a solid part of the vehicle.

This type of test and analysis is achieved using the functionality associated with groups, contours and
virtual points.

Groups

A group is a set of at least two points that is assigned a group nam e. If a larger number of points is
defined in a group, the tracking process is more robust because accurate results c an be obtained when
some of the points are obscured and their positions c annot be measured. The points in a group should be
marked on a part of the image that is reasonably rigid, e.g. the head of a dum my. The less relative
movement there is between the group points during the test, the m ore accurate and practical are the
results. It is possible to include any points in a group, e.g. som e on the dummy and some on the vehic le,
but the results are both less ac curate and less meaningful. As many groups may be defined in a camera
view as required, but a point may belong to only one group at a time. See Maintaining Groups.
Note: A contour can be selected as if it were a point and assigned to a group.

Contours

A contour is an outline drawn on an image as a series of straight lines. The m ore lines there are and the
shorter they are, the more accurate is the representation of a physical aspect in the im age, e.g. an
outline of the face on a crash dummy. The contour should be drawn on a part of the im age that is
reasonably rigid, e.g. the face of a dummy, for the same reasons given for groups. For the best results,
the contour should stand out visibly against its background, e.g. a light facial outline against a dark
background. The contour must be drawn as a single line, but may be as complex as required to meet the
requirement. It can contain closed loops which are c reated by returning to an earlier point for the second
time, or by retracing line segments. The basic  rule is that all the points on the contour m ust be linked
together by a single unbroken line, although points and line segments may be reused as often as
required. Each contour is associated with a point group and its position in succ essive images is
determined relative to the positions of the points in the group. As m any contours may be defined in a
camera view as required. See Maintaining Contours.

Virtual Points

A virtual point is one whose position is calc ulated from the known position of other points in the image,
rather than by measurement. Virtual points are used in two distinct situations. If the position of a point
cannot be measured by the tracking algorithm, for example because the point is obscured by an airbag,
it is deemed to be lost and its position may be calculated. Alternatively, a point may be specified as
being always virtual, i.e. its position is always calculated. An exam ple when this feature is useful is
where a coordinate system is based on a particular point which is not visible in all images. See 
Maintaining Virtual Points.

Tracking

When tracking using groups, contours and virtual points, an ideal set of c onditions, i.e. as described
above, leads to the best results. The further from this ideal, the less accurate are the results. There is no
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sudden cut-off beyond which groups, contours and virtual points should not be used.

Point Group Tracking
The points in a point group are tracked in the same way as if they were individual points not in a group.

Virtual Point Tracking
Virtual points are not tracked because a tracking algorithm is not assoc iated with them. If a point is
specified as being always virtual, rather than just when lost, its position is always calc ulated from the
measured positions of the other points in its group.

Contour Tracking
There are three ways in which a contour can be used in trac king:

1. As a drawing tool 
2. As a tracked object 
3. As a virtual object

See Using Contours

Amending the Point Group

When a contour is drawn, its position is calculated by transformation with respect to the associated point
group. The positions of the points in the group when it is established are stored as a two dim ensional
model which is used as the basis for all transformations used to calculate the position and shape of the
associated contour. The definition of the two dim ensional model is not changed during tracking. However,
if the definition of the point group is changed, the two dim ensional model is changed and this may affect
the position and shape of the associated contour, i.e.

 Changing the position of an existing point in the group changes the position of the c ontour. 
 Adding a new point to the group does not change the position of the c ontour.
 Note: If the point is positioned in an image other than that in whic h the two dimensional model

was established, a reverse transformation is made to calculate the position it would have had in
the first image. It is this position that is added to the two dim ensional model. 

 Removing a point from the group changes the position of the contour.
 Note: At least two points must remain in the group, otherwise there is insuffic ient information to

make positional calculations. 

The following example shows the effect on the position of a c ontour of moving a point in the assoc iated
group.
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Maintaining Point Group Properties
A point group is a set of at least two points assigned a group nam e. A point can belong to one or more
point groups. As many point groups as required may be set up.

Note: A contour can be selected as if it were a point and assigned to a group.

Point groups are used in conjunction with contours and virtual points. See Groups, Contours and Virtual
Points.

You may: 
 Create a point group
 Import a point group
 Add points to a point group (Move Selection to Group)
 Add points to multiple point groups (Add Group to Selec tion)
 Remove points from a point group

Note: Above options are available either from Camera menu/Point Groups or by right-clicking in
the Test Contents window.

Creating a Point Group
1. Select the required camera view. 
2. Select at least one point in the Test Contents window whose position is marked in the  current

image. 
3. Select the Point Groups option from the Camera menu. 
4. Select the Create Point Group option from the Point Groups menu.

The Add Point Group dialog is displayed.
Note: If only one point is selected, an error message is displayed.
Note: If any of the points is not marked in the current image, an error message is displayed.  

5. Key the Point Group Name. 
6. Select the OK button.

The point group is created and its name is automatically displayed in the Test Contents window.
If this is the first group to be created, the Group column is automatically added to the Test
Contents window.

In the Test Contents window, the icon for each of the points in the group is c hanged from to

.

Importing a Point Group
1. Select the required camera view. 
2. Select the Point Groups option from the Camera menu. 
3. Select the Import Point Group option from the Camera menu.

The standard Open dialog is displayed. 
4. Browse for the required point group file. 
5. Select the Open button.

The points in the group are added to the selected camera view. The default Correlation trac ker is
assigned to them and they are marked as "unregistered". A red dot indicates that they are part of
a point group, i.e. .

Adding Points to a Point Group (Move Selection to Group)
1. Select the required camera view. 
2. Select the points in the Test Contents window to be added to the group. 
3. Select the Point Groups option from the Camera menu. 
4. Select the Move Selection to Group option from the Point Groups menu.

The Select Group dialog is displayed.
Note: If any of the points is not marked in the current image, an error message is displayed.  
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5. Select the required group from the list of those available. 
6. Select the OK button.

The selected points are added to the point group.

In the Test Contents window, the icon for each of the points in the group is c hanged from to

. 

Adding Point(s) to Multiple Point Groups (Add Group to Selection)
1. Select the required camera view. 
2. Select the point(s) in the Test Contents window to be added to another group. 
3. Select the Point Groups option from the Camera menu. 
4. Select the Add Group to Selection option from the Point Groups menu.

The Select Group dialog is displayed.
Note: If any of the points is not marked in the current image, an error message is displayed.  

5. Select the required group from the list of those available.  
6. Select the OK button.

The selected point(s) are added to the m ultiple point group.
 
In the Test Contents window a point belonging to multiple groups are listed several times, one
time for each group it belongs to. The icons for these points will have a +  sign in front of the icon
indicating the status of the point .

 Note: Virtual points can only belong to one point group.

Removing Points from a Point Group
1. Select the required camera view. 
2. Select the points in the Test Contents window to be removed from the group. 
3. Select the Point Groups option from the Camera menu. 
4. Select the Remove Selection from Group option from the Point Groups menu.

The selected points are removed from the point group, but not from the Test Contents window.
Note: A confirmation message is not displayed. However, points removed unintentionally may be
easily added back into the group.  

Point Group Files

Point Groups can be imported from external ".grp" files. These files are text files that can be created with
any suitable text editor. Each file contains a line for each point in the group. Eac h line contains three
fields, i.e. point name, x coordinate, y coordinate. The fields are separated by a space charac ter. The
point name must be consistent with the point naming standards and the coordinates are given in pixels.
An example of a point group file is shown below:

Point#A 10 20

Point#B 20 30

Point#C 30 40
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Using Contours (Optional Feature)
There are three primary ways of using the tracking func tion in relation to targets, contours and virtual
points:

1. As a drawing tool
The contour function is used as a drawing tool to position the contour in each suc cessive image. 

2. As a tracked object
A contour can be tracked directly as a separate item  in the same way as individual points are
tracked. In this case its position is determined directly from the image by the tracker. The
positions of virtual points can be calculated from their relationship to the contour. 

3. As a virtual object
A contour can be treated as virtual, i.e. similar to a virtual point. Its position in suc cessive tracked
images is calculated by transformation from the positions of the points in its assoc iated target. 

See Also...

Groups, Contours and Virtual Points

Maintaining Contour Properties
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Contour as a Manual Drawing Tool
(Optional Feature)
In this mode a contour is drawn in the image and is tracked as if it were a point.

It is recommended to track the contour by using the "step trac k" functions from the Time Panel toolbar:

  - tracks one frame backwards.
  - tracks one frame forwards.

Note: Tracking by using the  or  button should not be used because it is not effective. No
opportunity is given to ensure that the contour is positioned correctly in each successive image.

The following illustrations show some of the features of this mode of operation:
1. Add a Contour to the Default target. 
2. Draw the Contour in the first image.

3. Double-click on the Contour in the Test Contents window. 
4. Select Semi Automatic in the Contour Point Setup dialog.
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Note: The Contour moves with Group feature is not relevant in this mode. 
5. Select the OK button. 
6. Start the tracking by selecting in the Time Panel.

You are asked to confirm the Contour position in the next image.

7. You may: 
o Adjust the Contour shape or position using the norm al contour tools.
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o Rotate the Contour using the rotation tool.
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8. Repeat the above steps for each successive image.
Note: If the Contour is being tracked in Manual mode, it is lost in each successive image.
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It then has to be redrawn each time.
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Virtual Point from Contour Position
(Optional Feature)
In this mode a contour is drawn in the image, together with a point. The point is treated as if it were virtual
when the contour is tracked. The position of the contour in successive images is located by the tracker and
adjusted manually, while the position of the point is calculated by the tracker from the point position.

The following illustrations show some of the features of this mode of operation:
1. Add a Contour to the Test Contents window and draw it in the first image.

This may be achieved more accurately via a Zoom window.
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2. Add a Point to the Test Contents window and mark its position in the first image.
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3. Double-click on the Point in the Test Contents window and select the Virtual Tracker in the Point
Setup dialog.
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The Point is now shown in the Test Contents window as being Virtual.

4. Select the Point and the Contour in the Test Contents window.
5. Select the Point Groups option from the Camera menu.
6. Select the Create Point Group option from the Point Groups menu.

The Add Point Group dialog is displayed.

7. Select the OK button.

The icon for the Point and the Contour is changed to to indicate that they are in the 2D
model.
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8. Start the tracking by selecting in the Time Panel.
The tracker asks for confirmation of the Contour in the next image because it is being tracked in Semi-
automatic mode, by default.
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9. Adjust the position and shape of the Contour in the image.
This is best done via a Zoom window.
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10. Repeat the above steps for each image in the sequence until the tracking has finished.
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11. Display an XY Diagram.
12. In the XY Diagram dialog, select only the Point for display.

This shows that the calculation of the Virtual Point position has been accurate.
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Virtual Contour from Point Position
(Optional Feature)
In this mode some points are placed in the image, together with a contour. The c ontour is drawn in the
image and treated as if it were virtual when the points are trac ked. The positions of the points in
successive images are located by the tracker, while the position of the contour is calc ulated by the
tracker from the point positions.

The following illustrations show some of the features of this mode of operation:

1. Add three points to the Test Contents window and position them in the first image.

2. Select the three point and then the  tool.
In this case no changes are required in the Point Setup dialog because the points are set to use
Automatic tracking by default.
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3. Add a Contour to the Test Contents window. 
4. Draw the Contour in the first image.
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5. Select the Points and the Contour in the Test Contents window. 
6. Select the Point Groups option from the Camera menu. 
7. Select the Create Point Group option from the Point Groups menu.

The Add Point Group dialog is displayed.

8. Select the OK button.

The icon for the Point and the Contour is changed to to indicate that they are in the
2D model.
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9. Double-click the Contour in the Test Contents window. 
10. Select the Contour moves with Target checkbox in the Contour Point Setup dialog.

11. Select the OK button.
This marks the Contour node as being Virtual.
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12. Start the tracking by selecting in the Time Panel.
The tracking proceeds to completion because Automatic mode was selected for all the points.



p214

© Image Systems AB, 2011

The position of the Contour in successive frames is calculated from the Point positions. Because,
in this example, the three Points and the Contour are on the sam e rigid structure, the Contour
position is calculated exactly. 

13. Display an XT Diagram. 
14. In the XT Diagram dialog, select the Points and Contour for display.

This shows that the relative positions of the Points and Contour rem ain the same.
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Maintaining Contour Properties
(Optional Feature)
A contour is a named outline drawn on an image as a series of straight lines. It is assoc iated with a point
group.

Contours are used primarily to improve the visibility of the displayed images. However, they are in
conjunction with point groups and virtual points. See Groups, Contours and Virtual Points . Specifically, a
contour can be used in the calculation of the positions of virtual points. Alternatively, a contour can be
defined as virtual an its position calc ulated from the positions of real points. During tracking, the size and
angle of the contour are calculated, as well as its position, and are m ade available for subsequent
analysis and presentation.

There are two modes of operation when manipulating contours:
 Draw mode operates by left-c licking the last point in a contour and releasing the m ouse button. It

is used to draw the basic shape of the contour. 
 Drag mode operates by left-clic king any point or line in a contour and dragging it to a new

position before releasing the mouse button. It is used to: 
o move the position of a point; 
o add a point to the middle of a contour; 
o delete a line or group of lines. 

You may: 
 Create a contour.
 Draw a basic contour line.
 Reposition a point.
 Add a point to the end of a contour.
 Add a point to the middle of a contour.
 Remove a point.
 Create a loop.
 Rotate a contour.
 Use the pop-up menu:
 Note: The pop-up menu is available from the contour in the Test Contents and in the im age. 

o Delete the contour from the Test Contents window .
o Control the display of the contour.
o Clear the contour from the image.
o Undo the last operation.

Creating a Contour
1. Select the required camera view. 

Select the Add Contour option from the Camera menu.
2. The contour is added to the Test Contents window with a default name.

Note: The contour is not displayed in the image because it has not yet been drawn. So far, all that
has been done is to define the contour name and associate it with a point group. 

3. Double-click the contour in the Test Contents window.
The Point Setup dialog is displayed for the contour. 

4. Amend the Point name, if required. 
5. Specify the Frame to frame prediction - Using Frame to frame prediction mode is the default

and means that the tracking function takes into account the previous positions of the point when
tracking its next position. De-selecting Frame to frame prediction mode should be used in
circumstances where the movement of the point as seen in the image is erratic. 

6. If you wish the contour and the target to be moved together, i.e. to maintain the same relative
positions, select the Contour moves with Target checkbox. 

7. Select the OK button.
The Point Setup dialog is removed from the display. 
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8. Select the contour and change its name, if required. 
9. Draw the contour, see below. 

Drawing a Basic Contour Line
1. Select the required camera view.
2. Select the required contour in the Test Contents window.

When a contour is selected, the cursor changes to .
3. Left-click the first point in the contour.
4. Release the mouse button.
5. Move the cursor to the next point, left-click and release.

The contour is drawn as each point is spec ified.
6. Repeat the above step until the last point is plac ed.
7. Double-click the last point to complete the contour and disable the drawing tool. The select tool

will then be active at once. 

Note: It is best, if possible, to avoid having tracking points and contour line points too c lose together
because it makes point selection a little difficult.

Repositioning a Point
1. Select the required camera view.
2. Select the required contour in the Test Contents window.
3. Place the cursor at the point to be moved.

A circle is displayed around the point to confirm that it may be selected.
4. Left-click the point and drag it to the required position.
5. Release the mouse button.

Adding a Point to the End of a Contour
1. Select the required camera view.
2. Select the required contour in the Test Contents window.
3. Place the cursor at the required end point.

A square is displayed around the point to confirm that it may be selected.
4. Left-click the point and release the mouse button.
5. Proceed as defined in Drawing a Basic Contour Line.

Adding a Point to the Middle of a Contour
1. Select the required camera view.
2. Select the required contour in the Test Contents window.
3. Place the cursor at the line joining the points between which the new point is to be added.

The line changes colour to confirm that it may be selected.
4. Left-click the line and drag the selected point to the required position for the new point.
5. Release the mouse button.

The new point is positioned, the old line is removed and two new lines are drawn to connec t the
new point to the contour.

Removing a Point
1. Select the required camera view.
2. Select the required contour in the Test Contents window.
3. Place the cursor at the point to be removed.

A circle or square is displayed around the point, depending on its position in the c ontour, to
confirm that it may be selected.

4. Left-click the point and drag it to the next or previous point on the c ontour, as appropriate.
5. Release the mouse button.

The selected point is removed and the line segments readjusted.
Note: If the selected point is moved to a point several segments away, all the intervening points
are removed and replaced by a single segment between the two selected points.

Rotating a Contour
1. Hold down the <Alt> key. 
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2. Move the mouse to the cross indicating the contour in the im age.
The cursor changes to . 

3. Press and hold the left mouse button. 
4. Move the cursor slowly a little way from the start point. 
5. Move the mouse in a clockwise or anti-clockwise direction to rotate the contour to the required

position.
During this movement both the old and new positions are shown in the im age in different
colours. 

6. Release the mouse button.
The old contour position is removed and the new one is shown in the original contour colour. 

Creating a Loop

If you require a contour to contain loops, it is best to plan the sequenc e in which the contour points are
drawn because a contour must be a single continuous line. Loops are created by revisiting previous
points and retracing previous line segments. The sequence should endeavour to minimise the amount of
retracing.

It is assumed that a contour line is being drawn.

To create a loop by returning to a previous point:
1. Place the cursor at the required end point.

A square is displayed around the point to confirm that it may be selected. 
2. Left-click the point and release the mouse button. 
3. Move the cursor to the required previous point to create the loop, left-c lick and release. 
4. Proceed as defined in Drawing a Basic Contour Line. 
5. Left-click the end point. 

To create a loop by returning to a previous point and then retracing the previous line segment:
1. Place the cursor at the required end point.

A square is displayed around the point to confirm that it may be selected. 
2. Left-click the point and release the mouse button. 
3. Move the cursor to the required previous point to create the loop, left-c lick and release. 
4. While still in draw mode, move the cursor back to the end point, left-clic k and release. 
5. Proceed as defined in Drawing a Basic Contour Line. 
6. Left-click the end point. 

Note: If step 4 is performed in drag mode, rather than draw mode, the line just drawn is removed rather
than retraced. It is possible to return to the original end point in drag mode, but it has to be done via a
different route, as shown below.
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1. Place the cursor at the required end point.
A square is displayed around the point to confirm that it may be selected. 

2. Left-click the point and release the mouse button. 
3. Move the cursor to the required previous point to create the loop, left-c lick and release. 
4. Left-click the current point and drag the c ursor along a previously drawn line segment, left-click

and release. 
5. Repeat the previous step until the starting point in step 1 is reac hed. 
6. Proceed as defined in Drawing a Basic Contour Line. 
7. Left-click the end point. 

Note: Having retraced a line segment, there are two superimposed lines joining the two points. You may
drag either, or both in turn, to a new position, as described in Adding a Point to the Middle of a Contour ,
thus creating another closed loop. In the above example this may be done between points 2/5 and 3/6,
and points 3/6 and 4/7.

Deleting the Contour from the Test Contents Window
1. Right-click on the contour.

A pop-up menu is displayed. 
2. Select the Delete option.

A warning message is displayed requesting c onfirmation. 
3. Select the OK button:

The contour is removed from the image and deleted from the Test Contents window. 

Controlling the Display of the Contour
1. Right-click on the contour.

A pop-up menu is displayed. 
2. Select the Enable option to display the contour in the image. 
3. Select the Disable option to remove the contour in the image.

Note: The contour is not deleted from the Test Contents window. Also, the contour definition, i.
e. the list of points, is retained. 

Clearing the Contour from the Image
1. Right-click on the contour.

A pop-up menu is displayed. 
2. Select the Clear option to display the contour in the image.

Note: The contour is not deleted from the Test Contents window, but the contour definition, i.e.
the list of points, is discarded. This enables the contour to be redrawn. 

Undoing the Last Operation
1. Right-click on the contour.

A pop-up menu is displayed. 
2. Select the Undo Last option to display the contour in the image.

The effect of the last operation on the contour is removed.
Note: The undo operation is not recursive, i.e. only the position previous to the last operation is
retained. 

 



p220

© Image Systems AB, 2011

Maintaining Virtual Point Properties
(Optional Feature)
 A Virtual Point is one which position is calculated from the known position of other points in the

image, rather than by measurement. 
 It is typically associated with a Point Group. 
 During tracking, the position of the Virtual Point is calculated from the known positions of the other

points in the group.
 If the Virtual Point is added after tracking or the Virtual Point has been moved, it can be

recalculated by:
o Right-clicking on the Virtual Point in the point list and selecting Recalculate All.
OR
o Right-clicking on the Virtual Point in the Camera View window and selecting Recalculate

All.
 You may specify a Virtual Point as not being part of a point group, but its position must be specified

manually in each tracked image.
 Virtual Points are used in conjunction with contours and point groups. See Groups, Contours and

Virtual Points.

Specifying a Virtual Point

It is assumed that a point group has been established into which the virtual point is to be placed. 
1. Add a new point to the Test Contents. 
2. Specify the properties of the new point , setting the Tracking method to "Virtual". 
3. Mark the position of the new point in the first image to be tracked. 
4. Add the new point to the appropriate point group . 

See Also...

Point Setup dialog
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Presentation

Specifying an XT Diagram
Function
XT diagrams are used to plot a physical distance, speed or acceleration against time. Although it is
referred to as an XT diagram, either the x or y dimension can be plotted. In addition, "absolute pixel
coordinate/speed/acceleration" can be selected, which plots the hypotenuse from  the origin to the point

(x,y), i.e. .

Procedure
1. To setup the diagram:

o Select the New/  XT Diagram option from the Diagram menu.
OR
o Click the  tool in the toolbar.

The XT Diagram is displayed. 

2. To open the diagram properties dialog:

o Select the Properties option from the Edit menu.
OR
o Right-click in the diagram and select the Properties option from the pop-up menu.

The XT Diagram Properties dialog is displayed. 
The items from the Test Contents window that can be presented in an XT diagram  are displayed
in a similar structure in the Data Selection list. The items in the Data Selection list can be
sorted by Name or Group.

3. Set the diagram properties according to the preferences described below:

o Open the diagram properties dialog, if not already open.
o Select appropriate tab (Curves, Text Boxes) or Properties.
o Set the appropriate diagram properties, the changes will be implemented directly in the

diagram.
o Click the OK button when ready. 

Note; an error message telling what is wrong will appear in the diagram if it has been incorrectly
specified.

Diagram Properties dialog - Curves tab

4. To add data to the diagram:

o Optional: The Section drop box is where you select from which section to add data into
diagram. The list in the  Data Selection frame will display the data from the selected section
only. To be able to add data from any section in test, selec t <Any> in the section drop box.
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Then all data in test will be present in the data selection fram e at the same time.
   

o Select the desired item in the Data Selection frame. 
o Select the Add button. The item is transferred to the list of selected items in the Curves

frame. 
OR
o Enable the Auto Select check box. Then all available data will be added to the diagram  at

once. The Auto Select function will be disabled automatically if any data is added or removed
from the Column list in the Properties dialog.

OR
o Use "Drag-and-drop" (without opening the Properties dialog) simply by dragging the items

from the Test Contents window and dropping them in the diagram. It is possible to add
points, distances, angles and stick figures to diagram.

5. To remove data from the diagram:

o Select the Remove button.
OR 
o Right-click the item and select Remove Selected

 
The item is transferred to the Data Selection frame.

6. To change colour of any added curve item:
 

o Right-click the Colour or Alt Colour (representing interpolated points) and select the required
colour from the list displayed.

7. To turn on and off the display of the curve before and/or after the current tim e:
Note: The default is to display for the whole time range.

o To plot the curve before the current time, enable the Show before Now Check box.
o To plot the curve after the current time, enable the Show After Now Check box.

Note: De-selecting both check boxes displays only for the current tim e. Adjusting the current time
with the slider moves these points around the screen.

8. To display Accuracy (if any) of the data selected into the diagram :

o Enable the Show Accuracy check box.

9. To specify the diagram type:

o Select the required type from the Plot drop-down list.

10. To specify the Plot component:

o Select the required component from the Plot component drop-down list.

Note: The list contains an 'abs. xxxx' option, depending on the nature of the selected item , to
enable you to plot its absolute value. 

11. To specify the Coordinate system:

o Select  the required system from the drop-down list.
 

The default is the image coordinate system, which has the origin at the lower left corner of the
used image. If more than this coordinate system has been set up in the Scaling/Coordinate
Systems setup, such can also be used here. 
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The XT diagram will present the data according to the set c oordinate system at all times.

12. To compare two or more curves displayed in the same diagram: 

o Enable the Compare Curves check box.
 

o Key the required comparison Time, acknowledging the appropriate unit.
OR
o Select the button to set the time to t0.

 
o Key the required comparison Y value.
o The curves are adjusted so that they all use the specified Time and Y values as the origin. 

Diagram Properties dialog - Text Boxes tab

13. To insert a Text Box into the diagram:

o Click the Add button to get to the Text Box setup dialog.  
o When a text box is inserted in the list;

 Right clicking in the Name column will present a small right click menu from which the
properties dialog can be reached or the text box removed.

 Right clicking in the Colour column will make it possible to change the text colour.
 Right clicking in the Background column will make it possible to change the

background colour.
 Right clicking in the Border column will make it possible to change the text box border

colour.
o Delete a Text box from the list by marking in the list and click Remove.

Diagram Properties dialog - Properties

14. To specify the axes properties:

o Select the Axes button. 
o Key appropriate axes properties.

15. To specify the filter properties:
 
o Select the Filter button. 
o Key appropriate filter properties.

16. To specify the general properties:

o Select the General button. 
o Key appropriate general properties.

17. To add a corridor from an external file:

o Select the Add Corridor button. 

18. To specify corridors known to the system:

o Select the Corridors button.  

Right Click Menu
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Note; right clicking the XT diagram will offer fast access to a number of functions:
 
 Properties
 Zoom tool
 Selection Tool
 Distance Measurement tool
 Angle Measurement tool
 Show all  - will display the diagram in zoom 1:1. 
 Grid
 Legends
 Legends Settings
 Export Images
 Print - Prints the diagram.
 Copy - Copies the diagram to the clipboard.
 Paste -  Pastes the selected data into any appropriate applic ation.
 Create Diagram Copy - Creates an editable c opy of the existing diagram, any changes as desc ribed

above can be made without changing the original diagram.
 Copy to Time Table - Creates a copy of the contents of the current diagram , showing selected data in

table form. 

See also..

Multi Axis Diagram
XY Diagram
Advanced Diagram
3D Diagram
Image Diagram
Frequency Analysis Diagram
Managing Diagrams via Test Contents
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Multi Axis Diagram
Function
Multi Axis diagrams are similar to XT diagrams except that up to four different Y axes can be selected, i.
e. up to four different plots can be displayed in the sam e diagram. For example, the x, y and "absolute
pixel coordinate" values can be displayed in the sam e diagram.

Procedure
1. To setup the diagram:

o Select the New/  Multi Axis Diagram option from the Diagram menu.
OR
o Click the  tool in the toolbar.

The Multi Axis Diagram is displayed. 

2. To open the diagram properties dialog:

o Select the Properties option from the Edit menu.
OR
o Right-click in the diagram and select the Properties option from the pop-up menu.

The Multi Axis Diagram Properties dialog is displayed. 
The items from the Test Contents window that can be presented in an Multi Axis diagram
diagram are displayed in a similar structure in the Data Selection list. The items in the Data
Selection list can be sorted by Name or Group.

Note: This dialog is the same as the XT Diagram equivalent except that the Curves frame
contains four tabs, one for each of the possible Y axes. Each tab c ontains the same information as
the Curves frame in the XT Diagram equivalent.

3. Set the diagram properties according to the preferences described below:

o Open the diagram properties dialog, if not already open.
o Select appropriate tab (Curves, Text Boxes) or Properties.
o For each required Y axis, select the appropriate Y-Axis tab.
o Set the appropriate diagram properties, the changes will be implemented directly in the

diagram.
o Click the OK button when ready. 

Note; an error message telling what is wrong will appear in the diagram if it has been incorrectly
specified.

Diagram Properties dialog - Curves tab

4. To add data to the diagram:

o Optional: The Section drop box is where you select from which section to add data into
diagram. The list in the  Data Selection frame will display the data from the selected section
only. To be able to add data from any section in test, selec t <Any> in the section drop box.
Then all data in test will be present in the data selection fram e at the same time.
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o Select the item in the Data Selection frame.
o Select the Add button. The item is transferred to the list of selected items in the Curves

frame.
 OR
o Enable the Auto Select check box. Then all available data will be added to the diagram  at

once. The Auto Select function will be disabled automatically if any data is added or removed
from the Column list in the Properties dialog.

OR
o Use "Drag-and-drop" (without opening the Properties dialog) simply by dragging the items

from the Test Contents window and dropping them in the diagram. It is possible to add
points, distances, angles and stick figures to diagram.

5. To remove an item from the diagram:

o Select the Remove button.
OR 
o Right-click the item and select Remove Selected.

The item is transferred to the Data Selection frame.

6. To change colour of any added curve item:
 

o Right-click the Colour or Alt Colour (representing interpolated points) and select the required
colour from the list displayed.

 
7. To turn on and off the display of the curve before and/or after the current tim e:

Note: The default is to display for the whole time range.

o To plot the curve before the current time, enable the Show before Now Check box.
o To plot the curve after the current time, enable the Show After Now Check box.

Note: De-selecting both check boxes displays only for the current tim e. Adjusting the current time
with the slider moves these points around the screen.

8. To display Accuracy (if any) of the data selected into the diagram :

o Enable the Show Accuracy check box.

9. To specify the diagram type:

o Select the required type from the Plot drop-down list.
 
10. To specify the Plot component:

o Select the required component from the Plot component drop-down list.

Note: The list contains an 'abs. xxxx' option, depending on the nature of the selected item , to
enable you to plot its absolute value.  

11. To specify the Coordinate system:

o Select  the required system from the drop-down list.
 

The default is the image coordinate system, which has the origin at the lower left corner of the
used image. If more than this coordinate system has been set up in the Scaling/Coordinate
Systems setup, such can also be used here. 

The XT diagram will present the data according to the set c oordinate system at all times.
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12. To compare two or more curves displayed in the same diagram: 

o Enable the Compare Curves check box.
 

o Key the required comparison Time, acknowledging the appropriate unit.
OR
o Select the button to set the time to t0.

 
o Key the required comparison Y value.
o The curves are adjusted so that they all use the specified Time and Y values as the origin. 

Diagram Properties dialog - Text Boxes tab

13. To insert a Text Box into the diagram:

o Click the Add button to get to the Text Box setup dialog.  
o When a text box is inserted in the list;

 Right clicking in the Name column will present a small right click menu from which the
properties dialog can be reached or the text box removed.

 Right clicking in the Colour column will make it possible to change the text colour.
 Right clicking in the Background column will make it possible to change the

background colour.
 Right clicking in the Border column will make it possible to change the text box border

colour.
o Delete a Text box from the list by marking in the list and click Remove.

Diagram Properties dialog - Properties

14. To specify the axes properties:

o Select the Axes button. 
o Key appropriate axes properties.

15. To specify the filter properties:
 
o Select the Filter button. 
o Key appropriate filter properties.

16. To specify the general properties:

o Select the General button. 
o Key appropriate general properties.

17. To add a corridor from an external file:

o Select the Add Corridor button. 

18. To specify corridors known to the system:

o Select the Corridors button.  

Right Click Menu

Note; right clicking the Multi Axis Diagram will offer fast acc ess to a number of functions:
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 Properties
 Zoom tool
 Selection Tool
 Distance Measurement tool
 Angle Measurement tool
 Show all  - will display the diagram in zoom 1:1. 
 Grid
 Legends
 Legends Settings
 Export Images
 Print - Prints the diagram.
 Copy - Copies the diagram to the clipboard.
 Paste - Pastes the selected data into any appropriate applic ation.
 Create Diagram Copy - Creates an editable c opy of the existing diagram, any changes as desc ribed

above can be made without changing the original diagram.
 Copy to Time Table - Creates a copy of the contents of the current diagram , showing selected data in

table form. 

See also..

XT Diagram
XY Diagram
Advanced Diagram
3D Diagram
Image Diagram
Frequency Analysis Diagram
Managing Diagrams via Test Contents
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Specifying an XY Diagram
Function
XY diagrams are similar to XT diagrams except that time is not used as the default dimension on the x-
axis, i.e. the x-axis can be specified in the same way as the y- axis in XT diagram. For example, for a
point or group of points, the x-direction acceleration can be plotted against the y-direction acc eleration.
The results from an airbag (outline) tracker can also be displayed here. 

Procedure
1. To setup the diagram:

o Select the New/  XY Diagram option from the Diagram menu.
OR
o Click the  tool in the toolbar.

The XY Diagram is displayed. 

2. To open the diagram properties dialog:

o Select the Properties option from the Edit menu.
OR
o Right-click in the diagram and select the Properties option from the pop-up menu.

The XY Diagram Properties dialog is displayed. 
The items from the Test Contents window that can be presented in an XY diagram  are displayed
in a similar structure in the Data Selection list. The items in the Data Selection list can be
sorted by Name or Group. 

3. Set the diagram properties according to the preferences described below:

o Open the diagram properties dialog, if not already open.
o Select appropriate tab (Curves, Visualizers,Text Boxes) or Properties.
o Set the appropriate diagram properties, the changes will be implemented directly in the

diagram.
o Click the OK button when ready. 

Note; an error message telling what is wrong will appear in the diagram if it has been incorrectly
specified.

Diagram Properties dialog - Curves tab

4. To add data to the diagram:

o Optional: The Section drop box is where you select from which section to add data into
diagram. The list in the  Data Selection frame will display the data from the selected section
only. To be able to add data from any section in test, selec t <Any> in the section drop box.
Then all data in test will be present in the data selection fram e at the same time.

   
o Select the item in the Data Selection frame.
o Select the Add button. The item is transferred to the list of selected items in the Curves

frame.
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OR
o Enable the Auto Select check box. Then all available data will be added to the diagram  at

once. The Auto Select function will be disabled automatically if any data is added or removed
from the Column list in the Properties dialog.

OR
o Use "Drag-and-drop" (without opening the Properties dialog) simply by dragging the items

from the Test Contents window and dropping them in the diagram. It is possible to add
points, distances, angles and stick figures to diagram. 

5. To remove data from the diagram:

o Select the Remove button.
OR 
o Right-click the item and select Remove Selected.

The item is transferred to the Data Selection frame. 

6. To change colour of any added curve item:
 

o Right-click the Colour or Alt Colour (representing interpolated points) and select the required
colour from the list displayed. 

7. To turn on and off the display of the curve before and/or after the current tim e:
Note: The default is to display for the whole time range.

o To plot the curve before the current time, enable the Show before Now Check box.
o To plot the curve after the current time, enable the Show After Now Check box.

Note: De-selecting both check boxes displays only for the current tim e. Adjusting the current time
with the slider moves these points around the screen.

8. To display Accuracy (if any) of the data selected into the diagram :

o Enable the Show Accuracy check box.

9. To specify the type of data to be displayed on the x axis:

o Select the required type from the X list.

Note. This selection automatically changes the entries in the X comp list. 

10. To specify the type of data to be displayed on the y axis:

o Select  the required type from the Y list. 

Note: This selection can automatically change the entries in the Y comp list.

11. To specify the Coordinate system:

o Select  the required system from the drop-down list.
 

The default is the image coordinate system, which has the origin at the lower left corner of the
used image. If more than this coordinate system has been set up in the Scaling/Coordinate
Systems setup, such can also be used here. 

The XY diagram will present the data according to the set c oordinate system at all times.

Diagram Properties dialog - Visualizers tab
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12. Select the Visualizers tab to display the appearance of the airbag tracker.

13. Repeat the same procedure as for the Curves tab.

The differences are: 
o The Alt Colour column does not apply. 
o The Filter column does not apply.
o The Accuracy does not apply.  
o The X and Y lists are not displayed. 
o The frame frequency may be specified in several ways in order to select whic h time frames are

displayed. The options are: 
o "With Skip" - displays frames at the spec ified interval.
o "At current time" -  displays frames at current time.
o "All" - displays all frames. 
o "Dense" - displays a high density of frames, based on position density not time. 
o "Normal" - displays a medium density of frames, based on position density not tim e. 
o "Sparse" - displays a low density of frames, based on position density not time. 

14. To specify the selected X component:

o Select the required component from the X comp list. 

15. To specify the selected Y component:

o Select  the required component from the Y comp list. 

Diagram Properties dialog - Text Boxes tab

16. To insert a Text Box into the diagram:

o Click the Add button to get to the Text Box setup dialog.  
o When a text box is inserted in the list;

 Right clicking in the Name column will present a small right click menu from which the
properties dialog can be reached or the text box removed.

 Right clicking in the Colour column will make it possible to change the text colour.
 Right clicking in the Background column will make it possible to change the

background colour.
 Right clicking in the Border column will make it possible to change the text box border

colour.
o Delete a Text box from the list by marking in the list and click Remove.

Diagram Properties dialog - Properties

17. To specify the axes properties:

o Select the Axes button. 
o Key appropriate axes properties.

18. To specify the filter properties:
 
o Select the Filter button. 
o Key appropriate filter properties.

19. To specify the general properties:

o Select the General button. 
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o Key appropriate general properties.

20. To add a corridor from an external file:

o Select the Add Corridor button. 

21. To specify corridors known to the system:

o Select the Corridors button.  

Right Click Menu

Note; right clicking the XY diagram will offer fast access to a number of functions:
 
 Properties
 Zoom tool
 Selection Tool
 Distance Measurement tool
 Angle Measurement tool
 Show all  - will display the diagram in zoom 1:1. 
 Grid
 Legends
 Legends Settings
 Export Images
 Print - Prints the diagram.
 Copy - Copies the diagram to the clipboard.
 Paste -  Pastes the selected data into any appropriate applic ation.
 Create Diagram Copy - Creates an editable c opy of the existing diagram, any changes as desc ribed

above can be made without changing the original diagram.
 Copy to Time Table - Creates a copy of the contents of the current diagram , showing selected data in

table form. 

See also..

XT Diagram
Multi Axis Diagram
Advanced Diagram
3D Diagram
Image Diagram
Frequency Analysis Diagram
Managing Diagrams via Test Contents
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Specifying an Advanced Diagram
Function
Advanced diagrams are similar to XY diagrams except that data from different sequences can be plotted
in the same diagram.

Procedure
1. To setup the diagram:

o Select the New/  Advanced Diagram option from the Diagram menu.
OR
o Click the  tool in the toolbar.

The Advanced Diagram is displayed. 

2. To open the diagram properties dialog:

o Select the Properties option from the Edit menu.
OR
o Right-click in the diagram and select the Properties option from the pop-up menu.

The Advanced Diagram Properties dialog is displayed. 
The items from the Test Contents window that can be presented in an Advanc ed diagram are
displayed in a similar structure in the Data Selection list. The items in the Data Selection list
can be sorted by Name or Group.

3. Set the diagram properties according to the preferences described below:

o Open the diagram properties dialog, if not already open.
o Select appropriate tab (Curves, Text Boxes) or Properties.
o Set the appropriate diagram properties, the changes will be implemented directly in the

diagram.
o Click the OK button when ready. 

Note; an error message telling what is wrong will appear in the diagram if it has been incorrectly
specified.

Diagram Properties dialog - Curves tab

4. To add data to the diagram:

o Optional: The Section drop box is where you select from which section to add data into
diagram. The list in the  Data Selection frame will display the data from the selected section
only. To be able to add data from any section in test, selec t <Any> in the section drop box.
Then all data in test will be present in the data selection fram e at the same time.

   
o Select the item in the Data Selection frame. 
o Select the Add button. The item is transferred to the list of selected items in the Plot frame. 
OR
o Use "Drag-and-drop" (without opening the Properties dialog) simply by dragging the items

from the Test Contents window and dropping them in the diagram. It is possible to add
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points, distances, angles and stick figures to diagram. 

5. To remove data from the diagram:

o Select the Remove button.
OR 
o Right-click the item and select Remove Selected.

The item is transferred to the Data Selection frame.

6. To change colour of any added curve item:
 

o Right-click the Colour or Alt Colour (representing interpolated points) and select the required
colour from the list displayed. 

7. To turn on and off the display of the curve before and/or after the current tim e:
Note: The default is to display for the whole time range.

o To plot the curve before the current time, enable the Show before Now Check box.
o To plot the curve after the current time, enable the Show After Now Check box.

Note: De-selecting both check boxes displays only for the current tim e. Adjusting the current time
with the slider moves these points around the screen.

8. To display Accuracy (if any) of the data selected into the diagram :

o Enable the Show Accuracy check box.

9. To specify the diagram components:

o Amend the entries in the Plot frame.

Note: Certain amendments that you might make may prevent partic ular items from being
displayed in the diagram. A typical example of this is when the selec ted X Plot or Y Plot entry for
an item, e.g. acceleration, does not apply to another item, e.g. if velocity has been selected for it.
Items that can be displayed automatically are indicated with by a green tick in the OK column,
whereas those that cannot are indicated with by a red cross.

o The Plot table has the following columns that may be amended as follows: 
 OK - Right-click and select:

 Draw - to force the selected item  to be drawn in the diagram when it normally
would not be displayed. The axis is amended accordingly. 

 Remove selected - to remove the item from the diagram. 
 X View - Right-click and select: 

 Draw - to force the selected item  to be drawn in the diagram when it normally
would not be displayed. The axis is amended accordingly. 

 Remove selected - to remove the item from the diagram. 
 X Point - Right-click and select:

 Select Point to display the Select X Point dialog from which another item can
be selected from the Test Contents window. 

 X Plot -  Right-click and select the plot from the list:
 e.g. pixel coordinates. 
 e.g. pixel velocity. 
 e.g. pixel acceleration. 

 X Comp - Right-click and select the component from the list:
 e.g. x.
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 e.g. y.
Note: The list contains an 'abs. xxxx' option, depending on the nature of the selected
item, to enable you to plot its absolute value. 

 Y View - Right-click and select: 
 Draw - to force the selected item  to be drawn in the diagram when it normally

would not be displayed. The axis is amended accordingly. 
 Remove selected - to remove the item from the diagram. 

 Y Point - Right-click and select:
 Select Point to display the Select Y Point dialog from which another item can

be selected from the Test Contents window. 
 Y Plot - Right-click and select the plot from the list:

 e.g. 2D pixel coordinates.
 e.g. pixel velocity.
 e.g. pixel acceleration. 

 Y Comp - Right-click and select the component from the list:
 e.g. x.
 e.g. y.

Note: The list contains an 'abs. xxxx' option, depending on the nature of the selected
item, to enable you to plot its absolute value. 

 Colour - Right-click and select the required colour from the list displayed.
 Alt Colour - Right-click and select the required colour from the list displayed. 
 Filter - Select the check box to apply the selected filter to this item . 

10. To specify the Coordinate system:

o Select  the required system from the drop-down list.
 

The default is the image coordinate system, which has the origin at the lower left corner of the
used image. If more than this coordinate system has been set up in the Scaling/Coordinate
Systems setup, such can also be used here. 

The Advanced diagram will present the data according to the set coordinate system  at all times.

Diagram Properties dialog - Text Boxes tab

11. To insert a Text Box into the diagram:

o Click the Add button to get to the Text Box setup dialog.  
o When a text box is inserted in the list;

 Right clicking in the Name column will present a small right click menu from which the
properties dialog can be reached or the text box removed.

 Right clicking in the Colour column will make it possible to change the text colour.
 Right clicking in the Background column will make it possible to change the

background colour.
 Right clicking in the Border column will make it possible to change the text box border

colour.
o Delete a Text box from the list by marking in the list and click Remove.

Diagram Properties dialog - Properties

12. To specify the axes properties:

o Select the Axes button. 
o Key appropriate axes properties.
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13. To specify the filter properties:
 
o Select the Filter button. 
o Key appropriate filter properties.

14. To specify the general properties:

o Select the General button. 
o Key appropriate general properties.

15. To add a corridor from an external file:

o Select the Add Corridor button. 

16. To specify corridors known to the system:

o Select the Corridors button.  

Right Click Menu

Note; right clicking the Advanced diagram will offer fast access to a number of functions:
 
 Properties
 Zoom tool
 Selection Tool
 Distance Measurement tool
 Angle Measurement tool
 Show all  - will display the diagram in zoom 1:1. 
 Grid
 Legends
 Legends Settings
 Export Images
 Print - Prints the diagram.
 Copy - Copies the diagram to the clipboard.
 Paste -  Pastes the selected data into any appropriate applic ation.
 Create Diagram Copy - Creates an editable c opy of the existing diagram, any changes as desc ribed

above can be made without changing the original diagram.
 Copy to Time Table - Creates a copy of the contents of the current diagram , showing selected data in

table form. 

See also..

XT Diagram
Multi Axis Diagram
XY Diagram
3D Diagram
Image Diagram
Frequency Analysis Diagram
Managing Diagrams via Test Contents
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3D Diagram 
Function
3D diagrams are used to display 3D data in a rotatable 3 axis diagram. 

 

Procedure
1. To setup the diagram:

o Select the New/  3D Diagram option from the Diagram menu.
OR
o Click the  tool in the toolbar.

The 3D Diagram is displayed. 

2. To open the diagram properties dialog:

o Select the Properties option from the Edit menu.
OR
o Right-click in the diagram and select the Properties option from the pop-up menu.

The 3D Diagram Properties dialog is displayed. 
The items from the Test Contents window that can be presented in an 3D diagram are displayed
in a similar structure in the Data Selection list. The items in the Data Selection list can be
sorted by Name or Group.

3. Set the diagram properties according to the preferences described below:

o Open the diagram properties dialog, if not already open.
o Select appropriate tab (Curves, Visualizers, Text Boxes) or Properties.
o Set the appropriate diagram properties, the changes will be implemented directly in the

diagram.
o Click the OK button when ready. 

Note; an error message telling what is wrong will appear in the diagram if it has been incorrectly
specified.

Diagram Properties dialog - Curves tab

4. To add data to the diagram:

o Optional: The Section drop box is where you select from which section to add data into
diagram. The list in the  Data Selection frame will display the data from the selected section
only. To be able to add data from any section in test, selec t <Any> in the section drop box.
Then all data in test will be present in the data selection fram e at the same time.

o Select the desired item in the Data Selection frame. 
o Select the Add button. The item is transferred to the list of selected items in the Curves

frame. 
OR
o Enable the Auto Select check box. Then all available data will be added to the diagram  at

once. The Auto Select function will be disabled automatically if any data is added or removed
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from the Column list in the Properties dialog.
OR
o Use "Drag-and-drop" (without opening the Properties dialog) simply by dragging the items

from the Test Contents window and dropping them in the diagram. It is possible to add
points, distances, angles and stick figures to diagram. 

5. To remove data from the diagram:

o Select the Remove button.
OR
o Right-click the item and select Remove Selected.
 
The item is transferred to the Data Selection frame.

 
6. To change colour of any added curve item:

 
o Right-click the Colour or Alt Colour (representing interpolated points) and select the required

colour from the list displayed.

7. To turn on and off the display of the curve before and/or after the current tim e:
Note: The default is to display for the whole time range.

o To plot the curve before the current time, enable the Show before Now Check box.
o To plot the curve after the current time, enable the Show After Now Check box.

Note: De-selecting both check boxes displays only for the current tim e. Adjusting the current time
with the slider moves these points around the screen.

8. To display Accuracy (if any) of the data selected into the diagram :

o Enable the Show Accuracy check box.

In 3D, this will be shown as spheres.

9. To specify the Coordinate system:

o Select  the required system from the drop-down list.
 

The default is the image coordinate system, which has the origin at the lower left corner of the
used image. If more than this coordinate system has been set up in the Scaling/Coordinate
Systems setup, such can also be used here. 

The 3D diagram will present the data according to the set c oordinate system at all times.

Diagram Properties dialog - Visualizers tab

10. Select the Visualizers tab to display the appearance of the stick figures, distances, angles and
axes in the 3D diagram.

11. Repeat the same procedure as for the Curves tab.

The differences are: 
o The Alt Colour column does not apply. 
o The Filter column does not apply.
o The Accuracy does not apply.  
o The frame frequency may be specified in several ways in order to select whic h time frames are

displayed. The options are: 
o "With Skip" - displays frames at the spec ified interval.
o "At current time" -  displays frames at current time.
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o "All" - displays all frames. 
o "Dense" - displays a high density of frames, based on position density not time. 
o "Normal" - displays a medium density of frames, based on position density not tim e. 
o "Sparse" - displays a low density of frames, based on position density not time. 

Diagram Properties dialog - Text Boxes tab

12. To insert a Text Box into the diagram:

o Click the Add button to get to the Text Box setup dialog.  
o When a text box is inserted in the list;

 Right clicking in the Name column will present a small right click menu from which the
properties dialog can be reached or the text box removed.

 Right clicking in the Colour column will make it possible to change the text colour.
 Right clicking in the Background column will make it possible to change the

background colour.
 Right clicking in the Border column will make it possible to change the text box border

colour.
o Delete a Text box from the list by marking in the list and click Remove.

Diagram Properties dialog - Properties

13. To specify the axes properties:

o Select the Axes button. 
o Key appropriate axes properties.

14. To specify the filter properties:
 
o Select the Filter button. 
o Key appropriate filter properties.

15. To specify the general properties:

o Select the General button. 
o Key appropriate general properties.

Rotation tool / Select tool

When the 3D diagram is set up; 
 

16. Dragging the mouse pointer over the 3D diagram area, will activate the rotate tool. With the use
of this, the 3D diagram can be rotated and viewed from any desired angle. Holding the left mouse
button while dragging will enable the tool. To rotate the camera around its horizontal- and up
vector, drag the mouse while holding the left mouse button. To rotate the cam era around its
forward (principal) vector, hold shift while rotating. 

17. The mouse scroll wheel is used to zoom in and out in diagram.
When the select tool is active, double c licking a curve will make the 3D box to enclose only the
part of the curve(s) visible in the current zoom view. To get bac k to normal mode, right click the
diagram and select Show All.  

18. When middle mouse button or when left mouse button and ctrl is pressed at the sam e the
panning tool is activated enabling the user to m ove the position of the diagram in the window and
can also be used if the user wants to zoom  in on different parts of the diagram. Panning will be
restored to its original position when zoom in/out using right c lick or normal menu or toolbar
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item, or when Go to Default, X-Y, …

19. Position the pointer on or close to a plotted curve to make the Rotate tool automatically change to
the Select Tool in order to display the curve coordinates. At any time, the pointer can be moved
away from the curve to reactivate the rotate tool again.

20. When the select tool is active, double c licking a curve will make the 3D box to enclose only the
part of the curve(s) visible in the current zoom view. To get bac k to normal mode, right click the
diagram and select Show All. 

Right Click Menu

Note; right clicking the 3D diagram will offer fast access to a number of functions:
 
 Properties - Goes to the diagram setup.
 Show All - Puts the zoom mode back in normal view in order to show all data in diagram .
 Camera - Presets perspectives for reviewing data in diagram a suitable overview perspective

(Default) or any of the base planes:
o Go to Default.
o Go to X-Y Plane.
o Go to X-Z Plane.
o Go to Y-Z Plane.

 Curtains -  It is possible to draw curtains to the plotted curves in the 3D diagram . 
 Curtain settings - To orient the curtain, a Curtain Plane has to be defined. The curtain is an

orthogonal projection on the defined curtain plane. This feature is an excellent tool for reading the
diagram axes without having to use the rotation tool. Therefore, it should always be enabled on
printouts and screen shots.

 Arrow Settings
o Show - Shows or hides the x-,y- and z-axis.
o Colour - To change the colour of the x-,y- and z-axis.  

 Grid
 Legends
 Legends Settings
 Export Images
 Print - Prints the diagram.
 Copy - Copies the diagram to the clipboard.
 Paste -  Pastes the selected data into any appropriate applic ation.
 Create Diagram Copy - Creates an editable c opy of the existing diagram, any changes as desc ribed

above can be made without changing the original diagram.
 Copy to Time Table - Creates a copy of the contents of the current diagram , showing selected data in

table form. 

See also..

XT Diagram
Multi Axis Diagram
XY Diagram
Advanced Diagram
Image Diagram
Frequency Analysis Diagram
Managing Diagrams via Test Contents
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Image Diagram
Function
Image diagrams in TEMA are a mixture between XY and camera view windows - a plotted curve c an be
superimposed on the image. Using Image Merge, several image sequences can be displayed in one image
diagram simultaneously. 

Procedure
1. To setup the diagram:

o Select the New/  Image Diagram option from the Diagram menu.
OR
o Click the  tool in the toolbar.

The Image Diagram is displayed.
 

2. To open the diagram properties dialog:

o Select the Properties option from the Edit menu.
OR
o Right-click in the diagram and select the Properties option from the pop-up menu.

The Image Diagram Properties dialog is displayed. 
The camera views from the Test Contents are listed in the Data Selection list together with the
corresponding image sequences. The items in the Data Selection list can be sorted by Name or
Group.

3. Set the diagram properties according to the preferences described below:

o Open the diagram properties dialog, if not already open.
o Select appropriate tab (Images, Curves, Visualizers, Text Boxes) or Properties.
o Set the appropriate diagram properties, the changes will be implemented directly in the

diagram.
Note; an error message telling what is wrong will appear in the diagram if it has been
incorrectly specified.

4. To specify the Coordinate system:

o Select  the required system from the drop-down list.
 

The default is the image coordinate system, which has the origin at the lower left corner of the
used image. If more than this coordinate system has been set up in the Scaling/Coordinate
Systems setup, such can also be used here. 

The Image diagram will present the data according to the set c oordinate system at all times.

5. To correct for image distortion (Optional):

o Enable Lens Correction.
Note; only possible if the Camera Parameter Correct Lens Distortion is enabled in the
camera View Properties.
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o Enable Inscribed, to inscribe/circumscribe the image.

6. Click the OK button when ready. 

Diagram Properties dialog - Images tab

7. To add an Image sequence to the diagram:

o Select the item in the Data Selection frame. 
o Select the Add button.
o The image is transferred to the list of selec ted items in the Images frame. At the same time,

the first sample of the image sequence can be seen in the image diagram window.
 

8. To display a merged image, i.e two image sequences displayed in the diagram:
o Repeat the procedure "To add an Image sequence".
o Click the Align button.

9. To remove an Image sequence from the diagram:

o Select the Remove button.
OR
o Right-click the item and select Remove Selected.
 
The item is transferred to the Data Selection frame.

 
 

Diagram Properties dialog - Curves tab

10. To add a Curve, superimposed on the image:

o Optional: The Section drop box is where you select from which section to add data into
diagram. The list in the  Data Selection frame will display the data from the selected section
only. To be able to add data from any section in test, selec t <Any> in the section drop box.
Then all data in test will be present in the data selection fram e at the same time.

   
o Select the item in the Data Selection frame. 
o Select the Add button. The item is transferred to the list of selected items in the Curves

frame. 
OR
o Enable the Auto Select check box. Then all available data will be added to the diagram  at

once. The Auto Select function will be disabled automatically if any data is added or removed
from the Column list in the Properties dialog.

OR
o Use "Drag-and-drop" (without opening the Properties dialog) simply by dragging the items

from the Test Contents window and dropping them in the diagram. It is possible to add
points, distances, angles and stick figures to diagram. 

11. To remove data from the diagram:
 

o Select the Remove button.
OR
o Right-click the item and select Remove Selected.
 
The item is transferred to the Data Selection frame. 

12. To change colour of any added curve item:
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o Right-click the Colour or Alt Colour (representing interpolated points) and select the required
colour from the list displayed.

13. To turn on and off the display of the curve before and/or after the current tim e:
Note: The default is to display for the whole time range.

o To plot the curve before the current time, enable the Show before Now Check box.
o To plot the curve after the current time, enable the Show After Now Check box.

Note: De-selecting both check boxes displays only for the current tim e. Adjusting the current time
with the slider moves these points around the screen.

14. To display Accuracy (if any) of the data selected into the diagram :

o Enable the Show Accuracy check box.

Diagram Properties dialog - Visualizers tab

15. Select the Visualizers tab to display the appearance of Visualizers (for example the airbag tracker
).

16. Repeat the same procedure as for the Curves tab.

The differences are: 
o The Alt Colour column does not apply. 
o The Filter column does not apply.
o The Accuracy does not apply.  
o The frame frequency may be specified in several ways in order to select whic h time frames are

displayed. The options are: 
o "With Skip" - displays frames at the spec ified interval.
o "At current time" -  displays frames at current time.
o "All" - displays all frames. 
o "Dense" - displays a high density of frames, based on position density not time. 
o "Normal" - displays a medium density of frames, based on position density not tim e. 
o "Sparse" - displays a low density of frames, based on position density not time. 

Diagram Properties dialog - Text Boxes tab

17. To insert a Text Box into the diagram:

o Click the Add button to get to the Text Box setup dialog.  
o When a text box is inserted in the list;

 Right clicking in the Name column will present a small right click menu from which the
properties dialog can be reached or the text box removed.

 Right clicking in the Colour column will make it possible to change the text colour.
 Right clicking in the Background column will make it possible to change the

background colour.
 Right clicking in the Border column will make it possible to change the text box border

colour.
o Delete a Text box from the list by marking in the list and click Remove.

Diagram Properties dialog - Properties

18. To specify the axes properties:

o Select the Axes button. 
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o Key appropriate axes properties.

19. To specify the filter properties:
 
o Select the Filter button. 
o Key appropriate filter properties.

20. To specify the general properties:

o Select the General button. 
o Key appropriate general properties.

21. To add a corridor from an external file:

o Select the Add Corridor button. 

22. To specify corridors known to the system:

o Select the Corridors button.

23. To merge images in the diagram:

o Click the Align button.
  

Right Click Menu

Note; right clicking the Image diagram will offer fast access to a number of functions besides the
Properties described above; 

 Properties
 Zoom tool
 Selection Tool
 Distance Measurement tool
 Angle Measurement tool
 Show all  - will display the diagram in zoom 1:1. 
 Legends
 Legends Settings
 Export Images
 Print - Prints the diagram.
 Copy - Copies the diagram to the clipboard.
 Paste -  Pastes the selected data into any appropriate applic ation.
 Create Diagram Copy - Creates an editable c opy of the existing diagram, any changes as desc ribed

above can be made without changing the original diagram.
 Copy to Time Table - Creates a copy of the contents of the current diagram , showing selected data in

table form. 

See also..

XT Diagram
Multi Axis Diagram
XY Diagram
Advanced Diagram
3D Diagram
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Frequency Analysis Diagram
Managing Diagrams via Test Contents
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Image Merge
Function
The function enables simultaneous display of two image sequences in the same image diagram. This
prerequisites that a 2D coordinate transformation is done. 
By a graphical Align interface, this is easily done. By the help of this, an im age sequence is oriented and
scaled versus another.
 
In the image diagram, the image merging can be displayed in three ways; 

 Overlay - added images are placed on top of each other and are non- transparent. The order of the
images is defined when adding the images into diagram.  

 Blend - the added images are blended into each other, resulting in a m ixture of the images in
diagram. Every pixel in the resulting image is an average of the two c ontained images. 

 Interlace - the added images are interlaced into each other. The (horizontal) scan lines in each
contained image are mixed subsequently. Thus, the resulting image has its scan lines as taken from
the contained images in order. 

After the image merging, tracked points in any of the image sequences can be superimposed on the
merged image in diagram.   
 

Procedure
The following prerequisites that steps 1-3 in the image diagram setup have been completed.  

1. Add a second image sequence into the image diagram. This will make the Align button to the right to
be enlighten. Below the list of added image sequences is the Coordinate System combo box. This will
tell which coordinate system that is used. This is always that of the first im age in the images list. 
Thus, the second image will be oriented in this also. To change the coordinate system to that of the
second image sequence, remove both sequences and add them again in reverse order (double click in
left list will add a sequence to diagram).

2. Click the Align button. This will make the Aligned Coordinate Systems dialog to appear. In this,
define the coordinate system transformation for the desired orientation of the images to merge. 

 
3. In the list of image sequences, right click the second image sequence and selec t Properties. This will 

make the Image Merge Properties dialog to appear. In this, select the merge method; Overlay,
Blend or Interlace (as described above). The selected method will be stated in the images list. 

4. Set Image Tint to use a color marking; values below zero will mark any field in primary image that
is darker than the second with a yellow color and blue color for fields lighter. Values above zero will
result in the opposite colors. The tint color marking will be active even though Overlay merge (non
transparent images) is used.  The tint value will be stated in the im ages list also. 

5. If desired, add tracker data (if any) just like in any image diagram, click the curves tab and add
curves. 

See also..

Image Diagram
Scaling and Coordinate Systems



p248

© Image Systems AB, 2011

 



p249

© Image Systems AB, 2011

Specifying an Frequency Analysis
Diagram
Function
The Frequency Analysis function analyzes a signal (such as trac ked
coordinates, a computed angle, or imported measurement data) and
plots a curve that shows the signal's relative strength at different
frequencies. This curve is called an amplitude spectrum.
For multi-dimensional data (such as position c oordinates) a separate
spectrum is calculated for each component, as well as for the absolute value of the quantity.

The frequency analysis function appears as a spec ial kind of diagram
called a Frequency Analysis diagram. Such diagrams can be added
from the Diagram menu in the main window, or by pressing a button
on the Data toolbar. Adding a new Frequency Analysis diagram  will
open a new, empty diagram.

The setup dialog for the Frequenc y Analysis diagram is very similar to
that of the XT or XY diagrams, with the following differences:

* The X axis will always display frequency so there is no choice of X
  component. 

* The checkboxes for "show before now" and "show after now" are absent
  as the spectrum is always computed for the entire time span of the
  data.

* It is possible to mix different kinds of data in a more flexible way
  than for the other diagrams. For example, you can show the spectrum
  of an angle and a position in the same diagram.

Note: The spectrum will never contain any frequency higher than half
the sampling frequency of the input data. For example, if the image
frequency is 1000 Hz, the spectrum ends at 500 Hz. This is a
fundamental mathematical property of sampled signals known as the
sampling theorem (see any textbook on signals proc essing, or Wikipedia).

Procedure
4. To setup the diagram:

o Select the New/  Frequency Analysis Diagram option from the Diagram menu.
OR
o Click the  tool in the toolbar.

The Frequency Analysis Diagram is displayed. 

2. To open the diagram properties dialog:

o Select the Properties option from the Edit menu.
OR
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o Right-click in the diagram and select the Properties option from the pop-up menu.

The Frequency Analysis Diagram Properties  dialog is displayed. 
The items from the Test Contents window that can be presented in an Frequenc y Analysis
diagram are displayed in a similar structure in the Data Selection list. The items in the Data
Selection list can be sorted by Name or Group.

3. Set the diagram properties according to the preferences described below:

o Open the diagram properties dialog, if not already open.
o Select appropriate tab (Curves, Text Boxes) or Properties.
o Set the appropriate diagram properties, the changes will be implemented directly in the

diagram.
o Click the OK button when ready. 

Note; an error message telling what is wrong will appear in the diagram if it has been incorrectly
specified.

Diagram Properties dialog - Curves tab

4. To add data to the diagram:

o Optional: The Section drop box is where you select from which section to add data into
diagram. The list in the  Data Selection frame will display the data from the selected section
only. To be able to add data from any section in test, selec t <Any> in the section drop box.
Then all data in test will be present in the data selection fram e at the same time.

   
o Select the desired item in the Data Selection frame. 
o Select the Add button. The item is transferred to the list of selected items in the Curves

frame. 
OR
o Enable the Auto Select check box. Then all available data will be added to the diagram  at

once. The Auto Select function will be disabled automatically if any data is added or removed
from the Column list in the Properties dialog.

OR
o Use "Drag-and-drop" (without opening the Properties dialog) simply by dragging the items

from the Test Contents window and dropping them in the diagram. It is possible to add
points, distances, angles and stick figures to diagram.

5. To remove data from the diagram:

o Select the Remove button.
OR 
o Right-click the item and select Remove Selected

 
The item is transferred to the Data Selection frame.

6. To change colour of any added curve item:
 

o Right-click the Colour or Alt Colour (representing interpolated points) and select the required
colour from the list displayed.

7. To turn on and off the display of the curve before and/or after the current tim e:
Note: The default is to display for the whole time range.

o To plot the curve before the current time, enable the Show before Now Check box.
o To plot the curve after the current time, enable the Show After Now Check box.
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Note: De-selecting both check boxes displays only for the current tim e. Adjusting the current time
with the slider moves these points around the screen.

8. To specify the diagram type:

o Select the required type from the Plot drop-down list.

9. To specify the Plot component:

o Select the required component from the Plot component drop-down list.

Note: The list contains an 'abs. xxxx' option, depending on the nature of the selected item , to
enable you to plot its absolute value. 

10. To compare two or more curves displayed in the same diagram: 

o Enable the Compare Curves check box.
 

o Key the required comparison Time, acknowledging the appropriate unit.
OR
o Select the button to set the time to t0.

 
o Key the required comparison Y value.
o The curves are adjusted so that they all use the specified Time and Y values as the origin. 

Diagram Properties dialog - Text Boxes tab

11. To insert a Text Box into the diagram:

o Click the Add button to get to the Text Box setup dialog.  
o When a text box is inserted in the list;

 Right clicking in the Name column will present a small right click menu from which the
properties dialog can be reached or the text box removed.

 Right clicking in the Colour column will make it possible to change the text colour.
 Right clicking in the Background column will make it possible to change the

background colour.
 Right clicking in the Border column will make it possible to change the text box border

colour.
o Delete a Text box from the list by marking in the list and click Remove.

Diagram Properties dialog - Properties

12. To specify the axes properties:

o Select the Axes button. 
o Key appropriate axes properties.

13. To specify the filter properties:
 
o Select the Filter button. 
o Key appropriate filter properties.

14. To specify the general properties:

o Select the General button. 
o Key appropriate general properties.
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15. To add a corridor from an external file:

o Select the Add Corridor button. 

16. To specify corridors known to the system:

o Select the Corridors button.  

Right Click Menu

Note; right clicking the Frequency Analysis diagram will offer fast access to a num ber of functions:
 
 Properties
 Zoom tool
 Selection Tool
 Distance Measurement tool
 Angle Measurement tool
 Show all  - will display the diagram in zoom 1:1. 
 Grid
 Legends
 Legends Settings
 Export Images
 Print - Prints the diagram.
 Copy - Copies the diagram to the clipboard.
 Paste -  Pastes the selected data into any appropriate applic ation.
 Create Diagram Copy - Creates an editable c opy of the existing diagram, any changes as desc ribed

above can be made without changing the original diagram.

See also..

Multi Axis Diagram
XY Diagram
Advanced Diagram
3D Diagram
Image Diagram
Managing Diagrams via Test Contents
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Time Table 
Function
Time Tables are used to display results numerically, typically in support of a graphic al diagram or when
the data is to be exported to another system for storage or further analysis.

Procedure
To match the way different users work, the Time Table has two different setups:

 Simple
 Advanced

The setup is selected by using the tabs in upper left corner of the table setup . 

1. To setup the table:

o Select the New/  Time Table option from the Diagram menu.
OR
o Click the  tool in the toolbar.

The Time Table is displayed.

2. To open the table properties dialog:

o Select the Properties option from the Edit menu.
OR
o Right-click in the table and select the Properties option from the pop-up menu.

The Time Table Properties dialog is displayed.

3. Set the table properties according to the preferences desc ribed below:

o Open the table properties dialog, if not already open.

o Select appropriate tab (Simple, Advanced) or Properties. 
In the Advanced tab the items in the Data Selection list can be sorted by Nam e, Group, Data
Type, Coordinate System or Attributes.

o Set the appropriate table properties, the changes will be im plemented directly in the table.

o Click the OK button when ready. 

Note; an error message telling what is wrong will appear in the table if it has been incorrec tly
specified.

Table Properties dialog - Simple Setup tab

4. Select the Point(s) to add to the Columns list. 

Note; that multi selections can be done here, selec ting points from different trackers. Any
subsequent specification done will affect the whole selection.
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5. Specify what type of Attributes to use for the selected point. 

The range of attributes will depend on the type of point selected, thus, the list will update to
match the range of the selec tion made in the point list. 

Note: If a multi selection has been done, inc luding points from different trackers, the attribute list
will list all available attributes from all selected points. It is therefore important to know what
types of unique data that comes out from the different trackers.

6. Specify also the Time Derivative of the selection. 

The derivatives will be applied on all selected attributes for eac h point. 

7. Specify the Coordinate System to be used when presenting the data selection.
 

o Select from the drop-down list.
 

If more than one system is available in the test, the option All will present the specified data for
each coordinate system in the test.

8. Select the desired Function which will be applied on the data before presentation:

o At Current time will pass the data untouched.  
o The max and min functions will however calculate the extreme values of a sequence before

presentation. Thus, the use of any of those two functions will result in a presentation of data
that is unaffected by the current time. This as it is just one value for all times in a sequence.

9. To add data to the table (there are several alternatives):

o Click the  button (Add button) to insert the data selection in the Colum ns list. 
OR
o If a row in the Columns list is marked and the Add Similar button is clicked, all the available

similar data (same point type from the Points list, as in the selected row) that c an be specified
from the point list will be added to the list autom atically. 

OR
o If at least one data is available in the Columns list, enable the Auto Select check box. Then

all available similar data will be added continuously to the list/table. The Auto Select function
will be disabled automatically if any data is added or removed from the Columns list in the 
Properties dialog.

10. To change the order of the added items in the list:

o Mark an item an move up and down using the up and down buttons  . 

11. To remove an item from the table:

o Select the item in the Columns list. 
o Select the  button (Remove button).

12. To display Accuracy (if any) of the data selected into the table:

o Enable the Show Accuracy check box.

Table Properties dialog - Advanced Setup tab

13. To specify the items displayed in the Data Selection frame:
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o Select the Filtered check box to display filtered items only, otherwise only non-filtered items
are shown. 

o Select the Absolute Value check box to display absolute value items only, otherwise only
non-absolute value items are shown.

Note: Selecting both check boxes displays only filtered, absolute value items. Selecting neither
check box displays only non-filtered, non-absolute value items. 

14. To limit the items shown to a specific  Coordinate System: 

o Select the required system from the list. The default is to show item s from all systems. 

15. To add an item to the table:

o Expand the appropriate part of the Data Selection frame. 
o Select the required item. 
o Select the Add button.
o The item is transferred to the list of selected items in the Data frame.

Note: The first selected item determines the sample rate for the table. If data from  two camera
views with very different sample rates is to be displayed, care should be taken in the selection of
the first camera view, although the system does take steps automatically to compensate for the
difference. If the first camera view is subsequently removed, the sample rate is recalculated.

16. To add all items of the same data type:

o Expand the appropriate part of the Data Selection frame. 
o Select the required item. 
o Select the Add Similar button. All items with the same data type as the first selec ted is

transferred to the list of selected items in the Data frame.
OR
o Select the Auto Select button. All items with the same data type as the first selec ted is

transferred to the list of selected items in the Data frame continuously during the test. The
Auto Select function will be disabled automatically if any data is added or removed from the
Columns list in the Properties dialog.

17. To remove an item from the table:

o Select the item in the Columns list. 
o Select the  button (Remove button).

The item is transferred to the Data Selection frame.

18. To display Accuracy (if any) of the data selected into the table:

o Enable the Show Accuracy check box.

Table Properties dialog - Properties

19. To specify the filter properties:
 
o Select the Filter button. 
o Key appropriate filter properties.

20. To specify the general properties:

o Select the General button. 
o Key appropriate general properties.
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Sorting in Time tables

By clicking on the header of a column in the table (text diagram), the rows are sorted in inc reasing/
decreasing order according to that column.

Right Click Menu

Note; right clicking the Time table will offer fast access to a number of functions besides the Properties
described above; 

 Properties
 Print - Prints the table.
 Copy all - Copies complete table to the c lipboard.
 Copy selection - Copies selection of the table to the clipboard.
 Export...
 Paste -  Pastes the selected data into any appropriate applic ation.
 Create Diagram Copy - Creates an editable copy of the existing Time table, any changes as described

above can be made without changing the original Time table.

See also...

Point Table
String Expression Wizard
Managing Diagrams via Test Contents
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Amending Table General Settings
1. Select the General button in the Table Properties dialog.

The General Settings dialog is displayed. 
2. To amend the default table title, key in a new Title. 
3. To amend the data format, select the required Format from the list. 
4. To specify the decimal character, select the required Decimal Pointfrom the list. 
5. Select the OK button.

The dialog is closed and the changes made are reflected in the table. 
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Point Table
Function
Point Tables are used to display results per point num erically. Typically in support of a graphical diagram
or when the data is to be exported to another system for storage or further analysis.

Appearance
The Data selection area is divided into Rows and Columns, which mirrors the procedure of populating
the point table.  

 Each selected point will define one row in the point table. Therefore, the points are sorted under 
Rows. (Compare this with the time table where one frame will define one table row.) 

 Each selected attribute, function or other will define one colum n in the point table. For each selected
Point, the following information cab be listed in c olumns;

 
o View - The view in which the tracking for the selec ted point was made.
o Attributes - The selected Attribute.
o Time Derivatives - Sets time derivative. 
o Coordinate System - The selected coordinate system. 
o Function - The used function on the data. 
o Components - The selected components. 

Procedure
The whole idea of the Point Table setup procedure builds upon populating a table in two steps:

 Rows first
 Then columns to affect all rows

By using the Data Selector approach.

2. To setup the table:

o Select the New /  Point Table option from the Diagram menu.
OR
o Click the  tool in the tool bar.

The Point Table is displayed. 

2. To open the table properties dialog:

o Select the Properties option from the Edit menu.
OR
o Right-click in the diagram and select the Properties option from the pop-up menu.
 
The Point Table Properties dialog is opened.

3. Set the table properties according to the preferences desc ribed below:
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o Open the table properties dialog, if not already open.
o Set the appropriate table properties (Rows, Columns), the changes will be implemented

directly in the table.
o Click the OK button when ready. The selected data in the column list will now be displayed in

the presentation function. 

Note; an error message telling what is wrong will appear in the table if it has been incorrec tly
specified.

Table Properties dialog - Rows

4. First, define the points to be inc luded in the table.
 

o Select the point(s) in the Available Points field 
(multi select by holding the <Ctrl> key while selec ting items).

 
5. To add data to the table:

o Click the  button (Insert points button) to insert the selected point into the Selected Points
list. 

6. To change the order of the rows (points) in the table:

o Mark an item an move up and down using the up and down buttons  . 

7. To remove an item from the table:

o Select the item in the list. 
o Select the  button (Remove button).

Table Properties dialog - Columns

8. Select the Point(s) that are to be further presented than just the basic appearance as done when
specifying the rows above. 

Note: that multi selections can be done here, selec ting points from different trackers.

9. Specify what type of Attributes to use for the selected point. 

The range of attributes will depend on the type of point selected, thus, the list will update to
match the range of the selec tion made in the point list. 

Note:If a multi selection has been done, inc luding points from different trackers, the attribute list
will list all available attributes from all selected points. It is therefore important to know what
types of unique data that comes out from the different trackers.

3. Specify also the Time Derivative of the selection. 

The derivatives will be applied on all selected attributes for eac h point. 

4. Specify the Coordinate System to be used when presenting the data selection.
 

o Select from the drop down list.
 

If more than one system is available in the test, the option All will present the specified data for
each coordinate system in the test.
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5. Select the desired Function which will be applied on the data before presentation:

o At Current time will pass the data untouched. 
o The max and min functions will however calculate the extreme values of a sequence before

presentation. Thus, the use any of those two functions will result in the presentation of data
that is unaffected by the current time. This as it is just one value for all times in a sequence.

6. To add data to the table:

o Click the  button (Add button) to insert the data selection in the Column list. 

7. To change the order of the added items in the list:

o Mark an item an move up and down using the up and down buttons  . 

8. To remove any data from the table:

o Select the item in the Column list. 
o Select the  button (Remove button).

9. If a row in the column list is marked and the Add Similar button is clicked, all the available
similar data (same point type from the Points list, as in the selected row) that c an be specified
from the point list will be added to the list autom atically. 

10. To display Accuracy (if any) of the data selected into the table:

o Enable the Show Accuracy check box.

Table Properties dialog - Properties

11. To specify the filter properties:
 
o Select the Filter button. 
o Key appropriate filter properties.

12. To specify the general properties:

o Select the General button. 
o Key appropriate general properties.

Right Click Menu

Note; right clicking the Point table will offer fast access to a number of functions besides the Properties
described above; 

 Properties
 Print - Prints the table.
 Copy all - Copies complete table to the c lipboard.
 Copy selection - Copies selection of the table to the clipboard.
 Export...
 Create Diagram Copy - Creates an editable copy of the existing Point table, any changes as desc ribed

above can be made without changing the original Point table.

See also...
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Time Table
Managing Diagrams via Test Contents
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Report (optional)
Function
The Report function is used to gather data from a test into a single output. 

Procedure
1. To setup the table:

o Select New /  Report from the Diagram menu.
OR
o Click  tool in the toolbar.

The Report window is displayed.

2. To add data to the report:

o Items such as XT, Multi Axis, XY , Advanced 3D and Image diagrams and Test Summaries can
be added to the report.

o Clicking on their corresponding icon in the top of the window. 

3. To edit any added item (To open the diagram properties dialog):

o Mark the item in the report item list.

o Click the Report setup button .
OR
o  Right-click on it and selecting Setup. 

The diagram setups function as their standard-test c ounterparts.

OR
o Right-click in the diagram and select the Properties option from the pop-up menu.

4. To display an item:

o Click on it in the list. 

5. To display several items simultaneously:

o Use multi-select in the list (pressing the <ctrl> key while clicking).

6. To browse through the report:

o Use the arrows   to the right.
OR 

o Click on the desired report items and use the double-arrow keys   to go quickly to the
top or bottom of the list. 

7. To remove any item from the report:
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o Select the item and click the  button (Delete button).

8. To print the report:

o Click on  button (Print button).

Note; an error message telling what is wrong will appear in the diagram if it has been incorrectly
specified.

Right Click Menu

Note; right clicking the Report will offer fast access to a number of functions:
 
 Properties
 Zoom tool
 Selection Tool
 Distance Measurement tool
 Angle Measurement tool
 Show all  - will display the diagram in zoom 1:1. 
 Grid
 Legends
 Legends Settings
 Export Images
 Print - Prints the diagram.
 Copy - Copies the diagram to the clipboard.
 Paste -  Pastes the selected data into any appropriate applic ation.
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Test Summary
Function
A Test Summary is a framework that enables a Text Box to be inserted by itself in a report. As any text
box, it can contain any text and suits fine using Built-in Variables to create customized tables. 

Procedure
1. In the report, click the  tool.

An empty Test Summary is Added to the report displayed. 
2. Right Click the Test Summary in the list and select Setup. The Test Summary setup opens. 
3. Set up the Test summary Text Box. 
4. The contents in the Test Summary can be exported to excel. Right click and select Export. Select .

xls format. 

Tabbing in text box/xls file
To make  tabs  in the text, (using the syntax $\t$ ) to match columns in the exported excel, use space
between the '\t' patterns. For example, if we need one empty columns between two columns with values
in the exported xls file, type '\t \t' between the values. Please look at the following exam ple:

Syntax in Test Summary text box:

Value 1\t \tValue 2
Value3\t \tValue4

Value5\tValue6
Value7\tValue8

Appearance in excel:

See also...
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Absolute Value / Vector Length
If you choose to plot an absolute value in a diagram, a function is used to calculate the length of a
vector, i.e. its absolute value.

The function calculates the length of vectors or the absolute value of scalars, i.e. it rem oves the direction
component of a distance, a velocity or an acceleration.

The length of a vector is a scalar quantity of the same dimension as the vector's components. For
positions, the function calculates the distance from  the origin.

In the case of: 
 distance, which has length and direction components, the length is c alculated. 
 velocity, which has speed and direction components, the speed is calc ulated. 
 acceleration, which has acceleration and direction components, the acceleration is calculated. 
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Amending Diagram Axes
1. Select the Axes button in the Diagram Properties dialog.

The Axis Properties dialog is displayed. 

2. For each axis in diagram you can: 
o Select the required unit from the drop-down list. For a Multi Axis diagram, a selection is made

for each of the Y axes individually.  
o Scale automatically, select the Auto Scale check box. 
o Scale manually:

 De-select the Auto Scale check box.
 The Scale fields are enabled and contain the current corridors of the axes. 
 Key in the lower and upper bounds

3. For an XY diagram or 3D diagram select the Keep Aspect Ratio check box if you want the aspect
ration to be preserved. For a Multi Axis or Advanced diagram, select the Align Axes at Value
check box and key the required value. This aligns all the Y axes at the spec ified value. 

4. Select the OK button. The dialog is closed and the changes made are reflected in the diagram. 

See also...

3D Diagram
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Diagram Filters
1. Select the Filter Properties button in a Diagram Properties dialog. The Filter Properties

dialog is displayed. 

2. Select the Filter Type from the drop-down list:

FIR
o FIR applies a variable length low-pass filter, i.e. a filter which removes high frequency noise

and makes the data look smoother. All physical data is processed, except im ages and
calibration sequences. For vector data each component is filtered.

o A Filter Factor of '0' specifies no filtering, while '100' spec ifies maximum filtering.

CFC
o CFC applies a fourth order phaseless Butterworth filter. All physical data is processed, except

images and calibration sequences. For vector data each component is filtered. The filter is a
non-causal IIR (Infinite Impulse response) filter, i.e. a change in any input sample affects the
entire output. Invalid input samples are interpolated and the corresponding output sam ples
are marked as invalid. Input data is re-sampled to an equidistant timebase.

o The CFC parameter determines the cut-off frequency of the filter.
o For large CFC values, the cut-off frequenc y is larger than the Nyquist limit (the highest

frequency that can be represented at a given sampling frequency). In this case, the filter just
lets through its input signal, which complies with the SAE J211/1 spec ification.

o The specified CFC value determines the cut-off frequency which is the highest frequency in the
input signal that is passed to the output. It should be set well above the highest signal
frequency, otherwise part of the signal is filtered out as well as the noise.

o The CFC filter does not compute any accuracy estimate for its output data. This means that
when the CFC filter is active no accuracy data will be displayed if you selec t Show Accuracy in
the diagram setup.

Spline  
o Spline applies a spline smoothing filter. All physical data is processed, exc ept images and

calibration sequences. For vector data each component is filtered.
o The filter alogrithm fits a spline curve to each component of the data. A spline curve is a curve

that is constructed from multiple n:th degree polynomials (one polynomial for each pair of
consecutive data points) so that the n-1 first derivatives are continuous. The fit is optim ized to
make the curve as smooth as possible without losing information. The algorithm used is
known as GCV optimization.

o The settings control the degree of the polynom ials:
 Cubic: Polynomials of degree 3.
 Quintic: Polynomials of degree 5.
 Heptic: Polynomials of degree 7.

o The Spline filter does not compute any accuracy estimate for its output data. This means that
when the Spline filter is active no accuracy data will be displayed if you select Show Accuracy
in the diagram setup.

3. For an FIR filter, drag the Filter Factor slider to the required filter value.
 

4. For an CFC filter, key in the required CFC value.

5. Select a Spline filter by either checking the Cubic, Quintic or Heptic filter.

6. If you wish to set the filter definition as the default, select the Set As Default button.
Note: This sets a single default, not a default for each type of filter. 

7. Select the OK button. 
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Filter Algorithms
FIR Filter
TEMA's FIR (Finite Response Filter) filter is a low-pass filter with a single param eter, the “filter factor”,
which is a dimensionless number between 0 and 100, where a higher filter fac tor means harder filtering.
Instead of the user specifying the length of the filter, the filter half-length n varies from 1 to 10
depending on how many valid samples surround the current sample.

The filter algorithm is a Hamming low-pass filter, with the c oefficients

where n is the half-length of the filter and

and

with T being the sampling interval of the input.

The cutoff frequency f0 is given by the filter factor F according to the formula

Note that a filter factor of 0 corresponds to 

i.e. the Nyquist limit (the maximum frequency that can be represented with the sam pling interval T). If
we insert this value in the formula for the filter coeffic ients, we get 

that is, all the filter coefficients except h0 will be zero and the filter will just pass its input through
unchanged.
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Speed and acceleration filter algorithms
TEMA's speed and acceleration filters (also FIR filters) algorithms computes speed and acceleration from
tracking data. These algorithms require that the input is equidistantly sampled, i.e. that the time interval
between consecutive samples is the same throughout the sequence. 

If the input sequence doesn't satisfy this requirement it is re sampled by interpolating its values at
equidistantly spaced times.

The filter algorithms can be described by the following form ula:

where xi are the samples of the input sequence (after re sampling) are the samples of the output
sequence. When the data has more than one component this formula is applied independently to each
component. 

The numbers cj are called the filter coefficients, and the integer n is called the filter’s half length.  There
are 2n + 1 filter coefficients. 

In general, the greater the half length, the less sensitive the filter is to noise in the input data (because it
uses more data points for its computation, and random noise will average out between these points). 

However, a longer filter will leave longer gaps at the ends of the output: the form ula above can only be
applied if there are n input samples both before or after the sample being calculated. To reduce these
gaps, TEMA has an option to reduce the filter length at the ends of the input sequence. 

Speed Filters

Filter coefficients

The filters used to compute speeds and velocities have filter coefficients given by

where T is the sampling interval of the input sequence (i.e. the time between consecutive samples). 

This formula can be derived by least-squares fitting a quadratic equation to the 2 n+1 input points and
then taking the derivative of the fitted func tion.

The above coefficients make the filters anti symmetric: they extend n samples both before and after the

current sample and . This ensures that the filter is causal, i.e. that data is not moved in time. 

Short-sequence filter

The user also has an option to reduce the filter length even further at the ends of the sequences, down to
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a two-point filter. The formulas used for this “short-sequence filter” are

depending on at which end of the input sequence we are. This means that there will be an output sample
for every valid input sample, which is important in some applications.

Since only two input points are used, these formulas are very noise-sensitive – a small error in one input
sample will give a large error in the speed. Also, these formulas are not anti symmetric, so the filter will
not be causal (the calculated speed is really the speed at the tim e halfway between the input samples). 

The use of this option is rec ommended only if it is very important that there be no gaps at the ends of
the speed sequence.

Mean velocity from t0

TEMA also has a special option to calculate velocities as the m ean velocity from time zero rather than as
the instantaneous velocity. When this option is selected, the above filters are not used at all. Instead the
speed at time t is calculated simply as the displacement from time zero to time t, divided by t.  

This option is, obviously, only suitable for applications where the tracked objec ts are moving with
constant velocity.

Acceleration Filters

TEMA computes accelerations with the same type of filters as it uses for speeds. The only differenc e is
that the filter coefficients will be symmetric rather than anti symmetric (this is a mathematical
consequence of the fact that we are differentiating twice).

The system implements two filters of different half-length:

n = 2, coefficients;

 

and n = 4, coefficients;

 

These filter coefficients can be derived by applying the 3- and 5-point velocity filters twice in succ ession.

Normally, the 9-point (n = 4) filter is used. If the user selects the "reduce filter length at ends" option,
the 5-point filter will be used at the ends of the input sequence.

See also...

Diagram Filters
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Manipulating Diagrams and Tables
When a diagram or table has been displayed in it own window, there are a num ber of functions you may
perform: 

1. Double-click on the diagram/table Titlebar, or select the  button to expand the diagram/table to
fill the whole of the display area.
Selecting the  button returns the display area to its original c ondition. 

2. To minimise the diagram/table, select the  button. 
3. To save the diagram/table, select the Save Test or Save Test As option from the File menu. 
4. To close the diagram/table, select the  button.

Note: If you have not saved the diagram/table as part of the test, IT IS LOST. 
5. For a diagram only:

o To remove the grid, select the Grid option from the Diagram menu.
o Re-selection redisplays the grid. 
o To remove the legends, select the Legends option from the Diagram menu.
o Re-selection redisplays the legends. 
o Specify the Legend Settings. 
o To display curve coordinates: 

 Click on the curve whose coordinates are to be displayed.
 The selected curve is displayed in bold and an asterisk is added to the c urve's legend. 
 Move the mouse to a point of interest on the selected curve.
 A purple cross is displayed to indicate the current point selected with the m ouse.
 The coordinates of the current point (the closest ac tual sample value) are displayed in the

bottom left corner of the diagram.



 Note: The values are also displayed in the Statusbar and can be saved to Notes. 
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Diagram General Properties
1. Select the General button in the XT (or XY, or Multi Axis) Diagram Properties  dialog.

The General Properties dialog is displayed. 

2. To edit the default diagram title, type a new Title. 
3. To remove the default grid, uncheck the Show Grid check box. 
4. To specify the legend:

o Select the required check boxes (check or uncheck).
o The specified legend is displayed in the frame below the check boxes. 

 Show Legends - Displays the legends in the diagram. 
 Alt Colour - displays both the legend colour and the alternative legend colour in the

legends definition bar.
 Note: Interpolated points are always displayed in the alternative colour, irrespective of

whether the legends are shown or not. 
 Vertical Axis Min - displays in the legend the minimum vertical value, together with the

horizontal axis value at which it occurs. 
 Vertical Axis Max - displays in the legend the maximum vertical value, together with the

horizontal axis value at which it occurs. 
 Horizontal Axis Value - displays the current horizontal axis value. 
 Vertical Axis Value - displays the current vertical axis value. 

o To edit the legend for a specific point:
 Mark applicable point in the Legend list.
 Select Edit button.
 Type the new Legend name in the New legend dialog.
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 Select OK button.
 The new Legend name is shown in the left column (Legend) and the old Legend name is

shown in the right column (Default).
o To reset changed Legend name:

 Mark applicable point in the Legend list.
 Select Reset button.
 The Legend will be changed back to default Legend name.

5. To remove the default legends, uncheck the Show Legends checkbox. 
6. To specify the Print Options:

o Select the Measurable Axes. 
o Select the appropriate radio button, i.e. Centimetres or Inches. 

7. Select the OK button.
The dialog is closed and the changes made are reflected in the diagram. 
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Diagram Corridors
1. Select the Corridors button in the XT (or XY, or Multi Axis) Diagram Properties  dialog.

The Diagram Corridors dialog is displayed. 
2. To add a diagram corridor:

o Right-click the Colour and select the required colour from the list. 
o Select the diagram corridor in the list. 
o Select the Add button. 

3. To remove a diagram corridor: 
o Select the diagram corridor in the list. 
o Select the Remove button. 

4. Select the Close button. 

See Also...
Maintaining Corridors
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Accuracy Settings
Function
The Accuracy of displayed data in any diagram or table can be plotted in the sam e diagram/table.

Procedure
To show the Accuracy of displayed data:

1. Open the Properties dialog of applicable diagram/table, either by 
o right-clicking the diagram/table. 

OR
o selecting Properties from the Edit menu.
 

2. Enable the Accuracy to be displayed by checking the Show Accuracy check box. 

3. For diagrams, the Accuracy is shown as a -factor times the standard deviation ().

Set the size of the -factor by selecting desired value from the Std Dev. drop down list.
 

o In a XT diagram, the Accuracy will appear as error bars (vertical lines) on the curve. The

length of each bar will match the value of the standard deviation tim es the -factor. 
o For a Multi Axis diagram, same appearance as for a XT diagram.
o In a XY diagram, the Accuracy will appear as ellipses on the curve. The size of the ellipses

will match the value of the standard deviation tim es the -factor.
o For an Advanced diagram, same appearance as for a XY diagram.
o In a 3D diagram, the Accuracy will appear as ellipsoids on the curve. The size of the

ellipsoids will match the value of the standard deviation tim es the -factor.
o For an Image diagram, same appearance as for a XY diagram.

OR

For tables, the Accuracy is shown as the standard deviation  ().
o In a Time table, the Accuracy will appear numerically in the table.
o For a Point table, the Accuracy will appear numerically in the table.

   
4. For diagrams, set the intervals for the appearance of the accuracy plots (lines, rings or ellipsoids,

depending on diagram type). The Skip value entered will be the amount of time samples between the
accuracy plots in diagram.  
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Text Boxes
Function
Text boxes in TEMA are what the name implies; boxes where text can be inserted. Such boxes can be
inserted into all TEMA diagrams as well as overlays in the Image Export. The text box is also a place
where expressions can be inserted and used. 

Appearance
Depending on from where in TEMA the text box dialog has been entered, diagram  (XT, XY, Multi Axes,
Advanced diagrams) setups or  Image Export the exact appearance varies slightly. The deviations are
described in each corresponding help section. The com mon features regarding text boxes however, are
those listed below.
 

 Text - this section contains settings for the text message in the text box. 
o Alignment sets the text alignment within the text box. This can be changed later in the

Overlays tab in the image export dialog. 
o Color  - set the color of the text. 
o Font - set the font of the text. Select the appropriate font, style and size. 

Procedure
Depending on from where in TEMA the text box dialog is entered, the proc edure of setting this up varies
slightly. 

1. Type the Text Box message. 
2. Use expressions if needed,  either typed manually or with the use of the String Expression

Wizard .'
3. To create tabs in the text, use the syntax $\t$. 
4. Specify the Alignment, Text Color and Font. 
5. Click OK when ready to insert the c reated Text Box in Diagram or export window. 

  
See also...

Text Box in XT Diagram 
Text Box in Multi Axis Diagram
Text Box in XY Diagram
Text Box in 3D Diagram
Text Box in Image Diagram
Text Box in Advanced Diagram
Test Summary
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Copy to Time Table
The Copy to Time Table function creates a Time Table that displays the same data as an existing X T, Multi-axis, XY,
Advanced XY or 3D diagram. For multi-dimensional data the Time Table will show all the data components, even if only
one component is displayed in the original diagram. 
 
The function is not available for Time Tables, Point Tables or Frequency Analysis diagrams. 
 
It can be accessed from the Diagram menu in the main window, from the right-click menu in a diagram of the relevant
types, or from the right-click menu in the Test Contents window (prov ided one or more diagrams are selected).
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Scaling and Coordinate Systems
The scaling and coordinate system  functions enable measurements and calculations to be made more
accurately by relating parts of the image to their corresponding features in the real world.

1. Select the required camera view. 

2. Specify points/reference points in applicable image sequence.
Minimum number of points are for:
o Single Parallel: 2.
o Multiple Parallel: 2 or 0.
o Skewed: 2.
o 4 Points: 4.

3. Select the Scaling/Coordinate Systems option:

o from the Edit menu.
OR
o by right-clicking in the Camera View.
OR
o by clicking the  tool.

The Scaling/Coordinate Systems dialog is displayed.
Note: If a camera view has not been selected, the message "No active Camera View found" is
displayed in the Status bar and the dialog is not displayed.
 

4. Set up Motion Planes.

5. Specify Coordinate Systems. 

6. Specify Coordinate Grids. 

7. Select the OK button. 
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Motion Planes
1. Select the Scaling/Coordinate Systems option:

o from the Edit menu.
OR
o by right-clicking in the Camera View.
OR
o by clicking the  tool.

The Scaling/Coordinate Systems dialog is displayed. 

2. Specify points/reference points in applicable image sequence.
Minimum number of points are for:

o Single Parallel: 2.
o Multiple Parallel: 2 or 0.
o Skewed: 2.
o 4 Points: 4.

3. Select the Motion Planes tab.

4. Select Mode:
o Disabled - Motion Planes calculation disabled.
o Single Parallel - Only scaling 

(useful when the motion plane and image plane are parallel).
o Multiple Parallel - Scaling and compensation for offset 

(useful for more then one motion plane and when these are parallel to the im age plane).
o Skewed - Scaling and compensation for offset and skew of motion plane(s)

(useful when the motion plane and image plane are skewed and NOT parallel to eac h other).
o 4 Points - Scaling and compensation for offset and skew of motion plane(s)

(useful when relative positions of 4 reference points are known).

Single Parallel Mode

5. Select Time Mode and set the Scale:

o For Dynamic Time Mode:
Note: If Dynamic mode is selected, a reference time is not required because the system
calculates the transform parameters in every image in the sequence. 
 Set the Scale for the reference Point 1 and Point 2:

 Select Point 1 and Point 2 from the drop-down lists.
 Fill in Distance between points (value, unit). 

o For Static Time Mode:
 Set the Reference Time for valid analyse data (value and unit).

 Fill in value and select unit from the drop-down-list.
OR
 Select the  button to set the Reference Time to the current time.

 Set the Scale for the reference Point 1 and Point 2:
 Select Point 1 and Point 2 from the drop-down lists.
 Fill in Distance between points (value, unit). 
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o For Manual Mode:
Note: If Manual mode is selected, a reference time is not required because the system  bases
the transform solely on the Scale factor. 
 Fill in Scale factor per pixel (value, unit). 

6. Press OK button.

Multiple Parallel Mode

5. Select Time Mode and set the Scale:

o For Dynamic Time Mode:
Note: If Dynamic mode is selected, a reference time is not required because the system
calculates the transform parameters in every image in the sequence. 
 Select No Scaling.
OR
 Set the Scale for the reference Point 1 and Point 2:

 Select Point 1 and Point 2 from the drop-down lists.
 Fill in Distance between points (value, unit). 

o For Static Time Mode:
 Set the Reference Time for valid analyse data (value and unit).

 Fill in value and select unit from the drop-down-list.
OR
 Select the  button to set the Reference Time to the current time.

 Select No Scaling.
OR
 Set the Scale for the reference Point 1 and Point 2:

 Select Point 1 and Point 2 from the drop-down lists.
 Fill in Distance between points (value, unit). 

o For Manual Mode:
Note: If Manual mode is selected, a reference time is not required because the system  bases
the transform solely on the Scale factor.
 Select No Scaling.
OR
 Fill in Scale factor per pixel (value, unit).

 
6. Select Planes:

o For a Measured Distance between Camera and Reference Plane:  
 Select Measured.
 Fill in Distance (value, unit). 

o For a Calculated Distance between Camera and Reference Plane:  
 Select Calculated (known internal camera parameters are required).

o For Secondary Planes: 
 Compensate for Plane Offsets relative to the reference plane by selecting this

option.
 Press Edit Offsets button.

 Fill in Offsets value for applicable point in the Plane Offsets dialog and press
OK button.

OR



p282

© Image Systems AB, 2011

 Import Offsets values from file by pressing the Import button and then
selecting file in the Open dialog.

OR
 Export Offsets values from file by pressing the Export button and then saving

the file in the  Save as dialog.
Note: The file format is text (not binary) XLS. This format is tab-separated values,
which can be read by Excel or Notepad. 
Each line in the file contains the name of a point (the name may contain spaces),
followed by one or more tab characters and a floating-point number that specifies
the offset of the point. 
If the first line of the file starts with /unit (note that this is not a valid point name),
followed by one or more tab characters and the name of a length unit, all offset
values are interpreted as given in that unit. If no such line is present TEMA's c urrent
default length unit is used. 

OR
 Fill in Offsets value for applicable point in the Test Contents dialog.

7. Press OK button.

Skewed Mode

5. Select Time Mode and set the Scale:

o For Dynamic Time Mode:
Note: If Dynamic mode is selected, a reference time is not required because the system
calculates the transform parameters in every image in the sequence.
 Set the Scale for the reference Point 1 and Point 2:

 Select Point 1 and Point 2 from the drop-down lists.
 Fill in Distance between points (value, unit). 

o For Static Time Mode:
 Set the Reference Time for valid analyse data (value and unit).

 Fill in value and select unit from the drop-down-list.
OR
 Select the  button to set the Reference Time to the current time.

 Set the Scale for the reference Point 1 and Point 2:
 Select Point 1 and Point 2 from the drop-down lists.
 Fill in Distance between points (value, unit). 

o For Manual Mode:
Note: If Manual mode is selected, a reference time is not required because the system  bases
the transform solely on the Scale factor.
 Fill in Scale factor per pixel (value, unit).

6. Select Planes:

o For a Measured Distance between Camera and Reference Plane:  
 Select Measured.
 Fill in Distance (value, unit).
 Select how the distance has been measured (see illustration below):

 Perpendicular to Plane.
OR 
 Along Camera Axis.
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o For a Calculated Distance between Camera and Reference Plane:  
 Select Calculated (known internal camera parameters are required).
 Select how the calculated distance shall be displayed:

 Perpendicular to Plane.
OR 
 Along Camera Axis.

o Set the Orientation of the image plane relative to the reference plane.
 Fill in Azimuth (value, unit), see illustration below.
 Fill in Elevation (value, unit), see illustration below..
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o For Secondary Planes: 
 Compensate for Plane Offsets relative to the reference plane by selecting this

option.
 Press Edit Offsets button.

 Fill in Offsets value for applicable point in the Plane Offsets dialog and press
OK button.

OR
 Fill in Offsets value for applicable point in the Test Contents dialog.

7. Press OK button.

4 Points Mode

5. Select Time Mode:

o Dynamic.
OR 
o Static: 

 Set the Reference Time for valid analyse data (value and unit).
 Fill in value and select unit from the drop-down-list.
OR
 Select the  button to set the Reference Time to the current time.

OR
o Manual.

6. Select four Reference Points:

o Select Point, Point 2, Point 3 and Point 4 from the drop-down lists.
Note: Only points with 2D model coordinates can be used as referenc es.

7. Select Planes:

o For a Calculated Distance between Camera and Reference Plane:  
 Calculated is selected automatically (known internal camera parameters are required).
 Select how the calculated distance shall be displayed:

 Perpendicular to Plane.
OR 
 Along Camera Axis.
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o For Secondary Planes: 
 Compensate for Plane Offsets relative to the reference plane by selecting this

option.
 Press Edit Offsets button.

 Fill in Offsets value for applicable point in the Plane Offsets dialog and press
OK button.

OR
 Fill in Offsets value for applicable point in the Test Contents dialog.

8. Press OK button.

See Also...

Motion Planes Explanation

Scaling and Coordinate System
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Motion Planes Explanation
A common case in motion analysis is that the motion is confined to a plane. For example, consider a car
moving straight ahead. The side of the c ar is approximately flat and parallel to the direction of m otion, so
points on the side of the c ar will move in a plane (two-dimensional motion). In TEMA, such a plane is
called a Motion Plane.

A slightly more complicated case is when points on both the left and right side of the car are observed.
Then the points move in two parallel planes at different distances from the camera. Since objects further
away from the camera look smaller, there will be two different sc ale factors, one for each plane.

The situation becomes even more complicated if the camera is not looking straight at the car (i.e. the
sensor plane is not parallel but at an angle to the sides of the car). In this c ase, the scale factor will vary
depending on which part of the plane is being looked at, since different parts of the plane are at different
distances from the camera.

The Motion Planes function calculates the scale factors in cases such as these, and uses them  to calculate
the x and y coordinates within each Motion Plane. Another way of describing this is that the func tion
removes the effects of perspective, recovering the actual size of objects despite the fact that their
apparent size depends on their distance from the camera.

1 Different Modes of Transformation
Since this description is rather abstract, a set of simple, concrete examples will now be used to show how
the Motion Planes function works in different cases. TEMA's Motion Planes func tion can operate in
different modes that correspond to these cases.
 
1.1 The Single-Parallel Case
In the simplest case, all observed points are in the sam e plane and the camera is looking straight at the
plane (i.e. the sensor plane is parallel to the Motion Plane).
Then the real-world positions of the points in the plane (x and y coordinates m easured in e.g. metres or
inches) can be obtained from their positions in the image (pixel coordinates) by just applying a sim ple
scale factor. This is called the single-parallel case, since there is a single Motion Plane, which is parallel
to the sensor plane.

Suppose the motion of the second hand of a wall cloc k is being studied. The camera is placed on a tripod
in front of the clock and pointed straight at the wall. The second hand m oves in the plane of the c lock
face, so if the camera is properly aligned, there will be a single Motion Plane which is parallel to the
sensor.

Tracking the tip of the second hand gives x and y coordinates that are m easured in pixels. If the
end-user wants results in real-world coordinates, m easured in metres, the Motion Planes function can be
used to compute the image scale and apply it to the data.

To compute the scale two points (called the reference points) are needed with a known distance between
them. For example, the length of the second hand can be measured and both ends of it trac ked. It is also
possible to enter the image scale (measured in metres / pixel) manually.

Note: in previous versions of TEMA (3.4 and earlier), this func tion was called "2D scaling".

1.2 The Multiple-Parallel Case – Adding more planes
Suppose now that not just the motion of the second hand is measured, but also the coordinates of som e
points on the wall on which the c lock is mounted. These points will not lie in the same plane as the
minute hand, but in a parallel plane that is further away from  the camera. This means that a different
scale factor must be used for these points.

Instead of tracking two new reference points on the wall, TEMA allows the user to com pute the wall’s



p287

© Image Systems AB, 2011

scale factor from that of the second hand, provided two more distances are being measured: the distance
from the reference plane to the camera (to be precise, to the camera’s focal point), and the distance
between the reference plane and the wall plane (called the wall plane’s offset). The offset is defined as
positive when the plane is further away from the camera than the reference plane is, and negative
otherwise.

TEMA can handle any number of Motion Planes. In fact, it assumes that each point has its own Motion
Plane, and lets the user enter the plane offsets at a point-by-point basis. The only exception to this is
that both reference points must lie in the reference plane.

If the focal length of the camera is known (e.g. if the camera has been calibrated), TEMA can calculate
the distance between the camera and the reference plane automatically. 

If the actual size of the object is not interesting, it is possible to om it the scaling and just compensate for
the different offsets of the planes. This produces output coordinates that are m easured in pixels. In this
case the reference points are not necessary. On the other hand, it is not possible to calculate the distanc e
from the camera, so this distance must be measured by some other method.

1.2.1 Another Example
Another way of describing what the Motion Planes function does in this case is that it removes the effects
of perspective.

The following example shows a measurement of two distanc es on a vehicle. 

The points Q1 and Q2 have offsets = 1 m, since they are 1 metre behind the reference plane as viewed
from the camera, while P1 and P2 lie in front of the reference plane and have offsets of –1 metre.

The two distances P1-P2 and Q1-Q2 are equal, but because of perspective the latter two points seem  to
be closer to each other in the image. Using the Motion Planes function removes this effect, as shown
below:

Note: The operation of removing the perspective effects is also called depth scaling.
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1.3 The Skewed Case
In all the previous cases the camera sensor was parallel to the motion planes (or, in other words, the
camera axes was perpendicular to the planes).

The case where this is not true is called the skewed case. 

In the skewed case different points on the plane will have different distances to the camera, so the scale
factor will not be constant but will vary over the image. In the example with the c lock, the second hand
will appear to be of different length at different times, and if the clock face is circular in reality its image
will be an ellipse.

If the orientation of the camera relative to the planes is being known, TEMA can calculate the scale factor
and how it varies across the image. As in the parallel case TEMA needs the distanc e from the camera to
the reference plane and the offset of each additional plane, and two reference points that are a known
distance apart must be defined.

If the camera’s focal length is known TEMA can calculate the distance from the camera to the reference
plane. 

Unlike the parallel case, the two reference points and the distance between them  are necessary.

The orientation of the camera relative to the plane is given as two angles, azimuth and elevation.
Azimuth is measured horizontally (telling whether the camera looks to the left or the right) and elevation
vertically (up or down). A positive azimuth means that the camera is turned clockwise, and a positive
elevation that it looks up.

In the skewed case the Motion Planes function compensates both for the perspective effect caused by the
offsets of the different planes (depth scaling as in the parallel case), and for the perspective effec ts
caused by the oblique view (turning the elliptic clock face back into a c ircle).

1.4 The 4-Point Case
An alternative way of handling the skewed case is to use four rather than two referenc e points, and
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calculate not only the scale, but also distance to and the orientation of the cam era from these points.

The points must have known x and y coordinates in the plane's c oordinate system. TEMA reads these
coordinates from a file and stores them in the test. The camera's focal length must also be known.

2 Time Modes
In all the cases the user may specify whether the transformation should be dynamic, static or manual.
This is called the Time Mode of the transformation.

In Static mode the transformation parameters are calculated only once and that is at the specified
reference time. This means that the reference points only need to be trac ked in one image.

In Dynamic mode the transformation is recalculated for each successive image. This can be used when
the camera moves relative to the reference plane, or if the geometry of the setup c hanges in some other
way; the effect is to remove the effects of unwanted motion from the data. 

Finally, in Manual mode the user enters the scale factor manually. In the skewed case this value refers to
the scale at the image's principal point (usually the centre of the im age).
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Maintaining 2D Coordinate Systems
The available coordinate systems for the currently selected c amera view are listed in the Coordinate
Systems frame. Initially, there is always one coordinate system, based on the bottom left corner of the
image, with horizontal and vertical x and y axes. It is assigned the sam e name as the camera view. 

1. Select the Scaling/Coordinate Systems option from the Edit menu.
The Scaling/Coordinate Systems dialog is displayed. 

2. Select the Coordinate Systems tab. 
3. You may:

o Add a coordinate system. 
o Change the definition of a coordinate system. 
o Remove a coordinate system. 
o Assign a different coordinate system to a camera view. 

4. Select the OK button. 

To perform a coordinate transformation, there are two different interfaces; Aligned, which is best suited
for image merging in image diagrams, or Standard for other uses. 

Adding a Coordinate System

A new coordinate system needs to be added if the measurements made are not based on the bottom  left
corner of the image, the default, but on some other fixed point in the image. 

Note: A new coordinate system can be set up without reference to tracked points. This is ac complished
by using the following procedure, but without selecting points from  the lists in the Translation and Axis
Definition frames. 

1. Select the Add button.
The New Coordinate System dialog is displayed. 

2. Key the Name for the new system. 
3. Select Aligned Or Standard to get to the desired coordinate system transformation interface.
3. Select the OK button.

The dialog is removed and all the fields are enabled in the selec ted Coordinate systems interfece
tab. 

Changing the Definition of a Coordinate System
1. Select the coordinate system whose definition you wish to change. 
2. Amend the settings as described in Adding a Coordinate System. 

Removing a Coordinate System
1. Select the coordinate system whose definition you wish to remove. 
2. Select the Remove button. 

Assigning a Different Coordinate System to a Camera View

If you wish to display data on the same diagram from two camera views in either the same or different
tests, the camera views must both use the same coordinate system. When a camera view is created, a
coordinate system with the same name is automatically defined. Additional coordinate systems may be
defined, as required.

Typically, in a 3D test, the two camera views are called 'left...' and 'right...'. To display data on the sam e
diagram from two camera views, a new coordinate system  is created for the 'right...' camera view which
has the same name and definition as the coordinate system for the 'left...' camera view. Both camera
views are assigned to the same coordinate system as follows: 

1. Select the coordinate system to be assigned to the camera view.
The change is effected when the OK button is selected. 
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See Also...

Image Merge
Coordinate System - Setup Procedure
Scaling and Coordinate System
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Standard
Procedure
1. Select Dynamic or Static mode by clicking on the appropriate radio button.

If Static mode is selected, key in the Reference Time, selecting the time unit from drop-down list.

2. Alternatively, select the  button to set the Reference Time to the current time.
If Dynamic mode is selected, a reference time is not required because the system calculates the
transform parameters in every image in the sequence. 

3. If you wish to base the new system on a different origin, in the Translation frame:
o

o Select the new origin from the Point drop-down list. 
o Specify the x offset value, selecting the unit from the adjacent list. 
o Specify the y offset value, selecting the unit from the adjacent list. 

4. If you wish to amend the names of the axes, in the Axis Names frame:
o Select the First Axis name from the list. 
o Select the Second Axis name from the list. 

5. If you wish to specify a new axis definition, in the Axis Definition frame:
o Select the x or y radio button, depending on whether the line between Point 1 and Point 2 is

the x or y axis.
o The other axis is automatically offset from this line by 90°. 
o If you wish to invert the other axis, select the Invert x (or y) Axis checkbox. 
o Select Point 1 from the adjacent drop-down list. 
o Select Point 2 from the adjacent drop-down list. 
o If you wish to rotate the coordinate system about the origin, key the Offset Angle, selecting

the unit from the adjacent list.
o This is measured counter clockwise from the positive x axis. 

See also...

Aligned Coordinate Systems
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Aligned 
Function
When it comes to merging images, the align transformation interface is better suited than the standard
transformation interface. 

Procedure
1. To the right in Coordinate Systems dialog is the graphical Align interface. This displays the two

images that corresponds to the available coordinate systems. The uppermost is the image whose
coordinate system is the fixed. The lower is the one to be oriented in the fixed system . Tracked points
(if any) in both images can also be seen. By the use of this interface, the second (lower) im age is
oriented in relation to the primary one (upper) by relating point(s) in one of the images are to point
(s) in the other:

   
o Click in a position in one of the images  with the left mouse button. This will present a

select tool marking the position. Drag the mouse to the other image and click at the
position at where to associate those two positions. This can be done for as many
positions as desired. 

o Tracked points with the same name in both images will be automatically associated. This can
be overridden by dragging the select tool from one tracked point to another in both views. It is
not possible to associate a tracked point with a non-trac ked position.  

o Right clicking a association line will make it possible to remove it. 
o Each image in the graphical Align interface can be scrolled and/or zoom ed in/out individually

using the scroll bars and the zoom buttons   . The associations set will not be changed
by this. When a point associated bec omes non visible due to scrolling, an arrow will point to
the direction of that point in the image.  

2. Select transformation Mode. Select Dynamic or Static mode by clicking on the appropriate radio
button.
If Static mode is selected, key in the Reference Time, selecting the time unit from drop-down list.

Alternatively, select the  button to set the Reference Time to the current time.
If Dynamic mode is selected, a reference time is not required because the system calculates the
transform parameters in every image in the sequence. 

3. More coordinate systems can be added using the Add button in the lower left corner of dialog. The
New Coordinate System dialog will appear. Give the new coordinate system  a suitable name. Then
select Aligned Or Standard. Standard will open the Standard Coordinate Systems interface in which
a new coordinate system can be created. When finished, this new c oordinate system will show up in
the list of available coordinate systems.  

4. Scaling - put a mark in the Allow Scaling check box to enable scaling when orientating the aligned
coordinate system (and its image). If not enabled, only rotation translation is done when aligning.  

5. Click OK button when ready. Based on the point relations, the sec ond image will now be oriented
(rotated and translated) versus the primary image. The merged result can now be seen in an image
diagram. 

See also...

Standard Coordinate systems
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Maintaining 3D Coordinate Systems
The available coordinate systems for the currently selected c amera view are listed in the Coordinate
Systems frame. Initially in a 3D test, there is only one 3D coordinate system, based on the selec ted
calibration target. The cameras are orientated with respect to this coordinate system. Subsequently,
other coordinate systems can be added, typically for use in the presentation of results. 

1. Select the 3D Coordinate Systems option from the Edit menu.
The 3D Coordinate Systems dialog is displayed. 

2. You may:
o Add a coordinate system. 
o Change the definition of a coordinate system. 
o Remove a coordinate system. 
o Assign a different coordinate system to a camera view. 

3. Select the OK button. 

Procedure
Adding a Coordinate System

1. Select the Add button.
The New Coordinate System dialog is displayed. 

2. Key the Name for the new system. 
3. Select the OK button.

The dialog is removed and all the fields are enabled in the 3D Coordinate Systems dialog. 
4. Select Dynamic or Static mode by clicking on the appropriate radio button.

If Static mode is selected, key in the Reference Time, selecting the time unit from drop-down
list.

Alternatively, select the  button to set the Reference Time to the current time.
If Dynamic mode is selected, a reference time is not required because the system calculates the
transform parameters in every image in the sequence. 

5. If you wish to base the new system on a different origin, in the Translation frame:
o Select the new origin from the Point drop-down list. 
o Specify the New x value, selecting the unit from the adjacent list. 
o Specify the New y value, selecting the unit from the adjacent list. 
o Specify the New z value, selecting the unit from the adjacent list. 

6. If you wish to specify a new axis definition:
o Select the  x, y or z radio button to define the primary axis.
o Depending on the choice made, the radio buttons in the Plane frame are modified to relate

the selected axis with the other two, i.e. 
o For x, xy and xz; 
o For y, yz and xy; 
o For z, xz and yz. 

o Select a point from the Point 1 list in the Axis frame to define the selected axis. 
o Select a point from the Point 2 list in the Axis frame to define the selected axis. 
o Select the required radio button in the Plane frame. 
o Select a point from the Point 1 list in the Plane frame to define the selected plane. 
o Select a point from the Point 2 list in the Plane frame to define the selected plane. 

Changing the Definition of a Coordinate System

1. Select the coordinate system whose definition you wish to change. 
2. Amend the settings as described in Adding a Coordinate System. 
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Removing a Coordinate System

1. Select the coordinate system whose definition you wish to remove. 
2. Select the Remove button. 

Assigning a Different Coordinate System to a Camera View

If you wish to display data on the same diagram from two camera views in either the same or different
tests, the camera views must both use the same coordinate system. When a camera view is created, a
coordinate system with the same name is automatically defined. Additional coordinate systems may be
defined, as required.

Typically, in a 3D test, the two camera views are called 'left...' and 'right...'. To display data on the sam e
diagram from two camera views, a new coordinate system  is created for the 'right...' camera view which
has the same name and definition as the coordinate system for the 'left...' camera view. Both camera
views are assigned to the same coordinate system as follows: 

1. Select the coordinate system to be assigned to the camera view.
The change is effected when the OK button is selected. 

See Also...

Getting Started - 3D

Coordinate System - Setup Procedure
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Coordinate Systems - Setup Procedure
Coordinate systems may defined as dynamic or static. A reference time is specified for a static  coordinate
system and the axis position at that time is retained for all other times.

A dynamic coordinate system means that the frame of reference is recalculated for each successive
image.

A dynamic coordinate system is used where there is a need to remove the effects of unwanted m otion
from the data. For example, if part of the image is rotating, a dynamic coordinate system may be used to
ensure that the two selected points remain on the x-axis.

A static coordinate system means that the frame of reference is calculated only once and that is at the
reference time that you specify. Returning to the rotating example, it would mean that the two points do
not remain on the x-axis.

The following diagram illustrates how to set up new c oordinate systems.

The default coordinate system is based on X, Y with the Origin at their intersection, i.e. at the bottom
left corner of the image.

If the origin is moved to point P1, coordinates are then based on X - new origin and Y - new origin, i.
e. the origin is moved, but the orientation is not c hanged.

IF a new x-axis is then defined running from point P2 to point P3, coordinates are then based on X -
new origin and axis and Y - new origin and axis with the origin at P1, i.e. the origin is moved and
the orientation is changed.

If the y-axis is then inverted, coordinates are then based on X - new origin and axis and Y - new
origin and axis (invert) with the origin at P1.
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Maintaining Coordinate Grids
A coordinate grid consists of two series of lines at 90 degrees to eac h other superimposed on the image.
The orientation of the lines is not restricted to the horizontal and vertical planes. Different grid definitions
may be specified for different camera views, but there can be only one grid definition per cam era view.

For each camera view more than one coordinate system may be specified. In order to display a
coordinate grid on an image, it must be related to one of the coordinate system s specified for the camera
view. This is because the origin and orientation of the c oordinate system are used to define the origin
and orientation of the coordinate grid.

To specify a coordinate grid: 
1. Select the Grid Coordinate System from the combination list.

The list contains only those coordinate systems defined for the selected camera view.
The special entry "-- No grid --" is used to remove the grid from the image without removing the
grid definition. This is useful if you wish to use the grid during analysis, but not on printed
reports, or vice versa. The grid does not have to be redefined to redisplay it. 

2. Specify the Grid division.
The smaller the division, the smaller the gap between the grid lines.
The division may be specified in pixels or real world units. 

3. Select the Grid Colour and Axis Colour. 
4. Select the required Show checkboxes to specify the grid components to be displayed.

The Show All and Hide All buttons are used to select/de-select all the checkboxes. 
o Grid - displays the grid. 
o Axes - displays the direction of axes and the components displayed on each. 
o Ruler - displays a legend indicating the scale of the image in the units selected for the Grid

Division. 
o Grid Division - displays a legend indicating the size of the gaps between the grid lines in the

selected unit. The area of grid block is also displayed. 
5. Select the OK button. 

See Also...

Scaling and Coordinate System
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3D/6D

3D Calculations
3D from intersection
When a photograph is taken of a 3-dimensional scene, information about depth is lost and a 2-
dimensional image is generated. This means that it is in general impossible to reconstruc t the 3D scene
from only one image. When asked about the position in space of a given point in the im age, the best that
can be done is to compute the direction from the camera to the point. 

Light from the target point enters the cam era's lens and forms an image on the film. The target point
could have been placed anywhere on the line and still have produc ed the same point in the image. 

If there are two or more cameras viewing the same point, the situation improves considerably. Each
camera gives a line in space on which the target should lie. In an ideal world, these lines intersec t in a
point and all that has to be done is to compute the point of intersection. In the real world, they do not
and some, hopefully small, measurement errors are unavoidable causing the lines to miss the target. A
complete 3D position computation can be done using just two camera views. Though, the acc uracy
increases when using more camera views than two. In TEMA, there is no upper lim it for the number of
participating camera views in a 3D computation. The procedure as a whole using more than two camera
views is similar to the case when only two c amera views are used. 
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TEMA takes the observations (tracked pixel coordinates) from each camera, computes the direction from
each camera to the target, and finds the target position that is the best fit to the observations. "Best fit"
means that the sum of the squares of the difference between the observed directions and the direc tion to
the computed position should be as small as possible. In other words, TEMA performs a least squares
estimation of the target position.

Accuracy

The accuracy of the result depends on the camera geometry, i.e. the way the cameras are placed. This is
especially important if only two cameras are used. The best results are obtained when the lines of sight
from the cameras intersect at right angles. If they intersect at a very narrow angle the ac curacy is
considerably lower. 

Camera Orientation

To compute 3D data, the position of each camera must be known. To convert pixel coordinates to a
direction in space, the orientation of the c amera must be known, i.e. the direction in whic h the camera is
pointed. Some internal parameters (so called because they describe the camera-lens combination itself,
not where it is placed) of the camera must also be known. 

For each camera, TEMA uses six external parameters (three coordinates and three angles) and four
internal parameters, making a total of ten parameters. Fortunately, it is not nec essary to know all these
parameters or to measure them. Instead,  TEMA computes them from the image sequences. 

Reference Points

 The reference points should be well spread out both in spac e and in the images. As a rule of
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thumb, there should be reference points in all quadrants of the image, about two-thirds of the
way from the image center to the edges. 

 There must be at least four referenc e points visible in each camera view; this is the minimum
number for a calibration to be possible. However, using more points gives a better result, and it is
recommended that as many reference points are used as is practically possible. 

 Note that the 3D coordinate system that is created when measuring the reference points will be
used by TEMA when calculating camera positions and 3D data. TEMA supports right handedness
only. A good advice is to have the Z axis pointing upwards also. See here for more info.

See also...
3D - Getting Started

Camera Orientation
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3D Tracking Help Lines (Optional
Feature)
When tracking in 3D, once a point has been given in one cam era view, help lines showing the possible
positions of the point are shown in other c amera views. 

An example of this is shown below:
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In the left camera view, point Lower_left is visible, as shown below:
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However, it is not visible in the right camera view because it is outside the image. However, the location
of point Lower_left is indicated as being somewhere beyond the left end of the yellow line whic h is the
projection of the point from the left camera view, as shown below:

Note: In this case it can be seen that the line would not pass exactly through the centre of the target
point. This is because the position and calibration of the cameras has not been specified ac curately.

In order to display the help line, the point must be put to sleep in one camera view, in this case the right
camera. When the point is positioned manually in the left camera view, the help line is automatically
displayed in the right camera view, but only for the first image. For the help line to be visible in
subsequent images in the sequence, the point must be put to sleep in the right cam era view and tracked
in the left camera view. If the point is not put to sleep during tracking, the trac ker asks for its position to
be marked in the right camera view, which cannot be done bec ause it is outside that camera view.
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Importing Camera Parameters
(Optional Feature)
Note: This function is only available with the 3D or 6D Optional Feature.

Calibration and Orientation data is automatically saved when a test is saved. If you wish to use the sam e
data in a subsequent test, you may import it from the saved test, thus avoiding the need to repeat the
process. 

1. Select the Import Camera Parameters option from the Camera menu.
A standard Open dialog is displayed with the file type preset to '.ted'. 

2. Select the required test. 
3. Select the Open button.

Import Camera Parameters dialog is displayed, listing the camera views in the test for whic h
such data has been saved. 

4. Select the required camera view. 
5. Select the OK button.

The stored data for the selected camera view is imported. 
6. Repeat the process for any other camera view that you require. 

See Also...

Getting Started - 3D

Getting Started - 6D
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Calculating the Orientation of a Camera
(Optional Feature)
The Camera Orientation (camera position and direction) can be determined either

o in relation to a surveyed target, e.g Static Camera Orientation.

OR

o in relation to a another camera, e.g Relative Camera Orientation.

Please read more about applicable subject by clicking the links above.

See Also...

Getting Started - 3D
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Static Camera Orientation
Function
To determine the camera position and direction in relation to a surveyed target. The points and their x, y
and z coordinates must be specified in the target imported from an external file. It is not possible to add
points to the target dynamically and use them for orientation because their c oordinates are not known to
the system. Once a target has been imported into one camera view, it can be copied into another. Note:
The function is only available with the 3D Optional Feature.

Important notes about the 3D coordinate system

 The X,Y, and Z-axes  of the 3D coordinate system are defined from the coordinate system of the
reference points. E.g. if Z is "right" for your reference points, Z will also be "right" for any computed
3D coordinates in TEMA. Thus, the coordinate system used when measuring the reference points is
the same that is used by TEMA when orienting the c ameras and calculating the 3D. 

 TEMA always assumes a right handed 3D coordinate system. Therefore, make sure that the reference
points have been measured in the correct handedness. If a left handed c oordinate system is the case,
a quick solution is to switch sign on one of the axes. This will c hange the handedness of the
coordinate system. If you try to do camera orientation on left-handed reference points you will get
wrong 3D results (but no error messages).

 When orienting the cameras, TEMA calculates 3D position as well as attitude angles. Those  angles are
defined as: First yaw around original z-axis, then pitch around new y-axis, then roll around new
x-axis. An effect of this is that yaw, pitch and roll values are easiest to interpret when the coordinate
system of the reference points is defined as X forward, Y left and Z up. In this c ase yaw equals
turning your head, pitch equals nodding your head, roll equals tilting your head.

Procedure
1. Select the Find Static Camera Orientation  option from the Camera menu.

The Static Camera Orientation dialog is displayed.
 

2. Select the points to be used in the calibration by selec ting/unselecting the appropriate chec k
boxes.
The default is to include all the points listed.

 
3. Specify the Calibration Interval by selecting the appropriate radio button: 

 All times - performs the calibration over the complete time scale. 
 From/To - performs the calibration over the spec ified time scale: 

o Enter a From and/or To time, selecting the appropriate unit. 
o Select the appropriate  button to set the From or To time to the current time. 
o Select the  button to set the From time to the earliest time. 
o Select the  button to set the To time to the latest time.

 
4. Select the Calibrate button.

Note: An error message is displayed if too few c alibration points have been tracked. Track at least
four calibration points before continuing.
The Static Camera Orientation Results  dialog is displayed, showing the results. The following
details are displayed:

 Camera Position - x, y and x coordinates in the 3D coordinate system. See the above
Notes for the requirements on this. 

 Camera Orientation - Roll, Pitch and Yaw attitude angles. See the above Notes for
angle definition.
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 RMS Residual - The root mean square value of the individual point residuals. 
 Point Residuals - The level of error for each reference point between its m easured

position and its calculated position.
 
5. Check the RMS Residual value.

If it is small, the calculation is deemed to be accurate.
If it is large, check which of the Point Residuals are large.
A large value in any of the values shows that either a measured point position is not correc t, the
camera parameters have not been specified correctly or a reference point has not been positioned
accurately in the camera view. The cause of the problem should be identified and eliminated
before the calculation is repeated.

 
6. Select the OK button.

The Static Camera Orientation dialog is redisplayed.
 
7. Select the Close button.

The camera view icon in the Test Contents window changes to , indicating that the orientation
of the camera has been set.

Note: When the orientation of a second camera view has been calculated, the system
automatically add a 3D Results item to the Test Contents window. It contains a list of the target
reference points. Whenever another camera view is added, the 3D Results is recalc ulated. For a
point to be classified as a 3D point, it must be available in at least two cam era views, both from
cameras whose 3D position has been calculated by TEMA.

 
8. The camera (with Camera Orientation) can be displayed either 

 as a Curve showing its 3D position (applicable in all types of diagram s).
and/or
 as a Visualizer (symbol) showing both position and rotation (applic able only in a 3D

diagram).

To display camera as a Curve
o Select the Curves tab in the Plot section in the diagram Properties dialog.
o Highlight the applicable camera  in the Data Selection section and click Add button.

OR
Double-click on the applicable camera  in the Data Selection section.
The camera will be added in the Curves tab in the Plot section.

o Press OK button.
o The camera is now displayed in the diagram.

To display camera as a Visualizer  Note! Only valid for a 3D diagram.
o Select the Visualizer tab in the diagram Properties dialog.
o Highlight the applicable camera  in the Data Selection section and click Add button.

OR
Double-click on the applicable camera  in the Data Selection section.
The camera will be added in the Visualizer tab.

o Press OK button.
o The camera is now displayed (default size) in the diagram .
o The size of the Visualizer can be set/changed, either by:

o Simultaneously moving the cursor over the Visualizer and using the scroll function on
the mouse.

o Simultaneously keeping the left mouse button down and moving the cursor in the 
vertical direction.

o Right-clicking on the Visualizer, selecting Visualizer and then setting the size in the
Visualizer size dialog.

o Right-clicking on the Visualizer in the diagram Properties dialog, selecting
Properties and then setting the size in the Visualizer size dialog. 
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Illustration of camera as Visualizer. 

See Also...

Getting Started - 3D
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Relative Camera Orientation
Function
To determine the camera position and direction of one camera relative to another camera, using images
of the same scene as seen by the two cameras. 

Relative Camera Orientation always operates on a pair of cam eras. One camera is called the primary
camera and the other is called the secondary camera. The function calculates the sec ondary camera's
position and orientation in a coordinate system defined by the primary camera.

The user must identify a number of points and place them in both camera views. At least six points are
required but eight to ten points are rec ommended. 

Unlike in Static Camera Orientation the points do not have to have known 3D c oordinates. The distance
between two of the points must be known and entered as an input to TEMA. This is bec ause otherwise
the system will not be able to determine the scale of the scene: if you make everything, say, twice as
large, and move the cameras twice as far away from the scene, all images will look exactly the same, so
you must tell TEMA how large things really are.

Important notes about the 3D coordinate system

 When orienting the cameras, TEMA calculates 3D position as well as attitude angles. Those angles are
defined as: First yaw around original z-axis, then pitch around new y-axis, then roll around new
x-axis. An effect of this is that yaw, pitch and roll values are easiest to interpret when the coordinate
system of the reference points is defined as X forward, Y left and Z up. In this c ase yaw equals
turning your head, pitch equals nodding your head, roll equals tilting your head.

 If the primary camera hasn't already been oriented, the c oordinate system is defined to have its
origin in the primary camera's focal point, and its axes are oriented as X forward, Y left and Z up as
seen from the primary camera. 

Notes about point selection

The points used for relative orientation should be easily identifiable and well-defined in both views. It is
very important that these points are accurately tracked since inac uracies here will affect the entire 3D
process.

The points must not lie on or close to a line since then it is not possible to find the c amera position (the
points will look the same if the camera is rotated around the line). Ideally the points should be
distributed evenly over the entire measurement volume, but this is not an absolute requirem ent (all the
points can e.g. lie in the same plane). There should be points in all four quadrants of both im ages.

Calibrating more than two camera views

If you have more than two camera views they should be calibrated in pairs, e.g. (with three views) view
1 + 2 and view 2 + 3 or views 1 + 2 and 1 + 3. You do not have to use the sam e points for different
pairs of cameras, since each pair is oriented separately.

Procedure
1. Create two camera views and define the camera parameters for each view. 
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2. Identify at least six (preferably 8-10) points in the two views and track them  in both views. The
points must have the same name in both views. 

3. Select the Find Relative Camera Orientation  option from the Camera menu. The Relative
Camera Orientation dialog is displayed.

4. Select which camera views belong to the primary and secondary cameras (if you only have two
camera view, this will be set automatically).

5. Select the points to be used in the calibration by selec ting/unselecting the appropriate chec k boxes.
The default is to include all the points listed.

6. Specify the Calibration Interval by selecting the appropriate radio button: 
o All times - performs the calibration over the complete time scale. 
o From/To - performs the calibration over the spec ified time scale: 

 Enter a From and/or To time, selecting the appropriate unit. 
 Select the appropriate  button to set the From or To time to the current time. 
 Select the  button to set the From time to the earliest time. 
 Select the  button to set the To time to the latest time.

7. Select the two points that will define the scale. Enter the distance between the points ("distanc e"
refers to the 3-dimensional distance as measured by e.g. a ruler in the scene).

8. Press the Calibrate button.

Note: An error message is displayed if too few c alibration points have been tracked. Track at least six
calibration points before continuing.

9. The Relative Camera Orientation Results  dialog is displayed, showing the results. The following
details are displayed:

o Camera Position - x, y and x coordinates for both cameras in the 3D coordinate system.  
o Camera Orientation - Roll, Pitch and Yaw attitude angles for both cameras. See the above

Notes for angle definition.
o Baseline – the calculated distance between the two cam eras.
o RMS Parallax - The root mean square value of the individual point parallaxes. 
o Point Parallaxes - The level of error for each reference point. The parallax is defined as the

"miss distance" between the lines of sight from each camera to the point.

10. Check the RMS Parallax value.
If it is smaller than or of the same magnitude as the required measurement accuracy the calculation
is deemed to be accurate. If it is large, check which of the Point Parallaxes are large. A large value
in any of the values shows that either a measured point position is not correct, the cam era
parameters have not been specified correctly or a reference point has not been positioned acc urately
in the camera view. The cause of the problem  should be identified and eliminated before the
calculation is repeated. Please note that points that are far away from  the camera will in general have
larger parallaxes than points that are close to the camera.

11. If the calibration results are acceptable, press the Accept button. The camera view icon in the Test
Contents window changes to , indicating that the orientation of the camera has been set.

Note: When the orientation of a second camera view has been calculated, the system automatically
add a 3D Results item to the Test Contents window. It contains a list of the target reference points.
Whenever another camera view is added, the 3D Results is recalculated. For a point to be classified
as a 3D point, it must be available in at least two cam era views, both from cameras whose 3D
position has been calculated by TEMA.

12. The camera (with Camera Orientation) can be displayed either 
o as a Curve showing its 3D position (applicable in all types of diagram s).
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and/or
o as a Visualizer (symbol) showing both position and rotation (applic able only in a 3D

diagram).

To display camera as a Curve
o Select the Curves tab in the Plot section in the diagram Properties dialog.
o Highlight the applicable camera  in the Data Selection section and click Add button.

OR
Double-click on the applicable camera  in the Data Selection section.
The camera will be added in the Curves tab in the Plot section.

o Press OK button.
o The camera is now displayed in the diagram.

To display camera as a Visualizer  Note! Only valid for a 3D diagram .
o Select the Visualizer tab in the diagram Properties dialog.
o Highlight the applicable camera  in the Data Selection section and click Add button.

OR
Double-click on the applicable camera  in the Data Selection section.
The camera will be added in the Visualizer tab.

o Press OK button.
o The camera is now displayed (default size) in the diagram .
o The size of the Visualizer can be set/changed, either by:

o Simultaneously moving the cursor over the Visualizer and using the scroll function on
the mouse.

o Simultaneously keeping the left mouse button down and moving the cursor in the 
vertical direction.

o Right-clicking on the Visualizer, selecting Visualizer and then setting the size in the
Visualizer size dialog.

o Right-clicking on the Visualizer in the diagram Properties dialog, selecting
Properties and then setting the size in the Visualizer size dialog. 

Illustration of camera as Visualizer. 

See Also...

Getting Started - 3D
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Camera Position and Rotation
Definitions
When performing a camera orientation in TEMA, 6 parameters are computed for the camera: x, y, z, roll,
pitch and yaw.

Example computation of the camera position (x, y, z) and orientation (roll, pitch, yaw).

External Coordinate System
The position and attitude of a camera is always relative to a right-handed external coordinate system . In
the case of a static camera orientation the coordinate system is defined by the reference points. In the
case of a relative camera orientation the coordinate system is defined by one of the cameras.

Camera Position
The x, y and z paramaters are position coordinates of the focal point, or projection c entre, of the camera
in the external coordinate system. Physically, the focal point is located inside the camera, along the
optical axis. Its exact location along the optical axis depends on the focal length of the lens.

Camera Attitude
The roll, pitch and yaw parameters are Euler rotation angles according to the x y z (roll-pitch-yaw)
convention, and they describe the attitude of the camera in the external coordinate system.
Mathematically, the attitude describes a coordinate transformation between the camera coordinate
system – a coordinate system which moves together with the camera, so that a given point on the
camera always has the same camera coordinates – and the external coordinate system which forms the
frame of reference in which we want our results. The camera coordinate system is defined to have the
x-axis parallell with the optical axis of the camera, the y-axis parallell to the sensor and pointing left and
the z-axis parallell to the sensor and pointing up.
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The attitude of a camera with a certain roll, pitch and yaw parameters is defined as follows:

1. Start with the camera in the zero position, i.e. with roll=pitch=yaw=0. This means that the camera
coordinate system and the external coordinate system are aligned, as in the illustration above.

2. Rotate yaw degrees around the z-axis of the external coordinate system. Positive yaw is
counter-clockwise (ccw) as observed from above the camera.

3. Secondly, rotate pitch degrees around the new/rotated y-axis of the camera coordinate system.
Positive pitch is clockwise (cw) as observed from left of the camera.

4. Third, rotate roll degrees around the new/rotated x-axis of the camera coordinate system. Positive roll
is counter-clockwise (ccw) as observed from in front of the camera.

Note: The order of rotations is important!

An effect of this definition is that yaw, pitch and roll values are easiest to interpret when the external
coordinate system is defined as x forward, y left and z up. In this c ase yaw equals turning your head,
pitch equals nodding your head, roll equals tilting your head.

Examples:
o (roll=0º, pitch=0º, yaw=0º) corresponds to a camera in the zero position. I.e. the optic al axis

is aligned with the x-axis of the external coordinate system (ECS), “left” on the c amera sensor
is aligned with the y-axis of the ECS and “up” on the c amera sensor is aligned with the z-axis
of the ECS.

o (roll=90º, pitch=0º, yaw=90º) corresponds to a camera that is turned “left” 90º, then tilted to
clockwise (as observed from inside the camera) 90º. I.e. the optical axis is aligned with the
y-axis of the ECS, “left” on the camera sensor is aligned with the z-axis of the ECS and “up”
on the camera sensor is aligned with the x-axis of the ECS.

The attitude of the camera can also be expressed mathematically as the following rotation matrix R:

where roll=, pitch= and yaw=.

If we perform the matrix multiplications we get an explicit formula for R in terms of the sines and c osines
of the three parameters:
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with the notation

 

etc.
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Enter Camera Orientation
Function
If the 3D orientation of camera used in a 3D test is known, this function can be used instead of the 
Camera Orientation function that calculated the 3D position of a camera by the use of reference points in
two images. 

Here, we manually enter the 3D position of the camera directly. After this, a 3D test can be done using
this camera position. 

If we have used the Camera Orientation function, when the Enter Camera Orientation dialog is opened,
the output values from the Camera Orientation calculation will be present here. Any value can be entered
here, amending the calculated position. If changed, the new position will be used in the 3D test. 

Procedure
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Maintaining 3D Point Properties
(Optional Feature)
Note: Because a 3D point is derived from a 2D point in two or more camera views its definition is
automatically specified. Only the name can be changed. 

1. Select the required 3D point in the Properties List dialog. 
2. Select the Properties option from the Edit menu.

The 3D Point Setup dialog is displayed 
3. Key in the required Name for the point. 
4. Select the OK button.
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Inserting Reference/Target Points
(Optional Feature)
This function is used to insert the reference/target points from  an externally defined target. The
reference/target points are subsequently used to calculate the orientation of the c amera via the Static
Camera Orientation function.

Note: The function is only available with the 3D(Referenc e Points) or 6D(Target Points) Optional Feature.

Procedure
1. Select the appropriate Camera View window. 
2. Select the Insert Reference Points (3D) or Insert Target Points (6D) option from the Camera

menu. Note that the 3D coordinate system that is created when measuring the reference points
will be used by TEMA when calculating camera positions and 3D data. TEMA supports right
handedness only. A strong recommendation is  have the Z axis pointing upwards. See here for
more info.

3. To import reference/target points from a file: 
o Select the Import from File option from the sub-menu.
o A standard Open dialog is displayed with the file type preset to '.trg'. 
o Select the required target file. 
o Select the Open button.
o The Imported Target Model dialog is displayed. 
o Amend the target model, if required. Note that the 3D c oordinate system in which the target

model is expressed will be used by TEMA. Therefore, there are a few requirem ents on the
target model. See here for more explanation. 
 For each point you wish to define for the target: 

 Select the Add button.
 A point is added to the Points list. which has a default Name (P1, P2, etc.) and its x,

y, z coordinates set to 0,0,0. 
 Select the Name of the point and change it, if required. 
 In turn, select the x, y and z coordinates of the point and change them to the required

values. 
 For any point you wish to remove from the target: 

 Select the point. 
 Select the Remove button.
 The point is removed. 

 For any point you wish to modify:
 Select the entry in the Points list. 
 Select the Name of the point and change it, if required. 
 In turn, select the x, y and z coordinates of the point and change them to the required

values. 
o Select the required Unit from the list. 
o Select the OK button.
o The target points are added to the selected camera view in the Test Contents window. The

target file name is used as the name of the point Group. 
4. To copy reference/target points from another view: 

o Select the Copy from Other View option from the sub-menu.
o The Select Points dialog is displayed. 
o Select the required target from the list of those already in the test. 
o Select the Copy button.
o The points from the selected target are displayed in the Test Contents window under the

selected camera view. The target file name is used as the name of the point Group. 
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Target File Formats
The formats used by TEMA to import target models are described below:

 TRG Files (*.trg) - 3D Targets
The TRG format is the standard format for Cartesian target models in TrackEye and TEMA. 

A TRG file is a Windows text file. Both 8-bit and Unicode characters are supported. It consists of two
parts: point definitions and line definitions. 

A typical TRG file may look like this:

length unit=feet

* Point definitions with normal vectors

A 0  -9.8550984 1.0933176

B -6.096 -3.7590984 0.155448

"Point 1" -6.096 -3.7590984 1.0445496 

"Point 2" 6.096  -3.7590984 0.158496 

"Point 3" 6.096  -3.7590984 1.0475976

The file starts with a line that specifies the length unit in whic h the coordinates are given. The same
abbreviations for length units as are used inside TEMA. This line c an be omitted. If it is not present
TEMA interprets the coordinates in the current default length unit. 

The following lines define the target points. Each line contains the name of the point followed by its x,
y and z coordinates. The name and coordinates are separated by space and/or tab characters.

It is allowed to have point names containing spaces. In that case the point nam e must be surrounded
by double quotation marks (").

This file also contains one comment line. Any line starting with an asterisk (*) is skipped c ompletely
and can be used for comments. Blank lines or lines containing only space and tab characters are also
skipped.

Note: Numbers may use either a dec imal point or a dec imal comma.

 TGT Files (*.tgt) - 2D Targets
The TGT format is the standard format for 2D target models in TrackEye and TEMA. 

A TGT file is a Windows text file. Both 8-bit and Unicode characters are supported. It consists of two
parts: point definitions and line definitions. 

A typical TGT file may look like this:

length unit=cm

A 0 -9.855

B -6.096 -3.759

"Point 1" -6.096 -3.759

"Point 2" 6.096 -3.759

"Point 3" 6.096 -3.759

The file starts with a line that specifies the length unit in which the coordinates are given. The sam e
abbreviations for length units as are used inside TEMA. This line can be omitted. If it is not present
TEMA interprets the coordinates in the current default length unit. 

The following lines define the target points. Each line contains the name of the point followed by its x
and y coordinates. The name and coordinates are separated by space and/or tab characters. Numbers
may use either a decimal point or a decimal comma.
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It is allowed to have point names containing spaces. In that case the point name must be surrounded
by double quotation marks (").

The file may also contain comment lines. Any line starting with an asterisk (*) is skipped completely
and can be used for comments. Blank lines or lines containing only space and tab characters are also
skipped.

See Also...
Getting Started - 3D
Getting Started - 6D
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3D with moving cameras
Function
In applications where the cameras are not still during a test, a static camera orientation will not work as
it will only be valid for the exact image at where it is done. 

When the camera moves, so will all reference points in relation to the camera. Therefore, a new camera
orientation has to be done for each image of the sequence. This is what the Dynamic Camera
Orientation function does. 

The dynamic camera orientation will work for non-moving cameras as well, but the static orientation is
faster if there are many reference points. 

Procedure
This example has one moving camera and one that is still. 

1. For the non-moving camera, perform steps 1-8 in the 3D calculation procedure. 
2. Add the non moving camera view to the test. 
3. For the moving camera, right click in the Contents list and selec t Camera view properties/ Camera

Parameters. Enable Dynamic Orientation by clicking in the c heck box.  
4. Insert Reference Points for the moving camera. The Dynamic Camera Orientation does not have any

settings dialog, as the static does. As soon as at least four reference points have been inserted in the
view, the dynamic camera orientation function will calculate the camera position in the current image.
In this case, as the still camera is already oriented, 3D data for the referenc e points will be produced
at the same time. 

5. Continue with points 12 - 18 in the 3D test. 

See also...

Static Camera Orientation
Inserting Reference Points  
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6DOF Calculations (Optional Feature)
The 6DOF Calculations function computes the position and orientation of a tracked object from  a single
camera view. 

The motion of a rigid body can be described with six parameters: three position coordinates (x, y and z),
which give the position of a specific point on the body, and three attitude angles (roll, pitch and yaw),
which give its orientation in space. We therefore say that the body has six degrees of freedom, or 6DOF.
The term 6D (for "six dimensions") is often used as a synonym for 6DOF, and TEMA refers to the six
parameters as the 6D position of the body. 

To be able to perform 6DOF calculations for an object we must define an object coordinate system that
moves along with the object. If we know the  6D position of the object, and the objec t coordinates of a
point on the object, we can calculate where in an image, taken by a camera with known parameters, the
point will appear. 

On the other hand, if we have observed at least three points with known object coordinates, and m easure
the coordinates of these points in the image, we can set up and solve a system of equations that give us
the 6D position of the object. Unfortunately, with three points these equations usually have m ultiple
solutions, of which only one corresponds to the correct 6D position. TEMA therefore requires at least four
points to be tracked in order to get a unique solution. 

Coordinate Systems

TEMA always assumes that the object coordinate system  is right-handed. 

All results are presented relative to the object's position at the tim e t0. This means that the computed 6D
position is 0 at that time, and the value at any other time shows how the objec t has moved relative to its
position and orientation at t0.

*** Starting from version 3.9 there is an alternative coordinate system , the 'Camera Coordinate System'.
This coordinate system has its origin in the camera's focal point. The x-axis is the optic al axis, the y-axis
is left and the z-axis is up. The computed 6DoF parameters will be calculated relative to the c amera.

Differences between 3D and 6DOF

The main differences between TEMA's 3D and 6DOF options is that the 3D option requires at least two
cameras observing the same object, while the 6DOF option only needs one c amera. On the other hand,
the 6DOF option requires that at least four points on the object be tracked, and that these points have
known coordinates in the object coordinate system, while the 3D option works with isolated points. 

See Also...

Getting started - 6D
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DIC (Digital Image Correlation, option)

DIC Inspection Lines

An "Inspection Line" can be placed anywhere inside the DIC ROI (region of interest). This line will appear
as a plottable sequence in the Advanced Diagram  and can also be exported from the "Export DIC Data"
function.

This allows inspection of strain values along any line to get a cross-sec tion. Inspection lines work by
simply picking samples from the (previously calculated) continuous strain field along the line definition.
This guarantees that the results shown in the  inspection line will always agree with other results in TEMA
DIC.
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Camera Control (Optional)
Function
The camera control option enables the control of multiple high speed cameras of various types.

Camera Control delivers live images so that the user obtains instant feedback when param eters such as
resolution, frame frequency, exposure time, etc. are changed. 

Functions are provided for arming and triggering the cameras, downloading the rec orded images and
exporting them.

All the cameras that have ever been found by the program at some point are stored so that tests c an be
set up without network connection and with cam eras unplugged.

Procedure
The following scenario shows a typical use of the system and includes all the main functions. See also 
Ancillary Functions.

1. Scan for Cameras on the Network
This command scans the available network to identify all the attac hed cameras.
The Camera Control functions start in Live Digital mode.

Note: At any stage the test can be saved and recalled for later use. If a special test setup is often
used, it is a good idea to save the test before arming so that it can be used as a template for
other tests.

2. Add Cameras to the Test
This command enables you to select the cameras you wish to include in the test.

3. Setup Cameras. 
This command enables you to specify the parameters for the cameras in the test.

4. Set the Black Reference for the Cameras
This command enables you to set a "black area" as a reference point for the c ameras in the test.

5. Arm the Cameras
This command activates the cameras and, optionally, downloads the captured images.

6. For each camera from which you wish to download images:
Note: This step is not necessary if the cameras are set to download automatically.
o Select the camera in the Test Contents window.
o Download Images from the Cameras (if not performed automatically).

7. Export the Downloaded Images.
If required, the downloaded images can be exported using the standard export functions, i.e.
o for a single camera - Exporting Images;
o for multiple cameras - Exporting Multiple Images.

8. Clear the Images from the Cameras.
This function deletes all the images from all the cameras in the test.

9. When the required image ranges have been downloaded, they can be used for tracking as usual in
TEMA (if the Tracking option is set). 

10. At any time you may use the Time Overview function to display the status of the available
images.

Ancillary Functions

Preferences
Parameters relating to Camera Control and the cameras used are stored in the Preferenc e Archive. Once
they have been set up, they should not need to be amended unless new camera types are introduced, or
if the physical connection of the I/O Module is changed. See Maintaining Camera Control Preferences.
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Camera Assignment
This function enables you to relate physical cameras to logical cameras in the test description. This
becomes necessary if you have set up and performed a test and saved its description for subsequent use.
When the test is setup again, the c ameras (identified in the network by their unique IP addresses) m ay
not be in the same physical locations as in the original test, i.e. the cam era identified in the test
description by the name "top" may now be physically pointing from the side. The Assign Cam eras
function enables you to switch the physical cam eras to their appropriate logical names. See Assigning
Cameras.

Storing Camera Setups
When the cameras in a test have been configured and their black references set, the following proc edure
can be used to save the test setup for future use.

1. Select the Save Test option from the File menu.
The Save as dialog is displayed with the ".ted" file type pre-selected. 

2. Save the test as a template in an appropriate file. 
Continue with the current test. 

4. When the template is to be reused, select the Open Test option from the File menu.
The Open dialog is displayed with the ".ted" file type pre-selected. 

5. Browse for the file containing the template.
6. If the cameras have placed in different physical positions, use the Assign Cameras function to

reallocate them to the correct logic al names in the program. 

See Also...

Camera Control Toolbar
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Scanning for Cameras
1. Select the  Scan For Cameras option in the Camera menu.

A progress message is displayed while the network is sc anned for existing cameras.

When the scan has been completed, the message is removed from the display. 

See Also...
Controlling Cameras
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Adding Cameras
1. Select  in the Standard toolbar.

The Add Camera dialog is displayed, showing the cameras located by the camera scan function.

Each of the identified c ameras can be in one of three states, i.e. "Empty", "Full" and "Armed"
If one of the cameras you wish to use is not listed, make sure that it is connected to the network
and repeat the network scan.

2. Select the camera(s) (multi select with the <Ctrl> key) that you wish to use in the test.  OR:
Select the Views  tab. Select view(s) from the Views list. When a view is selected, the associated
camera(s) will be added to the test.       

3. Select the OK button.
The selected cameras or views are displayed in the Test Contents window.

Note: The parameters displayed in the Test Contents window can be changed directly. The new
values are reflected immediately in the Camera Setup window

See Also...

Camera Setup Dialog
Controlling Cameras
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Camera Setup Window
Function
Configure the Camera(s) used in a test before rec ording. 

Appearance of Setup Window

Lock Parameters
Some parameters can be locked to aid the setup of c ameras. The parameters that can be locked are
Frame Frequency, Resolution and Duration. It is only possible these param eters when all c ameras
controlled by the setup window are on-line and both frequency and resolution can be changed freely (see
Preferences).

 None 
o All parameters can be changed independently of eac h other.

 Resolution 
o When Frame Frequency is changed the Duration is calc ulated automatically.
o When Duration is changed the Frame Frequency is changed to a value that will give the best

match (duration is updated with the ac tual duration obtained unless the obtained duration is
different for the different cameras then the typed value will be shown).

 Frame Frequency
o When resolution is changed a new duration is calc ulated automatically
o When duration is changed a resolution is calculated that, for the c hosen Frame Frequency, will

(if possible) give at least the desired duration (duration is updated with the actual duration
obtained unless the obtained duration is different for the different cam eras then the typed
value will be shown).

 Duration
o When Resolution is changed the Frame Frequency is changed to get the wanted duration. The

displayed duration will be updated with the obtained duration unless the obtained duration is
different for the different cameras then the typed value will be shown.

o When Frame Frequency is changed the Resolution is c hanged to get the wanted frame
frequency and (if possible) at least the duration wanted. The displayed duration will be
updated with the obtained duration unless the obtained duration is different for the different
cameras then the typed value will be shown.

o When Duration is changed the Frame Frequency will change to adapt to the new desired
duration.

o A previously typed value for the duration will always be the goal even if it c ould not be
reached in previous change of resolution or frame frequency.

Imaging
 Image Size

o Specifies the pixel resolution of the image in the camera. Once a value has been selected, the
Frame Rate, Exposure Time, Pre Trigger Frames and Total Frames values are calculated.
Although these can be overridden, it is not rec ommended.  

o Note: Values that are invalid for the selected camera are grayed out in the combination list.
o Note: When "Free" is enabled in the preferences for Image Sizes the combination list is

replaced by enter fields for width and height where the user can type in the desired Image
Size (the resulting Image Size will change to the closest possible size). By pressing "Full" the
maximum resolution for each camera will be obtained.

 Frame Frequency
o Specifies the image frequency in Hz. 
o Note: Values that are invalid for the selected camera are grayed out in the combination list.
o Note: When "Free" is enabled in the preference for Frame Frequencies the c ombination list will

be replaced by an enter field where the user can type the desired Frame Frequency (the
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resulting Frame Frequency will change to the closest possible size).

Recording
 Pre Trigger Frames - Specifies the additional number of frames to be recorded before the Start

Time. 
 Total Frames - Contains the calculated total number of frames that can be stored in the camera,

given the selected Resolution. 
 Start Time - Contains the calculated time at which recording is to start. 
 End Time - Contains the calculated time at which recording is to end.
 Duration – Only enabled when:

o All cameras (controlled by the Camera Setup Window) are on- line.
o Frame frequency and image size can be changed freely (see Preferences).
o The Lock Parameters have been set to the sam e for all cameras (Resolution, Frame Frequency

or Duration).

Auto Download
 Enable - Check box used to indicate that images are to be automatically downloaded from the

camera to the system. 
 Download Priority - A camera with a low number will download before a camera with a high

number. 
 Start Frame - Specifies the number of the frame, including Pre Trigger Frames, at which

downloading is to start. 
 End Frame - Specifies the number of the frame, including Pre Trigger Frames, at which

downloading is to end. 
 Start Time - Contains the start time calculated from the Start Frame number. 
 End Time - Contains the end time calculated from the End Frame number. 
 File names for Dual download (optional). Specify filename 1 and 2. 

Exposure
 Exposure Time

o Specifies the exposure time (µs) for each image in Live Digital and Live Video operational
modes. (The longer the time, the lighter the image). 

o Note: The value set here will be used for  Snapshots also (when in Camera Control Mode,

clicking the Snapshot button .)
 Auto Exposure

o This is a Phantom Camera feature. If the toggle is enabled, the set Exposure level will be the
maximum value. 

o A rectangle can be defined by typing the values of four c orners (Left, Right, Top and Bottom)

in the camera view, or by using a defined Area Of Interest, using the  button. 
o The medium light in this rectangle is captured and used as Exposure Level. However, if the

value is lower than what is manually typed, it is not used.  
 Low Light Exp 

o The exposure and frame frequency are set to a special low light m ode to allow for focus
setting, etc. in low light conditions. The use of this is feature is to be able to set up the cam era
before a test without the need of extensive light. 

o Note: The value set here will be used for Low Light Snapshots also (when in Cam era Control

Mode, clicking the Low Light Snapshot button .)
 EDR Exposure

o This setting is applicable to Phantom cameras only.
o Extreme Dynamic Range exposure is used when the images contain very bright areas as well

as darker areas and both must be exposed correctly throughout the test. A typical exam ple
would be windscreen reflection from a light source appearing in part of the image sequence,
where a shutter time that gives the correct exposure when the reflection oc curs would cause
overexposure when the reflection is not present. Traditionally, this type of applic ation would
require either two cameras set with different exposures, or two separate tests.

o The EDR function enables the user to set a general exposure time for pixels that does not
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cause overexposure and a separate pixel dependent exposure for those pixels that cause
overexposure. It should be noted that the only reason to use EDR is if im age data is expected
to be in the overexposed areas of the image.

o The Y-axis indicates Black to White. The X- axis is the exposure time.

o Without EDR Applied:
Pixel 1 is exposed for the Integration period and becomes fully exposed, i.e. white, as does
Pixel 2. For the same exposure time Pixel 3 has some grey level.

o With EDR Applied:
EDR time is always shorter than the main exposure time and is applied from the end of the
main integration time. Pixel 1. is charged at the same rate as previous but is c lamped at a
factory set grey level. The Pixel is clam ped for a duration until EDR time, where once again the
pixel is allowed to charge. This is at the same rate and in the case of Pixel 1 is still
overexposed. Pixel 2 however does not reach saturation and so has some grey level instead of
being over exposed. Pixel 3 is not affected by EDR as it never reached the EDR clamp level. As
data is gathering is not intended to produce aesthetic ally pleasing images, EDR is a featured
to help obtain data where overexpose is an obstac le. EDR affects the image, i.e. a
monochrome image appears flat while a color image does not have representative c olors. The
argument being that to have good data but wrong c olor ismore of an advantage than correct
color but poor data. The EDR function gives the effect of an inc rease in Dynamic Range, which
is why it is often referred to as Extended Dynam ic Range instead of Extreme Dynamic Range.

Features of the camera setup

 The camera setup is a window. Therefore, it can be put in Free  or Locked  Mode. 
o If the camera setup window is in Free mode, it will display the settings for the c amera

currently selected in the test contents list. Even multi selections can be done. 
o If the camera setup window is in Locked mode, it will display the settings for the c amera(s) at
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where it was locked, no matter what is selected in the test contents list. The window can be
locked having  multi select cameras also. Having the camera setup locked on one camera
view, another can be opened for the any other c amera in the list, including the one already
selected or multi selection. 

Time Overview
 The Time Overview Window will be shown.

Show Summary
 Pressing this button a list is shown with name, image width and height, frame frequency, and

exposure time for all cameras controlled by the Camera Setup Window. 
 The Summary and Advanced will never be shown at the same time. The advanced section of the

Camera Setup Window will, if shown, be hidden when the Show Summary button is pressed.
 Hide Summary – Will hide the summary list.

Show Advanced
 Button used to display the parameters in the Miscellaneous frame and the Low Light Exp and EDR

Exposure parameters in the Exposure frame. 
 The Summary and Advanced will never be shown at the sam e time. The summary section of the

Camera Setup Window will, if shown, be hidden when the Show Advanced button is pressed.
 Miscellaneous

o Lock to IRIG time code - This setting is applicable to Phantom cameras only. A physical
input signal is used to control the camera timing. 

o Use External Frame Clock - The camera uses a signal from an external timing source for
frame control. 

o Download JPEG compressed images  - enable when using cameras with internal image
compressing. 

o Ready signal even if camera goes off-line after arming (optional)  - In some tests, we
might have cameras that are disconnected during the actual Arm /Trigger sequence. Typical
example is onboard cameras in impact tests. Because of the disc onnection, TEMA cannot
communicate with them. Enabling this option will make TEMA assuming they are armed and a
download will be made after the test is ready and the c amera is put back online.  

 Hide Advanced - Button used to remove the Miscellaneous group of parameter settings. 

Procedure
1. Select the camera to be configured.

Note: You may select more than one camera and configure them all in the same way in a single
operation. In such multiple select cases, field values that are different for the selected cam eras
are represented by blanks, and toggles by a gray toggle. By selec ting/setting a value the blank
disappears and all selected cameras are updated with the value set.

2. Select the  Camera Setup Window option in the Camera menu.
The Camera Setup window is displayed, showing a default set of parameters.

Note: Several of the parameters are also displayed in the Test Contents window and can be
changed directly. The new values are reflec ted immediately in the Camera Setup window.

3. Specify the required parameters, i.e. Imaging (image size and Frame frequency) , Recording
, Auto Download and Exposure.

4. If necessary, select the Show Advanced button and configure the Miscellaneous parameters
and the two additional Exposure parameters.

5. If a high Frame Rate is selected for the test, this limits the exposure time to short times only of
course. If this short time is too short to give a good image without the heavy duty lighting on, a
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special "low light" operational mode can be selected by clicking the low light button  in the
tool bar. These are orthogonal to the Video and Digital operational m odes. In low light mode the 
Frame Rate is always 50 Hz and the spec ial Low Light Exp exposure slider is used. The purpose
of this is to enable live images to be shown without the risk of the user forgetting to reset the 
Exposure and Frame Rate before arming.

6. Select the OK button.

7. Repeat the above procedure for other cameras that require different parameter settings.

It is also possible to set up multiple cameras if there is more than one present in the test. Multi select in
the test contents list and select the Camera setup . If a multiselection is done, the camera setup
window will not display any camera specific settings for any camera but only those common for the whole
selection. 

See Also...

Controlling Cameras
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Setting the Black Reference for the
Cameras
This function makes an image more even by compensating for the differing leakage c urrents
of each pixel which cause the addition of a constant to each pixel value. It can be used to rem ove stripes
or fixed pattern noise from images from Phantom imagers.

1. Select the camera to be configured.

2. Select the  Set Black Reference option in the Camera menu.
The Set Black Reference for <camera name> dialog is displayed.

3. Place the lens cap over the lens.
4. Select the OK button.

5. When the function has completed, select the OK button.
6. Repeat the above procedure for the other cameras in the test.

See Also...

Controlling Cameras
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Arming the Cameras
Function
The Arm command will arm all cameras in all Test Sec tions (optional) at once. The Trigger command,
that will start to capture images and record on the camera memories, is reached from the Arm dialog. 

Appearance
 Download Directory. With the Dual Download (optional) is used, there will be two different

Download directories here. Both can be amended. The default value(s) are taken from  the
Preference Archive/Directories. By default, the path will be taken from  what is specified in the
Preference Archive. However, this can be amended to any other download path. If any of the
directories specified does not exist, such will be c reated prior to the download.  

 The list of all the Camera Views affected by the Arm command. For every camera in list, the
following information is provided: 

o View - Name of the Camera View.
o Camera - Name of the Camera.
o Filename - The name of the file to be downloaded. With the Dual Download func tion

(optional), there are two columns for this, one for each download directory. The filename(s)
are taken from what is specified in the Camera Setup window for each camera, but can be
clicked and amended in the columns as well. Not only the file name(s) can be specified here,
but a whole path with the download directory can be typed. If a path is typed here, this will be
used instead of or in combination with what is in the Download Direc tory enterfiled above.
Some examples of this:
 If the Download Directory enter field contains the path C:\teimage\Download, and the

Filename pattern here is Download_1/Images, then the final path and filename will be
C:\teimage\Download\Download_1/First_Shot. 

 If the Filename pattern is C:\teimage\Images\First_Shot then the path in the Download
Directory enter field will not be used at all, only the path in the filenam e pattern. 

 If any of the directories specified in the Filename pattern does not exist, such will be
created prior to the download.  

o Status - status of each the c amera during the Arm/Trigger procedure. 
 Empty - The camera RAM memory is empty. 
 Full -  If automatic download is not selected, the "Full" status is displayed to indicate

completion.
 Armed - The camera is Armed, but no Trigger signal has been sent yet
 Triggered  - The camera has received a trigger signal
 Downloading - The percentage of the specified download range.
 Download Completed
 Waiting - The camera is waiting for other cameras to finish downloading, as the

number of parallel downloads is limited in order to save bandwidth. 
o DL Start - Image starting frame at Auto Download.
o DL End - Image ending frame at Auto Download.
o Warnings - Warning messages before and during the Arm/Trigger procedure. The warning

messages are sorted in a tree structure in categories. To see which cam eras that are affected
by the warning, click the + adjacent. 

Procedure
1. Open the Arming and Triggering dialog by:

o Selecting the  Arm option in the Camera menu
OR
o Pressing the  Arm button in the toolbar.
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The Arming and Triggering dialog is displayed.

The Status indicator (coloured circle to the left) is grey at start but will change colour depending on
status:

o Grey - Arm button not pressed yet, waiting for rec ording.
o Red - Error.
o Green - Cameras are armed.
o Blue - Recording (and download) in progress.
o Yellow - Recording (and download) not completed.
o White - Recording (and download) completed.

2. If you wish to amend the download destination for a c amera: 
o Amend the Download directory (directories) . 
o Select the appropriate Filename and change it.
o The Status indicator is grey (waiting for recording).

3.  Press the Arm button.
o The Status indicator will turn green.
o The recording time indicator will start.

Press the Disarm button to stop recording.

4. Press the Trigger button.
o The Status indicator will turn blue during recording (and download).

5. Wait for the cameras to finish recording.
o The Status indicator will turn white when recording (and download) is c omplete.
o The image sequences will be automatically downloaded after recording is complete (if Auto

Download is enabled).

6. Close the Arming and Triggering dialog.
 

See Also...

Snapshot Recording

There is an optional feature that is called Single Frame Arm that works in Single Test Sections only.
This will capture a snapshot from the cameras in test.
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Snapshot Recording
Function
The Snapshot Recording command (similar to the Arm command) will capture and record short image
sequences (one to a few images) per camera. The Capture command, that will start the rec ording, is
reached from the Snapshot Recording dialog. 

This command is very useful when capturing images of a calibration board for performing a Lens
Calibration.

Appearance
 Download Directory. The default value(s) are taken from the Preference Archive/Directories. By

default, the path will be taken from what is specified in the Preference Archive. However, this c an be
amended to any other download path. If any of the directories specified does not exist, such will be
created prior to the download.  

 The list of all the Camera Views affected by the Capture command. For every camera in list, the
following information is provided. 

o View - Name of the Camera View.
o Camera - Name of the Camera.
o Filename - The name of the file to be downloaded. The filenam e(s) are taken from what is

specified in the Camera Setup window for each camera, but can be clic ked and amended in the
columns as well. Not only the file name(s) can be specified here, but a whole path with the
download directory can be typed. If a path is typed here, this will be used instead of or in
combination with what is in the Download Directory enterfiled above. Som e examples of this:
 If the Download Directory enter field contains the path C:\teimage\Download, and the

Filename pattern here is Download_1/Images, then the final path and filename will be
C:\teimage\Download\Download_1/First_Shot. 

 If the Filename pattern is C:\teimage\Images\First_Shot then the path in the Download
Directory enter field will not be used at all, only the path in the filenam e pattern. 

 If any of the directories specified in the Filename pattern does not exist, such will be
created prior to the download.  

o Status - Status of each the camera during the Snapshot Recording procedure. 
 Waiting - The camera is waiting to start capturing/recording images.
 Recorded images # - Number of recorded images in the image sequence. 

o Warnings - Warning messages before and during the Capture procedure. The warning
messages are sorted in a tree structure in categories. To see which cam eras that are affected
by the warning, click the + adjacent. 

Procedure
7. In the Test Contents dialog, select (mark) those cameras aimed to start capturing images.
8. Open the Snapshot Recording dialog by:

o Selecting the  Snapshot Recording option in the Camera menu
OR
o Pressing the  Snapshot Recording button in the toolbar.

The Snapshot Recording dialog is displayed.

The Status indicator (coloured circle to the left) is grey at start but will change colour depending on
status:

o Grey - Capture button not pressed yet, waiting for recording.
o Red - Error.
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o Pink - Recording and download in progress
o Green - Waiting for new recording.

9. If you wish to amend the download destination for a c amera: 
o Amend the Download directory. 
o Select the appropriate Filename and change it.
o The Status indicator is grey (waiting for rec ording). 

10. Press the  Capture button.
o The Status indicator will turn pink (recording and download in progress).
o The Status indicator will turn green (waiting for new recording).

Press the Close button to stop recording.

11. Press the  Capture button for each new image to be captured and added to the belonging image
sequence.

o The image sequences will be automatically downloaded after recording is complete.

12. Close the Snapshot Recording dialog.

See Also...

Arming Cameras

There is an optional feature that is called Single Frame Arm that works in Single Test Sections only.
This will capture a snapshot from the cameras in test.
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Single Frame Capture (Optional)
Function
If working with Test Sections (optional), and the active section is in single mode, the arm commando will

be replaced with the Single Frame Capture, or Snapshot Capture, button . 

Appearance
 Download Directory. With the Dual Download optional functionality, there will be two different

directories available for camera download. The default value(s) are taken from  the Preference
Archive/Directories.  However, this can be amended to any other download path. If any of the
directories specified does not exist, such will be c reated prior to the download.  

 The list of all the Camera Views affected by the Single Frame Snapshot command. For every camera
in list, the following information is provided; 

o Name - name of the Camera View
o Camera - name of the camera in View
o Filename - the name of the file to be downloaded. With the Dual Download function

(optional), there are two columns for this, one for each download directory.  Both patterns can
be amended. The filename(s) are taken from what is specified in the Camera Setup window for
each camera, but can be clic ked and amended in the columns as well. Not only the file name
(s) can be specified here, but a whole path with the download directory c an be typed. If a path
is typed here, this will be used instead of or in c ombination with what is in the Download
Directory enterfiled above. Some examples of this;
o if the Download Directory enter field contains the path C:\teimage\Download, and the

Filename pattern here is Download_1/Images, then the final path and filename will be C:
\teimage\Download\Download_1/First_Shot. 

o if the Filename pattern is C:\teimage\Images\First_Shot then the path in the Download
Directory enter field will not be used at all, only the path in the filenam e pattern. 

o If any of the directories specified in the Filename pattern does not exist, such will be
created prior to the download.  

o Warnings - warning messages before and during the Arm/Trigger procedure. The warning
messages are sorted in a tree structure in categories. To see which cam eras that are affected
by the warning, click the + adjacent. 

Procedure
The procedure is basically the same as with the Arm commando described above. 

1. Select the Arm...  option in the Camera menu.
The Single Frame Capture dialog is displayed.

2. If you wish to amend the download destination for a c amera: 
o Amend the Download directory (directories) . 
o Select the appropriate Filename and change it. 

3. When clicking the Low Light button , the snapshot will be captured using Low Light mode. 

4. Select the Capture button.

5. When the function has completed, select the Close button.
Note: The Stop button is used to cancel the capture of images, but the images already captured
are downloaded.
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Note: If working with Test Sections (optional), the Arm command will only arm the cameras which views
are assigned to the currently active Test Section respectively. 

For the camera views not assigned to the active Section, the m essage 'Not Relevant for this Section' will
be stated in the filename pattern(s) in the Camera Setup window.  
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Manually Downloading Images from
the Cameras
Function
To download recorded images from a camera in test. There are two main ways of doing this, Manual
Download, as described below, and Automatic Download, which is set before the Arm/Trigger command
in the Camera Setup dialog. 

Also, if no Arm/trigger command has been sent to the c amera, there is a Live Download function that can
be used for downloading the currently displayed image in a camera view. 

Procedure
1. Select the camera from which images are to be downloaded.
2. Select the  Download Images option in the Camera menu.

Alternatively, right-click the required camera icon in the Test Contents window.
Select the  Download Images option in the pop-up menu.
If an Arm/Trigger command had been performed, the Download images from <camera
name> dialog is displayed, else the Live Download dialog will open 

3. Use the image sequence play buttons or the time slider to identify the range of images to be
downloaded.

4. If there is a large number of images, adjust the Speed slider to play the sequence faster.
5. Specify the Start and End images of the range you wish to download. If Auto Download had been

enabled for the camera, the range specified there will be set as default here as well. Set the
Current frame to Start/End by clic king the Use Current Frame buttons .

6. If required, amend the Filename for the generated image file. If set in the Preference Archive/
Directories or Sections Setup (optional), default File Names will be inserted from start. Those c an
be overwritten.  A full path including the destination directory can be typed here, or inserted via
the browse function. If using Dual Download (optional), two destinations can be specified here. 

7. Click in the Compress check box to enable file download in compressed format

Note: The Manual Download procedure might be of value even if Auto Download is enabled. This as the
auto Download only downloads the range spec ified in the camera setup. Should some event of interest
occur outside the boundaries of this interval, this can be downloaded m anually. 
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7. Select the OK button.
If there are images already in the specified file, a message is displayed, in which you can select
wheter to overwrite the existing file of to cancel and go back to the download dialog and specify a
new name to the view.

The selected image range is downloaded to the specified file. A progress dialog is displayed.

Note: The Cancel button is used to cancel the download, but it does not delete
the half-written file but makes it a completely valid, but shorter, image file.
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See Also...

Auto Download
Redo Auto Download
Live Download
Camera Setup Dialog
Controlling Cameras
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Dual Download (optional)
Function
An optional  feature where it is possible to specify two destinations for the autom atic and manual 
download commands. The procedure used for this is to first download to the first destination (presum ably
on the local disk) and then copy from there to the second destination. This m inimizes time until data is
safe on one disk.

Procedure

1. Specify the two download destinations. Go to preferenc es/Directories and set the Download 1 & 2
directories. Type in full paths or browse. 

2. Set the filename pattern also. The name typed here will be used to name the resulting downloaded
files. By default the filename pattern $VIEWNAME$ is used. When downloading, this very syntax will
be replaced by the name used for the camera view in the test contents list. 

3. Go to the Camera Setup Dialog. In the Auto Download area, there are two enter fields  called First
Filename and Second Filename. These are the dual download filenames. If the syntax pattern
above has been used in the preference, the view name in the test contents list will be in the enter
fields. If the view name is changed in the test c ontents list, so will the download filenames, but not
vice versa. The reverse buttons  

 
  
See also...

Manual Download

Live Download
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Live Download (optional) (optional)
Function
If working with Test Sections (optional), and the active section is in single mode, this function will be
available. The commando will download the image currently displayed in a camera view window. If this is

in snapshot mode, the latest shapshot using any of the snapshot functions (Norm al Light   or Low

Light Snapshot ) will be downloaded. If in continous mode, the one image displayed when the
Download button was clicked will be downloaded.

Appearance

Procedure
The live download command prerequisites that the c amera is online (green camera  in the test
contents list) and that no Arm/Trigger command has been sent to the camera. If this is done, the Manual
Download dialog will open instead. 

1. Mark the live camera in the test contents list and c lick the Manual Download button  in the tool
bar OR right click the camera in the list and select Manual Download . The Live Download dialog
appears. 

2. Enable instant image compression to jpeg format when downloading by c licking in the Compress
check box

3. If required, amend the Filename (2 filenames for Dual Download (optional)) for the snapshot
download. If set in the Preference Archive/Directories or Sections Setup (optional), a default File
Name will be inserted from start. This can be overwritten.  A full path including the destination
directory can be typed here, or inserted via the browse func tion.

See also..

Manual Download
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Redo Auto Download
Function
To download recorded images from a camera in test. There are three ways of doing this:
 Manual Download
 Auto Download - automatic download which is set before the Arm/Trigger command in the

Camera Setup dialog.
 Redo Auto Download - as described below, performs the Auto Download from the Redo Auto

Download dialog and is reached from the Camera menu.

Appearance
 Download Directory - The default value(s) are taken from the Preference Archive/Directories. By

default, the path will be taken from what is specified in the Preference Archive. However, this c an be
amended to any other download path. If any of the directories specified does not exist, such will be
created prior to the download.  

 The list of all the Camera Views affected by the Redo Auto Download command. For every camera
in list, the following information is provided: 

o View - Name of the Camera View.
o Camera - Name of the Camera.
o Filename - The name of the file to be downloaded. With the Dual Download func tion

(optional), there are two columns for this, one for each download directory. The filename(s)
are taken from what is specified in the Camera Setup window for each camera, but can be
clicked and amended in the columns as well. Not only the file name(s) can be specified here,
but a whole path with the download directory can be typed. If a path is typed here, this will be
used instead of or in combination with what is in the Download Direc tory enterfiled above.
Some examples of this:
 If the Download Directory enter field contains the path C:\teimage\Download, and the

Filename pattern here is Download_1/Images, then the final path and filename will be
C:\teimage\Download\Download_1/First_Shot. 

 If the Filename pattern is C:\teimage\Images\First_Shot then the path in the Download
Directory enter field will not be used at all, only the path in the filenam e pattern. 

 If any of the directories specified in the Filename pattern does not exist, such will be
created prior to the download.  

o Status - status of each the c amera during the Arm/Trigger procedure. 
 Empty - The camera RAM memory is empty. 
 Full -  If automatic download is not selected, the "Full" status is displayed to indicate

completion.
 Armed - The camera is Armed, but no Trigger signal has been sent yet
 Triggered  - The camera has received a trigger signal
 Downloading - The percentage of the specified download range.
 Download Completed
 Waiting - The camera is waiting for other cameras to finish downloading, as the

number of parallel downloads is limited in order to save bandwidth. 
o DL Start - Image starting frame at Auto Download.
o DL End - Image ending frame at Auto Download.
o Warnings - Warning messages before and during the Arm/Trigger procedure. The warning

messages are sorted in a tree structure in categories. To see which cam eras that are affected
by the warning, click the + adjacent. 

Procedure
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13. Open the Redo Auto Download dialog by selecting the Redo Auto Download option in the
Camera menu.

The Redo Auto Download dialog is displayed.

14. If you wish to amend the download destination for a c amera: 
o Amend the Download directory (directories) . 
o Select the appropriate Filename and change it.

15. Press the Download button. (Press the Stop button to stop recording).

16. Close the Redo Auto Download dialog.
 

See Also...

Manual Download

Auto Download
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Clearing Images from the Cameras
Certain cameras, e.g. Kodak, cannot provide live images while there is a stored image sequence. This
command is used to clear such cameras. It has no effect on cameras, such as phantom cameras, that can
provide live images while there is a stored image sequence.

1. Select the  Clear Cameras option in the Camera menu.
The Clear Cameras dialog is displayed.

2. Select the OK button.
All the images in all the cameras in the test are deleted.

See Also...

Controlling Cameras
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Assigning Cameras
This function enables you to relate physical cameras to logical cameras in the test description. This
becomes necessary if you have set up and performed a test and saved its description for subsequent use.
When the test is setup again, the c ameras (identified in the network by their unique IP addresses) m ay
not be in the same physical locations as in the original test, i.e. the cam era identified in the test
description by the name "top" may now be physically pointing from the side. The Assign Cam eras
function enables you to switch the physical cam eras to their appropriate logical names. 

1. Select the required camera in the Test Contents list.
2. Select the  Assign Camera To View option in the Camera menu.

The Assign Camera dialog is displayed, showing the cameras located by the Camera Scan
Function.
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3. Select the camera that you wish to use in the selected camera view in the Test Contents
window.

4. Select the OK button.

See Also...

Controlling Cameras
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Image Enhancement
Function
The Image Enhancement dialog is used to improve the colour composition and quality of a displayed
image by adjusting the colours and associated factors in the im age via a Vector Scope and/or the RGB
waveform. Both tools are displayed in the dialog. See dialog illustration and description.

Procedure
There are two ways of making adjustments:

 Use drag and drop in the Vector Scope and RGB Waveform graphs and view the results in the
displayed image. The changes made are automatically reflected in the parameter values displayed
below the two graphs.

 Adjust the parameter values displayed below the Vec tor Scope and RGB Waveform graphs and
view the results in the displayed image. The changes made are automatically reflected in the
Vector Scope and RGB Waveform graphs.

 Note: The Enabled Image Operations checkboxes can be used to view the before and after
situation. When a checkbox is deselected, the effect of any corresponding param eter changes is
removed. When the checkbox is selected, the changes are applied.

For instructions on the use of these tools, see: 
 Using the Vector Scope
 Using the RGB Waveform
 Using the Histogram

The objective of image enhancement is to improve the quality of the displayed image. The nature of
different image sequences dictates that no firm rules can be prescribed and that the procedure is
necessarily subjective.

The image enhancement can be performed across the whole image or on just a selected area of interest.

It is recommended that adjustments are made in the following sequence:
1. White Balance
2. Saturation/Hue
3. Contrast/Brightness
4. Edge Enhancement (Filter)

In normal circumstances the Degamma/Gamma operations should not be deselected.
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Image Enhancement Window 
Appearance
The Image Enhancement dialog contains the following:
 
Visualizations of the image dynamic and colour contents.   
 Vector Scope - contains the vector scope graph and associated controls:

 Intensity - slider used to increase or decrease the intensity of the colour representation in the
Vector Scope.

 Luminance - contains three radio button used to select the im age luminance range displayed in
the Vector Scope. 
o All - the full luminance range.
o High - only top 50% of the luminance range is displayed.
o Low - only bottom 50% of the luminance range is displayed.

 Tool - contains a list of tools. The selection made determines the factor that is to be adjusted via
the Vector Scope.
o White Balance Low - the white balance of the top 50% of the range.
o White Balance High - the white balance of the bottom 50% of the range.
o Saturation/Hue - the colour intensity and shade.

 RGB Waveform - contains the RGB waveform graph and associated controls:
 Intensity - slider used to increase or decrease the intensity of the colour representation in the

RGB Waveform.
 Tool - contains a list of tools. The selection made determines the factor that is to be adjusted via

the RGB Waveform.
o White Balance High/Low - the white balance of the full range.
o Contrast/Brightness - the contrast and brightness.
o Range - the contrast and brightness of the image is adjusted to make use of the full colour

range available. The selected range is fitted into 5% - 95% section of the total displayed.

 Histogram - indicates which part of the colour range is most concentrated. 
 Tool - contains a list of tools. The selection made determines the factor that is to be adjusted via

the Histogram.

 Show/Hide. The scope and histogram windows can be individually turned on and off, use the
corresponding buttons for this; 

o  Show/Hide RGB scope.

o  Show/Hide Vector scope. 

o  Show/Hide Histogram. 

 Vertical/Horizontal appearance. The scopes and histogram windows can be positioned vertic ally or

horizontally in the dialog, use the Vertic al  or Horizontal   buttons for this.

Note: Settings can be made by editing in the scopes also. Dragging levels will give the program an input
of desired new levels. The image will then be updated to match the new levels and, in turn, send a signal
to the visualizations to change. 

Tab Structure
 C/B - adjustment controls.

o Contrast - the contrast can be adjusted by am ending the numeric value or by moving the
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slider. Adjusting one automatically changes the other.
o Brightness - the brightness can be adjusted by am ending the numeric value or by moving

the slider. Adjusting one automatically changes the other.
See Auto Adjust below.

 Colour - adjustment controls.
o Saturation - the colour intensity can be adjusted by amending the numeric value or by

moving the slider. Adjusting one automatically changes the other.
o Hue Angle - the colour can be adjusted by am ending the numeric value or by moving the

slider. Adjusting one automatically changes the other.
 Edge - adjustment controls.

o Strength - specifies how much sharpening is performed. The zero point is in the middle of the
slider, i.e. the lower the number, the more blurring; the higher the number, the more
sharpening.

o Radius - specifies how the sharpening is performed. A low number concentrates the
sharpening towards small features, a high number concentrates on larger, more diffuse
features.

 WB - adjustment controls. The three columns relate to Red, Green and Blue.
 High - the white balance for the top 50% of the colour range, i.e. these figures are related

to the position of the top sliders in the RGB Waveform  graph.
 Low - the white balance for the bottom 50% of the colour range, i.e. these figures are

related to the position of the bottom  sliders in the RGB Waveform graph.
Note: The adjacent Auto buttons are used to perform the white balance automatically,
based on the specified area of interest.

o WB Presets - contains a series of radio buttons used to select a lighting configuration, i.e.
None, Daylight, Tungsten or Fluorescent. These apply preset calibrations to the image
without the need to mark the image. The last option, White Patch, is always disabled and
refers to the standard method. It is automatically selected when an area of interest is spec ified
in the image.

 Gamma - adjustment controls.
o Gamma - adds a Gamma correction related to the particular screen being used.
o FileGamma - the Gamma correction made when the image sequence was recorded.

 Enable - contains a series of check boxes used to select which image properties can be adjusted.
Those not selected cannot be adjusted, even automatically.
o Contrast / Brightness - adjusts the contrast and brightness.
o Edge - uses a sharpening filter to perform edge enhancement.
o Colour - adjusts  colour intensity and shade.
o White Balance - adjusts the displayed colours relative to a selected c olour.

The White Balance can be adjusted via the Image Enhancement tools or by the separate White
Balance tool.

 Reset - button used to remove the affects of the changes made.
 Reset All - button used to remove the affects of the changes made in all tabs.
 Auto Adjust - button used to adjust the contrast and brightness of the im age automatically.
 Calibrate Camera - button used to transfer (and save) applicable data to the cam era connected

to applicable image view. (The transferred data will be found in the Tools m enu\Preferences
\Camera Control, when the camera is configured). Next time the same camera is connected to an
image view these saved data will be used and the im age intensity will be scaled acc ordingly.

 Help - button used to display context-sensitive help.

Pixels Statistics
The pixel statistics is updated automatically by the system. It cannot be amended by the user.

 Note: Crushed and clipped pixels can already be present in the image before adjustments are
made.
o Crushed % - contains the percentage of pixels whose c olour has been minimized, i.e. become

totally black, by the adjustments made.
o Clipped % - contains the percentage of pixels whose c olour has been maximized, i.e. become

totally white, by the adjustments made.
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See Also...

Image Enhancement
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Image Enhancement - Contrast/
Brightness

1. Select the Auto Adjust button.
This adjusts the colour and brightness using an internal algorithm. The result can be amend, if
required, as described below.

2. Select the Contrast/Brightness tool from the list in the RGB Waveform frame.
3. Amend the Contrast and Brightness levels in the C/B tab until the required result is obtained.

See Also...

Image Enhancement Dialog - Description

Using the RGB Waveform

 



p356

© Image Systems AB, 2011

Image Enhancement - Edge
Enhancement

1. Amend the Strength and Radius levels in the Edge tab until the required result is obtained.

See Also...

Image Enhancement Dialog - Description
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Image Enhancement - Saturation/Hue
1. Select the Saturation/Hue tool from the list in the Vector Scope frame.
2. If you wish to set different levels for the High and Low Luminance, select the appropriate radio

button and perform the procedure for each.
3. Amend the Saturation and Hue Angle levels in the Colour tab until the required result is

obtained.

See Also...

Image Enhancement Dialog - Description

Using the Vector Scope
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Image Enhancement - White Balance
Function

Procedure
The following instructions prerequisites that all the image enhancement visualization scopes are visible. 

To set the White Balance for the low and high ranges separately
1. If you wish to set different levels for the High and Low Luminance, select the appropriate radio

button in the Vector Scope frame and perform the procedure for each.
2. Select the White Balance High tool from the list.
3. Amend the High level RGB values in the WB tab until the required result is obtained.
3. Alternatively:

o Draw an appropriate area of interest.
o Select the adjacent Auto button

4. Select the White Balance Low tool from the list.
5. Amend the Low level RGB values in the WB tab until the required result is obtained.
5. Alternatively:

o Draw an appropriate area of interest.
o Select the adjacent Auto button

To set the White Balance for the full colour range
1. Select the White Balance High/Low tool from the list in the RGB Waveform frame.
2. Amend the High and Low  levels in the WB tab until the required result is obtained.

To set the appropriate lighting configuration
1. Below the RGB values are the lightning configuration presets. Select the appropriate radio button

Note: The White Balance can also be set using the separate White Balance tool. A setting made using
the White Balance tool are reflected in the Image Enhancement tool.

See Also...

Image Enhancement Dialog - Description

Using the Vector Scope

Using the RGB Waveform
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Using the RGB Waveform

 

Each of the three columns represents 100% of the range for the assoc iated colour and can be moved in
two ways:

1. From the top down, reducing the amount of the selected colour:

 

2. From the bottom up, Increasing the amount of the selected c olour:
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3. Also, set the appropriate Intensity by dragging the slider below the scope.
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Using the Vector Scope

 

The direction lines superimposed on the graph indicate the colour towards whic h the colour balance is
adjusted, i.e.

 B - Blue 
 M - Magenta 
 R - Red 
 Y - Yellow 
 G - Green 
 C - Cyan 

The lines can be moved in two ways:
1. Moving around the circle, adjusts the hue towards the target c olour:

 

2. Moving towards the centre of the circle, adjusts the colour saturation:



p362

© Image Systems AB, 2011

 

3. The visualization can be set to Show All RGB values, High or Low. Use the radio buttons below
the scope. 

4. Also, set the appropriate Intensity by dragging the slider. 
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Using the Histogram

Each of the three curves represents the grey sc ale value for a colour channel; Red, Green or Blue.
The X axis represents the intensity and the Y axis represents the probability.
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Preferences
Function
Preferences are default settings used by the system that you may set to your own requirements. The
values set are used by the system unless overridden in particular circumstances. To carefully set up the
preferences to match the way you work is well worth the effort and tim e.  

Groupings
Each preference is assigned a grouping. The grouping for a preference is set in the Preference
Management (optional).

 Global - affects all users
 Profile - affects the selected Profiles  
 User - affects the current user only
 Machine - affects the current machine only. Used mainly when working towards a server. The

settings for the server will then affect all the clients to this.  

The preferences can be re-assigned a new grouping; a user preference can be set to a global instead etc .
The assignment for the preferences set in TEMA from start is a recommended default. 

Procedure
Preferences are maintained via the Preferences dialog which contains a list of the preferenc e categories
and a frame containing the settings for the selected category.
 

1. Select the Preferences option from the Tools menu.
The Preferences dialog is displayed. 

2. Select the preference you want to amend:

Note! If you want to reset the changes in any preference to the factory default values, select
Revert to Factory Settings by right-clicking the preference name in the preference list. This is
valid for all preferences except for Image Export. 

o Attributes (optional)
o Analysis

 Velocity
 Acceleration

o Camera Control (optional)
o Camera Types (optiona) (3D and 6D only) 
o Directories
o Disc Cleanup (optional)
o General 

 Display
 Cursor
 Tool Color

 Tracking
 Windows Defaults
 Time/Date
 Image Cache
 New Test (optional)

o Image Export
o Image Import
o Keyboard Bindings
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o Policies (optional)
o Precision and Units
o Remote Export Servers (optional)
o Test Planning System (optional)
o Views (optional)
o Presentation
o Printing

3. Repeat the above step until you have made all the required changes. 
4. Select the OK button. 
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Attributes
Function
A TEMA test and the camera views can be assigned extra information, or attributes. 

Camera View Attributes
Camera view specific additional information; focal length etc. The c amera view attributes created here
can be reached from the Camera view right click menu/Camera View Attributes

Note: Updated Camera View Attributes will affect new tests only. Neither the currently opened nor any
other existing tests are affected. 

Test Attributes
Test attributes are additional test information that can be used in various places in the program. 

Examples of use:

 When working with a Test Database Interface, specific xml files from an external test system can
be imported into TEMA. The contents in the file will then be re-interpreted and presented as a TEMA
test. The xml file contains some test specific  information in its syntax. Such will when imported into
TEMA appear in as test attributes.  With the help of this, the xm l file can be quality checked before
import into TEMA. The attributes setup is used for this. It is here the desired test attributes are set
up.  When making attempts to import, all of the required attributes must be in the file in order for
TEMA to accept the file. We can also export a tem a text into xml format. The set test attributes will
then be put into the resulting xml file. 

 Gun Scoring Test Data

Procedure
1. Enter the Attributes tab in Preferences.  
2. Select the Attribute type (Test or Camera View Attributes)
3. Add a new Attribute with the Add button. The Add Attribute dialog will open. In this, select the

suitable Attribute name from the drop down list and then type in the Attribute nam e and tool tip if
needed.  

4. Press OK when ready. 
5. Any attribute in the lists can be edited. Mark the attribute in the list and select Edit. The Edit

Attribute dialog will appear. 
6. in the Edit Attribute dialog, you c an amend the following parameters;  

o Attribute name. 
o Tool tip. This will be shown in the attribute's entry field
o Minimum numbers of characters entered . If set in policy, the amount of characters are

checked by TEMA at End Test command. 
o Number of lines for value.
o Default value. For integer attributes, this must be an interger. For floating attributes a

floating  value will do.

7. Press OK when ready.  

8. The order of the attributes in the list can be changed with the arrow buttons  . 
9. Delete an attribute by marking it in the list and pressing Delete.

Accessed via...
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Preferences/Attributes Set

See also...

Test Database Interface (optional)

Test Planning System (optional)
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Analysis
The Analysis preferences are:

 Velocity
 Acceleration
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Maintaining Velocity Preferences
The velocity preferences are used to specify how the velocity c alculations are performed, i.e. how many
adjacent points are taken into account when determining the velocity at a point. This is particularly
important for short sequences and at the ends of long sequenc es.

1. Select the appropriate Filter Length radio button, i.e. 3, 5, 7 or 9-point.
This specifies how many points are taken into account when calculating the velocity at a point. 

2. If you wish to limit the action of the specified filter at the ends of the sequence, select the 
Reduce Filter Length at Interval Ends  checkbox.
When this option is selected, a shorter velocity filter is used at the ends of the sequenc e. This
means that the number of samples that cannot be computed at the beginning and the end of the
sequence is reduced. 

3. If you wish to use a special length-two velocity filter to allow velocity calc ulations on very short
sequences, select the Use Short-Sequence Filter checkbox.
This filter operates down to two samples. It is more sensitive to measurement noise than the
normal filters, and is only be used if the Reduce Filter Length checkbox is selected. 

See Also...

Preferences
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The End
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Maintaining Acceleration Preferences
The acceleration preferences are used to specify how the acceleration calculations are perform ed at the
ends of sequences. 

If you want the system to reduce the filter length, i.e. the number of points used in the calculation, select
the Reduce Filter Length at Ends of Interval  checkbox.

See Also...

Preferences
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Camera Control Preferences (Optional)
Function
In order to organize the use of cameras in camera control, the cameras ever known by  the system is
stored. Those cameras can be set up to suit the way of use by the help of this preference pane. 

Note: These preferences only apply if the Camera Control optional feature is included in the system. 

Appearance
Information related to all the cameras seen by the program are stored in the Preference Archive for
future use. This allows the operator to specify the cameras to pertain in a test even when they are off-
line.

The following types of information are retained:
 Image Sizes

o The Entries in this list are used to fill the image sizes combination list in the Camera Setup
dialog. 

o Any value can be added here, but values that are invalid for the selected cam era are grayed
out in the combination list. 

o The order of the items in the list can be changed by help of the sort up  and down 
buttons. 

o When "Free" is enabled the list will not be used and the user can c hange Image Sizes freely
(within the limit of the camera specifications).

 Frame Frequencies 
o Entries in this list are used to fill the Frame Rate combination list in the Camera Setup dialog. 
o Any value can be added here, but values that are invalid for the selected cam era are grayed

out in the combination list.
o When "Free" is enabled the list will not be used and the user can c hange the Frame Frequency

freely (within the limit of the camera specifications).
 Known Cameras

o Contains a list of the camera types known to the system. 
o New camera types are added to the list automatically by the Camera Scan function. 
o New cameras can be added to the list. The Add Camera Dialog will then ask for camera

configuration. 
o Present known cameras can be edited; renamed. 
o Cameras no longer used may also be removed from the list.  

 Advanced
o Settings for live cameras connected to a frame grabber. 
o Click the check box to enable live images. 
o The size of the frame grabber buffer can also be set here. Enter the appropriate memory size

in MB. Set also the number of concurrent downloads. 
o Camera scanning and Remote control can also be configured from here. 

Maintaining Image Sizes

To add a resolution:
1. Select the Add button in the Image Sizes frame.

The Add Resolution dialog is displayed. 
2. Key in the Width and Height of the new resolution. 
3. Select the OK button. 

To remove a Image Size:
1. Select the resolution to be removed.



p373

© Image Systems AB, 2011

Note: Certain resolutions are c lassed as predefined and it is not possible to remove them. When
selected, the Remove button becomes gray. 

2. Select the Remove button in the Image Sizes frame.
The selected resolution is removed. 

Maintaining Frame Frequencies

To add a frame rate:
1. Select the Add button in the Frame Rates frame.

The Add Frame rate dialog is displayed. 
2. Key in the New Frame rate. 
3. Select the OK button. 

To remove a resolution:
1. Select the frame rate to be removed.

Note: Certain frame rates are c lassed as predefined and it is not possible to remove them. When
selected, the Remove button becomes gray. 

2. Select the Remove button in the Frame Rates frame.
The selected frame rate is removed. 

Maintaining Known Cameras

Note: Cameras are added automatically via the Scan Camera function except for c ameras connected via
a frame grabber. Such cameras has to be added with the Add button.

To remove a camera:
1. Select the camera to be removed.

Note: Cameras that are currently in use cannot be removed. These are indicated by a green icon
in the Known Cameras frame. Only cameras with a red icon can be removed. 

2. Select the Remove button in the Known Cameras frame.
The selected camera is removed. 

To configure a camera
1. Select the camera to be configured.
2. Select the Configure button in the Known Cameras frame. The Configure Camera window

appears. 
3. Change camera name by typing in the enter field. 

Maintaining Camera Specific Preferences and various

 General 
o Max Number Of Concurrent Downloads  from connected cameras can be set here. Type the

value in the enter field. 
  Phantom  

o Enable scanning. I order to make the camera scanning customized and more time efficient, the
camera types included can be set. If this toggle is disabled, no Phantom  Cameras will be included
in the scanning. 

o Use NVRAM as backup if possible -   Function used to emulate a battery backup function: if
the power goes off after the c amera became "Full" it will stay full.

 Photron
o Enable Scanning. I order to make the camera scanning customized and more time efficient,

the camera types included can be set. If this toggle is disabled, no Photron Cam eras will be
included in the scanning. 

 Redlake 100k
o Enable Scanning. This toggle is to speed up the process of sc anning for cameras. When

disabled, no Redlake 100k Cameras will be included in the scanning. 
 Redlake HG



p374

© Image Systems AB, 2011

o Enable Scanning. I order to make the camera scanning customized and more time efficient, the
camera types included can be set. If this toggle is disabled, no Redlake HG Cam eras will be
included in the scanning. 

o Continuous Live Image. Due to the design of the HG camera, this toggle has to be enabled in
order for live images to be captured from the camera. 

o Limit Temperature. When enabled, TEMA will turn off the camera when the sensor reaches its
limit temperature for func tion, +50° C. This is to prevent the sensor from the risk of getting to
hot (which in turn can lead to sensor failure). NOTE: Unless the application demands it, it is
recommended that this toggle is enabled at all tim es during camera usage. 

 Emulated
o Scan for DV cameras. Enable toggle to include Digital Video (DV) cameras in the scanning. 
o Frame Grabber Buffer Size (per camera).  Key in the value in MB. Clicking the Add button

will open up the Add New Camera dialog. Here, a new camera can be added to the test. 
1. Select the Configuration. There are two preset frame grabber-camera configurations. The

frame grabber and camera can also be set up manually. Select from the drop down lists. If
Gigabit Ethernet is the frame grabber, then

2. Click Add when finished. The Add Camera dialog will appear.  This will add the defined
camera to the test. It will now be in the list of known cameras. 

Using Dalsa cameras on a Coreco frame grabber.

The configure camera window will appear with more settings when using a frame grabber.
1. Select the camera to be configured.
2. Select the Configure button in the Known Cameras frame. The Configure Camera window

appears. 
3. Camera Settings. Change camera name by typing in the enter field. Change camera type by

selecting from the drop down list. Set also the appropriate COM port for the cam era connection.
Perform a fine camera calibration by enable the Time Calibration Settings check box. The
camera readout time can be set. This is the tim e required by the camera to send data (one image
frame) to the frame grabber. The default value is empirically determined. 

4. Frame Grabber Settings. Change Frame Grabber type by selecting from the drop down list. Set
also the appropriate resource index, which is the port number on the frame grabber. The default
value is -1. Set the CNF file by browsing to the file location on the workstation. Set also im age
mode. Default is L. 

 Remote Control

o Mode Single Client. 
Master - Slave.
Slave Only.

o Settings Group Name.
Port.
Arming Delay.

 Sound Trigger
o Use Microphone as trigger. A sound signal can be used for sending a trigger c ommand to the

cameras in the test. Enable for use. Connect a microphone to the workstation.  Set also the
threshold level for the trigger-sound signal. 

Maintaining the Advanced settings
1. Enable the Use Continuous Live Image toggle to enable live images. 
2. Key in the Frame Grabber Buffer Size in MB. 
3. Set also the maximum number of concurrent downloads. 
4. Configure Scanning. By selecting certain items in the camera list, the camera scanning can be

customized and more time efficient. 
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5. Configure Remote Control. 
Maintaining the I/O Module

1. If required, amend the I/O Module Address.
This is the IP address of the module in the network. 

2. For each of the Inputs and Outputs, select the appropriate pin from the adjacent lists, i.e. 
o Inputs

 Initiate Video Sequence - sending this signal is equivalent to clic king the Arm button
in the Arm dialog. 

 Trigger Monitor - test signal, not used. 
o Outputs

 Computer Ready - indicates that all cameras in the test are on-line and armed, and
that the Arm dialog is in its armed state. 

 Video Setup OK - indicates that "Initiate Video Sequence" can be sent, i.e. that the
Arm dialog is on the screen and its Arm button is enabled. 

 Computer Trigger - test signal, not used. 

See Also...

Controlling Cameras

Preferences
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Configure Known Cameras
Sapera

GigE

dv

phantom

redlake

Basic White Balance

More information to come (MITC).
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Maintaining Camera Type Preferences
(Optional Feature)
Note: These preferences only apply if the 3D and/or 6D optional features are inc luded in the system. 

If you work with the same cameras regularly, you can set the basic  information for them as preferences
so that it does not have to be entered each time a camera is used. 

1. You may:
o Add a new camera type. 
o Edit a camera type. 
o Remove a camera type. 
o Revert to defaults. 

2. Select the OK button. 

Adding a Camera Type

1. Select the Add button.
A new camera type is added to the list with a default set of param eters. 

2. Amend the default parameters by selecting each field and editing it: 
o Name. 
o Image Width. 
o Image Height. 
o Pixel Size. 

Editing a Camera Type

1. Select the camera type to be edited. 
2. Amend the parameters by selecting each field and editing it. 

Removing a Camera Type

1. Select the camera type to be deleted. 
2. Select the Remove button.

The selected camera type is removed. 

Reverting to Defaults

1. Select the Revert to Defaults button.
All new camera types are removed and the parameters for the remainder are reset to their
original values. 

See Also...

Preferences
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Maintaining Default Directory
Preferences
Function
Default Directories
In order to avoid re-keying a full path name to specify a frequently used destination you m ay specify a
default folder and subsequently just key in the file name. Separate default folders may be specified for
image export files and text export files. You may wish to spec ify a set of working folders to simplify the
use of the system and copy particular files between these working folders and their perm anent storage
areas.

Filename Patterns
In general, to avoid re-keying a filename commonly used when exporting from TEMA, a filename pattern
can set here can be used instead. 

Generic default filenames can be set, using a type string enclosed in $ characters. The result will be
used as filenames in the Camera Setup window. 

Example; we use $VIEWNAME$ as the default filename pattern in the Image Export Filenames patterns.
This result in that the filename given to a Camera View in the contents tree is used as default filename
for the image export automatically. Of course, this can be overridden by typing any filename in the
Image Export dialog. This is not reversible; the view name will not change in the test contents tree if the
changing image export filename is changed.  

Appearance
Directories

Image Import - 

Image export - default directory for Image Export Destination

Test Files - default directory for saving TEMA test files (.ted files) when perform ing the File/Save or File/
Save As.. commando. It  is also the default directory that opens when opening up a existing test. 

Download 1 & 2 - This is a Camera Control preference setting. When downloading files from  a camera,
there is a Dual download (optional) function which allows downloads to two different destinations
simultaneously. The default download directories can be set here. If one of those two are left em pty, no
download will be made to this second directory. 

Test Templates - default directory for saving TEMA template files when performing the File/Save as
Template commando. Note: If nothing is typed here, and we perform the File/New Test command, TEMA
will load the <Empty test> template instantly, in other words, the Tem plate functionality is disabled. 

Filename Patterns

Filename pattern for live image export
This is a Camera Control preference setting. When downloading files from  a camera, there is a Dual
download (optional) function which allows downloads to two different destinations sim ultaneously. The
resulting directories and default filenames of the downloaded files c an be set here. 
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The filename can include a full path to a destination direc tory, for example; C:\Test folder\TEMA\Test
\camctl.

Procedure
1. Directories. For the used directories, key a new directory name including the full path, or selec t the

 and browse for the name.

2. Enable the 'Add Empty test to Template list' toggle, in order to make an empty Template, with  no
setups at all, available when Opening a new test. For normal use, it is recommended to have this
toggle enabled at all times. 

3. Filename Patterns. Any default filename can be typed in the enter fields. If using a m acro
replacement pattern, type in the macro enclosed in $$ characters. 

4. Select the OK button when ready. If any of the specified directories are not present, TEMA will ask
whether to create such directory or not. 
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Disc Cleanup setup
Function
This preference pane is used to setup a file deletion service. This
allows you to schedule deletion of certain files after a spec ified
file retention time has expired. Please be aware of the danger with
this setup. After you enter a deletion request here it will rem ain in
effect until removed. All files matching the patterns will be deleted
without warning as soon as their retention times expire. Check your
file name patterns one extra time before adding the deletion request!

The list shows the deletion requests that have been set up so far.
Each request consists of a file pattern, a retention tim e in days and
an option to include files in all sub-directories of the directory
specified in the pattern, and also the sub-directories themselves. 

Procedure
To add a new deletion request click the add button and enter the file
pattern in the entry field. * characters are treated as wildcards
which match any combination of letters in the file name. For instance
to remove all .tei files in the directory c:\TEMA\download you
specify the pattern:

c:\TEMA\download\*.tei

By selecting the Include Subdirectories option you indicate that the
deletion request is to operate on files in all sub-directories of the
directory in the pattern as well. Use this option with discretion, please!

By selecting the Empty Directories option you indicate that the deletion 
request is to remove all emptied subdirectories of the directory in the pattern 
as well.   

Finally you must specify the file retention time in days. Files which
are older than this day, and match the pattern, are removed any time
that the application runs. This chec k is performed when the
application starts and then once every hour.
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General

Maintaining Display Preferences
Preferences
Different computer screens handle the display of images differently. This is due to differences in the way
that the voltage level is converted to a light level. The system  assumes a default gamma value for
imported image files. Depending on the nature of the sc reen you are using, you may need to set the
display gamma to a different value to achieve clear im ages. 

1. Key an appropriate Display Gamma. 
2. Select the OK button. 

See Also...

Specifying Views

Maintaining Views - Image File Properties

Preferences
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Maintaining Cursor Preferences
Preferences
The choice of cursor shape is a matter of personal preference. The system offers a choice of three cursor
shapes for point positioning. 

1. Select the required cursor. 
2. Select the OK button. 

The options available are: 
 Cross

The cursor is displayed as a simple cross, i.e.

 Cross wire
The cursor is displayed as a pair of cross wires extending to the boundaries of the im age, i.e.

 Target Cross wires
The cursor is displayed as a pair of cross wires extending to the boundaries of the im age, but with
the center section displayed as a target point, i.e.

See Also...

Preferences
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Maintaining Tool Colour Preferences
The Colour Editor dialog is displayed in which you can specify the required colour for TEMA tools.

See Also...

Preferences
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Maintaining Tracking Preferences
Move Point Method
The normal mode of operation when repositioning points during trac king is to click on the point and drag
it to the required position. The alternative is to click at the place where you want the currently selec ted
point in the Points List window to be repositioned.

If you choose to reposition points by clic king, the normal mode of operation the system uses to move
from point to point is to move to the next image automatically. You may amend the preference setting to
prevent this, which means that the  or  button has to be pressed to move to the next image when all
points in the current image have been specified. 

1. If you wish to reposition points by dragging, select the Drag radio button. 
2. If you wish to reposition points by clic king:

o Select the Click radio button. 
o Select the Auto Step to Next Image check box if you to move automatically to the next

image, otherwise deselect it. 

Overwrite Manual Point
 Yes - Enables that manually tracked samples will be overwritten. A warning message will appear and

must be acknowledged.
 No - Manually tracked samples keep their positions.

See Also...

Preferences
Unregister a Point in the Selected Interval
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Window Defaults
In order to customize the appearance of the TEMA workspace, the defaults of the windows when
appearing can be set. 

 Text to show in Title Bar - type an initial default name for new windows. This can be changed in for
each window individually later.  

 Number of Image Window Columns  - this value can be set between 1 and 4 and will result in as
many columns that image windows (camera views) will be placed at. Useful in a test with m any
camera views. The sizes of the windows will be set to match the column condition set. 

 New Image Windows are free - click in check box to enable.
 New Camera Setup Windows free - click in check box to enable.
 New Image Enhancement Windows are free - click in check box to enable.

At the bottom of the preference window/general is a number 
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Time/Date
Specify the format of the Timestamp display here.
For example YY-MM-dd 

See also...

Specifying Time Control
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Image Cache
Image Cache is an "Intermediate memory" for fast access, which enables to increase the speed when
replaying an image sequence.

1. Fill in values for either:
o Total size (Mbytes).
o Time to keep (in seconds).
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New Test
Enable certain windows to be intially open when starting up a new test. 

 Gun Scoring Setup (optional: Gun Scoring)
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Image Export
Function
The two Image Export Preference panes do not have any individual settings. The settings are all done in
the Export dialog, either in:

 the Image Export
OR
 the Combined Image Export

in which the set up parameters can be saved into the preference archive. Later, such saved preference
setting can be applied in a test and used again. 

The saved settings are all in the list presented in applicable preference pane. 

Appearance
Each pane consists of a list of saved settings. There is always a Default setting, whic h cannot be
removed. When a new test is created, the Default settings are applied as the initial settings suggestion
when the user enters the Export dialog. Below the list are functions for rem oving or renaming items from
the list. 

Procedure
Save/Load Settings
When the Export dialog has been entered, but before the export is actually perform ed, some parameters
may require some changes by the user. Now, the status at where the im age export is at this stage can be
saved in the preference archive also using the Save in Preference func tion. When this option is selected,
there is a choice of where in the preference archive to store this inform ation. 

1. Store the settings as a new Default, thus overwriting the previous default setup. If this is done, this
will be the settings that are initially applied on a new test etc .

2. Save the settings in another name. This will add a new instance in the list of preference settings. 

If (1) is selected, the next time the Load Preference button  is clicked in the Export dialog, the
"new" Default will be used. 

If (2) is selected, the next time the Load Preference button  is clicked, the user will get the choice
of which settings to apply; the Default (now, still the "old" one, which was untouc hed) or the new
instance in the list.

Maintaining the List
1. Any item besides the Default can be removed. Mark the item in the list and click Remove. 
2. Any item besides the Default can be renamed. Mark the item in the list and click Rename.  A small

rename dialog will appear where a new name for the image export setting can be typed. 

 



p390

© Image Systems AB, 2011

Image Import
Function
To set the defaults for importing image sequences into a camera view. 

Appearance
 Bayer - set the inteprestation method for the color patterns used in Bayer files.  

 Photo CD - set the image size used when importing pcd files. 

 DRS Tiff  - a DRS tiff file may contain one frame that can be used as blac k reference. To use this
frame for image subtraction, removing noise in the image sequence as a whole, c lick the Remove
Calibration Image Subtraction check box. If the user knows that the DRS tiff file to import is a
color file, the Force Color Interpretation should be enabled in order for TEMA to handle the im age
correctly. 

 AVI - Normally TEMA will detect automatically when to use DirectShow or not. However, in some
rare cases the user has to intervene. Experiment by turning this parameter on or off if suspecting that
the AVI sequence is not read correctly.
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Maintaining Keyboard Binding
Preferences
A large number of keyboard hot keys are used in TEMA. Most im portantly, the time panel and tracking
functions are available on the F-keys.

The list of factory keyboard assignments in the current version is given below.

The list contains all the TEMA com mands that are available for binding to a key com bination. Where a
key combination is not displayed, the corresponding command does not have a hokey

These assignments are stored in the Preferenc e Archive and may be amended as required.

The following functions are provided:
 Bind a command to a hokey. 
 Unbind a command to a hokey. 
 Revert a command to its factory setting . 
 Revert all commands to their factory settings. 
 Generate a printable key map. 

Binding a command to a hokey
1. Select the Command that you wish to bind.
1. Note: If an already bound command is selected, the old binding will be overwritten. Also, there

are some commands that cannot be bound or have their binding c hanged, e.g. Exit. In these
cases, the Bind and Unbind buttons are disabled. 

2. Select the Bind button.
2. The Bind <command name> dialog is displayed. 
3. Select the Key to which the command is to be bound. 
4. Select the Modifiers to be associated with the key. 
5. Select the OK button.
5. If the selected Key/Modifiers combination is already in use, the new binding is added to the list.
5. If the selected Key/Modifiers combination is already in use:
5. The Unbind old command dialog is displayed. 

o Select the OK button to replace the original binding with the new one. 
o Select the Cancel button to leave the original binding intact. 

Unbinding a command to a hokey
1. Select the Command that you wish to unbind.



p392

© Image Systems AB, 2011

1. Note: If the selected command is not already bound, the Unbind button is disabled. Also, there
are some commands that cannot be unbound or have their binding c hanged, e.g. Exit. In these
cases, the Bind and Unbind buttons are disabled. 

2. Select the Unbind button.
2. The binding is removed from the list. 

Reverting a command to its factory setting
1. Select the Command whose binding is to be returned to its factory setting. 
2. Select the Revert button.
2. The factory setting is restored.
2. Note: The Revert button is disabled for commands that have not had their bindings c hanged. 

Reverting all commands to their factory settings
1. Select the Revert All button.
1. The Revert All dialog is displayed. 
2. Select the OK button.
2. The factory setting is restored for all c ommands that have had their bindings changed. 

Generating a printable key map
1. Select the Key map button.
1. A printable list of the current bindings is displayed. 
2. Select the Print button to print the list. 
3. Select the Close button to close the list. 

See Also...

Preferences
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Policies (optional)
Function
Policies are settable security limitations for the changing of certain program parameters or the
performance of certain program actions. 

The policy levels spans from no limitations (lowest security level) to a password protected level where
only an administrator can unlock and change the polic y (highest security level). 

The use of this is to minimize the risk of having important test settings changed by m istake. 

Policy Levels
The policy levels from lowest to highest will result in the following when c hanges are to be made at
where it is assigned;   

 Allow - no action. The parameter change or program action can be performed with no limitation.  
 Dismissible Warning - a warning will appear when then the attempt to perform the parameter

change or program action is done the first time. A check box can be marked that will dismiss the
warning next time a change is made.  

 Warning Every Time - a warning will appear each time the parameter change or program action is
to be made. This can not be dismissed. 

 Password Protected - the password as set in the Preference Management will be required to
perform the parameter change or program action.

 Password + Warning  - the password as set in the Preference Management will be required to
perform the parameter change or program action, plus a warning will appear. 

 Forbidden - no changes can be done here. In order to perform the parameter change or program
action, the policy level assigned for this action must be changed in the Preference Management.  

Appearance
The program actions that can be assigned policy levels are;

 Add remove views not specified from Test Planning system. This policy controls the handling of
camera views in a test when working towards a test planning system . When making attempts to add
an external view, the system will react due to the policy set. 

 
 Adding views that are not in the 'Views' preference. This policy controls the handling of camera

views not in the preference 'Views' list. When making attempts to add an a camera view that is not in
the list, the system will react due to the policy set. 

 Selecting file name other than the pattern in Save Test As command . This policy controls the
name to which a test is saved when performing the 'Save As..' command. When the test was created,
the name specified will be used as a reference. When making attempts to save the test in another
name than this, the system will react due to the policy set. 

 Selecting Image download file name other than pattern. This policy controls the name to which
the file from a camera download is saved. When a download is about to be done, the system  will
react to the name set in the Camera Setup dialog, Arm dialog or Manual download dialog due to the
policy set. 

 Policy for Performing the Image Export Command. This policy controls the performance of
image export, when making attempts to perform such, the system will react due to the policy set. 
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 Changing the Image Export Format. This policy controls the possibility to change the im age
format to which an image export can be done. When making attempts to perform such, the system
will react due to the policy set.

 Editing the Image Overlay setup. This policy controls the possibility to make any changes in the
Image Export/Overlay setup. When making attempts to perform such, the system will react due to
the policy set.

 Ending a test without downloading all images.  This policy controls the possibility to perform the
End Test commando without downloading all images from the cameras used in the test prior to the
command is given. 

 Ending a test without saving the TED file. This policy controls the possibility to perform the End
Test command without saving the test (.ted file) prior to the com mand is given. 

 Ending a test where mandatory Attributes don't have values. This policy controls the possibility
to perform the End Test command even when Test Attributes, requiring at least n characters, are
without any values.  

Note: in the Preference Management, there are also settable policies with the same logic as what is used
here. However, these are valid for whole preferenc e panes, not only single program parameters.

See also...

Preference Management
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Maintaining Precision & Units
Preferences
Precision
The precision at which the values of various quantities are m aintained by the system may be specified as
a set of defaults. If you normally work at a particular level of accuracy or your organization has a
standard governing precision levels, those levels may be specified as a set of preferences.

The precision at which values are displayed may be specified either in absolute or relative terms and
can be set per data type. 

 Absolute precision is spec ified in terms of providing a decimal accuracy level and a measurement
unit. For example, a time precision specified as 0.0001 seconds would display all tim e values with
a precision of one ten thousandth of a second. The first significant digit is the first non- zero digit
from the left, and then more digits are added up to the desired precision. Below  is a more
illustrative example by rounding a number of numbers to four signific ant digits:

        1.234567 -> 1.235
        12.34567 -> 12.35
        123.4567 -> 123.5
        1234.567 -> 1235
        12345.67 -> 12350
        0.1234567 -> 0.1235
        0.01234567 -> 0.01235

 Relative precision is specified in terms of the number of significant digits, irrespective of the
decimal point position. 

Specify or override an inherited precision

Many data types are organized into a tree structure of types and subtypes (the list in the left-hand pane
in the preferences window shows this tree struc ture).

By default each data type inherits the prec ision setting from its "parent" type (if it has any). As an
example, longitude, which is a sub-type of angle, inherits the settings from  angle. This can be overridden
by selecting the override option. This will make it possible to give a data type a setting different from
that of its parent. Selecting don't override reverts to inheriting from the parent.

Procedure
To simplify the maintenance of the prec ision specification, some data types inherit their precision from a
higher level in the tree, but you may override this, if necessary. 

1. Select the measurement type from the Available Dimensions list whose precision you wish to
specify. 

2. To specify the precision in absolute terms:
o Check the Absolute Precision box. 
o Key in a precision value (which specifies the precision to that level). 
o Select the appropriate unit, if appropriate, from  the drop-down list (e.g. time precision may be

specified in seconds, minutes, etc.). 
3. To specify the precision relative terms:

o Uncheck the Absolute Precision box. 
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o Key in the number of significant digits. 
o Select the appropriate unit, if appropriate, from  the drop-down list (e.g. time precision may be

specified in seconds, minutes, etc.). 
4. To override an inherited precision:

o Select the Override button. 
o Specify an absolute or relative prec ision. 

5. To specify an inherited precision:
o Select the Don't Override button. 

6. Repeat the process for any other data types. 
7. Select the OK button. 

Units
If your organization uses a particular standard set of measurement units for quantities such as distanc e,
speed or acceleration, you may specify those units as defaults. In any particular situation if a different
unit is required, you may override the default.
 

1. To amend a default unit, select the measurement type from the Available Dimensions list.
The current Default Unit is displayed. 

2. To change it, select the required unit from the drop-down list.
Note: The drop-down list only contains those entries that are valid for the selected m easurement
type. 

3. Select the OK button. 

See Also...

Preferences

 



p397

© Image Systems AB, 2011

Remote Export Servers
Function
In order to save processor capacity at the workstation, image exports can be set to be performed by an
external computer. This external computer is called Server while the "main" computer is called Client.

Appearance 
The preference pane contains a list of the current set up export servers. The list includes; 

 The server IP address
 The used outport on the server machine
 The directory used for communication between the client and the server (job directory). 

New items can be added to the list or present ones removed. Items in the list can also be edited.  

Procedure
Go to the preference pane via Tools/Preference/Remote Export Servers  
1. To set up a new remote server, click the Add button. The Setup Remote Server Parameters  dialog

will appear.

2. Browse to the set job directory for the Remote Export Server. If the selected directory does not
contain the server information, TEMA will tell that this is no server job directory.  

3. Click OK. The server is now defined and will be used at image export. 

Note: If more than one server is defined here, a selec t dialog will appear at an image export. Here, we
can select the desired server to use. The order of the servers in this list will be conserved in that dialog
as well. To change the order of servers in the list, m ark an item in the list and use the move up and

down buttons . 

If a local export might be in need occasionally in the way you work, add a Loc al Server by clicking the 
Add Local button. Having both a remote and a local server setup, when an Im age Export commando is
given, a select server dialog will appear. In this dialog, we you can selec t whether to use the remote of
the local server for the export.  

Accessed via...
Tools/Preferences/Remote Export Servers.

See also...
Server Export
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Test Planning System (optional)
Function
This Preference Pane is used to setup how to c ommunicate with an
external Test Database. To make this interface flexible for different
test databases used in various organizations the interface is fully
configurable.

The Test Database Interface is based on execution of external
command line programs which are run subordinate to TEMA to read or
write information from the actual Test Database. These programs must
be provided by the customer or the Test Database manufacturer. The
interface programs must produce or read the Test information in a XML
format file. The exact XML format is specified by Image Systems AB

Procedure
1. In the top part Test Identification of this Preference Pane you specify which elements your Test

Specification consists of. Maybe the most common case is to have only one string, c alled something
like "Test Id" or "Test number". In some cases it can be more convenient to enter the specification in
several named fields, and here you can define exactly how the test specific ation is to be entered to
suit your test database. This setup works in the same way as for other attribute sets, see further on 
Attribute sets.

2. In the field XML file name you must enter the full path of a temporary file which will be used as the
XML file which connects the Test Database Interface programs to TEMA. Before calling the "End Test"
program and after calling the "Start Test" and "Refresh Test" programs TEMA will write and read this
file respectively.

3. Password.  This is an non-visible password that can be referred to using the syntax pattern
$PASSWORD$ in the Start, Refresh and End commands. 

4. The three following sections (Start, Refresh and End Test commands) are identical and specify the
program to use for each of the three interface c ommands, along with their parameters. Note that in
many cases the "Start" and "Refresh" commands could be identical, typically the Test Database
doesn't care if this is the first or second time the data for a specific test is retrieved. Separating the
commands allows the Test Database to keep track of which Tests have been started and disallow
starting the same test twice. By having a separate Refresh com mand this can be allowed even if the
test has already been started.

5. The Program Name part must refer to an executable file (.exe extension). A bat file is not ok, but in
this case you can spec ify "cmd.exe" (Windows' command prompt) as the program and /C and the bat
file's name as the two first parameters. This will run cmd.exe as the program and it in turn will
interpret the bat file.

6. The Timeout field is a timeout in milliseconds for the external program. If the program does not run
to completion within this period it is aborted and the com mand is aborted. This happens for instanc e
if the network connection to the Test Database is lost.

7. In the Parameters part you can add the program's parameters one by one. By making this a list the
problem with spaces in parameter values could be avoided. Click Add and then type the value in plac e
in the list box. To transfer the Test Identification the user has typed to the external program  you use
a macro replacement syntax in the parameters. This is done by enc losing the name of the Test
Identifier, for instance Test number in $ characters inside the parameter text. If the Test Identifier
contains spaces it must be enclosed in ' (single quotes) also. A sim ple parameter could look like this: 
$'Test number'$. If you have several parts of the identifier these can be sent as separate param eters

mailto:support@imagesystems.se
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to the external program or as one long parameter which would look something like this: Model:
$Model$, Test type:$'Test type'$, Run number:$Run$. This example encodes three different Test Id
parts into one parameter of the command line program to call. If you add parameters which don't
contain $ characters to the parameter list these will be sent verbatim  to the external program. One
use of this is to merge all the three interface func tions into one external program which is told what
to do using an extra parameter, with values such as "Read" and "Write".

8. The Global Policies section is the place at where a policy is set for New Tests to be started that are
outside the boundaries of the test planning system . Allowing this may risk the confusion of having
tests outside and inside the test planning system at the same time. 

9. Password. This enter field allows the user to store a non-observable password text string which c an
be used among the parameters to the external c ommands using $PASSWORD$. This feature allows
sending of passwords to external programs such as databases without having to show them  to
everyone inspecting the preferences of TEMA.

 

See also...

Test Database Interface
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Views (optional)
Function
To organize the camera handling in a test, the known cameras can be associated to views. If the list is
not empty, the user can select a view into a test, using a proc edure similar to this of adding a camera.
The difference is that views can be given a customized name and be put into groups having the same
camera settings.

For the views in the list, if any changes of Im age Enhancement, Camera Control, Rotation and Mirroring
or the assigned Test Sections (with End Test Exports),the setting can be saved in the Preference Archive

using the Set As Preference function . The setting saved for a view can be loaded into the view in

another test later using  the Revert To Preference function . Also, settings can be copied between
views in the list.

With test database interface.  
The  view list can be set to co-operate with a test database, if present. The database acts as m aster -
camera view names can only be created and stored in the list via this.    

Opening test with views not in the list.
When opening a test or when saving a new test with camera views not in the list, a dialog will offer the
possibility to add this to the list (or those) and to copy settings from  other views in the list to this new
view(s). 

Appearance
Camera Groups list
The list of the present camera groups. 

The view list
For each camera view in the list, the following information is listed
 Name - View Name. 
 Camera - the camera assigned to the camera view. 
 Group - the group to which the view is sorted
 Enh - a 'X' will be present if the view has been am ended using any Image Enhancement functionality,

and the setting has been saved in the Preference Archive using the Set as Preference function .
 Cam - a 'X' will be present if any changes has been made for the view in the Camera Setup window,

and the  status has been saved in the Preference Archive using the Set as Preference function .
 Rot - a 'X' will be present if the Orientation (Rotation and Mirroring) of the view has been c hanged,

and the setting has been saved in the Preference Archive using the Set as Preference function .
 Sect - a 'X' will be present if the view has been assigned/unassigned a Test section compared to what

was the status when the view was added to the list, and the status has been saved in the Preference

Archive using the Set as Preference function .

Procedure
1. Add a Group to the test. By using the Add button, new groups can be created. Note: No groups

has to be defined in order to be able to add cameras to the views list. However, in a test with lots of
cameras, it might be a fine idea to be able to sort the c ameras into groups

2. Add a camera view to the list. Click the Add button. The Add Camera View dialog will open.
Name the view. The View can also be associated to a group, if present, and a Cam era from the list of 
known cameras in the Camera Control preference pane. 
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3. Click OK when ready. The camera view can now be seen in the views list. 

4. Edit - Click the Edit button to change the View name, Group or camera for a view. 

5. Remove - Delete a view from the list by selecting the item in the list and click the Remove button.

6. Copy Settings - To copy the status of one view for Image Enhancement, Camera Control,
Orientation (Rotation and Mirroring) or Test Sections to one or several other views, mark the view(s)
to copy to (multi select by holding the <Ctrl> key while selecting in the list) and select Copy. The
Copy Settings Dialog will appear. In this, select the view to c opy from and select the appropriate
check boxes to the settings to be copied. 

7. Erase Settings  - To erase settings from one or several views, mark the view(s) to copy to (multi
select by holding the <Ctrl> key while selecting in the list) and select Erase Settings. The Erase
Settings Dialog will appear. In this, select the  appropriate check boxes to the settings to be erased. 

8. Click OK when ready. 
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Maintaining Presentation Preferences
If standards have been developed for the presentation of diagrams and tables, the details of the standard
can be set as default preferences. 

1. Select Preferences in the Tools menu and then Presentation. 
2. You may:

o Specify Printing Preferences.
o Specify the Angle Range. 
o Maintain the list of Line Colours. 
o Maintain the list of Line Styles. 
o Specify Diagram Preferences. 

 Specify Font.
 Specify Colour Defaults.
 Specify 2D, 3D and Image Diagrams.
 Specify Text Diagrams. 

3. Select the OK button. 

Specifying Printing Preferences

1. If a colour printer not is used , select the Always b/w check box.
This produces a better quality when printing colour diagrams on black and white printers. The
system automatically uses colours on colour printers and 'dash-dot' on black and white printers.
However, some printers claim to be colour printers but produce grey scale printing. Selecting the 
Always b/w check box ensures that 'dash-dot' is used rather than indistinguishable c olours. 

2. The Map Line styles makes it possible to relate spec ific colours with a line style when printing
using a black and white printer.  

3. Specify the measurability of the axes by:
o Selecting the Auto, Manual or both Measurable Axes check boxes. (If both, see further

about Printer Axis Length Dialog below).
o Selecting the required measurement unit radio button, i.e. Centimetres or Inches. 
o Specify the Calibration factor for the X and Y axes.

These are used for printers where the measured distance on the paper is not as expec ted. This
may happen with certain types of laser printer. In such circumstances, these values should be
set to the measured value divided by the expected value. 

Note:
The Measurable Axes function is used to control physical lengths on paper, i.e. it enables the
axes to be adjusted so that either a ruler can be used for measurement, or the axes match
those used on a diagram printed from an external source, i.e. another system  or a text book.
The Auto selection option allows the system to set the physical divisions of the axes
automatically without further user input.
The Manual option causes the Printer Axis Length dialog to be displayed after the required
printer has been selected during a print operation. This enables you m anually to specify the
physical divisions of the axes.
If both the Auto and Manual options are selected, the system performs the calculations
automatically and then displays them in the Printer Axis Length dialog during the print
operation so that the values may be adjusted.

Printer Axis Length Dialog
The dialog contains a setting for both the x and y axis. The value specifies the num ber of
centimetres or inches, depending on the preference set, for the value range spec ified for the
diagram axis. It also displays the maximum value, which obviously depends on the printer
selected.
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To specify the length of the axes: 
1. Key the required value for the X-Axis.
2. Key the required value for the Y-Axis. 
3. Select the OK button.

The diagram is printed.
Note: Selecting the Cancel button prints the diagram using the original axis length
settings.

4. Specify the printed Line Width by entering the required value.
5. Show or hide the Time Marker by enable or disable the Show Time Marker check box.

Specifying the Angle Range

The Angle Range can be specified only in diagrams including angle data by selecting one of the
following options: 

 Continuous;
 0 to 360º;
 -90 to 270º;
 -180 to 180º.

Maintaining the List of Line Colours

The available colours are displayed in the Line Colours list which you may amend.

To add a new colour:
1. Select the Line Colours Add button.

The Colour Editor dialog is displayed.
The default colour displayed is 'white'. 

2. Specify the required colour.
The new colour added to the Line Colours list in the Presentation frame. Its name is assigned
in terms of its primary colour values, e.g. 'R:155, G:155, B:177'. 

To edit a colour:
1. Select the colour to be changed from the Line Colours list.

Note: You can change the pre-loaded colours as well as those you have added. 
2. Select the Line Colours Edit button.

The Colour Editor dialog is displayed.
The current colour is displayed in the Colour frame. 

3. Change the colour.
The amended colour is replaced in the Line Colours list in the Presentation frame. 

To remove a colour:
1. Select the colour to be removed from the Line Colours list.

Note: You can removed the pre-loaded colours as well as those you have added. 
2. Select the Line Colours Remove button.

The selected colour is removed from the Line Colours list in the Presentation frame. 

Maintaining the List of Line Styles

The available styles are displayed in the Line Styles list which you may amend.

To add a new style:
1. Select the Line Styles Add button.

The Add Style dialog is displayed. 
2. Select the required style from the Line Style drop-down list.
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Note: You cannot define a new line style. 
3. Select the OK button.

The Add Style dialog is closed and the new style added to the Line Styles list in the
Presentation frame. 

To edit a style:
1. Select the style to be changed from the Line Styles list. 
2. Select the Line Styles Edit button.

The Add Style dialog is displayed.
Select the required style from the Line Style drop-down list. 

3. Select the OK button.
The Add Style dialog is closed and the amended style replaced in the Line Styles list in the
Presentation frame. 

To remove a style:
1. Select the style to be removed from the Line Styles list. 
2. Select the Line Styles Remove button.

The selected style is removed from the Line Styles list in the Presentation frame.
Note: The removed style may be added back later. 

Specifying Diagram Preferences

Font
2. Sets the font of all texts, except text box, in the diagram (s). 

o Select the appropriate font, font style and size. 
o The font settings will apply in all applic able diagrams.

Note: The font of text boxes is settable via the Text Box Setup dialog.

Colour Defaults

The following default colours can be amended: 
 Background Colour; 
 Axis Colour; 
 Grid Colour; 
 Box Colour.

To change a default colour: 
1. Select the appropriate Edit button.

The Colour Editor dialog is displayed. 
2. Change the colour in the same way as a line colour is changed . 

2D, 3D and Image Diagrams

1. Set the 2D and/or 3D Diagram colours.
2. Specify the Origin of the coordinate system against which the data is to be displayed. The options

are: 
o source image, lower left. 
o source image, image centre. 
o source image, optic centre. 
o source image, media centre. 
o digitized image, lower left. 

3. Specify the Marker size, size 0-5 is available.
4. Set the Line width of the lines/curves in the diagram.
5. If you want diagrams to be displayed by default with a grid, selec t the Grid check box. 
6. If you like all data available to be inserted in any new diagram introduced, select the Auto select
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option. 
7. Select the Auto scale option if you like a 2D diagram to auto scale its axes to display all data at

all times.
8. Specify the Legends to be displayed: 

o Select the Show Legend check box to display legends. 
o Select the Alt Colour check box to display the automatically calculated alternative colour as

used for the corresponding plotted curve in diagram. 
o Select the appropriate check boxes to display a spec ific value, i.e.

 Horizontal Axis Value.
 Vertical Axis value.

o Select the appropriate check boxes to display the m inimum/maximum limits of the data for
each curve, i.e. 

 Vertical Axis Min. 
 Vertical Axis Max. 
 Horizontal Axis Min. 
 Horizontal Axis Max.

Text Diagrams

1. For tables, i.e. Text Diagrams, enable buy clicking in the check boxes; 
o Show Row Counter check box, if the diagram  rows are to be numbered. 
o Show Interpolated values in parenthesis
o Use Comma as decimal character
o Show incomplete value with asterisk
o Show values in full precision

2. Set the Stripe Colour (from the drop down list). 
o This preference is used to simulate, both on the screen and on plain paper, the use of

horizontally striped paper. The selected colour alternates with white in a striped pattern. 

See Also...

Preferences
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Maintaining Printings Preferences
Function
The Printing Preferences are a set of default values used when printing cam era views, diagrams or
reports. They may be maintained as part of the Preference Archive maintenance procedure or directly at
the time the print function is selected. 

To amend the print settings, see Printing. 

See Also...

Preferences
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Preference Management (optional)
Function
To minimize the risk of a user changing certain preference setups parameters by mistake there is a
"security" level above the preferences level. From here, an administrator can
 set the Policies for the changing of the preferences in the different preference groupings. 
 add new user Profiles.
 Regroup preference panes. 
 

Note: To set a policy at this level will affect the possibility to c hange any parameter within a certain
preference, not only single program actions, as in the Policies preference. 

Appearance
 The preference management dialog has all the Preference tabs in the leftmost list. 
 The list to the right is the list of the existing Profiles. New Profiles can be added here and old ones

can be removed also. The default Profile can not be removed.
 Below the lists is where the preference policies are set. 

Procedure
1. Enter the Preference Management from the Tools menu. 

2. First time entering the preference management, a password must be set. This  can be changed in
the Preference Management dialog when entering. 

3. After setting a password, the Preference Management dialog  will appear. 

4. In the list of Preference tabs, the c olumn listing the Groupings can be right clicked. This will offer the
possibility to change the groupings for the preferences. Note: If the grouping Profile is set, the
current used Profile can not be changed. This has to be done from  the Profiles dialog.

5. The list to the left is where new Profiles can be added or Removed with help of the buttons. Add will
open up the Add New Profile dialog. Here, the new profile can be named. Settings can also be
copied from another existing profile in the preference archive into the new profile.   

6. Policy for entering this function. Change the way the Preference Management dialog can be
entered (this function aims at the Preference Management dialog). Select from the drop down list;
Warning every time will raise a warning every time the dialog is to be entered. Password Protected
will ask for the password to allow entranc e. Password + Warning will do both. 

7. Policy for changing Profile specific Preferences . The Profile specific Preferences are Preferences
having the grouping Profile. Select the policy level from the drop down list.

8. Policy for changing Machine specific Preferences . The Profile specific Preferences are Preferences
having the grouping Machine. Select the polic y level from the drop down list.

9. Policy for changing User specific Preferences . The Profile specific Preferences are Preferences
having the grouping User. Select the policy level from  the drop down list.

10. Policy for changing Profile after a test has started . 

11. Password. Set a pass word to be used for entering the Preference Management and for each place
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where the Policy level Password Protected is set. 
o Set also the Retention time. This is the time for how long a password is active. If a retention

time is not set (zero), we have to type the password every tim e when performing a Password
Protected program action. If a retention time is set, the password will be active for that period
of time. In other words, the retention time counts from when the password is typed. Before
the time is to an end, we can enter/perform the  same protected program action without
having to type the password. After the retention time, the password has to be used again etc. 

12. Copy/Import.   Clicking the Copy/Import button will open up the Copy/Import Dialog. Select the
desired option. Enable by clicking in the appropriate check box.

o Copy - this option will offer copying of preferences settings within the c urrent preference
archive. Enable and click Next.  Select the desired preference from the list, to be copied.
Click Next when ready. Depending of the current grouping of the selected Preference, the
copying will be done between Users, Profiles or Machines using the present preference
archive. Select the origin and c lick Next when ready. Then, select the destination by clicking
in the check box(es). Confirm the copy ac tion by clicking Copy. 

o Import - this option will offer an import of preference settings used in an external Preferenc e
archive. Enable and click Next. Browse to the desired .tep file (which is the file that c ontains
all preference settings for a TEMA installation).  Click OK when Ready. 

Note: The policies that controls the changing of parameters in the preference archive really c ontrols any
writing to this. There are other ways to write into the preference arc hive then through the preference
panes. Such are: 

 Updating settings regarding Test sections, Orientation, Image Enhancement and End Test exports for
camera views in the Views list. 

 Saving Named Image Export settings  in the Preference archive
 Updating the Default Tracker in the Preference archive. 

As all those actions imply writing in the preference archive, they are also affected by the policies in the
same way as the changing of parameters in the preference panes. 

See also...

Policies
Preferences
Profiles (optional)
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Profiles (optional)
Function
In some applications there might be a need of having different users sharing the sam e set preference
settings. 

We call these sets Profiles. When logging on to TEMA, a dialog will ask the user to spec ify the Profile to
be used. The preferences settings grouped as Profile will then be adjusted to what is specified for the
specified Profile instantly. 

When changing the used Profile to another, the program parameter settings will be changed to match the
current profile. 

Procedure
A new Profile is added in the Preference Management dialog. 

To change a Profile, go to Tools/Profiles and select from the drop down list in the Profiles dialog. Press
OK when ready. 

See also...

Policies
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Data Output

Copying to the Clipboard
The Copy option in the Edit menu enables the current data to be copied to the clipboard. The data m ay
be textual or graphical. From the clipboard you may Paste the data into any appropriate application, e.g.
a word processor, a spreadsheet application, a text editor, etc.
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Image Export (optional)
Function
To export complete or partial images from an image sequence or a selected part of this. If any overlayed
data, as curves displaying tracked data is present, this can be exported together with the im ages also. A
title slate can be added in which information about the images can be given to the viewer. Several
images from different camera views can be exported simultaneously. The image export  can be done into
most commonly used image formats. 

Note: The image export can be done from All presentation windows (XT, XY, multi axis, 3D and image
diagrams) also, not only camera views. 

The image export can be performed on a Remote Export Server machine also

Appearance
The appearance of the Image Export window is Export Settings to the left and the Export Area to the
right. 

Export settings
The export settings are sorted under five different tabs;
 
 Output -  defining the output file. 

o The Directory will override the Default Directory for image export as set in the Preferences. 
o File Name. (Optional - camera control: the use of the built-in variables  $DIRTIME$

and/or $DIRDATE$ will result in the time and/or date of when a trigger command
was given to the cameras) 

o Storage format - select amongst the available image formats in the Storage Format dialog.   
o Keep Compression - when enabled, if the original image file is compressed using jpeg, the

same compressing will be used for the exported image file as well.
o Full bit depth - The Bit Depth of an image is the number of bits used to hold a pixel. It is

sometimes called "color depth" or "pixel depth," The bit depth determines the maximum
number of colors that can be displayed at one time. In TEMA, overlayed graphics as tracked
data (curves) has 8 bits depth. Due to technical lim itations in MS Windows with different bit
depths, an image with a bit depth greater than 8 bits can not be exported together with
overlays in its full bit depth. The whole export will be done using the bit depth of the overlays
in such case. If the full bit depth is to be conserved in the export, enable this toggle. The
export will then be done with the image only, excluding the overlays.  

o Add source overlays - will export the image sequence and the tracker data (curves) but no
other graphics on the image sequence (text boxes or image boxes added to an image diagram
). The text boxes added into an image diagram will be scaled with the image. Text boxes can
be added in the image export dialog also, which will not be sc aled with the image. 

o Auto Size - will auto scale the exported image in order to fill the export window as best as
possible. 

o Re-specify the part of the image to be exported by keying the X and Y Offset.  
o Re-specify the size of the image to be exported. To export the complete image - select the

 button. In this mode, a new offset and image size can be set. Note: The re sizing and
offset of the export window can be set by an export rectangle in the export area with the help
of the mouse. 

o Zoom Factor - specify the size of the image that is to be written to the export file from by
either the available Zoom Factors in the drop down list or select the "Zoom factor" option in
the list and key an alternative zoom factor.

o Select the Maintain Aspect Ratio check box, if required. 
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o Select the Down sampling Pre filtering check box to resample the original image before the
selected zoom factor is applied. This improves the quality of the exported images.

 Title slate - This is an animated first image frame(s). This can be equipped with additional text
boxes with any information, just like the rest of the exported sequenc e. However, the overlays added
here will only be shown in the set title slates. The text boxes in the title slate m ay contain
information about the image file in specific text and image boxes only shown here. 

o Background  - set the background color to the title slate(s).
o Text and image file overlays - list of the added text and image boxes to the title slate. The

columns can be right clicked in order to change the positioning and alignment. 
o Maintain the contents in the list by the use of the buttons beneath it; Edit, Remove, Add

Text box and Add Image Box. 

 Time - amend the range of images to be exported, if required, by:
o If 'Relative to Current Image' is checked, Time Range and Image Range (below) are relative

to current time/image. 
o Modifying the Time Range.
o Modifying the Image Range. To export the complete image sequence (all frames) - select

the  button. To customize the range, unclick this. The export range c an then be delimited
manually by editing the time and interval start-  and end limits. 

o Modifying the Number Of Images you wish to export. In order to lock the num ber of images

to be exported, not being affected by any other parameter change, click the lock button .

When locked, this will change to .
o To export only the image currently displayed in the export window, clic k the  button. 
o If required, modify the Skip Count (i.e. the number of images in the sequence to be skipped

between the images that are exported).
Note: Amending any of these parameters automatically updates the values of the others. 

 Overlays - specify the overlays to be exported with the image file. Graphic overlays (curves and text
boxes) present in the image diagram or tracking node can be removed and new text and image boxes
can be added to the export window. 

o Text and image file overlays - list of the added text and image boxes to the export window.
The columns can be right c licked in order to change the positioning and alignment. The built-
in variables $TIME$ inserted in a test box will result in the current tim e in every frame when
exported,  $EXPORTFILENAME$ in the name of the name of the file as given in the im age
export dialog. 

o Maintain the contents in the list by the use of the buttons beneath it; Edit, Remove, Add
Text box and Add Image Box. 

Export Area

 The first image in the sequence is displayed in the Preview frame. 

 The image to be exported is shown in the Export Window frame. This is either the full image or the
part of the image pre-selected in the Zoom window. 

 If Overlays has been added to the image, those will be visible on the images. This can be  as text
boxes or tracked data. 

 Save as Preference Archive setting  . The current export settings will be saved in the
preference archive. There are two alternatives when saving here. Either save the setting as a new 
Default. This will make those settings  to be applied to a new test when created. Or, the settings can
be saved in your own name. Any number of settings can be saved in the preference archive like
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this, to match different requirements of Image Export.

 Revert to Preference archive setting  . The current export settings will be overridden by the
settings in the preference archive. If there are more instances in the image export settings in the
preference archive, then just the default (see above), then any of the alternatives can be selec ted
and applied.

 Export will export the image sequence to a local directory on your workstation. In order to save CPU
power on the workstation, a server can be set to perform  the image export. This is useful when
exporting image sequences containing high resolution images. In the Preferenc es/Remote export
server, a server can be defined and used for this. If a server is defined, this will perform  the export
automatically. In fact, several servers can be defined. If more than one is set up, a Selec t Server
dialog will list the available options. 

Having a server set up, there is no other specific actions to be taken when letting a server perform  the
image export. 

Progress Bar
Below the Export Settings Area is the progress bar. This will reflect the export proc edure in percentage. 
Cancel will cancel the export operation. 

Procedure
The following steps are to be taken to export an im age sequence used in a tracking icon or in an image
diagram. 

1. Select the camera views in the Test Contents window for which images are to be exported, hold the
<Ctrl> key to multi select camera views.

2. Select the Export Images option from the Camera menu. The Image Export dialog is displayed. If
an Area Of Interest rectangle have been defined, only the part of the image enclosed by this
rectangle will be displayed in the dialog. The Multi Image Export dialog is displayed is more than
one camera view has been selected. 

3. Begin with the Output tab. In this, specify the output Directory and resulting File Name. The
directory does not have to be on the workstation but can be on any plac e on your network available
from the workstation. If Server Export is to be used, the directory must of course be available from
the server. 

4. Further, set desired image format. If a file format and configuration other than the default AVI file
format and configuration is required: 

o Select the Storage Format button.The Storage Format dialog is displayed. 
o Select and specify the required file format. 

5. Produce a Title Slate, if desired. Use the Add text box dialog to create the overlays. 
6. Key the Time Range or Image Range of the images to be exported. Those two ranges are of course

dependent on each other and are merely two different ways of spec ifying the length of the image
export.  

7. The Number Of Images will be equal to the image range span. If set to a smaller value, the upper
image range limit will be lowered to match the new amount of images to export. If every im age in a
sequence is to be exported, the Skip Count should be set to zero. Skip count n will export every n:th
image in the sequence, thus effec ting the Number of Images but not the Range spans. 

8. The Window tab; re-size the export window, i.e. the Size of the exported images. The values can only
be decreased, cutting the set export window. The Offset is the positioning of the cut  outcrop in
relation to the non re-sized image. 

9. Amend the Zoom Factor of the export window if desired. 
10. Go to the Overlays tab. Initially we see only one item in the Layout list. This is the image. If this is

re-sized in the previous step, the position of the outcrop can be set. Right c lick the Position column
and select an alignment from the drop down list.

11. Add additional overlays text boxes with any information. Use the Add text box dialog to create the
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overlays. 
12. When all parameters have been set, and if happy with them , Click the Save in Preference Archive

button  to save the settings in the preference archive. You may also Revert to any of the currently

saved settings in the Preference archive by clicking the Revert..  button. Just remember that the
setup done will be overridden if done so. 

13. Select the Export button to export the image sequence as set up. 
14. Select Server Export if a Remote Export Server is to take care of the export operation.
15. The image export will be performed. A progress message is displayed while the export is underway. If

the Cancel button is selected during the export, the images exported up to that point are retained in
the exported files. These have too be manually deleted if they are not required. Note: If the specified
export destination directory does not exist, a message is displayed asking if you wish to c reate it. 

Note: When a successful Image Export has been performed, the settings used will be saved in the test
(the .ted file). Next time an Image Export will be done in that test, those settings will be initially applied.
 At any time, the user can change any parameter and if done, when performing a new export, the image
export information in the .ted file will be updated. This is not the sam e as the function of saving the
Image Export settings in the preference archive, which can be done parallel to this. 

Manage an Overlayed Text Box
 To add a new Text Box to the exported image, clicking the Add Text box button. 

o The Box position setting is where the position of the box within the export window is
specified. This can be changed later in the Overlays  tab in the im age export dialog.  

o Alignment sets the text alignment within the text box. This can be changed later in the
Overlays tab in the image export dialog. 

o Background - set the color of the text box background. 
o Border - set the color of the text box border. 
o The Text is set up like any text box.

 To Edit an already inserted text box, mark this in the list and click Edit. The Text Box dialog will then
appear in which the text box can be re-edited. 

 To Delete a text box in the list, mark this and select Remove. 

Add or Edit Overlays Image Boxes
When clicking the Add Image box or Edit button (having an inserted image box marked in the list) has
been clicked, the Add/Edit image box dialog opens. With the help of this, an overlay image box can be
set up.

Accessed via...
Any Camera view window (right c lick menu) or via Camera/Export Images in the menu bar. 

See also...
Multiple Image Export
Storage Formats
Combined Image Export
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Specifying the Storage Format
The Storage Format dialog is used to specify the output file format in various situations. The nature of
the details displayed in the dialog vary depending on the format type selec ted.

1. Select the required type from the Format list. 
2. Depending on the type selected, specify the appropriate details:

o Multiple TIFF files (.tif)
 Compression: 

 No Compression. 
 LZW Compression - non-destructive compression of the output file. 

 Colour mode: 
 Auto - the software selec ts the most appropriate mode, depending on the original

image and which modes are supported by the output format. 
 L - grayscale 8 bits. 
 RGB*24 - colour 8 bits per colour. 
 RGB*48 - colour 16 bits per colour.

o MPEG (.m2v, .m1v)
 Format (i.e. MPEG standard): 

 MPEG-1. 
 MPEG-2 Standard definition. 
 MPEG-2 High Level. 
 MPEG-2 4:2:0 (Mediaplayer compatible) 

 Frame Rate: 
 No Conversion. 
 24fps to 25fps - creates 25 frame per second video sequences from 24 frame per

second film. 
 Only I-frames - special variant of the MPEG format that does not compress as well, but is

necessary for input to some editing systems. 
 Write Interlaced - should be used if the input is from  video. 
 Bitrate (0-50 Mbit/sec) - compression level for MPEG. 
 Colour mode: 

 Auto - the software selec ts the most appropriate mode, depending on the original
image and which modes are supported by the output format. 

 YUY2 - 16 bit colour data with 8 bit luminescence and 8 bit colour (typically used for
video). 

o AVI-file (.avi)
 Compressor - to select a compressor:

1. Select the Change button.
The Video Compression dialog is displayed. 

2. Add a Digital Signature (optional)
3. Specify the required compression. 

 Frame Rates: 
 Recording, Desired. The default value is the frame rate that is set in TEMA. If you later

load this file into TEMA, this will be the c amera Frame Rate. 
 Play, Desired. The desired play speed in other programs, such as the Windows Media

Player. 
 Fix Play Rate: As the AVI format does not allow exact representation of both these

values, the program makes a compromise that is seen in the "Resulting" values to the
right of the enter fields for Frame Rate and Play Rate. If this c heck box is marked, the
Resulting Play Rate will be kept as desired. If not, the desired c amera Frame Rate will
not be changed. 

 Colour mode: 
 Auto - the software selec ts the most appropriate mode, depending on the original

image and which modes are supported by the output format. 
 BGR*24 - Colour 8 bits per colour (different memory layout to RGB). 
 L - grayscale 8 bits. 
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o Multiple JPEG-files (.jpg)
 Quality - The JPEG format compresses the images. If the image quality is set to a

higher level, more disk space is used but the images look better. 
 Colour mode: 

 Auto - the software selec ts the most appropriate mode, depending on the original
image and which modes are supported by the output format. 

 RGB*24 - Colour 8 bits per colour. 
 L - grayscale 8 bits. 

3. Select the OK button. 
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Multiple Image Export
Function
This function is similar to the Export Images function, but enables simultaneous export of images from
more than one camera view at the same time with same export settings, overlays etc . 

This is for example useable when controlling several cameras in the TEMA Camera Control.

Note: When multi selecting items in the test contents list and selec ting image export, only the marked
camera views will be exported, no point windows. 

Appearance
The multi image export window differs from the image export window in that only the Output, Title Slate
and Overlays tabs are available.  

Procedure
1. Select the camera views in the Test Contents window for which images are to be exported, hold

the <Ctrl> key to multi select camera views. 
2. Select the Export Images option from the Camera menu.

The Multi Image Export dialog is displayed. 
3. Proceed as when performing a ordinary image export. 

See also...
Image Export
Storage Formats
Combined Image Export
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Server Export (optional)
Function
Image export can be done on a Remote Export Server machine, saving CPU on the analysis machine. 

Requirements
 A network where directories can be shared between two computers, with permissions to write.
 A correct set up Remote Export Server in preferences
 Image Systems Server program installed on the server computer. The program is an free standing

application for performing image exports from a client, using a server. The program  is used to
configure the server machine to make communication between the machines possible. 

 A Job Directory defined and shared for both client and server (see below).
 The export destination folder is available for both server and c lient (shared).

Communication
The communication between the client and the server is done via a directory on the network that is
available to both machines. In most cases, this directory, called Job directory, is placed on the server
machine. When the program IM Server starts on the server, the IP num ber of the server is checked and
written on a file called image systems export server configuration.  This file is placed on the job directory.
When a server export is to be done, the client will read the server IP num ber in this file on the job
directory. After this, it can connect to the server and letting the server export be perform ed.

Procedure
1. Set up the Remote Export Server in the preference pane.
2. Install IM Server on the Remote Server Machine. 
3. Set up the parameters in IM Server (Job directory etc.)
4. Perform steps 1-12 in the ordinary Image export procedure. Step 3 - make sure the destination

directory is shared, available from both Client and server.
5. Select Export.

o If one single Remote Server is defined, this will be used automatically and there will be no
progress bar on the client side. The progress can only be seen on the server side. 

o If several remote servers are defined, the select server dialog will appear. Here, we can select
which Remote server to use.

o We can add a local "server" in the preference pane server list. This represents a ordinary loc al
Image export. The reason this can be added is if there is a need for perform ing local and/or
remote exports in the same test. If a local server is present, this can be selec ted in the select
server dialog and a local image export will be performed, with a progress bar present.  
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Digital Signature (optional)
Function
In applications where it is important to use the same image files as where used in a test for later use, a
digital signature function is of great value. 

When exporting an image sequence to .avi format using image export, a digital signature c an be
attached to the exported file. This will contain the date of export and a chec ksum. 

With this option, when this file is used in TEMA later on, as a new cam era view, TEMA will note that the
file has a signature. In the Open Image File dialog, the Check Signature button will be enabled. By this,
the check sum can be reviewed and controlled by the operator. Should the file have been tam pered with,
the checksum will change, proving this.  

Procedure
1. At Image Export, select file format .avi. 
2. Click the Sign check box. 
3. Proceed with the steps in Image Export.
4. When exported, the resulting file will contain a digital signature. 
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Image Boxes
Function
It is possible to insert a bitmap image as an overlay to an exported image. 

Procedure

In the image box setup dialog, spec ify the following; 
 
 The Box position in the export window. This can be changed later in the Overlays tab in the image

export dialog.  
 Filename - browse to an image on the workstation. 

See also...

Text Boxes
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Combined Image Export
Function
To export selected items for external presentation(s), in which the user decides and designs the c ontents
and layout (alignment, file name, title slates, overlays etc).
 
Possible items (merged together) are:
 Complete or selected part(s) from an image sequence.
 Camera views.
 Diagrams (not tables) displaying trac ked data.
 Point zooms, etc.

The export can be done into most commonly used image formats. 

The Combined Image Export is performed via a wizard.
The appearance of the Image Export window is Export Settings to the left and the Export Area to the
right. 

Procedure
The wizard for Combined Image Export (in Edit menu) consists of three steps. Each step is num bered and
gives a short guideline.

Step 1 - Selection
1. Select items in the list.

o Hold down Shift button to select a range of items.
OR
o Hold down Ctrl button to add or deselect items.

2. Press Next button when ready.

Step 2 – Layout
1. Set the Width and Height of the Export Area, which will define the total size in pixels of the

exported images.

2. Make a Selection in the list.
o Use the arrow buttons to the right of the list to move the selected items within the predefined 

Layout (see  below).
OR
o Use the mouse to move or resize items in the preview window to the right.

3. Set the Layout:
o Auto enabled – The Layout is set by default.
o Auto disabled – The Layout is set by entering No of rows and No of columns.
o Fill last row(s) enabled – The last row(s) of items will be filled out.
o Row <=> Column enabled – The row(s) will be transferred into column(s).

4. Press Next button when ready.

Step 3 – Export
1. Output tab - Define the Output File (directory, name and type).
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o Directory - Browse for folder to set the Output File Directory. The Directory will override the
Default Directory for image export as set in the Preferences.

o File Name - Enter File Name of Output File to be exported.
o Storage Format – Select amongst the available image formats in the Storage Format dialog. 

2. Title Slates tab – Add frames Before and After the main sequence.
This is an animated first (and/or last) image frame. This can be equipped with additional text boxes
with any information, just like the rest of the exported sequenc e. However, the overlays added here
will only be shown in the set Title Slates. The text boxes in the Title Slates m ay contain information
about the image file in specific text and image boxes only shown here. 

o Background  - Set the background colour to the Title Slate(s) from the drop-down list.
Disable One Frame to  increase the Duration

o Layout - Create a list of the added Text and Image boxes to the Title Slate(s). 
 Click Add Text Box or Add Image Box.
 Maintain the contents in the list by using the buttons beneath it; Edit and Remove.

 To Edit an already inserted box, mark this in the list and click Edit. The Box
dialog will then appear in which the box can be re-edited. 

 To Delete a box in the list, mark this and select Remove. 
 The columns can also be right clicked in order to change the:

 Text - The text is set up like any text box.
 Alignment - Sets the text alignment within the text box.
 Colour - Sets the colour of the text in the text box.
 Position - Specifies the position of the box within the export window.
 Background - Sets the colour of the text box background.
 Border - Sets the colour of the box border.

 The built-in variables $EXPORTFILENAME$ inserted in a test box will result in the nam e
of the file as given in the Output tab in every frame when exported. 

3. Time tab – Amend the range of images (Time Extent) to be exported, if required, by:
o Modifying the Time Range .
o Modifying the Image Range . 

 To export the complete image sequence (all frames) - select the  button. 
 To customize the range, unclick this. 
 The export range can then be delimited manually by editing the time and interval start-

and end limits. 
o Modifying the Number Of Images  (equal to image range span). If set to a smaller value, the

upper image range limit will be lowered to match the new amount of images to export.
 In order to lock the number of images to be exported, not being affected by any other

parameter change, click the lock button . When locked, this will change to .
 To export only the image currently displayed in the export window, click the 

button. 
o If every image in a sequence is to be exported, the Skip Count  should be set to zero. Skip

count n will export every n:th image in the sequence, thus effecting the Number of Images but
not the Range spans.

 Note: Amending any of these parameters automatically updates the values of the others.

4. Overlays tab – Specify the Overlays to be exported with the im age file.
Each item in the main sequence can be equipped with additional text boxes with any inform ation.
Graphic overlays (curves and text boxes) present in the im age diagram or tracking node can be
removed and new text and image boxes can be added to the export window. 

o Background  - Set the background colour to the Overlay(s) from  the drop-down list. Disable
One Frame to  increase the Duration

o Layout - Create a list of the added Text and Image boxes to the Overlay(s). 
 Click Add Text Box or Add Image Box.
 Maintain the contents in the list by using the buttons beneath it; Edit and Remove.
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 To Edit an already inserted box, mark this in the list and click Edit. The Box
dialog will then appear in which the box can be re-edited. 

 To Delete a box in the list, mark this and select Remove.
 The columns can also be right clicked in order to change the:

 Text - The text is set up like any text box.
 Alignment - Sets the text alignment within the text box.
 Colour - Sets the colour of the text in the text box.
 Position - Specifies the position of the box within the export window.
 Background - Sets the colour of the text box background.
 Border - Sets the colour of the box border.

 The built-in variables $TIME$ inserted in a test box will result in the current tim e in
every frame when exported,  $EXPORTFILENAME$ in the name of the name of the file
as given in the Output tab.  

5. Previous button – moves to previous step in the wizard. 
Next button – moves to next step in the wizard. 

6. Save Preference button  - The current export settings will be saved in the preference archive.
There are two alternatives when saving here. Either save the setting as a new Default. This will
make those settings  to be applied to a new test when created. Or, the settings can be saved in your
own name. Any number of settings can be saved in the preference archive like this, to m atch
different requirements of Combined Image Export.

Load Preference button  - The current export settings will be overridden by the settings in the
preference archive. If there are more then just the Default settings (see above), then any of the
alternatives can be selected and applied.

7. Press Export button when ready. Cancel button - cancels the export.

Note: When a successful Combined Image Export has been performed, the settings used will be
saved in the test
(the .ted file). Next time an Combined Image Export will be done in that test, those settings will be
initially applied. At any time, the user can change any parameter and if done, when performing a new
export, the information in the .ted file will be updated. This is not the sam e as the function of saving
the Combined Image Export settings in the preference archive, which can be done parallel to this. 

Accessed via...
Edit menu/Combined Image Export.

See also...
Image Export
Multiple Image Export
Managing Diagrams via Test Contents
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Exporting Data
This function is used to export data from a table to a variety of different external form ats for use in other
systems.

1. Display the Table you wish to export.
It is important to set up the table so that it contains only the data you wish to export because the
whole of the table is exported.
 

2. Select the Export Data option from the Diagram menu.
A Save as dialog is displayed.
The Save as type drop-down list contains the available formats.
 

3. Specify in the Save in field the folder to which you wish to export the images.
 

4. Key in the File name of the file to which you wish to export the images.
 

5. Select the type of file you wish to export from the Save as type drop-down list.

The options are: 
o Excel - (.xls) 
o Tab Delimited Ascii - (.txt) 
o Diadem - (dat.) 
o ISO - (.iso) 
o CASDAS - (.dat) 
o MatLab - (.dat) 

6. Select the Save button. 
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Exporting Tracked Data (Optional
Feature)
Note: This option only applies if the Airbag tracker option is installed. It exports the tracked outline from
the Airbag tracker, together with the name and 2-dimensional coordinates for other points.

1. In the Test Contents window: 
o Select the camera view to be exported. 
o Select the data to be exported, i.e. points, contours, etc.

Note: Selecting only the camera view exports nothing. 
2. Select the Export Tracked Data option from the Object menu.

The Select Coordinate System dialog is displayed. 
3. Select the required coordinate system from the list. 
4. Select the OK button.

The standard Save as dialog is displayed with the ".xml" file extension pre-selected. 
5. Specify the name and location to which the data is to be exported. 
6. Select the Save button.

The tracked data is exported. 

Note: Alternatively, right-click the item to be exported and selec t the Export Tracked Data option from
the pop-up menu.
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Specifying Video Compression
The Video Compression dialog is used to specify the type of c ompression used when exporting image
sequences to an AVI file.

Note: The AVI settings are not TEMA settings, but are specific to each codec defined by the codec
supplier.

1. Select the required type of compression from the Compressor list.
Depending on the type selected, the other fields in the dialog are enabled, otherwise they rem ain
disabled.
Note: The Configure button is not always enabled with the other fields. 

2. Amend the Compression Quality using the slider.
If the image quality is set to a higher level, more disk space is used but the images look better. 

3. If you wish to specify key frames: 
o Select the Key Frame checkbox. 
o Key the required frequency of the key frames.

Without the specification of key frames, the compression of a frame is determined in terms of
the differences from the previous frame.
With the specification of key frames, each key frame is retained in full and successive frames
determined as differences until the next key frame is reached. This is useful if there are large
scale changes between groups of images n the sequence 

4. If you wish to specify the data rate: 
o Select the Data Rate checkbox. 
o Key the required rate.

Specifying a data rate overrides the quality setting and adjusts the quality to ac hieve the
desired data rate of the output file.

5. If enabled, select the Configure button and specify the advanced parameters specific to the
selected compressor. 

6. If you wish to identify the version of the compression routine, select the About button. 
7. Select the OK button. 
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Printing a Selected Item
This function is used to print a selec ted displayed image, diagram or table. 

When the printer has been selected during a print operation and the print initiated, the Printer Axes
Length dialog is displayed if the appropriate presentation printing preference has been set. 

1. Select the required image, diagram or table. 
2. Select the Print option from the File menu.

The Print dialog is displayed. 
3. Specify the print layout.

Note: The printing is initiated from the Print dialog. 
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Printing Test Reports
This function is used to print a report containing one or m ore camera views and/or diagrams included in
the test.

1. Select the Print Report option from the File menu.
The Print Report dialog is displayed. 

2. To preview an item, select the item in the Print frame.
It is displayed in the Preview Selected frame. 

3. To remove an item from the report, de-select its c heckbox in the Print frame. 
4. To adjust the sequence of the item in the report, select an item and use the  and  arrows to

place it in the required position. 
5. Specify the Pagination by:

o Selecting the No limit checkbox to allow the system to control the pagination. 
o De-selecting the No limit checkbox and keying the Maximum prints per page. 

6. Specify the required Orientation by selecting the appropriate radio button:
o Distribute - spreads the items across and down the page. 
o Vertical - spreads the items down the page. 
o Horizontal - spreads the items across the page. 

7. Select the Options button.
The Print Options dialog is displayed. 

8. Specify the print options. 
9. Select the OK button.

The report is printed via the standard print dialog. 
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Specifying the Print Options
The Print Options dialog is used to specify how a selected item or a print report is to be printed. The
same set of details can be set as a print preference. It is these values that are displayed when the Print
Options dialog is displayed. The values can be overwritten, as required, for individual prints.

1. To add the date and time, select the Date checkbox. 
2. To specifying a logo:

o Select the Logotype checkbox. 

o Key the Logotype path, or select the adjacent  button and browse for it in the standard
Open dialog. 

o Specify the size of the logo by keying appropriate values for the Width (mm) and Height
(mm) fields. 

3. To specify descriptive text, key one or more lines of text in the Text frame. 
4. If you wish to append the test description to text, select the Append button.

The test description is appended to the Text.
Note: If a test description has not been defined, nothing happens, i.e. nothing is appended. 

5. To specify the page setup:
o Select the Page Setup button.

The standard Page Setup dialog is displayed. 
o Specify the required settings: 

o Paper size and source; 
o Orientation (portrait and landscape); 
o Margins (top, bottom, left and right). 
o Printer properties 

o Select the OK button. 
6. Select the Close button.
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Miscellaneous

Defining an Area of Interest
A rectangular area of interest can be defined in a camera view to limit the part of the image used for:

 Image Enhancement. 
 Image Export. 

To draw an area of interest:
1. Select the  tool. 
2. Press the <shift> key and hold it down. 
3. Move the mouse to a corner of the required area of interest. 
4. Press the left mouse button and drag the mouse to the opposite corner of the required area of

interest. 
5. Release the mouse button. 
6. Release the <shift> key. 

To amend the area of interest:

There are a number of ways that an area of interest can be am ended:
1. Redraw the area of interest as described above. 
2. Position the mouse inside the rectangle, press the left mouse button and drag the rec tangle to the

required position 
3. Select any of the four sides or corners with the mouse and drag it to the required position. 
4. Use the Area of Interest dialog: 

o Select the Area of Interest option from the Edit menu.
The Area of Interest dialog is displayed. 

o Key appropriate values for the Offset X, Size (X), Offset Y and Size (Y) fields. 
o Select the OK button. 

To remove the area of interest:
1. Select the Area of Interest option from the Edit menu.

The Area of Interest dialog is displayed. 
2. De-select the Activate checkbox. 
3. Select the OK button.

Note: This action removes the area of interest from the display and disables its effect on other
functions. However, it still remains defined and can be reactivated by re- selecting the Activate
checkbox in the Area of Interest dialog. 
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Browsing for a Folder
1. Select the required folder in the file structure.

Alternatively, if you require a new folder:
2. Select the location for the new folder.
3. Select the Make New Folder button.

A new folder is inserted at the specified location.
4. Amend the folder name.
5. Select another entry.

The amended part of the file structure is re-sequenced.
6. Select the OK button.
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Deleting an Item
1. Select the item, or group of items, you wish to delete. 
2. Select the Delete option from the Edit menu.

Alternatively, click the  button.
In some cases a confirmation dialog is displayed before the deletion is performed, while in others
it is not. Confirmation is always requested when removing a camera view.

For example:
o Unregistered points are deleted from the Test Contents window without confirmation, while

the deletion of those containing tracked data causes a confirmation to be displayed. 
o When a camera view is deleted from the Test Contents window, the Remove Camera View

confirmation dialog is displayed. Confirmation must be provided before the deletion is
performed. 
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Displaying a Camera View
1. Select the required camera view in the Points List window. 
2. Select the Show Camera View Window option from the Camera menu.

Alternatively, select the  tool.
The Camera View window is displayed, showing the selected c amera view.
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Displaying Toolbars
The system displays all of its toolbars by default when the system is first used. You may toggle the
display of each of the toolbars independently by selec ting the appropriate option in the Tools/Toolbars
sub-menu: 

 Standard 
 Point Control
 Tools
 Default Trackers
 Data
 Time Panel
 Time Slider
 Camera Control
 Test Sequence
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Editing Colours
The Colour Editor is used in a number of dialogs to spec ify a display colour.

As the selection is changed, it is reflected in the Colour frame. 
1. Specify the approximate colour by clicking at the appropriate place in the Hue and Saturation

frame. 
2. Select the colour more accurately by dragging the slider in the Value frame. 
3. Specify the colour exactly by keying the value or dragging the slider in eac h of the Hue,

Saturation, Value, Red, Green and Blue fields. 
4. Select the OK button. 
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Expressions (optional)
Function
TEMA handles a set of expressions that can be used in combination with text in text boxes. An expression
is different from ordinary text as it will be interpreted by TEMA as a value. The values can be predefined
variables, data, attributes and a number of functions. 

As an example, by using the Predefined variable COMPUTER will result in the nam e of the used
workstation. 

For each place where expressions can be used, the string expression wizard will be present. This will aid
the creation of expressions. However, any expression can be created in a text box with no help from  the
wizard.

Below is a list of the expressions and from where in a TEMA test they can be reached 

Predefined variables
The Predefined variables can be used in:
 

o Default directory paths (set in the Preference Archive).
o Text boxes in Diagrams and Image Export layouts.

The Predefined variables are:

 COMPUTER -  the name of the used workstation. 

 EXPORTFILENAME - the name of the exported file as set in the image export dialog. 

 FIRSTIMAGE - Image number of first exported image. 

 FIRSTTIME - Time of first exported image. 

 INPUTFRAMEFREQUENCY - the frame rate for the sequence to export (Hz). 

 INPUTSIZEX - the amount of pixels in x direction of the  sequence to export. 

 IMPUTSIZEY - the amount of pixels in y direction of the  sequence to export. 

 LASTIMAGE - Image number of last exported image. 

 LASTTIME - Time of last exported image. 

 NUMBEROFIMAGES - the number of images. 

 OPERATOR -  the name of the workstation from which TEMA is run. 

 OUTPUTFRAMEFREQUENCY  - the frame rate for the exported image sequence (Hz).
 
 OUTPUTSIZEX - the size of the output file in the x direction. 

 OUTPUTSIZEY  - the size of the output file in the y direction. 
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 SECTION - the name of the current Test Section. 

 TESTFILE - the complete name of the .ted file from which the export was performed (with path and
extension).

 TESTFOLDER - the path to the .ted file from which the export was performed. 

 TESTNAME - the name of the .ted file from which the export was performed (without path or
extension).

 
 TIME - current time in the Time Panel. 

 TRIGGERTIME - Camera control feature. The time at when the system recognizes that the first
camera in a test has been triggered. Absolute time. 

 
 VIEWNAME - the name of the camera view from which the export was done. 

 ZOOMFACTOR - the set zoom factor for the image export.
 
 DIRTIME - (Camera control Variable) the time for when the Trigger command was sent to the

camera shooting the image sequence to be exported.

 DIRDATE - (Camera control Variable) the date for when the Trigger com mand was sent to the
camera shooting the image sequence to be exported.

Gun Scoring Statistics Variables (optional)
All coordinates are defined in the score card coordinate system . COG means Centre Of Gravity. 

 AimToCenter [Section] - the 2D distance between the Aim Point and the COG point.
 
 AimX [Section] - the x coordinate of the Aim Point.

 AimY [Section]- the y coordinate of the Aim Point.

 Angle [Section] - Angle Of Impact.

 CenterX [Section] - the x coordinate of the COG Point.

 CenterY [Section] - the y coordinate of the COG Point.

 ExtremeMax [Section] - the greatest 2D distance between any two points.  

 ExtremeX [Section] - the extreme x coordinate.

 ExtremeX [Section]- the extreme y coordinate.

 MRad [Section] - the mean distance between the COG point and all other points. This func tion is
transparently used for calculating the Spread Circle in the Gun Scoring application

 StdDevRad [Section] - the standard deviation of the mean distance between the COG point and all
other points.

 StdDevX [Section] - the standard deviation of the x coordinate of all points.
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 StdDevY [Section] - the standard deviation of the y coordinate of all points.

 ShootingRange - the Shooting Range value as typed in the Test Data setup.

See also..

Variable Wizards
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The String Expression Wizard
(optional)
Function
To effectively use Expressions, there is a  Wizard available which appears when c licking the wizard icon.
With the use of this, we do not have to type the expressions m anually, nor remembering what variables
there are. The wizard interface contains lists of all available variables, data, attributes and func tions to
use. We only have to select the correct combination of data and functions and insert in the text box. 

The expression wizard can be looked upon as an extension of the text box setup, as expressions c an be
typed even there. 

Note: All expressions can be entered without the help of the wizards, they are just there to
ease the process if needed. 

What about The $$ characters..?
Anything typed in an enter field that has the Variable Wizard ic on  next to it, will be interpreted by
TEMA as a string. If a value shall be entered here, such has to stand between $ characters. We can say
that a word enclosed in $$ characters goes untouched by this string-interpretation. Built- in variables are
keywords that are to be used as values, not strings. Therefore, they need to be enc losed by $$ to result
in anything useful, a variable. Any of the variable words typed just as they are (without the $$ enclosing)
will be interpreted just as the string it is. 

Note: When manually typing a variable, the user has to remember the $$ characters.

The Wizard contains the list of the available . Selec ting one of built-in variables in the wizard- list will
make the variable appear in the enter field between two $ signs, inserted by the wizard autom atically. 

Note: Using this wizard means the user do not have to remember the $ characters when
selecting a variable. 

Appearance

Data Select area
The upper part of the wizard is the data select area. Here, we can select Variables or/and Data to insert
in the Edit area. 

 Variables - The list of available Predifined Variables. 

 Points - The list of the available tracking data for selection, per point. 

 Attributes - The available attributes for each point selected in the Points list. The available Attributes
varies depending on the tracking algorithm used. Also, the desired Time Derivative and
Component can be selected here. 

 Coordinate system - The available coordinate system in the test. 

Edit area
The edit area is, in fact,  the text box edit area. Any text can be typed here. The Expressions created by
the wizard's data select area will end up here togehter with any optional text. 
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Preview area
Here is the initial result from the used expressions together with any optional text. Note that the
message 'Value at' will not appear in the text box when the wizard is c losed

Procedure

1. Enter the wizard by c licking the open string expression wizard button .
2. To use any of the Predifined Variables, select one from the list and click Use. The Variable will now

be insted into the preview area.  
3. Select the Point(s) to add to the Column list. Note that multi selections can be done here, selec ting

points from different trackers. Any subsequent specification done will affect the whole selection. 
4. Specify what type of Attributes to use for the selected point. The range of attributes will depend on

the type of point selected, thus, the list will update to match the range of the selection made in the
point list. Note: If a multi selection has been done, inc luding points from different trackers, the
attribute list will list all available attributes from all selected points. It is therefore important to know
what types of unique data that comes out from the different trackers.

5. Specify also the Time Derivative of the selection. The derivatives will be applied on all selected
attributes for each point. 

6. Specify the Coordinate System to be used when presenting the data selection. Select from  the
dropdown list. If more than one system is available in the test, the option All will present the
specified data for each coordinate system in the test.

7. Select the desired Function which will be applied on the data before presentation; At Current time
will pass the data untouched.  The max and min functions will however calculate the extreme values
of a sequence before presentation. Thus, the use any of those two functions will result in the
presentation of data that is unaffected by the current tim e. This as it is just one value for all times in
a sequence.

8. Click the Use button to insert the data selection as an expression in the edit area. 
9. Type any text in the edit area togehter with the expressions added. 
10. Click OK when ready. The final result will appear in the text box. 

 

See also...
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File Names
File names used in the system must conform to the standard Windows file naming convention.

In addition, the following restrictions apply:

1. File names must not end in a numeric digit. This is because integer numbers are appended to the
file name by the system to identify individual images within a sequence.

2. The "-" (minus) must not be used. This is bec ause image numbers may be negative. To separate
words in file names, use the "_" (underline) character. 
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Find Image
Function
Some applications with high speed photography might result in image sequences where only a few or
even one single image out of thousands of frames contains the actual event of interest. To go through
such sequences in hunt for the interesting fram e or frames can be both time consuming and hard. 

In such cases, the Find Image function is a fine help. The function helps to identify the fram e(s) of
interest. This is done by analyzing the pixel content of the first fram e in the sequence. This value is then
compared with the ditto of the subsequent frames, in a scan-like process. When a frame with a pixel
difference that matches the set parameters appears, the scan will stop at this frame. It is then up to the
user to decide whether this is the frame of event or not. 

Procedure
1. Select  Find Image from the Edit menu or right click a camera view and select  Find Image.

This will open up the Find Image dialog. 

2. The Sensitivity slider is the tool for setting how different the image of interest must be from the first
image for the scan to stop. 

3. Set the Duration. This is the least amount of frames to contain the event of interest. 

4. Define the Object Size x and Object Size y. This is the expected size in pixels of the object that will
appear and/or move in the event. 

5. Enable the toggle Do fine search to find start of events  in order for the scan to stop at the first
frame of the event. If this is unchecked, and the duration is set to n frames, the scan might stop at
n-1 frames from the start frame of the event. 
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Gun Scoring
Function
TEMA Gun Scoring combines Camera Control and Analysis functionality to perform  a Gun Scoring test
analysis in almost real time at the test shooting site. The single cam era used does not need to be
perpendicular to the scoring paper.  

The system is designed  for the use of a Frame grabber Camera. This has no internal memory. Therefore,
all recorded images are always live images directly from the camera, downloaded to a set download
directory.

The system allows the same camera to be used to shoot both a reference (2D scaling) sequenc e and the
analysis sequence. This is done by Test Sections,which enables the maintenance of two parallel image
sequences and trackings in one test.  

Note: Some of the functions described have extensive help sections in the rest of the TEMA help, som e
are described here only. Also, in addition to this functional description, there is a Step-by-step guide
which describes how to use the functions in the Gun Scoring test analysis proc edure in the most effective
way.  

Concept
The TEMA Gun Scoring concept includes two different parts; 

1. The TEMA Gun Scoring functions package.
2. A Factory Template with all presets necessary for easy usage of the pac kage.

Functions Package 

Gun Scoring Setup
A setup dialog where certain Gun Scoring settings can be done.

Test Setup
 Statistical Analysis: Sets the Shooting Range value and used Unit. This will be used when

calculating the Angle of Impact (see Statistics calculations below).  The value can also be captured in
the presentation with help of the Statistics Variable ShootingRange.

 Also, if we have set up Test Attributes in the test, those will be listed here together with a
corresponding enter field where they can be specified with values.   

 Download Filenames. Sets the download filename (per section). If the filename is useable, this will
be indicated by the word OK below the enter field. This is done per section. In the Factory tem plate,
there are two sections defined from start. Those are called GeoSetup and Test. The filenames are also
defined in the template, using some built-in variables; $VIEWNAME$_GeoSetup  and $VIEWNAME
$_Test. The syntax $VIEWNAME$ will use the corresponding view name for each section
automatically. Amend the pattern if desired. 

Camera/Microphone Setup
 Camera Setups. In order for any settings to be done, a online live camera must be connected to the

system. 
o Imaging. Frame frequency and image size for the frame grabber camera can be reviewed
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here, but not changed.
o Recording. 

 Sound Sync (Single Shot). For single shot tests. Set the time to pass between the
sound peak (the shot) and the instant at when the c amera will capture an image of the
scoring card penetrated by the bullet just fired. 

 Sound Trig (Burst). For burst test (where the time between each shot is very small)
 The Start time. Only values equal to or below zero can be entered here (note

that the minus sign must be entered also). When a value is set, as m any
seconds as set will be recorded before the sound trig. If this is set to zero, the
camera will start recording directly when the sound triggers the system . 

 The End Time. This is the amount of time for the camera to record after the
sound trig. 

 Microphone. Sets the Microphone threshold levels for the sound sync or sound trig. 
o Level Now is the current value in dB, updating continuously if a microphone is connected to

the system
o The Max Level is the maximum obtained value out of the c urrent value since the reset button

was last used.
o The Reset function will reset the max value and start over. 
o The desired Threshold Level for the Sound Sync/Trig can be typed in the enter field.  

Test Procedure
A small summary of the Gun Scoring step-by- step guide below. 

Geometry Scaling

Single Frame Capture
This is where we can download a single snapshot from  the camera in Camera Control Mode, mainly for
use in the GeoSetup section before the reference points are positioned. The Caption command will only
arm the cameras which views are assigned to the currently active Test Sec tion respectively. 

 Download Directory.  By default, the path will be taken from what is specified in the Preference
Archive. However, this can be amended to any other download path. If any of the directories specified
does not exist, such will be created prior to the download.  

 The list of all the Camera Views affected by the Single Frame Snapshot command. For every camera
in list, the following information is provided; 

o Name - name of the Camera View
o Camera - name of the camera in View
o Filename - the name of the file to be downloaded. The filenam e is taken from what is

specified in the Gun Scoring Setup, but can be clic ked and amended in the columns as well.
Not only the file name(s) can be specified here, but a whole path with the download direc tory
can be typed. If a path is typed here, this will be used instead of or in c ombination with what
is in the Download Directory enterfiled above. Some examples of this;
o if the Download Directory enter field contains the path C:\teimage\Download, and the

Filename pattern here is Download_1/Images, then the final path and filename will be C:
\teimage\Download\Download_1/First_Shot. 

o if the Filename pattern is C:\teimage\Images\First_Shot then the path in the Download
Directory enter field will not be used at all, only the path in the filenam e pattern. 

o If any of the directories specified in the Filename pattern does not exist, such will be
created prior to the download.  

o Warnings - warning messages before and during the Arm/Trigger procedure. The warning
messages are sorted in a tree structure in categories. To see which cam eras that are affected
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by the warning, click the + adjacent. 

Note: the Arm command will only arm the cameras which views are assigned to the c urrently active Test
Section respectively. 

Arm
This function has much in common with the Single Frame Caption function described above. However,
there are a few differences.

 This function downloads the moving images from the test, not only one single im age.
 The camera view list;

o Status - status of each the camera during the Arm/Trigger procedure. 
o Empty - the camera RAM memory is empty. 
o Full -  If automatic download is not selected, the "Full" status is displayed to indicate

completion.
o Armed - The camera is Armed, but no Trigger signal has been sent yet
o Triggered  - The camera has received a trigger signal
o Downloading - the percentage of the specified download range.
o Download Completed

 Manual Trigger button. In case sound trigger is not an option, the trigger signal c an also be
manually given to the system by clicking this button.

 Warnings - warning messages before and during the Arm/Trigger procedure. The warning messages
are sorted in a tree structure in categories. To see which cameras that are affected by the warning,
click the + adjacent. 

 Download progress bar. When the Trigger command has been given, a main progress bar will
visualize the download procedure. This bar will reach 100% at the amount of set recorded live images
from the frame grabber camera, thus this will always c omplete.

Point Generator
In Gun Scoring, the Point Generator is limited to 5 points per frame when tracked. 

Statistics calculations

When a  test is performed, there is a number of parameters that are calc ulated automatically with no
settings for the user. The results are captured by the use of Statistics Built- in Variables into the final
report. 

The gun scoring statistics are constant values, not sequences of tim e. They are computed per section,
and are based on the last tracked samples (per section) of all points that are considered 'valid'. A point is
'valid' if it doesn't belong in a group (this exc ludes e.g. all reference points) and has a name different
from the aim-point name, which is specified in the Test Data Setup dialog.

The results are all using the same coordinate system, the Scoring Paper coordinate system . This is
oriented in the reference plane as set by the 2D reference points and its 2 axes defined by the patterns of
the perforation holes in the paper in the last trac ked image frame.
The axis definition is; the y axis goes through the point farthest to the right and the x axis through the
lowest point. 

 Extreme Vertical. Vertical distance between the center of the hole made by uppermost shot and the
center of the hole made by the lowermost shot.
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 Extreme Horizontal. Horizontal distance between the center of the hole made by the shot farthest
to the right and the center of the hole made by the shot farthest to the left. uppermost shot and the
center of the hole made by the lowermost shot.

 Extreme Spread. Distance Between centers of the shot holes farthest apart.

 Position. x, y coordinate value of each shot.

 Center Of Impact (COI). The point at which the algebraic  sums of the vertical and horizontal
components respectively of the distances to the center of each slot hole are zero. 

 Mean Radius. From the center of impact, measures the distance to the center of each shot hole of
the target . Add these distances and divide by the total num ber of holes. 

 Standard deviation. The square root of the average squared deviation from  the mean. x,y
coordinate value. 

 Aim to Center of Impact. Distance. 

 Angle of Impact (AOI). This is half the opening angle; AOI=arctan(MRad/ShootingRange).

Spread Circle

The Spread Circle is a point specifically produced for Gun Scoring reports, which cannot be seen in the
test contents list. Its position is the Center of Impact, and its accuracy radius is the Mean Radius, as
described above, transparently using the Statistics Variable MRad.

When in an image diagram, the spread circ le can be added to the diagram just like any other curve. It
will then appear as a tracked point in the Center Of Impact.

1. Right click the Spread Circle in the Curves list
2. Select Show Accuracy.
3. Standard Deviation.
4. Press OK. The calculated Mean Radius will now be visualized as the ac tual spread circle. 

Note: The Spread Circle is different from the other points in the test. Each tracked point in TEMA has a
corresponding accuracy. This accuracy can be visualized in e.g. XY and image diagrams as an uncertainty
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ellipse. The Spread Circle is different in the sense that its ellipse is not a visualization of its ac curacy, but
instead corresponds to the statistical Variable MRad. When added to a XY or image diagram, it does
indeed appear at the Center Of Impact. It is, however, not the Center Of Im pact (COI) by definition.
When displaying the Mean Radius, this is done via the Acc uracy drop box. The circ le around the point is
really the calculated Mean Radius visualized and not the accuracy of the COI point. 

Preferences
 Preferences/General - open Gun Scoring Setup dialog at new test startup. Enable by c licking in the

check box.

Factory Template
The factory Template is a .ted file that shall be copied into the Templates Directory in your TEMA
installation. When starting up the program, this template can be selec ted from start. If this is done, all
the most important program parameters will be preset instantly. The presents are; 

 Two Test Sections. Those are called GeoSetup and Test. The Calibration function has a setting
that will download one single image from the camera only. This will be used for loc ating or
tracking the 2D reference points. The Analyze section has no such lim itation for the download but
will allow downloading of all images from the actual test  

 One Camera View. This is assigned to both sections in order to use it both when perform ing the
2D geometry setup and during the analysis. 

 Default filenames for the downloads, per section . The filename patterns contains the Project
name and each sections name. This is done with help of the syntaxes $'Project Title'$_GeoSetup &
$'Project Title'$_Test where Project_Title is a Test attribute (see below) spec ified in the Gun
Scoring Setup. 

 A 2D reference model imported in the GeoSetup section. This c ontains the measured 2D
coordinates for the reference points on the Scoring paper. The Referenc e Points are listed on the
point list ready for tracking when an image in provided. 

 2D Reference Points are defined in Geometry setup. 

 Aim Point track Point is added to test in the GeoSetup.

 A Point Generator. This has been set up using a Perforation hole as reference. The trac ker
algorithm is Center Of Gravity Tracker for detecting dark object on white background. No Frame
To Frame Prediction is used. The point generator c an detect 5 perforation holes maximum. 

 Exclude areas have been added to the image, per section. This is because the point generator
looks in the whole image and we need to restrict the generator to looking only at the areas of
interest. The image has been set to exclude by default and then been equipped with one m ore
exclude area enclosing the Scoring paper in which tracking will be allowed.

 Test Attributes. A number of attributes have been defined as follows

 Project Title. This is used for default filename patterns.

 Date

 Test Site
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 Project Manager name

 Weapon Type

 S/N# (Serial Number)

 Ammo Type

 Comment

 Report Generator in test. This contains 

 a Test summary that lists the Gun Score Statistics in the project Specification. This is all
done using built-in Variables. 

 an Image Diagram. This is specified for plotting the result from the Point Generator when
tracking is performed in the Test section.  

 Spread Circle in Image Diagram that shows the  calculated Mean Radius of the hole burst.  
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Geometry - Scaling (optional)
Function
A special case of 2D tests is a 2D test where all points of interest are in one plane (Gun Scoring is suc h
an application). Such has an advantage that can be used for obtaining a good result even if the c amera's
optical axis is not perpendicular to this plane (called Motion Plane). The Geometry setup is used for that.
By defining a Reference plane based on points on the Motion Plane, a projective plane to plane
transformation T can be made. T has 8 degrees of freedom. Therefore it requires four reference points to
be estimated. Each of those has two equations to be solved, x and y. 

Procedure
1. Select the Geometry option from the Edit menu.

The Geometry Setup dialog is displayed. 

2. Key  in the Reference Time manually or alternatively, select the  button to use the current
time. Select also the correct time units from the drop-box.

4. Select the four Reference Points (from the 2D Reference Target) , with the use of the
corresponding drop boxes. 

5. Select the OK button when all required points have been defined. When the referenc e points have
defined the geometry for a camera, this will be indicated with a blue C  on the camera icon in
the test contents list. 

Note: The coordinate system defined by the reference points is used for the transform ation purpose only.
When calculating the actual Gun Scoring results (statistics), another coordinate system (the Scoring
Paper coordinate system) is used. Those has nothing in c ommon.  

See Also... 

2D Reference Points
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2D Reference Points
Function
This function is used to insert 2D reference points from an externally defined target, used for c alcualting
the camera's position in Arena tests.  

Note: The function is only available with the Arena Test Optional Feature.

1. Select the appropriate Camera View window. 
2. Select the Insert Reference Points option from the Camera menu. 
3. To import reference points from a file: 

o Select the Import from File option from the sub-menu.
o A standard Open dialog is displayed with the file type preset to '.tgt'. 
o Select the required target file. 
o Select the Open button.
o The Imported Target Model dialog is displayed. 
o Amend the target model, if required. 

 For each point you wish to define for the target: 
 Select the Add button.
 A point is added to the Points list. which has a default Name (P1, P2, etc.) and its x

and ycoordinates set to 0,0
 Select the Name of the point and change it, if required. 
 In turn, select the x and y coordinates of the point and change them to the required

values. 
 For any point you wish to remove from the target: 

 Select the point. 
 Select the Remove button.
 The point is removed. 

 For any point you wish to modify:
 Select the entry in the Points list. 
 Select the Name of the point and change it, if required. 
 In turn, select the x and y coordinates of the point and change them to the required

values. 
o Select the required Unit from the list. 
o Select the OK button.
o The target points are added to the selected camera view in the Test Contents window. The

target file name is used as the name of the point Group. 
4. To copy reference points from another view: 

o Select the Copy from Other View option from the sub-menu.
o The Select Points dialog is displayed. 
o Select the required target from the list of those already in the test. 
o Select the Copy button.
o The points from the selected target are displayed in the Test Contents window under the

selected camera view. The target file name is used as the name of the point Group. 

Target File Format

Target files are text files containing actual measurements for the reference points, one line for each
reference point. Each line contains the name of the reference point and its x and y c oordinates, separated
by spaces, as shown in the following example.

Note: The measurements that you make for the target imply that a particular origin is selec ted. This
should be a readily identifiable fixed point in the test area.

Example target file:
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Lower_left 0.204 0.942
Upper_left 0.216 1.224
Lower_right 0.9878 0.5188
Upper_right 1.0035 0.884
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Gun Scoring
Step By Step guide to Gun Scoring test
For more detailed help, turn to the Gun Scoring functions descriptions or use the links. 

The procedure has two parts; 

 Software setup procedure; how to set up TEMA Gun Scoring prior to the testing procedure.

 The Operational Test procedure. The steps required to run a Live Fire Test. In applications with a
fixed camera mount there is a special procedure that can be used to decrease the overall tim e
required to run a test. This is referred to as Fixed Camera Procedure.

Software setup procedure

This part of the guide describes the initial steps to be taken in TEMA before the first live test is
performed. Once this is done these same settings will be available for use in future tests. 

1. Copy the .tep file provided by IS into the TEMA installation directory, overwriting the existing file. 

2. Copy the factory template GunScoring (.ted file) provided by IS into the TEMA installation/Tem plates
directory.

3. Set up the test rig with the scoring paper.

4. Mark four reference points on the scoring paper. All points has to be seen be the cam era used in the
test, as those points will be tracked in TEMA later. A point can be a black dot or a quadrant m ark.
Define a 2D coordinate system on the board. Measure the 2D positions of the reference points on the
board (x and y as measured in any coordinate system). Create a 2D reference model, consisting of
the point names and their 2D coordinates. Save as a file with ending .tgt, using any text editor. 

5. Connect A live camera to the workstation. 

6. Start TEMA with Gun Scoring functionality. 

7. Make sure the Factory Template GunScoring is opened.

8. If enabled in the preference archive, the Gun Scoring Setup dialog will appear automatically at
startup of the new test. Here, make the following settings and definitions:

o Test Setup
 Statistical Analysis: Set the used Shooting Range and the used units.
 The Test Attributes, as defined in the factory Template, give values to those ones

here. 
 Download Filenames. In the Factory template, there are two sections defined from

start. Those are called GeoSetup and Test. The filenames are also defined in the
template, using some built in variables; $VIEWNAME$_GeoSetup  and $VIEWNAME
$_Test. The syntax $VIEWNAME$ will use the corresponding view name for each
section automatically. Amend the pattern if desired. . 

o Camera/Microphone Setup
 Camera Setups. In order for any settings to be done, a online live c amera must be

connected to the system. 
o Imaging. Frame frequency and image size for the frame grabber camera can be
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reviewed here, but not changed.
o Recording. 

 Sound Sync (Single Shot). Enable this option when performing single
shot tests. In General, the longer the Shooting Range, the longer the tim e
might be needed. The time might be close to one sec ond or smaller. If the
time between each shot is smaller than that, the time might be long enough
for two shots to penetrate the scoring card before the cam era captures the
image. In such case, Burst mode (below) might be a better approach.

 Sound Trig (Burst). Enable this option when performing burst tests
(where the time between each shot is very sm all). Set the Start and End
Times for the camera recording in relation to the sound trig of the first
shot. 

 The Start time. Only values equal to or below zero can be entered
here (note that the minus sign must be entered also). When a value
is set, as many seconds as set will be recorded before the sound trig.
If this is set to zero, the camera will start recording directly when the
sound triggers the system. 

 The End Time. Set the amount of time for the camera to record
after the sound trig. 

 Microphone. Set the Microphone threshold levels for the sound sync or sound trig.
Position the microphone where it will be at the forthcoming test. Perform a test shot. Use
the values of the Level Now and Max Values as your guidance. The Level Now is the
background noise level. If a test shot is fired, this will be indicated by a new m ax value.
Set the Threshold level a bit below this m ax level and considerably higher than the
background noise.

9. Set the Directory for camera Download. This is done in the Preference Archive/Directories.

10. Select the Section GeoSetup.

11. The 2D Reference Model in the provided .tgt file provided may not have the correct 2D coordinates for
the test site. In case not, the .tgt file m ust be edited (outside TEMA) using a text editor, for example
Notepad.  Make sure to keep the format with the space delimiters. Save the file and note the
directory. It will be used in TEMA in the next step 

12. Import the 2D reference target  into TEMA via Camera/Insert Reference Points. Browse to the directory
at where the .tgt file was saved. In the import dialog, make sure the scaling of the 2D c oordinates is
correct!

13. Go to Geometry setup (Right Click the Camera View and select the option from  the list). Define the
four reference points. The 2D transformation calculation will be performed instantly here and no
Camera Calibration is needed. 

14. (Optional) In applications where the camera is fixed at all times, AND if the Aim Point measurement
is not used, the process can be streamlined even further. After step 13 above, perform  a single frame
capture and place the four reference points in the image. 

15. Create a new Template at this stage (Select File/Create Template). Note: If  the optional step 12 was
performed and the camera is fixed in all tests, activate section Test and uncheck the Toggle Wipe
Images and Tracked Data. The created Template will now contain pointers to the used images as
well as the tracked data for the reference points. Such Template will be referred to as Fixed Camera
Template in the following Test procedure instructions. If the template has no such information, the
template is a Free Camera Template. 
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Operational Test Procedure 

The operational test procedure guide is devided into Free and Fixed Cam era Mount, using Free or Fixed
Camera Templates (see step 15 above). Please note that the Fixed Cam era Procedure is only a
suggestion in order to run the test faster in case the c amera is fixed. The Free Camera procedure will
work in all conditions.

Free Camera Template

The Free Camera Procedure describes the steps to be taken in each test when a new Sc oring paper has
been installed, or if the camera has been moved between two tests. (Free Camera application)

16. Open up a New Test and Select the Template as was created in chapter 6 above. (Selec t File/New
Test. Select The Template as saved above).

17. Select the Section GeoSetup.

18. In the Sections tool bar, make sure the GeoSetup section is selected in the drop box. 

19. Add a live Camera view to the test. The camera shall overlook the test area and the reference points. 

20. Position the aim laser beam towards the scoring paper.

21. Perform a Single Frame Capture from the Camera (As the name indicates, this will just be a Snapshot
as we are in Single mode). 

 Select the Arm...  option in the Camera menu.
The Single Frame Capture dialog is displayed.

 Amend the Download directory, if desired.
 Select the appropriate Filename and change it. 
 Select the Capture button. When the function has completed, select the Close button.

22. Position the 2D reference points at their corresponding positions in the image. Make sure the camera
icon in the test contents list will be equipped with a blue "C", .  If not, go to the Geometry setup;
right click the camera view and select Geometry. The Geometry dialog will appear. Make sure the the
four Reference points are specified in this. When this is done, a 2D Geometry transformation will be
performed, and the blue C will appear on the c amera icon. 

23. The point Aim Point in the test contents list can be positioned in the image at where the laser pointer
was aimed. This is optional. Positioning this point will m ake certain Gun Scoring statistics
calculations. Thus, the aim point must have exactly this name in order to be included in calculations,
don't change this!

24. Switch section to the Test section. 

25. Now it is time for the test shooting. 
 Open up the Arm dialog; Select the  Arm option in the Camera menu. The Arming

and Triggering dialog is displayed.
 Arm the camera; Select the Arm button. 
 Amend the Download directory, if desired.
 Select the appropriate Filename and change it. 
 Fire onto the scoring paper.
 As we have set up the Sound Trigger, firing will arm and trigger the camera instantly.

(Note:If we do not have any sound trigger set up, we m ust manually trigger the
camera by clicking the Trigger button.)

 The Status changes to "Armed", and the Trigger button is enabled.
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Note: The Disarm button is used to reverse the action of the Arm button without
triggering.
A number of warnings can be displayed during the arming process. Those are sorted in
categories in a foldable structure.  

 "Image file will be lost." - displayed if automatic download is enabled and the
file to which the download is to be made already exists. 


During the data capture (with automatic download selected), the Status changes as
follows:

 When the download has completed, select the Close button.
Note: The Stop button is used to cancel the capture of images, but the images already
captured are downloaded.

26. The downloaded sequence will now appear in the cam era view.

27. Step to a typical frame in the image at where at least one perforation hole pattern is clearly visible.

28. The point generator is already added to the test when the template was loaded. All we have to do is
to set this up to detect preformation holes. (Right Click the Point Generator and selec t Point Setup.
Set up the point generator Tracker. Select COG tracker. Set the threshold values of the COG tracker
to detect the pattern in the best way. Uncheck the 'Fram e To Frame Prediction' if not unchecked).

29. When the point setup is ready, Right Click the Point Generator again and selec t Auto find Similar. The
initial result of the point generator can then be seen in this frame directly. The result must be that all
perforation holes are detected and nothing else. If this is not the case, go back to the point setup and
amend the COG tracker. Select Autofind again and trim  the point generator until a fine result is
obtained.

 
30. Track through the sequence. 

31. The produced Statistics will now be presented in the Report present in the template;
o a Test Summary with certain Statistics Variables.
o a XY  diagram with the Spread Circle. 
o a Image Diagram.  Note that the data can be presented using the unsc aled image coordinate

system or the scoring paper coordinate system. 

Fixed Camera Template
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This section describes the steps to be taken in each test when a new Sc oring paper has been installed in
a fixed Camera application and a Fixed Camera Template has been produced. 

1. Open up a New Test and Select the Fixed Camera Template as was created in chapter 6
above. (Select File/New Test. Select The Template as saved above).

2. Make sure the section Test is now active. 

3. Continue with steps 25 to 31 in the Free Camera procedure above.

Note: Even in a fixed camera application, the camera might have been slightly moved beween two tests
due to vibrations or other. If this is the case, it is easily detec ted in the image diagram as the reference
points placements can be seen there. If those does not match the positions of the quadrant marks on the
scoring paper, the camera has been moved. 

Now, even though this is detected after a test shooting has been performed, the test does not have to be
redone. Instead, change section to GeoSetup. Perform a new single fram capture and place the reference
points in this. The test data will now be recalculated using the new referenc e points. 
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Maintaining Properties
Many of the items displayed in the TEMA Main Window have a set of properties specific  to the type of
item. The majority of these properties may be specified by the user. 

1. Select the required item in the Test Contents window or a Diagram window. 
2. Select the Properties option from the Edit menu.

The dialog is displayed depends on the type of item selected, i.e.
o Camera View - Camera View Properties dialog.

 2D Point - Point Setup dialog for points. 
 3D Point - 3D Point Setup dialog. 
 Angle - Angle Setup dialog. 
 Contour - Point Setup dialog for contours 
 Distance - 2D Distance Setup dialog. 
 Stick Figure - Stick Figure dialog 

o Data View - Data File Properties dialog.
 Data Item - Data Setup dialog. 

o Diagrams: 
 Advanced Diagram - Advanced Diagram Properties dialog. 
 Multi Axis Diagram - Multi Axis Diagram Properties dialog. 
 Table - Table Properties dialog. 
 XT Diagram - XT Diagram Properties dialog. 
 XY Diagram - XY Diagram Properties dialog. 

Note: The Properties for an item may be reached via its corresponding right click menu as well.
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Maintaining Data File Properties
Data files containing appropriately formatted sequence data can be im ported into the system.

The Data File Properties dialog is displayed when a data file is selected and its properties displayed. It
contains the full path name of the imported file. It cannot be amended.

The Data Setup dialog is displayed when any of the data sequences is selected and its properties
displayed. The dialog is empty in this version of TEMA.
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Notes Window
Every time the <F12> key is pressed, the Notes dialog is displayed and the current contents of the
status bar are moved to the top of the list in the Notes window. This function c an be used for a number
of purposes such as recording the result from the distance measurement tool, recording airbag
coordinates, or saving an error message raised during tracking.

Note: This  function works even while dragging with the m ouse.

1. Select the Notes option from the View menu.
The Notes dialog is displayed.
The following functions can be initiated from the Notes window:
o Clear the list;
o Delete items from the list;
o Add a comment manually;
o Add a separating line;
o Print the list;
o Copy the list;
o Save the list.

2. Select the Close button. 

Clearing the List

1. Select the Clear button.
A confirmation message is displayed. 

2. Select the OK button.
The complete list is cleared.
Note: To remove items from the list, use the Delete command. 

Deleting Items from the List

1. Select the items to be deleted from the list.
The <shift> and <control> keys can be used in the standard m anner. 

2. Select the Delete button.
The selected items are deleted. 

Adding a Comment Manually
1. Select the Comment button.

The Add Comment Manually dialog is displayed. 
2. Key the required text.

Note: You can edit the text, if required. 
3. Select the OK button.

The new comment is added to the end of the list. 

Adding a Separating Line
1. Select the Add Line button.

A dotted line is added to the end of the list.
Note: A line cannot be added other than at the bottom of the list. 
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Printing the List
1. Select the Print button.

The Windows Print dialog is displayed. 
2. Select the required printer. 
3. Select the Print button.

The list is printed. 

Copying the List
1. Select the Copy button.

The complete list is copied to the clipboard.
Note: Individual items or selected groups of items cannot be copied. 

2. If required, you can select the Comment button and paste the copied list into a new com ment
and edit it before selecting the OK button. 

Saving the List
1. Select the Save button.

The Windows Save as dialog is displayed. 
2. Specify the save location. 
3. Select the Save button.

The list is saved.

 



p461

© Image Systems AB, 2011

Renaming a View
To rename a view:

1. Select the Rename View option from the Camera menu.
The name of the selected view in the Test Contents window is placed in edit mode. 

2. Amend the name. 
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Show Disabled Items
This function shows all disabled items in the Camera View window. 

Disabled items that can be shown are:
 Points
 Distances
 Angles
 Stick figures
 Contours

When the Show Disabled Items function is:
 Enabled - All items are visible in the Camera View window.
 Disabled - Only enabled items are visible in the Camera View window.

The Show Disabled Items function is accessed by:
 Right-clicking in the Camera View window.
OR
 Right-clicking on required Camera View in the Test Contents window.
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Supported Image Formats

Reading
The following image formats are supported for reading.

Proprietary Formats: 
 Trackeye Image Format (.tei) - Image Systems proprietary format.  

General Formats: 
 Tagged Image File Format (.tif) 
 Windows Bitmap format (.bmp) 
 Photo CD format (.pcd)
 Portable Network Graphics (.png) 
 JPEG format (.jpg, .jpeg) 
 Windows Media Video (.wmv) 
 Windows AVI format (.avi) 
 Quicktime (.mov) - Requires Quicktime to be installed on the computer. 
 MPEG-1, MPEG-2 (.mpg, .m1v, .m2v, .mpeg, .vob, .mts, .m2t, .m2ts) 
 MPEG-4 (.mp4) 
 DPX format (.dpx) 
 Cineon format (.cin) 
 Graphics Interchange Format(.gif) 

High Speed Camera Specific Formats: 
 Bayer format (.bay) - Redlake/Kodak format.
 Photosonics Range Camera Format (.rdf) - Photosonics format. 
 BLD format (.bld) - Weinberger format. 
 WRAW format (.vraw) - Weinberger Speedcam format. 
 CCI format (.cci) - Phantom format. 
 CIN/CINE format (.cin, .cine) - Phantom format. 
 DRS format (.tif) - Special multiimage TIFF variant used by DRS. 
 Image Express format (.tif) - Special multiimage TIFF variant used by Image express software.
 FTIF format (.ftif) - Photron variant of .tif with a possibility of extra inform ation from the camera.
 MRAW/RAWW format (.mraw, .raww) - Photron c amera raw format.
 MCF format (.mcf) - NAC camera format.
 VR2 format (.vr2)

 

Writing
The following image formats are supported for writing:

 Tagged Image File Format (.tif)
 JPEG format (.jpg)
 Windows Media Video (.wmv)
 Windows AVI format (.avi)
 Quicktime (.mov)
 MPEG-1, MPEG-2 (.m1v, .m2v)
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 DPX format (.dpx)

See also...
Opening Image Sequences
Image Diagram
Exporting Images
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TEMA Viewer
The TEMA Viewer is a version of TEMA that is used to view tests exported from TEMA or TrackEye,
typically to a CD. It contains a subset of the full TEMA functionality and is geared towards viewing test
results rather than conducting tests.

When the Viewer has been started, the TEMA Viewer window is displayed. It c ontains:
 A Menubar
 A set of Tool bars
 A Diagrams list - essentially the TEMA Test Contents window, but containing only camera views,

diagrams and zoom windows. 

Note: There is an Advanced TEMA Viewer also which includes more functionality than the basic one
described here. 

Menubar
The TEMA Viewer contains the following menu options:

Note: The full TEMA functionality is not available for all of the listed Viewer options.
 File

o Open - opens a test. 
o Close - closes the current test. 
o Print Setup - displays the Print Setup dialog to specify the print layout. 
o Print - prints the selected item. 
o Exit - Closes the TEMA Viewer. 

 Edit
o Copy - copies the current item to the clipboard. 
o Time Properties - sets the time properties, excluding the user defined interval. 

 View
o Test Description- displays the test description. It cannot be amended. 
o Tool bars - toggles the display of each of the Tool bars. 

 Tools
o Select Tool - selects the Select tool. 
o Distance Tool - selects the Distance tool. 
o Angle Tool - selects the Angle tool. 
o Zoom Tool - selects the Zoom tool. 
o Optimize display - Optimizes the display of images to increase performance. 

 Diagram
o Zoom 1:1 - Redisplays the diagram at the original size. 
o Grid - Toggles the display of the diagram grid. 
o Legends - Toggles the display of the diagram legends. 

 Window - contains a list of open windows. 
 Help - controls access to the help system. 

Tool bars
The TEMA Viewer contains the following tool bars:

 Time Panel - not all the TEMA tools are available.
 Time Slider - not all the TEMA functionality is available.
 General - contains the following tools:

o  - Open Test
o  - Print
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o  - Copy
o  - Select Tool
o  - Distance Measurement Tool
o  - Angle Measurement Tool
o  - Zoom Tool
o  - Zoom In
o  - Zoom Out
o  - Zoom 1:1

o  - Toggles the display of the diagram grid.

o  - Toggles the display of the diagram legends. 

Starting the Viewer
1. Load the CD containing the Viewer and the exported tests. 
2. Start Windows Explorer and locate the CD 
3. Double-click the "te_view" application.

The Choose Test Presentation dialog is displayed. 
4. Select the required test from the list displayed. 
5. Select the Open button.

The selected test is displayed in the TEMA Viewer window.

See also..
TEMA Advanced Viewer
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Exporting to a Viewer CD (Optional
Feature)
The CD Viewer is a separate application that is used to display test data and im ages, together with a
browser with viewing capabilities only. When the viewer is started, a list of available tests is displayed
from which the user can make a choice. Once a selection has been m ade, a CD Viewer Session is started.
This session is a reduced functionality version of the Image Systems TEMA application.  

Tests are exported from the Session window as CD Viewer Folders which contain all the relevant
information. The exported data is written to a specified folder struc ture that contains the viewer software
at the top level and a series of sub-folders, one for each exported test. There is also a sub-folder
containing help information. You can also customize the appearance of the Viewer. 

Prior to creating the CD, the contents of the Viewer CD folder structure can be reviewed and am ended. 

When one or more tests have been exported, the complete CD Viewer Folder structure can be written to
a CD. In this way a complete test, or series of tests, can be sent to a custom er without the customer
having to purchase and install a TrackEye system. 

There is an auto start function on the Viewer when written to a disk. When this is enabled, the Viewer
will automatically start once the CD is inserted into a c omputer. There is one requirement for this to be
working. When a Viewer export has been performed, the Viewer CD export directory will contain a file
named autorun.inf. In order to get the auto start function working, all files at the level at
where this file is should be written to the CD.

When a Session is exported to a Viewer CD folder, you have the opportunity to renam e or delete existing
exported files before performing the new export. This management function may also be initiated direc tly
from the Archive window. 

Note: The default Viewer CD folder is spec ified in the Preferences. 
1. Select the Export to Viewer CD option from the File menu.

If the default Viewer CD folder does not exist, you are asked if you wish to create it. 
2. If you wish to create it, select the Yes button, otherwise select No.

The Export To Viewer CD dialog is displayed with the: 
o CD Image Folder preset to the default set in the preferences. 
o New test presentation name preset to "untitled". 

3. Key in an alternative CD Image Folder, if required.
If the folder does not exist, a message is displayed when the Create button is selected asking if it
should be created.

Alternatively, select the button and browse for the required folder.
If the selected folder already contains one or more exported Presentations, they are listed in the 
Current Test Presentations frame. 

4. You may:
o Select an entry and Rename it via the Rename dialog which is displayed. 
o Select one or more entries and Delete them.
o A confirmation dialog is displayed to which you must respond. 

5. Amend the New test presentation name, as necessary. 
6. Specify the Splash And Copyright Directory  by browsing to desired location. 
6. Specify the time period which you wish to export by keying the Exported time interval: Start

Time and End Time.
Note: The Min Time and Max Time fields are used to display the c omplete time interval spanned
by the MDS. They cannot be amended. 

7. If you wish to compress the exported data: 
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o Select the Compress using MPEG-2 check box. 
o Specify the compression rate. 

8. Select the Create button.
The currently displayed test is saved as a Viewer Presentation, but remains as the current test.
You may continue to work with it. A progress dialog is displayed while the export is underway. 

See also..

The advanced Viewer
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Customizing TE/TEMA Viewer Startup
It is possible to change the startup sequence of CD-ROMs created with the Viewer Export func tion. You
can define hwo the splash sc reens shown while the Viewer program starts should look and also add a
special startup dialog showing copyright and/or disclaimer information. The viewer user will have to c lick
a button to accept the conditions for viewing the contents of the CD-ROM. 

Implementing this is done in two steps: 
 Create the files necessary to define the splash sequence and place them  in a directory. 
 Specify this directory under "Splash and Copyright Directory" in the "Export to Viewer CD"

function. 

An example directory called ViewerSplashesExample is available after installing T EMA and TrackEye,
located directly in the install directory. This directory contains all the necessary files for a sam ple set of
splashes and an amusing disclaimer text. 

The file te_view.spd and image files
These files control how the splash screen(s) look. te_view.spd is a XML-format file which refers to all the
used image files and define where and when to show each. 

For best results you should use the .png format for image files. Png is a standard format which can be
created by for instance Adobe Photoshop. The possibility of .png files to include a transparency layer
allows for nice visual effects. For simple cases you can use for instance .bmp, .gif or .jpeg images just as
well. 

The file disclaimer.txt 
The file disclaimer.txt contains the text of any c opyright/disclaimer dialog. If this file is present such a
dialog box is shown whenever the viewer starts. 

The first line in this file has special meaning. It can contain up to three com ma separated strings. The
first string is shown in the title bar of the dialog. The second string, if any, is shown as a button in the
bottom of the dialog. This is the "Accept" button. The third string is the text of the "Decline" button. 

If there is no decline text only one button will be shown, continuing to the applic ation. If there is no
accept text two buttons are shown, called exactly "Accept" and "Decline" respectively. 

Example file: 
------ 
Copyright, Yes, No
This CD-ROM contains Copyrighted material which 
may only be viewed by authorized persons. Clic k Yes below to confirm 
that you are allowed to see the images. 
------ 

Notes and Tips 
All files in the "Splash and Copyright Directory" are copied to the CD-ROM so this feature can as a bonus
be used to make sure that other types of files not used by TE/TEMA Viewer are copied to eac h created
CD-ROM. 

By creating several different directories you can select different sets of splashes and copyright texts
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depending on the nature of the data, for instance whether it is c lassified or unclassified. Then you just
select one of these directories when exporting. 

If you don't include any te_view.spd file a standard file from  the installation will be provided. This file
specifies the standard TE /TEMA Viewer splash sequence. 

See Also...

Exporting the Graph as a Viewer CD Session
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TEMA SPD file format
The TEMA SPD file format is used to specify the splash screen layout and anim ation cycle. The file uses
the XML format for easy customization.

Introduction
An SPD file contains two main sections; the first defining the images that will be used by the splash, and
the second defining how these images will be displayed. An image is defined by spec ifying a file name
and optionally a default position. The image is also given a unique ID which will be used in the sec ond
section to specify which image to display. The SPD file must contain an image with the ID set to "splash".
This image will be used as a background and should be large enough to ac commodate all other images
that will be displayed. 

The second section, the animation block, contains a sequence of frames specifying which images to
display at different times, making it possible to animate the splash. A frame can contain a number of
images and their respective positions in relation to the background im age. 

General layout
A typical SPD file has the following layout:

<?xml version="1.0" ?> Needed to identify the file as XML
<splash> Splash description block

<image id="splash"> Main image, "canvas"

<filename>file.png</filename>

</image> 

<image id="0"> Additional images 

<filename>otherfile.png</filename> 
<xpos>10</xpos> 
<ypos>20</ypos> 

</image> 

<image …> 

<anim wait="false"> Animation block 

<delay>100</delay> Speed 
<mode>once</mode> Type 
<frame> Animation frame block 

<show id="0"> Image display block 

<xpos>0</xpos>
<ypos>-1</ypos>

</show> 

<show …> Additional image display blocks 



p472

© Image Systems AB, 2011

<frame …> Additional animation frame blocks 

</anim> 

</splash>

XML Tags 
<?xml version="1.0" ?> 

Alll SPD files must start with an XML header like this. 

<splash> 

The main block. Must contain at least one image block and exactly one anim block. 

<image id="identifier"> 

The first image block in the file must have the id set to "splash". This is the main splash image. The
image needs to be large enough to fit any additional im ages that will be animated on top of it. Additional
image blocks with unique identifiers may be specified after this im age block. 

An image block may contain the following blocks (filename is required):

<filename>file.png</filename> 
<xpos>x-position</xpos> 
<ypos>y-position</ypos> 

The x-position and y-position are the offsets in pixels from the top-left corner of the m ain image.
Negative values will be interpreted as offsets from the bottom or right edge of the image.

<anim wait="waitmode"> 

The animation block follows the sec tion of image blocks and contains information about the splash
animation. The animation block may have a wait attribute which, if set to "true", will ensure that the
application waits for the splash animation to complete before removing it from the screen. The animation
block should contain the following blocks: 

<delay>delay-ms</delay> 
<mode>loop-mode</mode> 

The delay block specifies the number of milliseconds to wait before advanc ing to the next frame. The
mode block specifies the loop mode of the animation. This can be one of the following values: 

 once - Go through all animation frames and stop at the last.
 loop - Loop the animation frames until the application is loaded. 
 pingpong - Loop the animation frames in a ping-pong fashion. 

After these blocks at least one frame block must follow. 

<frame delay="override-delay-ms" loopstart="start"> 

The frame block describes a frame in the animation. The optional delay attribute is used to override the
main animation speed for this frame. The optional loopstart attribute can be set to "true" to define this
frame as the starting point when the animation loops. The frame block can contain any number of show
blocks. 

<show id="id"> 

The show block is used to display an image at a certain position in the splash. The show bloc k must
contain the id attribute which specifies which image to display. The position of the image is specified
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with the position blocks: 

<xpos>x-position</xpos> 
<ypos>y-position</ypos> 

Note that the image data will be copied with the SRCCOPY operator directly on top of the splash image,
which means that all pixels, including its alpha-values will be overwritten. Also note that the splash
image is progressively altered by the animation frames, meaning that the result of a fram e's display
operations is the starting image for the frame following it. 
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The Advanced TEMA Viewer (optional)
Function
The optional advanced version of the TEMA Viewer offers m ore functionality than the basic TEMA viewer.
Besides all functionality in the basic viewer, the advanced viewer contains the following features:

         - Modify graphs and spread sheets in  viewer

         - Build new graphs and spread sheets from existing data

         - Export images, data, graphs and spreadsheets from the viewer

         - Print graphs and spreadsheets

         - Perform image format conversions with export capability

Procedure
The procedure when exporting a TEMA test as well as starting up the advaced viewer  is similar to the
TEMA base viewer. 

Appearance
Besides the Menu bar and the Tool bar of the basic TEMA viewer, there are a few more features in the
Advanced viewer. Those are;

Add XT diagrams
Add XY diagrams
Add Advanced diagrams
Add multi axis diagrams
Add image diagrams
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TEMA Arena
Function
TEMA Arena is used to analyze tracked sequences of shrapnel from an Arena Test. The test results are
expressed in a 3D coordinate system with the warhead as the origin. 

For each input shrapnel sequence the following statistic s are produced:

 Position 
The position of the shrapnel pierce, both  3D position or pixel 2D coordinates within the panel.  

 Panel name (const)
The name of the panel that the shrapnel pierced.

 Exit time
The time passed between t0 and the penetration of the panel 

The tracking is automated by the use of a Point Generator. 

There is a Step-by-step guide which describes how to use the functions in the whole Arena test analysis
procedure in the most effective way. 

Appearance
The arena setup dialog is the interface where all the geometries of the test are set. 

The camera/panel geometry is set by using a 2D target model with 4 reference points

The panel orientations are expressed in a 3D polar coordinate system , having the Warhead as the origin. 

A laser gauge is used, which intersects with the origin. 
All the panels are assumed to be completely vertical

The orientation of the panels requires the following com ponents: 
 Distances and azimuth angles from the origin to each of the panel's edges.
 Distances from the lower bottom of the panels (left and right) to a laser gauge. This is done to

calculate if there is any tilting in a vertic al plane. 
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Guide
Procedure
The following instruction prerequisites that a TEMA Arena test configuration is used. 
In order to automate the process a bit, test Templates can be used. The meaning with a Template is to
make all settings first and store those in a template that can be used in all future tests. The tem plate
must be populated to contain all the necessary settings to perform  the test, including the tracker
parameters. In order to set the tracker parameters, an image sequence must be present. 

The instruction is divided into two main steps;
 Procedure: Create a Test Template. 
 Procedure: Use a Test Template

Create Test Template

Setting up geometry (steps 1 – 27)

1. First, create the 2D target models for each panel in the image sequence. For each panel, define
four reference points. The reference points must be measured in the panels local 2D coordinate
system. If multiple panels are used in the test, they need one target m odel each, even if they are
identical. 

2. Create target files for later use in TEMA Arena. The Notepad text editor is the best tool for this. The
format of the target files looks like this:

LL 1 1
UL 1 15
LR 3 1
UR 3 15

Where the first column in the name of the point. The next 2 columns is the measured x and y
components of the reference points. Use space as the c olumn delimiter. 

Save the file as <panel name>.tgt and note the path to where th files were saved. 

Repeat this for all panels. 

3. Open up a new TEMA test
4. Add some Test Attributes, if desired. This is done in Preferences/Attributes. Test attributes are used

for creating reports.
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5. In the Preference Archive, go to the Attributes pane. Click the Add button to add new attributes. The
Add Attribute dialog will then open. 

Below is a recommendation of useable attributes. See the presentation part of the guide for m ore
information. 
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6. Start a new test to activate the Test Attributes.

7. Add a new Camera View to the test. This is done by Selecting File/New Camera View. Select a
typical image sequence that is shot at the test site using the sam e lighting conditions as most
forthcoming tests. 
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Make sure to set the correct image frequency.

The illustration below shows a frame in such an image sequence, displaying three panels. 
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8. In this image, there is an area in the lower part of the im age that will interfere with the tracking of
the shrapnel. Therefore, position an exclude area in the image, covering this area. This is done via
Camera/Add Exclude areas. The illustration below shows a part of the image with such exc lude
area added. 

9. Import the 2D target models into TEMA Arena. This is done by c licking Camera/Insert Reference
points. 
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10. Browse to the created tgt files and mark one of them. Click Open. 

11. The Imported Target Model dialog will now open. This contains the target points and their 2D
coordinates. Be sure to select the correct Unit.

12.

13. Click OK to import the target into the test. Repeat for all panels.  

14. The test contents list will now be filled with the target points, sorted in the three panels. 
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15. Position the target points in the image, for each panel. 

16. Click the Arena setup  button  in the Tool bar. The Arena setup dialog will now open up. 
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17. Specify the Test Attributes with values for the test site. 

18. Click the Add button. The Add New Panel interface will open up.  All geometries of the test
template is set here.  

19. Enter the Panel Name/ID.

20. Set the Reference time (t0) with the correct Unit. The reference time should be set to the time at
when the reference points are located in the image.

21. Select the corresponding Reference Point group. There will be one group for each panel. 

22. Set the Panel Dimensions. Make sure to use the correct units!

23. Enter the Panel Orientation parameters, as measured at the test site
o Distance from Warhead to panel's left and right edges. 
o Distance from laser gauge to bottom left and right corners of panel.
o Azimuth angles to panel's left and right edges. 

Make sure to use the correct units!
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24. Click OK when ready. Repeat for all panels. 

25. To change any geometry set, mark the panel in the list in the Arena setup dialog and clic k Edit. The
Edit Panel dialog will then open. This is the same as the Add New panel dialog. Make the desired
edits and click OK. 

26. Click OK/Apply when ready. TEMA Arena will now apply the test defined geometries. If this was
successful, the message Geometry successfully applied will then appear. Click OK to continue.

27. Disable all the target points. This is done by multi selecting all the points in the test c ontents list
(hold the <Shift> key and mark in the list), right click and select Disable. The geometry setup is now
finished!
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Setting up Tracking

28. Using the time panel, step forwards in the image sequence until you find a typical shrapnel. The
illustration below shows such a frame in the same sequence; the same area pierced with several
holes from shrapnel. Those appears in the image as shrapnel (white dots). The goal is to
automatically track the shrapnel that pierces panels. 
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29. Add a Point Generator, to the test. This uses Autofind similar points functionality in each frame. 

30. Right click the Point Generator and select Point Setup. Select center-of-gravity (COG) tracker on one
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of the shrapnel. 

31. Enable the Subtract Background image/First Image  to increase the contrast. 

32. Configure the thresholds like the illustration below. Remember that the lower (darker) bound m ust be
pretty low to catch every shrapnel.

33. We recommend a blank Generated Name prefix in order to avoid confusion in the image when the
point generator has created a lot of track points.

34. Disable Frame to frame prediction, as the points that we autofind will not move. 

35. In the field Accept lost point for, enter a number greater then the total number of frames in the
sequence, e.g. 10000. The reason for this is shown below. 
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36. Click OK in the Point generator setup when ready.

37. Enter the Camera View properties/Tracking tab. Enable the Hide Non-Calculated Points to
minimize the confusion when there are many points in the image. Click OK. The tracking setup is now
finished!

Setting up presentation
In this example we setup: Point table, 3D diagram and report. 

Point Table

38. Define your data presentation. Recommended: add a Point Table to the test. Click the Point Table
button  in the tool bar.  Right click the table and select properties. The Point Table Properties
dialog will open. 

39. Set up the Point Table. This is an example of a setup: 
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o Panel Name 
 Select Panel name in the Attributes list. 
 Click the insert button .

o Position
 Select Position in the Attributes list. 
 Select 3D Results in the Coordinate System drop down list. 
 Select Last in the functions drop down list. 
 Click the insert button .

o Velocity
 Select Position in the Attributes list. 
 Select Velocity in the Time Derivatives drop down list.
 Select 3D Results in the Coordinate System drop down list. 
 Select Absolute Value in the components list.  
 Select At Current Time in the functions drop down list.

o Exit Time
 Select Exit Time in the Attributes list.  
 Select None in Time Derivative drop down list
 Select <All> in the components drop down list, 
 Select <All> in the Coordinate System drop down list.  
 Click the insert button . 

Click OK when ready

3D Diagram

40. Add a 3D diagram to the test. Clic k the 3D Diagram button  in the tool bar. Right c lick the diagram
and select properties. The 3D Diagram Properties dialog will open. 

41. In the 3D diagram properties dialog, click the Auto select check box to insert all 3D data into the 3D
Diagram. 
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42. Click the General button to the right. Unclick the Legends check box.

43. Click OK when ready. 

Report
44. Add a report generator to the test. Click the Report button  in the tool bar. In the report window.

45. Add a Test Summary text box  into the report. 

46. Click the setup button . The Test Summary setup dialog will open. item. Click  the string

Expression Wizard button . The String Expression wizard  will open up.  Here, both your Test
Attributes from the Preference archive as well as a number of permanent ones (Operator name etc)
can be found and inserted into the text box. Below is a rec ommendation of items added to the Test
Summary. 
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47. Click OK when ready. 
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48. Click OK.

49. Create a Template from the test at this stage; File/Create Template.   

50. In the Create Template dialog, leave the toggle Wipe Images and Tracked data  enabled. Give
the Template a suitable name and click OK. The template is now created and is ready to be used!

 Use a Test Template

1. Open up a new TEMA test. In the Select  Template dialog, select the new Template created according
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to the instructions above. An empty TEMA test with all the settings done above will now open up.

2. Right click the empty Camera View window and select Camera View Properties. The Camera View
Properties dialog will open. 

3. Click Load. The Open Image Sequence dialog will open.
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4. Browse to an image sequence for analysis.

5. Click OK in both dialogs to insert the image into the camera view.

6. Using the time panel, step to a frame where a number of shrapnel are visible in the image.

7. Adjust the parameters for the Point Generator to match the images. This is done by right clicking the
Point Generator in the test contents list and select Point Setup. Reset the COG sliders. Click OK in the
Point Generator Setup when ready. Note: if the light conditions are sim ilar between tests, this step is
unnecessary. 

8. Make sure the first frame of the image sequence is present. Look at the time panel, the current time
marker should be to the leftmost position. 

9. Start tracking forwards. 

10. When a shrapnel pierces a panel, the point generator will autom atically produce a point and assigned
to it. 
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11. The produced 3D data will now be presented in the 3D Diagram and Point Table.

The Report will display the selected attributes. The report can also be set to contain the other diagram
with test data. 
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12. Save the test. This is done by selecting File/Save Test. Give the test a suitable name, i.e. the day's
date. 

Tips and tricks

If error occurs during tracking. 

13. Stop the tracking procedure using the time panel.

14. Remove the generated points from the points list by selecting in the list using < Shift> and clicking
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Delete .

15. Re-adjust the parameters for the Point Generator. This is done by right clicking the Point Generator in
the test contents list and select Point Setup. Reset the COG sliders. Click OK in the Point Generator
Setup when ready. 

16. Make sure the first frame of the image sequence is present. Look at the time panel, the current time
marker should be to the leftmost position. 

17. Start tracking forwards again.

Unwanted points from tracking
Sometimes we get false track points on the panels that are not shrapnel pierc ing. 



p499

© Image Systems AB, 2011

To remove those, step back using the time panel. Identify the false points and note the point indexed in
the view. Mark the points in the point list and clic k delete. 
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See also...
Exclude areas
Autofind similar points
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Undo/Redo
The Undo option, available in the Edit menu or through the  button in the Standard Toolbar, cancels
operations made to any item in the Test Contents window. The shortcut is Ctrl+U.

The Redo option, available in the Edit menu or through the  button in the Standard Toolbar,
restores undone operations made to any item in the Test Contents window. The shortcut is Ctrl+Y

Limitations
 A deleted item from the Test Contents window can be restored in the Test Contents but not in the

Diagram.
 A deleted Diagram can not be restored.
 Undo/Redo is reset when changing the current time (step, play, track etc.)
 Undo/Redo is reset when a Camera View is deleted/added.
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Using the Zoom Window
A Zoom window is used to show part of a Camera View in greater detail to enable greater accuracy
when positioning points or measuring distances, for example.

1. Select the required View window. 
2. Select the Show Zoom Window option from the View menu or via the Tool bar, the Zoom

window button .
The Zoom window is displayed, containing the complete image. Scroll bars are used if the window
is not large enough.

3. To make the image larger, select the Zoom In option from the View menu, or click the  tool.
This operation may be repeated as often as required. 

4. To make the image smaller, select the Zoom Out option from the View menu, or click the 
tool.
This operation may be repeated as often as required. 

5. To return the image to its normal size, select the Zoom 1:1 option from the View menu, or click
the tool. 

Note: The options in the View menu are not always enabled:
 

 All three are enabled in the Zoom and View windows. 
 In a Diagram window only the Zoom 1:1 option is enabled. (This is equivalent to the Show All

option in the pop-up menu). The magnification of diagrams is controlled by the Zoom tool. 

6. To move the Zoom window in a Camera View window, hold the keys <Ctrl> while  left c licking
in the new desired place for the Zoom window within the Camera View window or diagram. The
Zoom window will then be placed with its centre at the place left c licked. When in Zoom window,
the same action taken will move the centre of the  Zoom window to the place clicked. 

See Also...

Using the Zoom Tool

Point Zoom
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TEMA 64-bit - exceptions
Tracking
The MXT tracking algorithm licensed from the Fraunhofer Institute is not supported.

Image Formats not currently supported 
*.VR2 & *.VRAW Old Weinberger formats.
*.RAWW Photron format.
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What's New?
What's new in TEMA 4.0?

What's new in TEMA 3.9?

What's new in TEMA 3.8?
What's new in TEMA 3.7?
What's new in TEMA 3.5?
What's new in TEMA 3.4?
What's New in TEMA 3.3?
What's New in TEMA 3.1?
What's New in TEMA 3.0?

What's New in TEMA 2.6?
What's New In TEMA 2.5?
What's New In TEMA 2.4?
What's New In TEMA 2.3?
What's New In TEMA 2.2?
What's New In TEMA 2.0?
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What's new in 4.0?

Version 4.0 of TEMA includes/integrates DIC 2D functionality as an option.

Digital image correlation and tracking is an optic al method that employs
tracking and image registration techniques for accurate 2D and 3D
measurements of changes in surface structures.

This is often used to measure deformation, displacement, strain and
optical flow, but it is widely applied in many other areas.

Please refer to DIC manual. 
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What's new in 3.9?
The following major changes have been made to TEMA between this release (3.9) and the previous
release (3.8).

64-bit version
 TEMA is now available as a 64 bit application (please note some exceptions regarding functionality)

Operating Systems
 New: Support for Windows 8, 32 & 64 bit versions

Tracking
 Major revision of 'Point Setup'. This is now a live window reflecting selection in other session windows.
 New algorithm to remove background image for 'airbag' tracking algorithm. Removes static background without

superimposing any pattern from the background on the foreground objects.

Analysis
 Considerably improved acceleration filters for smother data.

AOS
 All image formats from high speed camera manufacturer AOS in Switzerland are now recognized.

Camera Calibrations
 To simplify camera position/orientation handling it is now possible to export this type of data to a file which later can

be imported in to any TEMA test. In the ' Camera View Properties' there is now two new buttons, one for import
camera calibration parameters and one for exporting. For some types of calibration a new 'Export' parameters button
is introduced. 

Mandarin Chinese language version (option)
 As an option supplied with a translation of menus and dialogs to Chinese Mandarin. Additional language support is

installed during the install process v ia the configuration code. Languages can then be swapped from the 'Tools'
menu but TEMA has to be restarted before new language setting is applied.  

Wand Calibration (option)
 Enhanced algorithms increase processing speed with 25-45%, depending on type and size of images.

6DoF (option)
 To compute 6DoF data relative to the 'Camera Coordinate System' is now an alternative to the 'Object Coordinate

System'. The selection is made from the 'Camera' menu.

See Also...
Previous Release
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What's new in 3.8?
The following major changes have been made to TEMA between this release (3.8) and the previous
release (3.7).

Tracking
 A new tracking algorithm(beta) to track circular objects is introduced.  The Advanced Circle Tracker.  Data sequences

generated are circumference, area.
 The existing Circle Tracker now also generates data sequences for radius and area (tracked). 

Analysis
 The Frequency Analysis Diagram calculates frequency components of a signal (such as tracked

coordinates, a computed angle, or imported measurement data) and plots a c urve that shows the
signal's relative strength at different frequenc ies.

 The default length of the velocity filter is increased for, in most cases, smother results. Filter settings
are now also available per diagram.

Presentation
 Copy to Time Table function creates a Time Table using current data in  an existing X T, Multi-axis, XY, Advanced XY

or 3D diagram.
For multi-dimensional data the Time Table will show all the data components, ev en if only one component is
displayed in the original diagram. 

Calibrations
 The automatic WAND calibration algorithm is improved and is now more robust. Exposure of wand

calibration images is still important though, normal room exposure with wand illuminated balls
appearing very white.

See Also...
Previous Release
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What's new in 3.7?
The following major changes have been made to TEMA between this release (3.7) and the previous
release (3.5).

Analysis
 TEMA Wand Calibration is the brand new calibration tool for 3D analysis of of any high-speed test in the

automotive industry. The use of Wand Calibration will increase accuracy and ensure that the results
acquired from the analysis are accurate enough to draw the correct c onclusions. The wand calibration
replaces the traditional 3D test preparations, i.e. Lens Calibration and Camera Orientation. 

 Plane offsets values can be imported or exported in Multiple-parallel motion planes.
 The external camera parameters can be reset by selecting Cam era Orientation/Reset Camera

Orientation in Camera menu.

Tracking Usability
 Adding Point(s) to Multiple Point Groups (Add Group to Selec tion).
 The Show disabled items shows all disabled items (Points, Distances, Angles, Stic k figures, Contours)

in the Camera View window.

Presentation
 Combined Image Export - Wizard for combining selected image sequences, diagrams etc. and

exporting them to any image file format such as AVI.
 New preference for continuous/manual Angle Range in diagrams/tables.
 The Diagrams/Tables are visible in the Test Contents window and can be managed from there.
 Image Warping - The Lens Correction option c orrects image distortion in an Image diagram.
 The Test Contents items displayed in the  Diagram Properties Data Selection list can be sorted by

Name and Group.
 A Diagram copy of the existing diagram/table can be created. Any c hanges can be made without

changing the original.

General Usability
 Undo - Cancels operations made to any item in the Test Contents window .
 Redo - Restores undone operations made to any item in the Test Contents window .

See Also...
Previous Release
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What's new in TEMA 3.5?
The following major changes have been made to TEMA between this release (3.5) and the previous
release (3.4).

Compatibility
 Windows 7 support (32-bit and 64-bit).

Analysis
 Non-parallel motion planes:

o Handles motion planes that are non-parallel to the camera sensor by correcting for the varying
scale in the image. Useful for 2D applications with constraints on where to position the
camera.

o Flexible UI for setting up the motion plane in different ways:
 Azimuth/elevation angles between the optic al axis of the camera and the motion plane.
 4 reference (i.e. surveyed) points.

 Increased number of supported coordinate systems, maximum is now 15.
 Toggle for enable/disable of depth scaling.

Speed optimization
 Multi-core CPU support for speed improvements on modern computers.
 Algorithm optimizations for tests with many points, relations and diagram s.
 Functionality for minimizing/restoring diagram windows .

Tracking usability
 New preference “Overwrite manually tracked points during tracking [Yes/No]”.
 Maintaining virtual points will be easier by using the func tion Recalculate All, which overwrites the

virtual point’s position in each frame according to the current 2D model.

Camera Control
 Snapshot download: 

o New function "Snapshot Recording" for quick capture of single or multiple snapshots.

Presentation
 XT, Multi, XY, 3D, Image and Advanced Diagrams: 

o The colour of a curve representing interpolated points can easily be change by the "Alt Colour"
function.

 3D Diagram: 
o Adjustable size for Camera Visualizer.

 Time table:
o Can be configured to automatically add columns by the new function "Auto Select". 

(Also available for XT, Multi, XY, 3D and Image Diagrams).

General usability
 Preferences: 

o Functionality for reverting preferences to factory default values .
 New dongle for dongle licences: 

o The old dongle is replaced with a new model that is supported by Windows 7 and can be
updated remotely, e.g. at the customer site.

 Image export: 
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o Functionality to overlay absolute time information on each frame in image export.

See Also...

Previous Release
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What's new in TEMA 3.4?
The following major changes have been made to TEMA between this release (3.4) and the previous
release (3.3).

Tracking usability
 New function "Step Track" in Time Table toolbar:

o “Step track” tracks one frame forwards or backwards and stops (leaves trac king state and
enters normal state).

o “Step track” keyboard bindings (shortcut keys) and toolbar buttons are added.
o “Step track” makes confirm image and automatic/semi/manual modes obsolete. T hese modes

are removed.

General usability
 Improved error message handling in diagrams/tables/reports:

o If the user sets up an incorrect scaling or coordinate system, or removes/unregisters a point
that is used for scaling or a coordinate system, an error message will be shown in the
diagram/table.

 Toolbar revision:
o Toolbar buttons that are seldom used are removed:

 New data file (Standard toolbar).
 Show time overview window (Standard toolbar).
 Open notes window (Standard toolbar).
 Use area of interest (Tools toolbar).
 Find image (Time table toolbar).

o Toolbar button Time properties (Time Panel) is now optional.
o New “Point Control" toolbar with buttons for:

 Enable
 Disable
 Sleep
 Sleep in selected intervals (moved from Data toolbar).

Templates
 Improved templates concept including factory templates with the TEMA installation:

o Template installation: 
 A selection of factory templates is installed during installation. The selec tion is

controlled by the configuration code.
o Template management: 

 Functionality to delete and rename templates.
o New functionality: 

 Templates can be configured to ask for image files.

Presentation
 3D diagram: 

o New toggle for “Keep aspect ratio”. When disabled, the axes will be scaled so that the ranges
of the axes form a cube (3D only).

 All diagrams: 
o Settable fonts for diagram texts in the Diagram Preferences.

Analysis
 New Spline filter for data smoothing.
 New settings for 3D Interpolation algorithm: 
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o Linear or cubic.

See Also...

Previous Release
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What's new in TEMA 3.3?
The following major changes have been made to TEMA between this release (3.3) and the previous
release (3.1).

At a glance
 Lens Calibration – A new Lens Calibration feature is developed. Will dramatically improve the

accuracy in 2D and 3D tests.
 General Usability – Tracking optimization, improved image handling, user interfac e updates.
 Relative Orientation – Perform your camera orientation directly from two camera views, without a

surveyed target (e.g. a cage). This feature will simplify the test procedure for all 3D users.
 Presentational Improvements  – New diagram features for extended presentational possibilities.

In detail
 Usability:

o Relative image file search paths. With relative image file search paths it is easier to distribute
TEMA tests.

o Sort windows. Sorts the windows (test contents, cam era view windows and diagrams) as tiled
or cascade.

o Improved icons for set t0 and goto t0 in the tim e toolbar.
o Automatic adjustment of reference times for scale setup and coordinate systems setup when

setting the frame rate or t0.
o Open image sequence dialog: A “refresh”-button is added to the dialog. It will refresh the

image cache stored in the files imglist.tmp. Also, all imglist.tmp files now have the file
attribute hidden.

o The camera type list can now be configured to only contain camera models from specific
vendors.

 Presentation:
o Added visualization of cameras and 6DOF in 3D diagrams.
o Improved UI for manual legends in diagrams.
o Improved UI for adding accuracy visualization in diagrams.
o Added accuracy columns for the timetable.

 Licensing and installation:
o Demo license. It is now possible to install a demo license of any configuration on a computer

with TEMA already installed, without affec ting the current installation.
o TEMA now requires a reboot after installation if prompted for it during installation of the

program. This removes potential lic ensing problems.
o An additional check is made to ensure that the request.txt and license.txt files m atch when

installing a license. This removes potential lic ensing problems.

 Tracking:
o Greatly improved tracking and playing speed in AVI-files with incremental codecs, e.g. DivX

and XviD.
o Quadtracker: The function of the search area is adjusted so that the tem plate is allowed to

stretch outside the search area.

 Analysis:
o Lens calibration for 2D and 3D tests. A new lens calibration system for planar targets has been

added. It is highly recommended to use it in both 2D and 3D tests as it im proves the accuracy
and traceability of the result. It is included in TEMA Motion and TEMA Autom otive.

o Relative orientation for 3D tests. Perform your camera orientation in 3D tests direc tly from two
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camera views, without a surveyed target (e.g. a cage). This feature will sim plify the test
procedure for all 3D users.

o 3D interpolation. A cubic interpolation is automatically done on the 3D data on intervals with
sleeping points in one or more camera views.

See Also...

Previous Release
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What's new in TEMA 3.1?
The following major changes have been made to TEMA between this release (3.1) and the previous
release (3.0).

 Usability:
o Default Tracker toolbar. The toolbar contains a user-defined set of trackers. When a new

point is added to the test, the selection in the toolbar controls the settings of the point.
o New mode for adding points. If  the “auto” toggle in the new Default Tracker toolbar is

enabled, a left-click in the camera view window will add and position a new point to the
test. If it is disabled, the user must first add and then position the point to the test, as in
earlier versions.

o Drag-and-drop in diagrams. It is now possible to add points, distances, angles and stic k
figures to diagrams simply by dragging the items from the test c ontents window and
dropping them in the diagrams.

o Set point position. By selecting Position… in the Tracking menu, the user can manually set
the pixel coordinates of a tracking point.

 Presentation:
o 3D diagram improvements. The 3D diagram now features visualization of stic k figures,

distances, angles and axes.
o Sorting in Time tables. By clicking on the header of a column in the Time table, the rows

are sorted in increasing/decreasing order according to that column.
o Variable line width in diagrams. A preference for setting the line width in all diagrams has

been added.

 Tracking:
o Corner contour tracker. A brand new tracker for corners, based on the curvature of edges.

 Analysis:
o Contour analysis. The calculated parameters are extreme points (up, down, left, right),

major axis angle and size. The results can be presented in original or user- defined 2D
coordinate systems.

See Also...

Previous Release
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What's New in TEMA 3.0?
The following new functionality has been added to TEMA between this release (3.0) and the previous
release (2.6).

 TEMA General issues:

o New user interface for image export which also includes new functionality; title slate and
overlays (text and image boxes) can be added to the exported image file.

o Image Export Settings, specified in the Image Export interface can be stored in Preference
Archive and used in any test. 

o New Windows definition. A window can be Free or Locked. A free window will display any
item(s) selected in the test contents tree. Thus, m ulti-display is now  possible. 

o New user interface of the preference settings.
o A set of special Expressions, for easy output of test information in text boxes, Image Export

etc. A Wizard for the aid of using the variables is also included (optional)
o 3D Diagram
o Report Generator.Tool for producing cutomized reports including graphs and spreadsheets.

The report includes the Test Summary text box, which handles Expressions. 
o Point Table. Table with the tracked points as index instead of tim e. Each point will produce one

row in table. 
o Intersection tracker. Detects edges and finds intersections between detected edges. 
o Tracking image mode: Correlation, Intersection and Quadrant Symmetry trackers now

operates in 16 Bits. Thus, trac king can be done in color mode, including enhanced images. 
o Settable defaults for tracking Image mode. The set default c an be overridden for each tracked

point.
o Settable Policies for making changes in preference settings and spec ific program actions. 
o Templates. Create generic templates from a TEMA test, with or without im ages and tracked

data.
o Image Enhancement window improved.
o Multi selection in Open Image File dialog possible.
o Camera Menu. Possible to view used reference points via Camera/View Reference Points
o Find Image,for locating events in image sequences.

o Camera Menu. Possible to view used reference points via Camera/View Reference Points
o Quality data out from trackers
o New Install Shield version (MSI)
o Windows Vista supported. 

 TEMA server:
o Complete new Remote Server standalone solution. Allows a server to perform an image export

instead of the TEMA analysis workstation (optional).

 Camera Control issues (Enterprise edition):
o Dual destination download.
o Simultaneous setup of multiple cameras is now possible.
o Live Camera Download
o Preference Management (optional). 
o Camera Control: Default Interval in Manual Download
o User profiles.
o Test Sections 
o Settable Default File patterns in various places
o Settable Default Interval for Manual Download
o Interface towards a Test Planning system.
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 End Test Exports using named image export settings. 

 TEMA Arena
o A complete new product for Arena test analysis. 

 TEMA Gun Scoring: 
o A complete new, streamlined product for Gun Scoring Measurements.

 Point Generator
 Report Generator

 Test Summary.

See Also...

Previous Release
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What's New in TEMA 2.6?
The following major changes have been made to TEMA between this release (2.6) and the previous
release (2.5). 

 3D presentation of airbag volume data - used to display airbag volume data from the airbag volume
analysis functionality (optional) in three dimensions as a rotatable body.

 3D with moving Cameras - dynamic camera orientation makes 3D calculation possible with moving
cameras. 

 Image Diagram  - a plotted curve can be superimposed on the image. Using Image Merge, several
image sequences can be displayed in one image diagram simultaneously. 

 Advanced Viewer - More functionality to the TEMA viewer; 

         - Modify graphs and spread sheets in  viewer

         - Build new graphs and spread sheets from existing data

         - Export images, data, graphs and spreadsheets from the viewer

         - Print graphs and spreadsheets

         - Perform image format conversions with export capability

 Airbag visualizer for all times in Camera view - show tracker (visualizer) data in camera view window.

See Also...

Previous Release
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What's New in TEMA 2.5?
The following major changes have been made to TEMA between this release (2.5) and the previous
release (2.4). 

 Airbag volume

 Airbag circumference

 Remove License

 Exclude area

 Autofind similar points

 Suggest Point Position

 Confirm Image mode 

 Floating Licence, possible to see current users 

 Lens calibration 

 Floating Licence on Server 2003 is now supported

See Also...

Previous Release
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What's new in TEMA 2.4?
The following major changes have been made to TEMA between this release (2.4) and the previous
release (2.3). 

 File menu
o New Camera View: See Camera Parameters. 
o Print Options: The Print Setup dialog is now called Print Options. 
o Print Report: The procedure has been simplified. The Print dialog is now called Print Report. 

 Edit menu
o Area of Interest - defines a rectangular area of interest in a camera view that can be used to

limit the part of the image used for Image Enhancement and Image Export. 
o Delete: The deletion of tracked points displays a confirmation, while the deletion of

unregistered points does not. 
 View menu

o None.
 Object menu

o Export Tracked Data: Data for particular tracked items can be exported by right-c licking on the
item in the Test Contents window. 

o Point State: During tracking, points may now be unregistered or woken up.
o Note: These functions are selected from the pop-up menu rather than the Object menu. 

 Camera menu
o Camera Control (Optional Feature): A camera control function has been added to enable the

control of multiple high speed cameras of various types via Ethernet.
o Image Enhancement: The colour composition of a displayed image can be improved by

adjusting the colours in the image via a vector scope or the RGB waveform . 
o Image Export (Video Compression): When exporting single or multiple camera views to AVI

files video compression can be specified. 
o Image Export (Setup Procedure): This has been improved for single camera views. 
o Insert Reference Points: These can be inserted in two ways: 

o Importing from a file (original method). 
o Copying from another view (new method). 

o Multi Export Images: Similar to the Export Images function, but enables simultaneous export
of images from more than one camera view. 

o Time Overview: The status of the data in the test can be displayed graphically. It is of
particular benefit when used in conjunction with the Cam era Control option. 

 Diagram menu
o None. 

 Tools menu
o Licence/Disconnect: A connected network licence can be disconnected. 
o Preferences/Camera Types: The procedure has been changed so that all maintenance is done

in the tab. The Add and Edit dialogs are no longer used. A revert to defaults feature has been
added. 

 Camera View pop-up menu 
o Camera View Properties: 

o Camera Parameters: 
o Aspect Ratio: This can be specified. 
o Lens Distortion: The distortion parameters can be specified. 

o Tracking: The number of images to skip during tracking can be specified. 

See Also...

Previous Release
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What's new in TEMA 2.3?
The following major changes have been made to TEMA between this release (2.3) and the previous
release (2.2).
 

 Edit menu
o Camera View Properties/Airbag Analysis: 

 Extreme Points: The user can choose whether to compute the extreme points of the airbag
contour either as the points with the m aximum/minimum x or y coordinate (old method) or
as the intersections of the contour with the coordinate axes. 

 Volume (Optional Feature): Rotates the airbag contour around an axis and c omputes the
volume of the resulting rotational solid. 

o Scaling/Coordinate System: 
 2D Coordinate Systems: These can now be defined without reference to tracked points by

giving the coordinates of the origin and the rotation angle of the axes relative to the im age
coordinate system. 

 3D Coordinate Systems: The user can define additional coordinate system s for 3D data, in
a way analogous to how 2D coordinate systems are defined. Tracked points are used to
define the origin as well as the coordinate axes.

 Note: This feature is only available with the 3D optional feature. 
 View menu

o Notes: This function opens a window which can "collect" information from the status bar at the
bottom of the main window.

o Split View: This function enables an overview of a sequenc e to be displayed in the image
window. 

 Camera menu
o Add Body Model (Biomechanical system only): A body model can be added by: 

 Importing from a file. 
 Copying from another view. 

o Advanced Airbag (Only available with the Airbag Optional Feature) - new trac ker added. 
o Camera View: Airbag edge coordinates can be displayed in the Statusbar for both the Airbag

tracker and the Advanced Airbag tracker. 
o Copy a Tracker Setup: It is now possible to copy a tracker setup from one point to the selected

points in the Test Contents window.
o Duplicate Point Definition: It is now possible to add a new point with the same tracker as an

existing point (Duplicate). 
 Diagram menu

o Legends: Curve coordinates can now be displayed. 
 Tools menu

o AICON Lens Calibration (Optional Feature): A lens c alibration algorithm from AICON 3D
Systems GmbH is now supplied with TEMA. The algorithm requires the use of AICON's
proprietary calibration target and associated software. 

o Body Models (Biomechanical system only): Body models can be created and maintained. 
o Preferences: The following preferences have been added or amended: 

 Velocity 
 7 and 9 point filters added. 
 Reduce Filter Length at Interval Ends. 
 Use Short-Sequence Filter. 

 Key Bindings: Keyboard keys can be assigned to TEMA functions. 

See Also...

Previous Release
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What's new in TEMA 2.2?
The following major changes have been made to TEMA between this release (2.2) and the previous
releases (2.0 and 2.1). 

 General 
o New Versions: Two new versions of TEMA have been produced that contain subsets of the 2D

functionality. 
o Time Resolution: The system can handle time resolution to a level as low as nanosec onds (10-

9).
o Help lines: When tracking in 3D, once a point has been given in one c amera view, help lines

showing the possible positions of the point are shown in other cam era views. 
 File menu

o Import View: This option has been renamed from Import Camera View. 
o Print Report: This option now displays the Print Setup dialog from which the Print Report

dialog can be displayed. 
o Print Setup: This option has been merged with the Print option which is used to print a

selected item. 
o New View/Camera View: The Open Image Sequence dialog has been improved. 

 Edit menu
o Airbag Analysis Setup: The Airbag Analysis algorithm has been improved. The use interfac e

has not changed. 
o Scaling/Coordinate System: 

o 2D Scaling: The Perform Scaling checkbox has been removed, i.e. the selec ted scaling is
always applied. The default is No Scaling. 

o Coordinate Systems:  
o Origin: The specification of the origin has been improved. 
o Axis Names: The Axis names can now be specified. 
o Axis Definition: An offset angle can now be defined. 

o Depth Scaling: The user interface has been changed. 
o Test Description: This new option enables a description of the test to be created and

maintained. 
 View menu - no change. 
 Camera menu

o Add Contour: The implementation of contours has been improved, i.e. contours are now
tracked: 
o A contour may be tracked manually from frame to frame. 
o A contour may also be used to control virtual points, i.e. the opposite to the function in

previous versions. 

o Add Limit: A set of limits can be selected for the View window and used to display a boundary
in the image, in terms of one or more lines, for the presented data. 

o Add Point: The following changes have been made to the Point Setup dialog.
o Airbag Tracker: 

o Accept search area edge hits - added. 
o Shading compensation  - removed. 
o Subtract background image - added. 

o Circular Symmetry Tracker: 
o Pull point to straight path. 

o Constant Tracker: A tracker has been added to specify a fixed point in the image that can
subsequently be used as a reference point for analysis and display. 

o Correlation Tracker: the following functions have been added: 
o Sobel filter. 
o Pull point to straight path. 

o MXT Tracker:
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o Tracker version - added.
o Point Setup: The user interface has been revised, i.e. all settings are spec ified in one

dialog, whereas previously the tracker settings were specified in a separate dialog. 
o Quadrant Symmetry Tracker: 

o Pull point to straight path. 
o Virtual Tracker: 

o A tracker has been added to specify points or contours as being virtual. Their position is
calculated from the known positions of related points and contours. 

o When a virtual point in a group changes, its position within the group is autom atically
changed. This did not happen previously. 

o Auto Find Points: This new option has been added to find points automatically. It is currently
implemented only for the MXT Tracker. 

o Image Export: Changes have been made to the Image Export dialog (Downsampling
Prefiltering and Colour checkboxes).

o Point Groups: This new option groups together the options relating to point groups:
o Create Point Group
o Import Point Group: This new option enables point groups to be imported from external

files.
o Move Selection to Group
o Remove Selection from Group

o Point Name: A background colour may be specified for a point name. 
o Select New Image File: The Open Image Sequence dialog has been improved. 
o Set t0: The user interface has been changed. 

 Object menu
o Export Tracked Data: This new option exports the tracked data from the Airbag tracker to an

XML file.
 Diagram menu

o Advanced Diagram: A new diagram type has been implemented to enable more complex
diagrams to be displayed, i.e. individual components from different sequences can displayed
against each other, e.g. azimuth versus elevation. 

o Export Data: The CASDAS and MatLab export formats have been added. 
o Filters: The resampling mode can no longer be spec ified. 
o Legend Settings: The content of the displayed legends can be specified. 
o Multi Axis Diagram: Improvements have been made to the Multi Axis Diagram properties in

the following areas: 
o Align Axes
o Diagram Limits: A set of diagram limits can be selected for a diagram and used to display

a boundary on a diagram. 
o Legends

o Table: Improvements have been made to the Table properties in the following areas: 
o Data Attributes
o Coordinate System
o Decimal Point

o XT Diagram: Improvements have been made to the XT Diagram properties in the following
areas: 
o Diagram Limits: A set of diagram limits can be selected for a diagram and used to display

a boundary on a diagram. 
o Legends

o XY Diagram: Improvements have been made to the XY Diagram properties in the following
areas: 
o Diagram Limits: A set of diagram limits can be selected for a diagram and used to display

a boundary on a diagram. 
o Legends
o The range of diagrams that can be specified has been expanded to inc lude a function

introduced with Advanced diagrams, i.e. data type selection. 
 Tools menu



p526

© Image Systems AB, 2011

o Limits: A set of limits can be stored in an external file and used to display boundaries for the
presented data in terms of one or more lines in the displayed image or diagram. It is typic ally
used to indicate the acceptable limits of the data. An example is where there a measured
quantity must be within either legal or industry-accepted lim its. 

o Optimize Display Performance: The two previous menu options have been merged into one
that displays a dialog from which automatic or manual performance setup can be initiated. 

o Preferences: 
o Preferences Dialog: The dialog has been rearranged as a series of tabs. 
o Acceleration: New preference category. 
o Default Directories: A default directory for Viewer Export can now be spec ified. 
o Printing - New preference category. 
o Presentation: The Diagram preferences section has been extended. 
o Tool Colour: New preference category. 
o Velocity: New preference category. 

See Also...

Previous Release
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What's new in TEMA 2.0?
The 2.0 release contains the following additional functionality.

 Contours (Optional Feature) 
 Coordinate Grids
 Point Groups (Optional Feature) 
 Stick Figures
 Tracking Status Icons
 Viewer Export (Optional Feature) 
 Virtual Points (Optional Feature) 

Release 2.0 also contains the following changes from the 1.0 release:

 Site licences have been implemented. 
 A performance test  has been implemented to optimise the display of images. 
 An Autosave feature has been added. 
 A camera view may be renamed. 
 The File/Close menu option has been removed. 
 The Import Camera View dialog has been simplified. 
 The default setting for Depth Scaling has been changed to "off". 
 A third 2D Scaling mode ("Manual") has been added that is based solely on a spec ified scale

factor. 
 Additional features have been added to the specific ation of Coordinate Systems. 
 The Search Area used by the following trackers may be reduced after the second image has been

tracked: 
o Correlation
o Quadrant Symmetry
o Circular Symmetry
o MXT

 A shading compensation feature has been added to the Airbag tracker setup procedure. 
 The Image Export function has been rewritten. 
 Text may be displayed against a background colour for tracked and exported images. 
 Compare two or more curves displayed in the same XT Diagram or Multi-axis Diagram. 
 In Multi-axis Diagrams the scales of the third and fourth axes has c hanged place. 
 The Zoom function has been improved to enable Zoom In, Zoom Out and Zoom 1:1. previously

only the window size could be adjusted manually. 
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Managing Licences
The use of the TrackEye system is controlled by a licensing system designed to prevent the use of
unauthorised copies of the system.

If you attempt to start an unlicensed copy of the TEMA system , the Unlicensed dialog is displayed,
which requires you to acquire a licence before c ontinuing.

After upgrading the TEMA system, for example through the addition of an optional feature, a new licence
is required. If you attempt to start the TEMA system using the old licence, the Configuration Changed
dialog is displayed, which requires you to acquire a licence before continuing.

Both dialogs contain the following buttons: 
 Request licence - used to request a licence key. 
 Install licence - used to install a licence key.
 Temporary licence - used to obtain a licence that is automatically revoked after a period of trial

use. 

Licences are managed from the TEMA Main Window through the Licenc e option in the Tools menu, which
contains the following sub-options: 

 Request - used to request a new licence key. 
 Install - used to install a licence key.
 Connect - used to connect to a floating/site licence server. 
 Disconnect - used to disconnect to a floating/site licence server. 

Requesting a Licence Key

To request a licence key: 
1. Select the Request licence button in the Unlicensed dialog, or the Request option from the

Tools/Licence menu.
The Request a Licence Key dialog is displayed, showing the Configuration code, i.e. the serial
number you keyed in when the system was installed, and the Site code, i.e. a number generated
by the system from information about the specific  hardware, i.e. it is unique to the machine on
which it is generated. 

2. Verify that the Company name is correct. 
3. Verify that the Computer identification is correct. 
4. Key your Fax number if you intend to make the request via that method. 
5. If you intend to make the request on paper, i.e. by fax or post, selec t the Print button.

The request is printed and the Request a Licence Key dialog is removed from the display. 
6. If you intend to make the request electronically, i.e. by e-mail or diskette, select the File button

to display the standard Save as dialog and save the request as a text file. 
7. Select the OK button. 
8. Send the request to Image Systems, preferably via email

Installing a Licence Key

To install a licence key: 
1. Select the Install licence button in the Unlicensed dialog, or the Install option from the Tools/

Licence menu.
The Install Licence Key dialog is displayed.

o To install the key manually:
o Select the Enter manually button.
o The Enter Licence Key dialog is displayed. 
o Key the Licence key. 
o Select the OK button. 

licensing@imagesystems.se
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o To install the key from a licence file:
o Select the Load file button.
o A standard Open dialog is displayed. 
o Browse for the required licence file. 
o Select the Open button. 

In either case, if successful, the TEMA Main Window is displayed.

Connecting to Floating/Site Licence Server

1. Install the new TEMA software. 
2. Select the Connect licence button in the Unlicensed dialog, or the Connect option from the

Tools/Licence menu.
The Connect to Licence Server dialog is displayed. 

3. Key the name of the directory of the TEMA installation on the server.

Alternatively, select the button and browse for the directory. 
4. Select the OK button.

If a licence is available, it is assigned to the requesting com puter and a confirmation message
displayed.
If a licence is not available or the licence server is not accessible, a warning message is displayed
and the licence is not assigned. 

Disconnecting from Floating/Site Licence Server

To disconnect from a floating/site licence server: 
1. Select the Disconnect option from the Tools/Licence menu.

The licence is disconnected. 

Removing a licence key 
Removing a licence key from the TrackEye system will make the program unuseable. Performing the
command will create a file which can be sent to Im age Systems AB, support@imagesystems.se, e-mail to
verify that the licence has been removed. After removal, the only way to run the application again on the
computer from which the licence key was removed is to request and install a new licence from  Image
Systems AB. . 

To remove licence key, select the Remove option from the Tools/Licence menu. The Remove Licence
dialog is then displayed. Follow the instruc tions given.

Acquiring a Temporary Licence Key

A temporary licence for trial use of the TEMA system may be granted once, and onc e only, for a machine.
The licence cannot be renewed on the same machine. The length of the trial period is specified by Im age
Systems for each temporary licence.

To install a temporary licence key, select the Temporary licence button in the Unlicensed dialog. No
further action is required and the TEMA Main Window is displayed.

Before the end of the trial period you need to request a normal licence key based on both the computer
and TrackEye configurations.

Licensing System

The TEMA product is protected by a licensing system based on CrypKey. The system offers stand alone
licences, multiple licences and floating licences.

Stand alone licences

mailto:support@imagesystems.se
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A stand alone licence is locked to a specific computer. It has to be issued by exchanging codes between
the customer and Image Systems AB. In the event of a hard disk crash the lic ence has to be re-issued by
Image Systems AB. The licence can be moved to another computer by the customer without involving
Image Systems.

Multiple/Site licences

If a customer buys several licences for its own computers, they are managed via the concept of a
multiple licence. This works using a combination of the stand alone licenc e methods.

The TEMA system is installed on one of the customer's computers and the regular licence code exchange
with Image Systems AB is performed, but the licence code obtained automatically indicates the number
of licences purchased, all of which are initially assigned to the same computer. When installing TEMA on
other computers, the licence is acquired by using transfer c ommands from the first computer. Only the
purchased number of licences can be transferred in this way.

A site licence is a multiple licence with a very high licence count which enables a customer to install as
many copies of the software as required.

Floating licences

A floating licence enables a specified number of licences to be dynamically available to any number of
computers in the network. The restriction is that at any one tim e, the number of computers assigned a
licence is limited by the number of individual licences purchased as part of the floating lic ence.

The floating licence system relies on remote file transfer between a server com puter (a Windows
machine) and client computers. The server has service running that sc ans for licence requests in a
specific directory. The clients must have read and write access to this directory.

When installing TEMA with a floating licence, the licence server is installed separately from the TEMA
software. The server control files must be placed in a directory physically on the server machine. The
licence server obtains a licence code from Image Systems AB that spec ifies the maximum number of
simultaneous users. This number may be increased by obtaining a new licence code from Image Systems
AB.

Each client installation needs to be able to access the server control directory. This m eans that the server
must be online for any of the clients to operate. If there are no licenc es available when a c lient tries to
obtain one, a warning message is displayed and the client repeatedly c hecks for licence availability.
Licences are assigned on a "first come, first served" basis. If a client c omputer or its TEMA system
crashes, its assigned licence is returned to the licence server after a delay period of several m inutes.

New in TEMA 2.5 is that using Floating Licences will allow users to see which other clients that are
currently logged onto the same Floating Licence. If the number of clients are the maximum allowed, the
next client trying to log on will get a message telling login is not permitted and which other clients that
are allready logged on. 
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Dongle Solution
As an alternative to managing licenses, TEMA can be run with a dongle from Image Systems AB. A
dongle is a hardware key that fits in one of the USB ports. 

Procedure
1. Install TEMA with the configuration code labeled on the CD back cover. The following Warning dialog

will appear; 

2. Remove all USB dongles. Click OK when ready. 

3. After the TEMA installation procedure, place the dongle in the USB port.

4. Start TEMA. Done. 

Note: 

 The message as illustrated below appears if you start TEMA without the dongle in plac e. In case this
happens, Click Exit and insert the dongle in the USB port. Start TEMA again

 If you remove the dongle when you are running TEMA, the dialogue as illustrated below appears. In
case this happens, click Close and insert the dongle in the USB port again.

 If TEMA can not contact the dongle it will be closed after 5 m inutes. When this has happened, the
dialogue as illustrated below appears. Clic k Close. This will end TEMA and you have to make another
try.  Check that the USB port is working properly.
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Minidumps

Minidumps are for fault finding and debugging purposes.

If a software crash should occur TEMA tries to save valuable information for debugging purposes. This
information does not contain any user data. The TEMA user has to decide whether to pass on this
information to Image Systems or not.

Files generated by the minidump function can be attached to an email and sent to
support@imagesystems.se .

Up to and including version 3.8 [001]

The possibilities to analyze severe program crashes has been improved significantly. In this version,
when such an error occurs, this window will open 

with two options:

 Save Minidump and Exit.

This will create a small file (roughly 50KBytes) with software status at time of problems. No
user data!
This file will have a unique name including TrackEye version and date/time stamp, typically 
tema_4.0-3050-64-64_2014_12_15_09_13_54.dmp,
and will be found in the “Minidump” sub directory of the software installation. You have to
attach this file to an email to support@imagesystems.se in order for us to analyze it. We
appreciate if you send us all ‘minidumps’ you have, whether or not having a  service
contract. 

 Exit

This option will just close TrackEye.

From TEMA version TEMA v3.8 [002] the minidump mechanism has changed.
The purpose is to always get a minidump. Currently there are situations when the dump is never written. 

New behaviour:
The dialog coming up at crash time is gone.
Instead a basic minidump is written directly. Naming as before (application_version_datetime.dmp)
After that a more elaborate dump is written (that includes script language stack)
This has the word ‘cpm’ added to the filename: application_version_ datetime_cpm.dmp
The date/time stamp is now the time when the crashing application was started, not crash time.
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Depending on the nature of the crash the second dump may not be written.

If possible (depending on how serious the crash is) a command window is shown with the location of the dumps.

The location is not changed:
XP : subfolder ‘Minidump’ for each installed version (Program Files/Image Systems AB/<appl>)
Win7: c:\ProgramData\<appl>\minidumps

 



p535

© Image Systems AB, 2011

-> v3.8 [001]

The possibilities to analyze severe program crashes has been improved significantly.

If an error occurs, this window will open 

with two options:

 Save Minidump and Exit.

This will create a small file (roughly 50KBytes) with software status at tim e of problems. No user
data!
This file will have a unique name including TrackEye version and date/time stamp, typically
trackeye_5.0.1836.0_2007_12_17_08_23_16.dmp,
and will be found in the “Minidump” sub directory of the software installation. You have to attach
this file to an email to support@imagesystems.se in order for us to analyze it. We appreciate if
you send us all ‘minidumps’ you have, whether or not having a  service c ontract. 

 Exit

This option will just close TrackEye.

The minidump file can easily be attached to an em ail and sent to support@imagesystems.se , if possible
together with a short description what steps prec eeded the problem.

Location of minidumps:
 XP : subfolder ‘Minidump’ for each installed version (Program Files/Image Systems AB/<appl>)
 Win7: c:\ProgramData\<appl>\minidumps
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v3.8 [002] ->
From TEMA version TEMA v3.8 [002] the minidump mechanism has changed. The previous minidump mechanism did
not always succeed to save debugging info.

The purpose is of course to always get a minidump.  

New behaviour
 The dialog coming up at crash time is gone. Instead a basic minidump is written directly. Naming as before

(application_version_datetime.dmp)
 After that a more elaborate dump is written (that includes script language stack). This has the word ‘cpm’ added to

the filename: application_version_ datetime_cpm.dmp
 The date/time stamp is now the time when the crashing application was started, not crash time.
 Depending on the nature of the crash the second dump may not be written.
 If possible (depending on how serious the crash is) a command window is shown with the location of the dumps.

Location of minidumps:
 XP : subfolder ‘Minidump’ for each installed version (Program Files/Image Systems AB/<appl>)
 Win7: c:\ProgramData\<appl>\minidumps



© Image Systems AB, 2014


	Welcome to TEMA!
	Using Help
	System Versions
	Lite Version

	Getting Started
	2D - Getting Started
	3D - Getting Started
	6D - Getting Started

	Working with TEMA
	Starting up and Closing down
	Main Window
	Main Window - Illustration
	Display Area
	Test Contents
	Menu
	File Menu
	Edit Menu
	View Menu
	Camera Menu
	Tracking Menu
	Diagram Menu
	Tools Menu
	Windows Menu
	Help Menu

	Toolbars
	Standard Toolbar
	Point Control Toolbar
	Tools Toolbar
	Default Trackers Toolbar
	Data Toolbar
	Time Panel Toolbar
	Time Slider Toolbar
	Camera Control Toolbar
	Test Sequence Toolbar

	Tools
	Using the Selection Tool
	Using the Distance Measurement Tool
	Using the Angle Measurement Tool
	Using the Velocity/Distance Measurement Tool
	Using the Zoom Tool
	Using the White Balance Tool


	Windows 
	Setting Up the Test
	Specifying Camera Views
	Camera View Window
	Camera View Properties
	Airbag Analysis Properties
	Camera Parameters
	Colour/Contrast Properties
	Image File Properties
	Reselect Image File

	Tracking Properties
	Interpolation of Sleeping Points

	Camera View Attributes

	Opening Image Sequences
	Image File Not Found
	Specifying Image File Parameters

	Templates
	Test Sections (optional)
	Specifying the Gamma Correction
	Opening Data Files
	Importing Camera Views
	Setting Time Properties
	Setting up List Columns
	Creating and Maintaining a Test Description
	Lens Calibration
	AICON Lens Calibration
	3D Target Lens Calibration
	Results

	Planar Target Lens Calibration
	More about...
	Lens Distortion Model
	Lens Calibration Wizard dialogs


	Wand Calibration

	Test Database Interface (optional)
	Controlling Time
	Specifying Control Time 
	Time Overview
	Setting t0
	Setting the Current Time to t0

	Tracking
	Setting up and Running Tracking
	Managing Tracked Points
	Autofind similar points
	Point Setup
	Running Tracking
	Split View
	Exclude Area
	Point Generator

	Angles/Distances
	Maintaining Distances
	Maintaining Angles
	Angle Definitions


	Corridors/Stick Figures/Body Models
	Corridors
	Stick Figures
	Body Models (optional)

	Trackers
	Algorithms
	Airbag Tracker
	Airbag Analysis Calculations
	Airbag Volume analysis

	Advanced Airbag Tracker
	Centre of Gravity Tracker
	Circular Symmetry Tracker
	Constant Tracker
	AdvancedCircleTracker
	Correlation Tracker
	Corner Contour Tracker
	Intersection Tracker
	MXT Tracker
	Quadrant Symmetry Tracker
	Circle Tracker (Optional)

	Adjusting Threshold Levels

	Groups, Contours and Virtual Points
	Maintaining Point Group Properties
	Using Contours
	Contour as a Manual Drawing Tool
	Virtual Point from Contour Position
	Virtual Contour from Point Position
	Maintaining Contour Properties

	Maintaining Virtual Point Properties


	Presentation
	XT Diagram
	Multi Axis Diagram
	XY Diagram
	Advanced Diagram
	3D Diagram 
	Image Diagram
	Image Merge

	Frequency Analysis Diagram
	Time Table
	Amending Table General Settings

	Point Table
	Report (optional)
	Test Summary

	Absolute Value / Vector Length
	Diagram Axes
	Diagram Filters
	Filter Algorithms

	Manipulating Diagrams and Tables
	Diagram General Properties
	Diagram Corridors
	Accuracy Settings
	Text Boxes
	Copy to Time Table

	Scaling and Coordinate Systems
	Motion Planes
	Motion Planes Explanation

	2D Coordinate Systems
	Standard
	Aligned 

	3D Coordinate Systems
	Coordinate Systems - Setup Procedure
	Coordinate Grids

	3D/6D
	3D Calculations
	3D Tracking Help Lines
	Importing a Calibration
	Calculating the Orientation of a Camera
	Static Camera Orientation
	Relative Camera Orientation
	Camera Position and Rotation Definitions

	Enter Camera Orientation
	Maintaining 3D Point Properties
	Inserting Reference/Target Points
	3D with moving cameras
	6DOF Calculations

	DIC (Digital Image Correlation, option)
	DIC Inspection Lines

	Camera Control
	Scanning for Cameras
	Adding Cameras
	Camera Setup Window
	Camera Black Reference
	Arming Cameras
	Snapshot Recording
	Single Frame Capture
	Manual Download 
	Dual Download (optional)
	Live Download (optional)

	Redo Auto Download
	Clearing Camera Images
	Assigning Cameras

	Image Enhancement
	Image Enhancement window
	Contrast/Brightness
	Edge Enhancement
	Saturation/Hue
	White Balance (Image Enhancement)
	Using the RGB Waveform
	Using the Vector Scope
	Using the Histogram

	Preferences
	Attributes
	Analysis
	Velocity
	Acceleration

	Camera Control
	Configure Known Cameras

	Camera Types
	Directories
	Disc Cleanup
	General
	Maintaining Display Preferences
	Maintaining Cursor Preferences
	Maintaing Tool Colour Preferences
	Maintaining Tracking Preferences
	Window Defaults
	Time/Date
	Image Cache
	New Test

	Image Export
	Image Import
	Keyboard Bindings
	Policies (optional)
	Precision & Units
	Remote Export Servers
	Test Planning System (optional)
	Views (optional)
	Presentation
	Printing

	Preference Management (optional)
	Profiles (optional)
	Data Output
	Copying to the Clipboard
	Image Export (optional)
	Specifying the Storage Format
	Multiple Image Export
	Server Export
	Digital Signature
	Image Boxes

	Combined Image Export
	Exporting Data
	Exporting Tracked Data
	Specifying Video Compression
	Printing a Selected Item
	Printing Test Reports
	Specifying the Print Options

	Miscellaneous
	Area of Interest
	Browsing for a Folder
	Deleting an Item
	Displaying the Camera View
	Displaying Toolbars
	Editing Colours
	Expressions
	The String  Expression Wizard (optional)

	File Names
	Find Image
	Gun Scoring
	Geometry (optional)
	2D Reference Points

	Guide

	Maintaining Properties
	Maintaining Data File Properties

	Notes Window
	Renaming a View
	Show Disabled Items
	Supported Image Formats
	TEMA Viewer
	Exporting to a Viewer CD
	Customizing Viewer Startup
	The SPD file format
	Advanced viewer

	TEMA Arena
	Guide

	Undo or Redo
	Using the Zoom Window

	TEMA 64-bit - exceptions

	What's New?
	What's new in 4.0?
	What's new in 3.9?
	What's new in 3.8?
	What's new in 3.7?
	What's new in 3.5?
	What's new in 3.4?
	What's new in 3.3?
	What's new in 3.1?
	What's New in 3.0?
	What's New in 2.6?
	What's New in 2.5?
	What's new in 2.4?
	What's new in 2.3?
	What's new in 2.2?
	What's new in 2.0?

	Managing Licences
	Dongle Solution

	Minidumps
	-> v3.8 [001]
	v3.8 [002] ->


